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Maximizer CRM

@ Throughout this document,
Maximizer CRM is referred to
as Maximizer.

Maximizer on the Web

Maximizer CRM is specifically designed for small and medium-sized
businesses and corporate divisions of large companies. By integrating
sales, marketing, and customer service tools into one affordable
solution, Maximizer CRM helps organizations realize their primary
customer management goal of having many profitable and satisfied
customers.

Throughout the customer life cycle, as prospects move from the
marketing department to the sales department, and as customers are
passed onto service departments, Maximizer enables an organization
to communicate with its customers through multiple channels, to
share information, and to organize individual and team efforts.

Maximizer is a complete software solution that brings together
elements of CRM, enterprise contact management, marketing
automation, and other related applications to meet the sales,
marketing, and customer service challenges of modern businesses.

e Managing your company’s lists of Companies, Individuals
(people not associated with a Company), and Contacts (people
associated with a Company or Individual).

e Keeping track of your scheduled appointments and tasks.

®  Pursuing a sale using a structured sales strategy and team-based
selling.

e Managing customer service and your knowledge base
operations.

e Promoting your product through automated campaigns.
¢ Sending email messages to one or many recipients.

e Organizing and accessing your sales and marketing literature in
a shared library.

* Generating reports from any of the lists—Address Book entries,
opportunities, customer service cases, Hotlist tasks, and
additional information you keep on your entries.

For many organizations, it's impractical to send an entire database to
each remote machine—the database may be too large; there may be
concerns about distributing valuable lead and customer information;
or there may be a concern about connection times and the amount
of data being sent.

Maximizer's gives remote users access to the central Maximizer
database via the web. Remote users can access and work with
Address Book entries as they would in Maximizer at the office.



Log In to Maximizer

@ You can access the sample
Escona Tutorial Address Book
using “jnapoli” as the user ID
and “maximizer” as the
password.
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Remote users need only a web browser, Maximizer user ID, and
password. A travelling business person could step into a web café or
borrow someone’s computer to quickly connect to the home office
Address Book. Once online, it's easy to work with contact data, check
Hotlist tasks and calendar appointments, customer service cases, and
opportunities.

Maximizer runs in Microsoft Internet Explorer, Mozilla Firefox, and
Google Chrome. You can access Maximizer by entering the URL
directly in your web browser.

n Enter the Maximizer URL in a web browser.

The URL is set by your system administrator. Typically, the URL
would look like the following:

http://[YourServerName]/MaximizerWebAccess/Default.aspx

E From the Log in to drop-down list, select the Address Book you
want to open.

B Enter your User ID and password.
n Click Log In.

Maximizer
CRM2015r:

Escona Tutorial E|

Remember me
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Enable the Maximizer Add-On in Internet Explorer

If you use Internet Explorer to access Maximizer, you are prompted
when you first log in with information about an add-on from
Maximizer Software. The message is displayed at the top of your
browser window. You should accept the add-on.

n At the top of the browser window, click the message bar, and
select Run add-on.

E Click Run to confirm the change.

Configure Internet Explorer to Use Maximizer

If you use Internet Explorer, you may need to adjust your security
settings to access the full functionality of Maximizer. In Internet
Explorer, you must add Maximizer to the Trusted sites zone with the
security level set to Medium-low.

n In Internet Explorer, select Tools > Internet Options, and select
the Security tab.

E Select the Trusted sites security zone, and click Sites.

ﬂ In the Add this website to the zone field, enter the Maximizer
Web Access URL.

n Clear the Require server verification (https:) for all sites in
this zone checkbox.

E cick Add.
Maximizer is added to the list of sites in the zone.

Trusted sites ==l

# You can add and remove websites from this zone. All websites in

' this zone will use the zone's security settings.

Add this website to the zone:

Websites:

https:/jmaximizer. server.com Remove

7| Require server verification (https:) for all sites in this zone

Close

E Click Close.

With the Trusted sites zone still selected, click Custom Level.
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B In the Reset custom settings area, select Medium-low from
the Reset to drop-down list.

E If you use Windows Authentication, scroll down the Settings
list, and under User Authentication > Logon, select
Automatic logon with current user name and password.

This step is required only if Maximizer Web Access is configured
to use Windows Authentication. It allows you to log in to
Maximizer automatically using your Windows user account.

nmCIick OK to save the changes in the Security Settings dialog box,
and click OK again to save your Internet options.

Enable Pop-Up Windows in Firefox for Maximizer

Pop-up windows must be enabled for Maximizer in your browser to
access its full functionality. If you use Internet Explorer, pop-up
windows are enabled when you add Maximizer to the Trusted sites
zone. If you use Firefox, you may need to enable pop-up windows for
the site.

If Firefox is blocking pop-up windows, you are prompted with a
message at the top of the browser window when you try to access
certain commands. The message states that Firefox is preventing
Maximizer from opening a pop-up window.

n In Firefox, select Tools > Options, and select the Content tab.

E Next to Block pop-up windows, click Exceptions.

B In the Address of web site field, enter the Maximizer Web
Access URL, and click Allow.

(@) Allowed Sites - Pop-ups = e

You can specify which web sites are allowed to open pop-up windows. Type
the exact address of the site you want to allow and then click Allow.

Address of web site:

r
g

Site Status

maximizer-server Allow

Remove Site | | Remove All Sites Close
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ﬂ Click Close.
E Click OK to save the changes to the Options dialog box.

Change your Password

After you first log in to Maximizer, you should change your
password.

n In the top-right corner of the page, click Preferences.

E Click Password.
The Change Password dialog box opens.

ﬂ In the Old Password field, enter your current password.

n In the New Password and Confirm New Password fields,
enter your new password.

E If your user exists in more than one Address Book on the server,
select the Change your password in all databases on this server
checkbox to change your password

E Click OK to close the Change Password dialog box.

Click Save to save the changes to your preferences.

After changing your password, you will receive an email informing
you that your Maximizer user password has been changed. If you
receive such an email without changing your password, you should
contact your Maximizer administrator.

Maximizer Password Requirements

There are a number of requirements that user passwords must meet
in Maximizer.

e It must begin with a letter (A-2).

e It can contain only alphabetical characters (A-Z), numbers (0-9),
or the number-sign (#), dollar-sign ($), or underscore (_) symbols.

e |t cannot be the same as your Maximizer User ID.
* [t cannot be "PASSWORD", "ADMIN", or "ADMINISTRATOR".
¢ It can be a maximum of 30 characters.

In addition to these basic Maximizer password requirements, your
local domain security policy may also place additional restrictions on
the passwords that you can use for Maximizer users. For information
on whether additional password requirements are enforced by your
domain security policy, contact your network administrator.
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Maximizer Interface

@The Details tab is available in
the Address Book and
Opportunities pages. If you
open an entry in a different
page, the entry is displayed in
a dialog box.

Information in Maximizer is displayed in lists, which means that it can
be sorted and arranged in rows and columns. Lists make it easy to see
many entries at once and customize your views. Different types of
information are viewed in different pages in Maximizer. You can
easily move from page to page to access different types of entries.

Keep the following points in mind when working with the Maximizer
pages.
n Click on an entry in the list to make it the current entry.

The text in an entry is a link to open the entry in the Details tab.
You can click in an empty part of the row to make the entry the
current entry without opening the Details tab.

E View information and attached entries for the current entry in
the tabbed following pane.

E Use the menus to access all commands that are available in the
current page. You can also right-click to select common tasks
from the shortcut menu.

ﬂ Select an icon in the icon bar to move to a different page.

E At the top of the icon bar, use the button with the arrows on it
to hide or display the full icon bar.

E Add icons to the Quick Access toolbar above the icon bar for
one-click access to your saved searches and Favorite Lists.

Hover your mouse over the links in the left navigation pane to
access additional commands in pop-up windows including the
following:

User Information to view phone lists and status of other
Maximizer users.

Links to access external links.

Import to import Address Book entries and other data from
external sources.
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Administration to access administrative tasks.

¥
'} Address Book Search for Address Book entries... Q, E' fin M
184 Displayed - 91 Companies, 3 Individuals, 90 Contacts

« 5 Edit v Wiewd 3 Search v Actions ¥ Report v Help + :@ @ - @9
£« Name | Phone Number | Email Address city State | Department | Division |
B Quick Access = pr
& [5)ABC Wine Shop Inc. (604) 601-8000 escona@maximizer.com Vancouver 8c Sales =
@ # Y I 3 [ 3 Aggassi Cold Beer & Wine Stare (504) 601-8000 escona@maximizer .com Alice Spring £ B
g Iﬂﬂ R [/ 5 Albert's Steak House (604) 601-3000 escona @maximizer.com Albuquerque NM
Bl [ £ Al The Best Spirits (504) 601-8000 escona@maximizer .com Riverside cr
Z&] My Work
[y iy Woric Bay i *Amelia Liquors South (504) 601-8000 escona@maximizercom Amelia Island FL Customer Servic  Asia Padfic Regiol
Q Address Book 9 £ Andrews, Jennifer (604) 601-3000 escona @maximizer.com Winnipeg MB
(¥, opportuniies [ 3 Ansley Wine Merchants (504) 601-8000 escona@maximizer..com Atlanta A
3 Quumsﬂ
l—']:. Campaigns 1i°3 Astrr \finy nirits: AN4Y AN1-RONN. m Dews ¥ark nr A

[T] customer service S
= ABC Wine Shop Inc. i < ‘ Details
@ Knowledge Base

Contacts | History | Motes | User-Defined Fields | Documents | Customer Service | Opportunities | Activit » [+ & ¥ o

[z] rothst ABC Wine Shop Inc. Key Fields for: General Customer -3 @ @ [ Acons
Department: Sales : Add anote
Calendar R Annual Sales:  5500000.00 Territory: North / Int'l Pl
. = Frini Region: CAN - West Territory Set By Rule L
Company Librar; tatus: =| Create an opportuni
@ SR Industry: Retail Sales < P pporunity
Ful Access:  Publi reate a case
Phone numbers & SzeofClent:  Small A —
o Video Tutorials Sdeslead: Mo Receive 5 cal
Main: (604) 601-8000 leadstatus:  Hot S
Fax: (604) 601-8001
§i] User information Celk: (604) 601 8002 Schedule a meeting
= Pager: (144) 564-7778 Schedule a to-do
[@] tnks > Schedule an Action Plan
i Email addresses and website
s Import * +Favorite lists
§7 administration Rrnine asconafm

Main Lists and Tabbed Panes

The Maximizer interface displays entries in a main list and additional
information in tabbed following panes. The contents of the tabs in
the lower pane depend on the current entry in the main list. For
example, the Notes pane displays only the notes attached to the
current entry in the main list.

Keep the following points in mind when working in the tabbed
following panes.

Use the Filter drop-down list to filter the entries displayed in the
list.

E Click on a column heading to sort the entries in the list by the
values in the column.

Select the other tabs to navigate to other panes and view
additional information on the current entry.

ﬂ Use the right and left arrows to view hidden tabs if the screen is
not wide enough to display them all at once.

E Click and drag the top border of the lower pane to change its
size.
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E Click the arrow in the top-right corner of the lower pane to

minimize the pane.

Click the + icon next to the tabs to customize which tabs are

displayed in the tabbed pane.

E Maximizer remembers which tab is selected when you switch
between the main Maximizer pages, so that when you come
back to a page the same tab is open as when you left.

= 75 Delete
« Date

» 6j6/2012
7i28/2011
7j28j2011
712872011
7j14j2011
1018201
5/18/2010
1j1542010
1j15j2010

Time
2:24PM
2:33PM
2:17PM
1:43PM
12:53PM
4131 PM
4:10 PM
Z:02PM
11:48 AM

Type

Customer Service
Customer Service
Customer Service
Customer Service
Task

Customer Service
Customer Service
Task

History

Maximizer Pages

Dashboards

Gl

My Work Day

Address Book

L

show: [AlTypes <] s
Text
Case HQ-00090 has been created: Faulty Praduct
Case HQ-00042 has been deleted: Spoilk product, resend
Case HQ-00056 has been deleted: Faulty Product
Case HQ-00059 has been created: Faulty Product
Hatlist Task Completed: Confirm deadline
Case HQ-00056 has been created: Faulty Product
Case HQ-00042 has been created: Spoilt product, resend

B-m User-Defined Fields = Documents = Customer Service Oppnrt + BE
o

Filter: | &1 Dates B

reator
Joe MNapoli
Joe Napali
Joe Mapoli
Joe Napoli
Joe MNapoli
Joe Napali
Joe Mapoli

Scheduled Generic Action Plan plan on January 15, 2010 to star  Joe Napoli

Tertitory Alignment has changed field Territory Status' from 'Ur - Lou Jones

Full Access
Public
Public
Public
Public
Public
Public
Public
Public
Public

Read Access
Public
Public
Public
Public
Public
Public
Public
Public
Public

The main Maximizer page is the Address Book page, which lists the
Companies, Individuals, and Contacts in your Maximizer database
(Address Book). The following list provides a brief description of each
main page accessible from Maximizer.

The Dashboards page displays up-to-the-second indicators of your
company'’s performance, so you can see at a glance how your
company is doing.

The My Work Day page is an area where everyone in your company
using Maximizer can view Hotlist tasks, appointments, and company
announcements, as well as access to dashboards.

The Address Book page contains all the information about your
prospects, customers, business and professional associates, or any
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Opportunities

Campaigns

Customer Service

=

Knowledge Base

<

Hotlist

AR NN

other group of people you deal with on a regular basis. It links you to
related information about each Address Book entry, such as
Contacts, Hotlist tasks, customer service cases, opportunities,
documents, and user-defined fields.

The Opportunities page tracks your sales opportunities. It helps you
and your colleagues manage your sales processes. Opportunity
management defines and strengthens your selling methodology to
include all members of your sales teams.

The Quotas page allows you to keep track of your sales quotas. You
can view the forecast, weighted, and won revenue of your
opportunities compared to your quota for each month, quarter, or
year.

The Campaigns page allows you to create and manage automated
campaigns. Automated campaigns send out fax, print, and email
messages to your Address Book entries on a pre-defined schedule
and track how subscribers interact with the messages.

The Customer Service page supports and enhances your existing
customer service business processes. All Address Book entry issues can
be recorded, categorized, and escalated appropriately to ensure
issues are dealt with in a timely manner.

The Knowledge Base page provides you with a library-style tool to
manage your customer service solutions. The page is tightly
integrated with the Customer Service page. An article is typically
created for each case solution, answered question, or guideline
relating to your products or services.

The Hotlist is a to-do list of tasks and reminders that are usually
timeless. The Hotlist is where you record actions and follow-up
activities related to your interactions with Companies, Individuals,



Calendar

B

Company Library

Reports

€
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and Contacts. For example, you can use the Hotlist to schedule a
phone call to a Contact who is out of town for a week. When the
week is up, the Hotlist will remind you to call again.

The Calendar page allows you to schedule, print, and view your
appointments with Maximizer users or Address Book entries. Because
the calendar works with the Peg Board feature, you can make sure
that when you have an appointment, others can see when you are
busy or out of the office. If you need to be reminded of an
appointment, Maximizer can sound an alarm in advance of the
appointment or task.

The Company Library stores your company’s sales and marketing
information for everyone to access. The Company Library page
allows you to download documents, to view notes and hyperlinks in
the preview pane, and to send documents to Address Book entries.

The Reports page lets you access SQL Server Reporting Services
reports stored on your server and create new reports using SQL
Server Report Builder. SQL Server Reporting Services Integration
must be enabled in the System Options preferences in Maximizer
Administrator to access the Reports page.
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Lists of Entries

Types of Entries

Sorting Entries

Maximizer is list-based. You can customize the information listed by
changing the column setup, saving a Favorite List, or using a view
filter. In some pages, you can tell how many entries and what types
of entries are displayed in the current list by reading the title bar.

Filters are available for every page that has a View bar. Filters control
the type and amount of data you want to see at any given time.
Filters contain options that are specific to the type of data that is
displayed in each page.

Almost all of the information displayed in Maximizer is displayed in a
list, including notes and documents attached to entries, Hotlist tasks,
and Calendar appointments. Maximizer contains main modules that
list the following types of entries.

¢ Address Book entries — The main type of entry in Maximizer.
They include Companies, Individuals, and Contacts that are
attached to Companies or Individuals.

e Opportunities — Entries to keep track of sales opportunities.
They are associated with Address Book entries.

e Customer service cases — Entries to keep track of customer
service information. They are associated with Address Book
entries.

e Campaigns - Entries to keep track of automated campaigns.

An important part of viewing information in a list-based page is
sorting your list by different columns. By clicking on a column title,
you can re-sort your list by that column. If you click the column title
again, the list sorts in reverse order.

Sorting entries by column works from left to right. For example, if
you sort by a column that contains the City/Town field, entries with
the same city/town will be sorted by the next column to the right. If
you wish to change the order of the columns, you must change the
column setup.

The current sorting in a list is saved when you leave a page or close
Maximizer. When you next view the list, the columns are sorted the
same way as the last time you viewed the list.



Select Entries

@ The text in an entry is a link to
open the entry in the Details
tab. You can click in an empty
part of the row to make the
entry the current entry without
opening the Details tab.
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When you click on an entry, it becomes the current entry, marked
with an arrow to the left of the entry. Most commands are
performed on the current entry. The entries listed in the tabbed
panes depend on the current entry.

You can also select multiple entries to perform commands on many
entries at the same time. Checkmarks are displayed to the left of
selected entries. The current entry may or may not be one of the
selected entries.

e  Click the checkbox to the left of entries.

e Click on the entries one at a time while holding down the
Control key.

e To select all entries between two entries, select an entry and,
while holding down the Shift key, select another entry.

e Toselect or clear all entries in the current list, click the checkbox
at the left of the heading row, above the checkboxes for the
individual entries in the list. Or select Edit > Select All.

« Name Phone Number
/] 2 Adams, Dante (604) 501-8000
|+ i) Aggassi Cold Beer & Wine Store  (604) 601-8000
[+ i) Ansley Wine Merchants (604) 501-8000
[ i) The Inn At Littie Washington (604) 601-8000
s#] ic Westchester Wine Warehouse (604) 601-8000

e To clear selected entries, select Edit > Deselect All.

e To reverse which entries in the list are selected, select Edit >
Invert Selection.

Display only Selected Entries

n Select the entries that you want to display.

E Select Edit > Make Selected List Current.
The other entries are removed from the list.



14 | Maximizer Web Access
User's Guide

Remove All Entries from a List

Refresh a List of Entries

e Select View > Clear List.

As other users update entries, the information displayed in your list
of entries may get out of date. You can refresh the list of entries
displayed in the Address Book, Opportunities, Campaigns, Customer
Service, and Hotlist pages; in the Notes, User-Defined Fields, and
Documents panes; and in the Notes, Documents, Customer Service,
Opportunities, and Activities tabs in open entries.

If you refresh the list of entries in a main page, the information in the
column setup updates, but not all of the information displayed in the
tabbed panes. If you refresh a list in a tabbed pane, or in an open
entry, only the information in the current tab is refreshed.

If you refresh the list in the Address Book, Opportunities, Customer
Service, or Campaigns page, the current list of entries is maintained,
and only the information displayed is updated. If you refresh the list
in the Hotlist page, a tabbed pane, or in an open entry, the filter is

reapplied and entries may be added or removed from the list.

¢ In the top-right corner of the list, select the Refresh icon.
The information displayed in the list updates.
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@ You must be part of the
Company Announcement
Authors security group for your
documents to display in the
announcements list.
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My Work Day is an area where everyone in your company using
Maximizer can see Hotlist tasks, appointments, company
announcements, and dashboards.

I] Select the My Work Day icon to open the My Work Day page.

E Click on an appointment or a Hotlist task to view details of
the activity.

E Select a company announcement from the drop-down list to
display it in the page.

To add an announcement to the list, insert the announcement as
a note, or as a text or an HTML document in the Company
Announcements folder in the Company Library.

EI Select the Print icons to print activities or company
announcements for the day.

E Select the Calendar icon and select a date to display tasks and
appointments for a different day.

B Select the Dashboards tab to view your dashboards.

# My Work Day

<«

“;ﬂ Dashboards

(@ RecentEntries
.,15 User information *
|@ Links >
7 Administration  »

My Work Day Dashboards 9

[27,) My Work 0= n (] Activities
I:‘B Address Book Appointments E Welcome to Maximizer CRM B -

€ October 04, 2011, 9:00 AM - 10:00 AM,
[, Opportunities ¥ Driority: MED ¥ Date:  October 04, 2011 3:32 PM
= Weekly Sales Meeting N .
L_, ! = Subject: Welcome to Maximizer CRM
g Quotas October 04, 2011, 1:30 PM - 2:00 PM
’E c _ Intehrview il . T
4 With: Jane Doe - Aggassi Cold Beer & Wine Store
e ampaigns
(=] customer service October 04, 2011, 2:30 PM - 3:00 PM MV Work Day Announcement
Interview 2 e
- With: Jonrifer Tulley for Maximizer CRM 12
@“ Knowledge Base E
Tasks
E| Hotlist & October 04, 2011 .~ Welcome to Maximizer CRM 12!
= To-do: Phone Jennifer to schedule itment.
5| Calend With: Susanne Contreras - Grapes & Grains ) ) .
@ sienaar Congratulations on selecting the leading,
. October 04, 2011 v . X
f_m Company Library Review status reports from the past week, easy-to-use customer relationship management

- October 04, 2011, 5:00 PM
‘:J Reports Confirm deadline yours. Whether you're in management, sales,
With: West End Wine Shop

Current User: Joe Napoli | Preferences | Logout | Help =

Tuesday, October 04,2011 % | =) i:.] Company Announcements .=‘JE

(CRM) software solution for companies like

marketing, or customer service, Maximizer CRM
is designed to help you maximize revenues,
maximize customer satisfaction, and maximize
every single day.

To get the most out of your Maximizer CRM -
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Getting Help

Maximizer Help is your comprehensive guide to working with the
Maximizer modules. As you work with Maximizer, you probably
already know what business task you want to accomplish—such as
sending an email to many recipients, and recording your contact
management information. Maximizer’s help and guides have the
answers you are looking for.

The types of documentation you can expect to find to help you with
Maximizer include:

e  Online Help - Online step-by-step instructions with a table of
contents, an index, and search.

¢ Online manuals - Printable version of the online help that you
can read using Adobe Acrobat Reader.

Take a Tour of Maximizer

Open the Online Help

The Maximizer Welcome Tours provide you with quick video tours of
Maximizer Web Access and Web Access Administrator and introduce
you to some of Maximizer’s key concepts and features.

e To access the Maximizer Welcome Tours, select Help > Take a
Tour and choose the tour you wish to view.

You can look up Help topics the same way you would in a book—the
table of contents lists the topics in a logical order, and the index lets
you look up topics by keyword. Maximizer Help also lets you perform
a search for any word or words in any topic.

You can access the online help over the Internet or stored on your
server. When you first open the online help, you are prompted to
choose which version of the help you want to access. You can later
change this setting in your preferences. The version of the online
help on the Internet may contain more up-to-date information than
the version stored on your server.

n In the top-right corner of a page, following pane, or dialog box,
select the Help on the current page icon.

If it's your first time accessing the online help, you are prompted
to choose the source of the help content.

E If necessary, select the source of the help content, and click
Continue.



View Video Tutorials
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¢ To view the most up-to-date content over the Internet, select
Retrieve the hosted online help content from
Maximizer.

e To view content stored on your server, select Retrieve local
online help content.

Choose Local or Hosted Help Content - Mozilla Firefox ==

Online Help
Would you like to view your local help content or retrieve the hosted online help

content from Maximizer?

9) Retrieve the hosted online help content from Maximizer

Retrieve local online help content

The option selected above can be changed by clicking ‘Preferences’ from the
system menu

Note: Selecting to retriev the hosted online help content from Maximizer assures.
that you get the most "up-to-date” help content

If you're accessing the online help from a specific page or dialog
box, information associated with that page/dialog box is
displayed.

Some pages and dialog boxes provide links to video tutorials that
walk through how to make the most of the features in Maximizer.
Video tutorials are available in any page, following pane, or dialog
box where the Video help icon is displayed. You can also view a list of
all video tutorials from the icon bar.

¢ In the top-right corner of the page, following pane, or dialog
box, select the Video Help icon.

A new browser window opens and displays the video tutorial.
e |nthe icon bar, select the Video Tutorials icon.

The current list of video tutorials is displayed.
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Open the User's Guide

In addition to the online help, you can access a User’s Guidein .PDF
format that you can read online using Adobe Acrobat Reader. The
Maximizer CRM User’s Guide contains similar information to the
online help in a printable format. Like the online help, you can
search the guide, and access hyperlinks from the table of contents,
index, and cross-references to other places in the guide. You can also
save the guide to your local computer to access at any time, offline.

¢ In the top-right corner of the page, select Help > Support
Center.

Stay Connected with Maximizer

Click on the Twitter, Facebook, and LinkedIn icons to connect with
Maximizer on your favorite social networking site. There you will be
able to connect with Maximizer users and to hear the latest news
about Maximizer CRM.

Click the Feature Suggestions icon to make suggestions for new
features in Maximizer. You can also select the Feedback option in the
Help menu to provide feedback about existing features.
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“Address Book Entry Lists” on page 23
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About Address Book Entries

Maximizer's focus is on Address Book entries—Companies,
Individuals, and Contacts. Address Book entries can also be
designated as sales leads to help you organize your information.

The Address Book page gives you the ability to manage your daily
activities with companies, and the people who work for them. In
addition to the basic Address Book information, including addresses,
phone numbers, and email addresses, you can record other
important information, such as relationships between companies or
extra details, like the business type.

As you work with the Address Book entries in your Maximizer
Address Book, you can keep notes on your activities, so you can
always have a history of your activities with your customers.

Company and Individual

type Address Book A Company represents a
emriei;:ontain C(::lntacths company or organization. 2o Wdividual i
(people associated wit ividual & a person
peop a Company or Company not affiliated with any
Individual). You can company or organization.

attach notes, user- 1

defined fields, and Individual

documents to Address
Book entries. Contacts
Contacts

User-defined
ields

Types of Address Book Entries

There are three types of Address Book entries in Maximizer:
Companies, Individuals, and Contacts.

e Companies - Entries that represent corporate entities such as
businesses, associations, or organizations.

¢ Individuals - Entries that represent single, key people, like self-
employed professionals or entrepreneurs. These entries are not
associated with Companies.

e Contacts - Entries that represent the people attached to
Companies or Individuals. These entries refer to the people
inside organizations.
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Companies and Individuals can exist on their own in an Address
Book. Contacts are always attached to other Company or Individual
entries.

You can designate some of your Address Book entries as sales leads
to help organize your entries. Leads are your sales prospects. By
setting entries as leads, you can set them apart from your customers.

For many commands in Maximizer, you can specify whether you want
to include or exclude leads. For example, when you search for
Address Book entries, you can specify to search only for sales leads
matching the search criteria.

When you add an Address Book entry, you can add the entry a sales
lead. You can recognize if entries are sales leads directly in the
Address Book page. A star in the entry type icon indicates that the
entry is a sales lead. As well, the Sales Lead field is set to Yes.

Once a lead becomes a customer, you can change the value of the
Sales Lead field to No, indicating that the entry is no longer a sales
lead. If an opportunity is won for a sales lead, the entry is
automatically converted to a regular entry.

Typically, most of the activities on your Address Book entries are
completed in the Address Book page. Keep the following points in
mind when working in the Address Book page.

n Select the Address Book icon to open the Address Book page.

E Differentiate the types of entries with the icons representing
Companies, Individuals, Contacts, Company Sales Leads,
Individual Sales Leads, and Contact Sales Leads.

B Click on an Address Book entry to make it the current entry and
display its information in the following pane.

The text in an entry is a link to open the entry in the Details tab.
You can click in an empty part of the row to make the entry the
current entry without opening the Details tab.

ﬂ Use the tabbed following pane to view more information and
entries related to the current Address Book entry in the main
window.

E Use the Actions links to perform common actions with the
current entry like scheduling a meeting or creating an
opportunity.
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E In the title bar, view the number of each type of entry in the
current list.

Address Book

¥ | Opportunities

5 | Quotas

Campsians

[ customer service
(55} Krowlede Base
,ﬂ Hotlist

Calendar

Company Library
o Videa Tutorials

il user information

[@] uinks o
‘.‘é Import »

4§y Administration »

i Astnr Wine [EN4) AN1-RNNN

m New ¥ark

. Search for Address Book entries... Q, e f ]
Edit =  View =  Search *  Actions ¥  Report ¥ Hep v E] H - 9
[ = Name [ Phone umber | Email Address [ Department [ Division
W) Quick Access  » pA
@ # Y [ [ Aggassi Cold Beer & Wine Store (504) 601-8000 escona@maxinizer. com Alice Spring 8C E
— [ 3 Albert's Steak House (504) 601-8000 escona@maximizer.com Albuguerque N
[ £ All The Best Spirits (604) 601-8000 escona@maximizer.com Riverside cr
[ (% Amelia Liquors South (504) 601-8000 escona@maximizer.com Amelia Island FL Customer Servic  Asia Pacific Region
1 2 Andrews, Jennifer (604) 601-8000 escona@maximizer.com viinmipeg MB
[ £ Ansley Wine Merchants (604) 601-8000 escona@maximizer.com Atianta GA

ABC Wine Shop Inc.
Department: Sales

& Edit (=) Print

Phone numbers g

Main: (604) 601-8000
Fax: (604) 601-8001
Cell: (604) 601 8002
Pager: (144) 564-7778

Email addresses and website

esconafmayimizer com

Key Fields for: General Customer -0 Qe
Annual Sales: 5500000.00 Territory: North / Int'l
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i Status:
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Full Access: Public
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leadstatus:  Hot

Actions
Add anote
Add a document

Create an opportunity

Schedule a meeting
Schedule a to-do
Schedule an Action Plan

Create a case
Receive a call

Time a task
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Address Book Entry Lists

Change the List of Address Book Entries

You can quickly change the list of entries displayed in the Address
Book page to view all entries, all Companies and Individuals, or all

Contacts.
@You can also use the Search ¢ Inthe Address Book page, open the View menu, and select one
field at the top of the page and ; ; .
the options on the Search of the following options:
menu to search for specific ¢ All Entries - To display all Companies, Individuals, and
Address Book entries. . .
Contacts in the Address Book that you have the rights to
view.

e All Companies / Individuals - To display all Companies and
Individuals in the Address Book that you have the rights to
view.

e All Contacts - To display all Contacts in the Address Book
that you have the rights to view.

View Address Book Entry Details

To complete this procedure, you must have the Read permission for
Address Book entries.

You can view and edit details of Address Book entries at any time.
You can access an entry from the Address Book page or from a
customer service case or an opportunity attached to the entry.

n In the Address Book page, click on the entry to display its
information in the Details tab of the following pane.

—or —

In the Opportunities or Customer Service page, select View >
View in Address Book.

The Address Book page opens with the entry’s basic information
and Key Fields displayed in the Details tab of the following
pane.

E To view other information related to the entry, from the Key
Fields for drop-down list, select a different Key Fields list.

You can view additional user-defined fields, as well as the
customer service cases, opportunities, notes, documents, and
activities attached to the entry by selecting the corresponding
tab in the following pane.
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View Contacts Associated with Entries

You can view all Contacts associated with the current entry in the
Contacts tab of the following pane. If the current entry is a Company
or Individual, all of the Contacts for the Company or Individual are
displayed. If the current entry is a Contact, all of the Contacts for the
parent Company or Individual are displayed. If the current entry is an
opportunity, customer service case, or Hotlist task, all of the Contacts
for the Company or Individual associated with the entry are
displayed.

n Click on the entry to make it the current entry.

E In the following pane, select the Contacts tab.

The Contacts associated with the current entry are displayed.

E To view details of the entry, click the entry’s name.
If necessary, the Address Book page opens.

The Contact’s basic information and Key Fields are displayed in
the Details tab.

You can open the other tabs to view additional information on
the entry.

View a Recently Accessed Address Book Entry

You can view a list of recently accessed Address Book entries from
any page in Maximizer. When you select an entry on the list, the
Address Book page opens and details of the entry are displayed.

n In the heading bar, select the Recent entries icon.

A list of recently accessed Address Book entries is displayed.

E Select the Address Book entry from the list.

Find Duplicate Address Book Entries

Use this procedure to search for duplicate values in any field
displayed in a list of Address Book entries. For example, you can
search for multiple companies with the same name so you can
perform maintenance on your records. Or you can search for multiple
contacts with the same email address before sending out a campaign
to a list of entries.

You can find the duplicate values in all entries in the current list, or
you can select specific entries in the list to find the duplicate values
from only the selected entries.



@ If any entries are selected, the
command searches through
only the entries that are
selected.
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n Create a list of Address Book entries.
Select entries in the current list.

E Ensure the field you want to search is displayed in the column
setup.

E Click on the column heading for the field you want to search.

n Select Search > Find Duplicates in List/Selected.

Only entries with duplicate values in the sorted field are
displayed. You can use the Undo Search command to return to
the previous list.
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Retrieving Entries

Retrieve Contacts Associated with Address Book Entries

You can retrieve the Contacts associated with Companies and
Individuals to add the entries to the current list in the Address Book
page. If you select a Contact, the other Contacts associated with the
parent Company or Individual are retrieved.

You can retrieve the Contacts associated with a single Address Book
entry, or you can select multiple Address Book entries to retrieve all
Contacts associated with all selected entries at once.

n Click on the Company, Individual, or Contact to make it the
current entry.

Select multiple Address Book entries.
e Click the checkbox to the left of entries.

e Click on the entries one at a time while holding down the
Control key.

e Toselect all entries between two entries, select an entry and,
while holding down the Shift key, select another entry.
E Select Search > Retrieve Contacts.

Right-click, and select Retrieve Contacts.

Retrieve Companies and Individuals Associated with Contacts

You can retrieve the Companies or Individuals associated with
Contacts to add the entries to the current list in the Address Book

page.
You can retrieve the Company or Individual associated with a single

Contact, or you can select multiple Contacts to retrieve all Companies
and Individuals associated with the selected entries at once.

n Click on the Contact to make it the current entry.
—or-
Select multiple Contacts.
¢ Click the checkbox to the left of entries.

e Click on the entries one at a time while holding down the
Control key.
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¢ To select all entries between two entries, select an entry and,
while holding down the Shift key, select another entry.
E Select Search > Retrieve Companies/Individuals.

Right-click, and select Retrieve Companies/Individuals.

Retrieve Related Entries

You can retrieve the Related Entries that are linked to Address Book
entries in the Related Entries tab to add those entries to the current
list in the Address Book page.

You can retrieve the Related Entries associated with a single Address
Book entry, or you can select multiple Address Book entries to
retrieve all Related Entries associated with the selected entries at
once.

n Click on the Address Book entry to make it the current entry.
—or-
Select multiple Address Book entries.
¢ Click the checkbox to the left of entries.

e Click on the entries one at a time while holding down the
Control key.

¢ To select all entries between two entries, select an entry and,
while holding down the Shift key, select another entry.
E Select Search > Retrieve Related Entries.

Right-click, and select Retrieve Related Entries.

Retrieve Contacts from the Contacts Following Tab

You can view a list of Contacts for the current entry in the Contacts
following tab in the Address Book, Opportunities, Customer Service,
and Hotlist pages. You can retrieve these Contacts and add the
entries to the current list in the Address Book page where you can
view more information on the entries.

n In the Address Book, Opportunities, Customer Service, or Hotlist
page, click the entry to make it the current entry.

E Open the Contacts following tab.
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The following tab displays a list of Contacts associated with the
current Company, or with the Company associated with the
current opportunity, customer service case, or activity.

E Select the Contacts.
e (Click the checkbox to the left of entries.

e Click on the entries one at a time while holding down the
Control key.

¢ Toselect all entries between two entries, select an entry and,
while holding down the Shift key, select another entry.

n Select the View in Address Book or Show selected Contacts
in Address Book icon.

Retrieve a List of Opportunities for an Address Book Entry

You can quickly retrieve a list of the opportunities associated with an
Address Book entry and display them in the Opportunities page.

e Select the Address Book entry in the Address Book page and
select Search > Retrieve Opportunities.

The Opportunities page opens and displays the list of
opportunities associated with the Address Book entry.

Retrieve a List of Cases for an Address Book Entry

You can quickly retrieve a list of the customer service cases associated
with an Address Book entry and display them in the Customer Service

page.

e Select the Address Book entry in the Address Book page and
select Search > Retrieve Cases.

The Customer Service page opens and displays the list of cases
associated with the Address Book entry.



Chapter2 | 29

Adding Address Book Entries

@ If you have the Modify system
tables access right, you can
add, modify, and delete values
for system table fields such as
City by selecting the Edit List...
item from the drop-down list.
For a list of system table fields,
see the Maximizer CRM
Administrator’s Guide.

You can add Companies, Individuals, and Contacts to your Address
Book. Typically, “Company” entries represent a corporate entity you
would like included in your Address Book. “Individuals” represent a
person who is not affiliated with a company or organization.
“Contacts” are entries that are always associated with Companies or
Individuals. “Address Book entries” refers to all Companies,
Individuals, and Contacts in your Address Book.

If you need to add people to your Address Book, add them as
Individuals or as Contacts of an Individual or Company. If you need to
delete a Contact, its associated notes and documents are
automatically transferred to the “parent” Company or Individual,
which ensures you maintain a record of all interactions with a
company, even during changes.

Add a Company or an Individual

@ Mandatory fields that must be
completed when creating a
new entry are highlighted in
red.

To complete this procedure, you must have the Insert permission for
Address Book entries.

When you add entries for Companies and Individuals, you must
specify all of the details on the entry. You can add Companies and
Individuals as regular entries or as sales leads.

n Select the Address Book icon to open the Address Book page.
E Select Edit > Add Company/Individual or Company/
Individual Lead.
Right-click and select Add > Company/Individual or
Company/Individual Lead.
The Details following pane opens with blank fields for your new
entry.

ﬂ Enter the basic information for the Company or Individual
including name, address, phone numbers, and email
addresses.
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Add a Contact

@ This options applies only to the
current entry in the Address
Book page.

@ This option applies only in the
Address Book page.

ﬂ From the Key Fields for drop-down list, select a Key Fields list,
and enter values for the fields in the list.

E Click Save to save the entry to the Address Book.

After the entry is saved, you can select the User-Defined Fields
following pane to fill-in more information about the entry.

To complete this procedure, you must have the Insert permission for
Address Book entries.

You can add Contact entries attached to existing Companies and
Individuals. When you add a new Contact to the Address Book, you
need to specify only fields that are different than the Company or
Individual entry. You can add Contacts as regular entries or as sales
leads.

If you modify the address, you are prompted to change the current
mailing address for the Company or to create a new mailing address
for the Company. The new address is applied to the Contact, and you
can later apply it to other Contacts associated with the Company.

You can add a Contact from the main list in the Address Book page
or from the Contacts tab of the following pane.

n In the Address Book page, click on the Company or Individual to
make it the current entry.

—or —

In the Opportunities, Customer Service, or Hotlist page, select an
entry associated with the Company or Individual.

E Select Edit > Add Contact for or Add Contact Lead for.
Right-click, and select Add > Contact or Contact Lead.

In the following pane, select the Contacts tab, and select the
Add a Contact icon.

If necessary, the Address Book page opens.

In the following pane, the Details tab displays fields for the new
Contact. Some fields are populated with values from the
Company or Individual entry.

E Enter the basic information about the Contact, including the
name, position, and department. And specify any additional
information that differs from the Company or Individual entry.
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ﬂ Select the mailing address for the Contact if it differs from the
main Company or Individual address. You can edit any of the
existing addresses or add a new one.

When you create a new address, it becomes available to the
other Contacts associated with the Company or Individual. You
can later select it as the current address for other associated
Contacts.

E Click Save to save the entry.

Access Rights for Address Book Entries

@ The Select Users for Full or
Read Access dialog box is
available only in Maximizer
CRM Enterprise Edition.

For each Address Book entry, you can specify full access and read
access rights for any Maximizer users or groups, or you can specify
public access to grant access to all Maximizer users. Access rights to
specific entries are shown in the Key Fields area of the Basic
Information tab in the entry. You may need to select a different Key
Fields list to view the Full Access and Read Access fields. By default,
these fields are included in the <Default Key Fields> list.

You can specify access rights while adding or modifying an entry. If
you are using Maximizer CRM Group Edition, you can select a user, a
group, or public from the Full Access and Read Access drop-down
lists. If you are using Maximizer CRM Enterprise Edition, you can click
the ellipsis button next to the Full Access or Read Access fields to
select multiple users for full or read access rights.

Access rights for specific entries are granted in the Select Users for
Full or Read Access dialog box. Keep the following points in mind
when working in this dialog box:

n In the Available users and security groups area, select the
users and security groups for which you want to add full or read
access for this entry.

e To select multiple users or groups, press Control while
selecting the users/groups.

e Toselect a series of users/groups, select the first user/group in
the series, then press Shift and select the last user/group in
the series.

e Type the first letter in the item’s name to jump to that item in
the list.

Users are grouped by the security groups, teams, departments,
and divisions to which they belong if you have the “Display users
by groups” option enabled in your preferences.

E Click the heading of a user grouping to view users and security
groups in different groupings.
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B Click the right arrow to move the selected users or security
groups to the Selected users and groups list.

If you accessed the dialog box from the Read Access field, the
user or group is automatically assigned read access. If you
accessed the dialog box from the Full Access field, the user or
group is automatically assigned full access.

In the Selected users and security groups area, select a user
or group to modify the access rights for the user or group.

Select or clear the Full Access or Read Access checkbox to
modify the access rights for the selected user or security group.

Click the left arrow to remove the selected user or security group
from the list, stripping all access rights from the user or group.

Public cannot be removed from the list. Public access rights are
automatically changed when users or groups are given access
rights to the entry.

Select Users for Full or Read Access - Mozilla Firefox ==

Available users and security groups: Selected users and security groups:

All Users and Groups Name Permission

Celine Dancer - + - #fpublic n No Access

Daniel Brown 8 Joe Napol Full Access

Jon Bowser n

Lucy Garcia

8 Lou Jones Full Access

m

4 15ales Read Access

0 Eo B0 B0 E0 €0 g0

& Wark Bertoli [>5]
& Matt Graham
& Miranda Corell ‘7|
&wonda Whte

A accounting

Departments
Divisions E
Security Groups Permissions for selected user(s) or security group(s):

[ Full Access
[ read Access

Teams

\ 0K || Cancel \

Copy an Address Book Entry

To complete this procedure, you must have the Insert permission for
Address Book entries. To copy the associated opportunities, customer
service cases, notes, or documents you must also have the Insert
permission for each type of entry.

Use this procedure to create a new Address Book entry from an
existing Address Book entry. You have the option of copying all
opportunities, customer service cases, notes, documents,
appointments, and tasks associated with the entry.
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n Click on the Address Book entry to make it the current entry.

E Select Edit > Duplicate Current Entry.
The Duplicate Entry dialog box opens.

ﬂ Select the entries that you want to copy to the new entry, and
click OK.

Opportunities duplicates all opportunities associated with
the current entry.

Customer Service cases duplicates all customer service
cases associated with the current entry.

Notes duplicates all notes associated with the current entry
and any notes associated with duplicated opportunities or
customer service cases.

Documents duplicates all documents associated with the
current entry and any documents associated with duplicated
opportunities or customer service cases.

Appointments and tasks duplicates incomplete
appointments and tasks associated with the current entry
and any incomplete appointments and tasks associated with
duplicated opportunities or customer service cases.
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Mailing Addresses

The main address of a Company or Individual is specified in the
Details following pane. You can set up multiple addresses for
companies and assign different addresses to specific Contacts in the
company. Entries may have as many alternate entries as you want,
but only one address at a time can be selected as the current address
for the entry.

Add an Alternate Address for an Address Book Entry

Add alternate addresses for entries from the Details following pane.

n Click on the Address Book entry to make it the current entry.
E In the following pane, select the Details tab, and click Edit.
ﬂ At the bottom of the Address area, click Add new address.

Fields for entering a new alternate address appear.

Aggassi Cold Beer & W... ~ Contacks | History | Motes | User-Define

Address

Eld| selected address

Description: | *Main Address

Address 1: | 1234 Spring Drive

Address 21

City/Town: | alice Spring - | stfprov: | BC -

ZipfPostal: | vaL 3H8 Courtry: | Canada ~

Luf| Use this address for the entry X Delete

Description: | Alternate Address

Address 11

Address 21

ity Tovan: | StiProv: -

Zip/Postal: Country: -

+ Add new address

ﬂ Enter the new address.

@You can remove an old address E To use the address for the selected entry, click the pin icon or

from an entry by clicking the ; H
Delete lirk next to the address. click Use this address for the entry.
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Modifying Address Book Entries

You can modify the details of Address Book entries at any time. You
can perform a number of other tasks to change the properties of
Address Book entries, including adding alternate addresses to
entries, moving Contacts to other Companies or Individuals, and
converting Individuals to Companies and Contacts to Individuals.

Edit an Address Book Entry

To complete this procedure, you must have Modify permission for
Address Book entries and full access to the current entry.

The Details following pane in the Address Book page not only
displays basic information and key fields for the current entry, but it
also allows you to edit that information.

n In the Address Book page, click on the entry to display its
information in the Details following pane.

E Click the Edit button below the entry’s name in the Details
following pane.

The Details following pane expands and switches to edit mode,
allowing you to modify the entry’s information.

E Update the fields of the entry as necessary, and click Save to save
your changes to the entry.

Add an Image to an Address Book Entry

To complete this procedure, you must have the Modify permission
for Address Book entries and full access to the current entry.

An image representing each Company, Individual, and Contact is
displayed in the Details following pane of the selected entry. While
viewing the Details for an entry, you can upload an image file to
associate the image with the entry. The size of the file must be less
than 4 MB. When you add the file, you can crop the image so it fits in
the area provided in the Details following pane.

n Click on the Address Book entry to make it the current entry.

The current image for the entry is displayed next to the entry’s
name in the Details following pane. If no image has been
associated with the entry a placeholder image is displayed.
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E Click the entry’s current image next to the Name area of the
Details following pane.

The Upload Photo dialog box opens.

Click Browse.

Browse to and select an image file on your computer, and click
Open.

Click and drag around a portion of the image to select the part
of the image to include.

Any portion of the image that is outside of the selection area is
removed from the image when it's saved.

If necessary, you can adjust the sides of the selection area. To fit
the image without distorting its proportions, the width of the
selection area is kept equal to the height.

E Click Save Photo to associate the image with the entry.

Uplead Photo - Mexzilla Firefox ==
Upload Photo

You can upload an image file (jpg, .gif, .omp, .png, .tiff, etc..) that does not exceed 4MB.

|C:\Comacts\|kerr.png Browse_

To make adjustment to your photo you may drag around and resize the box. When satisfied with your changes click the

"Save Photo’ button.

Move a Contact to Another Company or Individual

To complete this procedure, you must have Insert, Modify, and
Delete permissions for Address Book entries.

You can move a Contact from one Company or Individual to another
Company or Individual. The Contact’s notes, documents, and user-
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defined fields move with the Contact. Appointments and Hotlist
tasks are updated to reflect the new location.

You have a number of options when moving a Contact:

¢ Change the Contact’s address to the main address of the new
Company or Individual.

e Prefix all of the Contact’s notes with text indicating that the
Contact has moved.

¢ Maintain the Contact’s association with opportunities and
customer service cases.

e Maintain relationships between the Contact and related entries.

e Update Favorite Lists containing the Contact to reflect the
Contact’s move.

e Update campaigns to reflect the Contact’s new location.

Delete or save the Contact’s entry with the original Company.

In the Address Book page, click on the Contact entry to make it
the current entry.

Select Edit > Move Selected Contact.

—or—-

Right-click and select Move Selected Contact.

The Find Target Address Book Entry dialog box opens.

Enter the search criteria, and click Search.

Select the Company that the Contact is moving to, and click OK.
The Move Selected Contact dialog box opens.

& | Move Selected Contact -- Webpage Dialog ==

Source entry: \Samson, Paul - Samson Consulting

Target entry: ‘ABC Wine Shop Inc.

Options

7] Use the main address of the source entry to create a maiing address for the
target entry

<

Prefix contact's notes with move text:
Contact moved from ‘Samson Consutting’ to "ABC Wine Shop Inc."

Maintain contact's association with Opportunities and Customer Service
Cases

<

Update Related Entries to maintain relationships.
Update Favorite Lists to reflect contact move

Update Campaigns to reflect contact move

ENERENE

Delete source entry after move

E Select the options for the move, and click OK to complete the
move.
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Combining Entries

You can combine information from multiple Address Book entries
into a single entry. To combine entries, you must select at least two
entries of the same type. The last entry selected is the target entry.
The other entries selected are the source entries. You can combine a
single source entry or multiple source entries into the target entry.
When you combine the entries, information from the source entries
is copied into the target entry. Information in the target entry is
always preserved after combining the entries.

Information is copied in the following ways:

e If afield has a value in the source entry but not the target entry,
the value in the source entry is copied to the target entry.

e If a multiple-value table field has a value in both source and
target entries, the combined entry contains all values for the
field.

e If asingle-value field has values in both source and target
entries, the combined entry contains the original value from the
target entry.

¢ If asingle-value field has different values in multiple source
entries (but not in the target entry), the combined entry contains
the value from the last source entry selected.

e If a source entry is a Company with Contacts, the Contacts are
copied to the target entry (if a Contact does not already exist
with the same name) or combined with existing Contacts in the
target entry (if a Contact already exists with the same name).

e If asource entry has notes, documents, customer service cases, or
opportunities, duplicate notes, documents, customer service
cases, and opportunities are created for the target entry.

If a source entry has an address specified, you have the option to
create an alternate mailing address in the target entry with the
address information from the source entry. You can apply this
address to any Contacts associated with the target entry.

You can combine entries in a number of ways. You can combine the
information into the target entry while keeping the original source
entries. Or you can combine the source entries into the target entry
and automatically delete the original source entries. You cannot
preserve the original target entry. However, information in the
target entry is never overwritten by information in the source
entries.
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Combine Information from Multiple Entries

@ The target entry is always the
last entry selected.

To complete this procedure, you must have Insert and Modify
permissions for Address Book entries.

Use this procedure to combine the information from a source entry
or multiple source entries into a target entry. You have the option to
keep the source entries or to delete the source entries. All
information is copied to the target entry without over-writing any of
the original information in the entry. The source and target entries
must be the same type of entries.

n In the Address Book page, click on the source entry to make it
the current entry.

In the Address Book page, select multiple source entries.
¢ Click the checkbox to the left of entries.

e Click on the entries one at a time while holding down the
Control key.

¢ Toselect all entries between two entries, select an entry and,
while holding down the Shift key, select another entry.

E Select the target entry.
ﬂ Select Edit > Combine Selected Entries.
The Combine Entries dialog box opens.

ﬂ To create alternate mailing addresses in the target entry using
address in the source entries, select Create alternate mailing
addresses from addresses in the source entry.

E To delete the source entries automatically, select Delete source
entries after merging is complete.

E Click OK to confirm the change.
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Converting Address Book Entries

After creating an entry, you may decide the entry is more
appropriate as a different type of entry. For example, you may create
an entry as an Individual and want to convert it to a Company with
Contacts.

When you convert an entry, Maximizer copies the entire contents of
the original entry to a new entry and the original entry is
automatically deleted in the process.

Convert Individuals to Companies

To complete this procedure, you must have Insert, Modify, and
Delete permissions for Address Book entries.

Use this procedure to convert Individuals to Companies. Maximizer
copies the entire contents of the Individual to a new Company entry
with the Individual converted to a Contact for the Company. All data
is converted, including the Individual’s Contacts. The original
Individual is automatically deleted in the process.

You can convert a single Individual, or you can select multiple
Individuals to convert them all at the same time.

n Click on the Individual entry to make it the current entry.
—or-
Select multiple Individual entries.
e Click the checkbox to the left of entries.

¢ Click on the entries one at a time while holding down the
Control key.

¢ Toselect all entries between two entries, select an entry and,
while holding down the Shift key, select another entry.

E Select Edit > Convert Individuals to Companies.
Right click and select Convert Individuals to Companies.

E Click OK to confirm the change.
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Convert Contacts to Individuals

@ The menu applies only to
entries selected in the main
list.

To complete this procedure, you must have Insert, Modify, and
Delete permissions for Address Book entries.

Use this procedure to convert Contacts to Individuals. You are asked
to confirm if you want the new Individual to inherit the Contact’s
address. All data is transferred to the new Individual entry and the
original Contact is automatically deleted.

You can convert a single Contact, or you can select multiple Contacts
to convert them all at the same time. You can select Contacts from
the main list in the Address Book page and from the Contacts
following pane.

n Click on the Contact entry to make it the current entry.
—or-
Select multiple Contact entries.
e Click the checkbox to the left of entries.

e Click on the entries one at a time while holding down the
Control key.

¢ To select all entries between two entries, select an entry and,
while holding down the Shift key, select another entry.

E Select Edit > Convert Contacts to Companies.
Right click and select Convert Contacts to Individuals.

E Click OK to confirm the change.

Convert an Individual to a Contact

To complete this procedure, you must have Insert, Modify, and
Delete permissions for Address Book entries.

Use this procedure to convert an Individual to a Contact of an
existing Company or Individual. You can choose to create a new
alternate address in the Company/Individual entry using the address
of the Individual entry. All data is transferred to the new Contact
entry and the original Individual is automatically deleted. Any
Contacts associated with the Individual are also transferred to the
Company/Individual.
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n Click on the Individual entry to make it the current entry.

E Select Edit > Convert Individual to Contact of a Company.

Right-click, and select Convert Individual to Contact of a
Company.

The Find Target Address Book Entry dialog box opens.
E Enter the search criteria, and click Search.

ﬂ Select the Company or Individual that the Individual is moving
to, and click OK.

The Convert Individual dialog box opens.

E To create an alternate mailing address in the Company/
Individual using the address of the Individual, select Create
alternate mailing addresses from addresses in the source
entry.

If the Individual entry has multiple addresses, all of the addresses
will be copied to the Company/Individual entry.

E Click Yes to confirm the change.



Chapter 2 43

Recording Relationships with Related Entries

In the course of business, it's common to have people and companies

who are somehow related or connected to each other. For example,

if one of your contacts is a supplier for another contact that is a one-
way relationship. However, if two of your contacts are sisters, that is

a two-way relationship. Maximizer allows you to view these types of
relationships in the Related Entries following pane.

Any Address Book entry can be related to another. All notes, user-
defined fields, and documents associated with a related entry are
then linked to the relationship. If an Address Book entry has entries
related to it, these are displayed in the Related Entries following
pane.

Relate Two Address Book Entries

n Select one or both of the Address Book entries you wish to
create a relationship for. Then, select Edit > Relate Entries.

—or —

Select the Address Book entry that you wish to create a
relationship for. Then, in the Related Entries pane, click the
Add a related entry icon.

The Add a Related Entry dialog box opens.

E Select the related Company / Contact and specify the details of
the relationship between the two entries. Then click OK.

Unlink Address Book Entries

Occasionally, relationships that you set up between two Address
Book entries change, and you may want to remove relationships
between entries. You can unlink two entries to remove the
relationship.

n In the Related Entries following pane, select the entry to
unlink.

E Click the Unlink the selected entries icon.
Right-click, and select Unlink Related Entry.
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Territory Management

@ Territory Management is not
available in all versions of
Maximizer CRM.

Set Up a Territory

Use Territory Management to set up territories and assign them to
Company and Individual Address Book entries. You can assign the
territories manually, or automatically through the application of
territory rules.

To use Territory Management, you must be assigned the Sales
Manager user role.

Once territories are created and assigned, any Maximizer user can
use the Territory and Territory Status fields in everyday tasks such as
searching for entries, adding column setups, inserting merge fields,
and creating reports.

To complete this procedure, you must have the Sales Manager role.

When you set up a territory, you can define rules that an Address
Book entry must match to be assigned to the territory during an
alignment. To build the rules, use fields such as City, Country, State/
Province and Zip/Postal Code. You can also use user-defined fields.

During an alignment, entries are tested against territories in the
order the territories appear in the Territory list. If an entry matches
the rules of more than one territory, the territory appearing higher
in the list is assigned to the entry.

All entries match a territory that does not contain any rules. So if you
create such a territory, it is placed by default at the bottom of the
Territory list. Otherwise, entries matching the rules of territories
appearing after it would not be matched to these territories. Instead
they would be matched to the territory without rules.

n From the Address Book page, select Edit > Territory
Management.

The Territory Management dialog box opens.



@ If an Address Book entry
matches the rules of more than
one territory, the territory
appearing higher in the
Territory list is assigned to the
entry.
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Territory Management ==

Setup | Alignment

[ 7errvory [ Account Manager [ [ add.. |

whest Jon Bowser
East tark Bertoli

Move Down

Description:

Close

H ciick Add.
The Add/Modify Territory dialog box opens.
E Enter a territory name and a description of the territory.

ﬂ Next to the Account Manager field, click the ellipsis, and select
account managers for the territory from the list of available
users.

E Click Add to select the fields you need to define territory rules.

E Specify whether Address Book entries must match all, or one or
more of the territory rules.

Click OK.
The new territory is added to the Territory list.

E If required, use the Move Up and Move Down buttons to move
the territory in the list.

Assign a Territory to an Address Book Entry

Users can manually assign territories and account managers to
Address Book entries on the Basic Information tab of open entries.

Users with the Sales Manager role can always manually assign
territories. When a sales manager assigns a territory, “Set by
manager” is displayed in the Territory Status field.
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Aligning Territories

@ Territories set by users are
always overwritten by territory
alignments.

Users without the Sales Manager role can manually assign territories
while creating new Address Book entries. They can also assign a
territory to an existing entry if a territory is not assigned and the
Account Manager field is blank. When a user assigns a territory, “Set
by user” is displayed in the Territory Status field.

Users can always manually assign territories for Address Book entries
to which they are assigned as account managers.

Changes to territory status are logged to an entry’s notes.

n Select the Address Book entry to which you want to assign a
territory.

E In the Details following pane, click the Edit button below the
entry’s name.

E If necessary, from the Key Fields for drop-down list, select a
Key Fields list that contains the Territory and Account Manager
fields.

By default, the Territory and Account Manager fields are
included in the <Default Key Fields> list.

n From the Territory drop-down, select the territory you want to
assign to the entry.

The Territory status field now indicates that the territory is “Set
by manager” or “Set by user”.

E Next to the Account Manager field, click the ellipsis, and select
account managers for the entry from the list of available users.

E Click OK.

Sales managers can automatically assign territories in the Alignment
tab of the Territory Management dialog box. Changes made when
you align territories override territories set by Sales Managers only if
you select the “Overwrite territories set by manager” option.

If the alignment assigns a territory to an entry, the name of the
territory is displayed in the Territory field, and the value “Set by rule”
is displayed in the Territory Status field. If no territory is assigned to
an entry (and one has not been set manually), the value in the
Territory Status field is “Unassigned”.

The value “Set by rule (unaligned)” is displayed in the Territory
Status field when:

e Anentry previously assigned to a territory no longer matches the
territory rules. (The rules or the entry have changed.) However, if
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the entry matches the rules of another territory, it will be
aligned to that territory.

e Aterritory that was set by a user at the time of the entry’s
creation does not match the rules of the territory it was assigned
to or the rules of any other territory.

e A territory that was assigned to an entry by a Sales Manager
does not match any territory rules, and the “Overwrite territories
set by manager” option is selected.

To complete this procedure, you must have the Sales Manager role.

Use this procedure to assign territories automatically using Territory
Management. Once the alignment is complete, Maximizer sends an
email to the current user with the results of the alignment. To receive
the email, you must have an email address specified in your user
properties. During the territory alignment, you can continue to work
in Maximizer.

n From the Address Book page, select Edit > Territory
Management.

E Select the Alignment tab.

E Specify the territory alignment conditions.
For example, if you want territories aligned for all Address Book
entries, select the All entries option.

ﬂ Specify the alignment options.

¢ Select Unassign territories to unassign territories from
Address Book entries.

e Select Overwrite territories set by manager to overwrite
territories that were set by Sales Managers.
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E Click Align Territories.

Territory Management

Setup Alignment

Territory alignment conditions

(©) Entries created / modified since 1810342010

@ Al entries
©) Allentries in the current view
©) Selected entries
Options
["] unassign territories

[ overwrite territories set by manager

Align Territories

Alignment results

Aligned: 26 Unassigned: 0 Skipped: 66 Failed: 0
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Draw a Map of an Address Book Entry

@ This option is for Address Book
entries only. It takes you
directly to a map for the
selected address.

You can quickly draw a map showing the location of an Address
Book entry or of the Address Book entry associated with an
opportunity or customer service case. You can choose to view only
the location of the entry, or you can view directions to or from the
Address Book entry and your current address.

n Click on the Address Book entry, customer service case, or
opportunity to make it the current entry.

Open the customer service case.
E Select Actions > Draw a Map.
Right-click, and select Draw a Map.

In the following pane, open the Details tab, and click an entry’s
address.

The Draw a Map dialog box opens displaying the address of the
current Address Book entry.

E Under Draw this type of map, select the type of map that you
want to view.

You can choose the following types of maps:

¢ Map of selected entry only.

e Map of travel route from current address to selected entry.
¢ Map of travel route from selected entry to current address.

n If necessary, enter your address in the Current address fields.

B ciick ok.

A new browser window opens to a page displaying the address
for the map.

E Choose an online map site and click OK.
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Phoning Address Book Entries

With Maximizer, you can track incoming and outgoing phone calls to
Address Book entries. Depending on your logging preferences, notes
may be automatically saved to the entries associated with the calls
and to the Phone Log.

Users can transfer incoming calls to other users. If a note is logged for
the phone call, the note includes the transfer information.

During the phone call, you can modify fields in the Address Book
entry and the changes are logged directly in the phone note.

Phone an Address Book Entry

@ In the Hotlist page, you can log
a phone call only from an
appointment or task
associated with a single
Address Book entry.

@ The menu applies only to
entries selected in the main
list.

You can track outgoing phone calls from the main lists in the Address
Book, Opportunities,Customer Service, or Hotlist page and from the
Contacts or Related Entries following pane.

If Voice-Over IP (VOIP) or Instant Messaging (IM) integrations are
configured, you can select the integration to launch the VOIP or IM
software automatically from Maximizer.

You can take notes on the phone call while the duration is timed.
Depending on your logging preferences, an outgoing call note is
automatically saved to the Address Book entry, customer service case,
or opportunity associated with the call. In the Hotlist page, the note
is saved to the Address Book entry associated with the appointment
or task.

After completing a phone call, you have the option of scheduling a
follow-up activity saved to your Hotlist.

n Click on the Address Book entry, opportunity, customer service
case, Hotlist task, or appointment to make it the current entry.

—or-
Open the customer service case.

E Select Actions > Make a Call.
—or-
Right-click and select Phone > Make a Call.
—or-
In an open customer service case, select Actions > Make a Call.
—or-

In the following pane of the Address Book or Opportunities
page, select the Details tab, and next to Phone numbers, click



@ The Message, No Answer, and
Busy options are available only
if you have phone call logging
preferences set to create
notes.

@ You can click Transfer and
select another Maximizer user
to log the transfer in the note.
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the Make a call icon (Address Book page), or under Actions,
select Make a call (Opportunities page).

From the drop-down list, select the VOIP/IM application and
phone number you are calling, and click Dial.
The VOIP or IM software is launched.

If VOIP or IM are not configured, select the phone number you
are calling.

Phone Call - Mozilla Firefox ==l
Call phone or chat

Call using Skype - Main: '(504) 601-8000" [«] [ Da_ |

sing Skype - Main: '(504) 801-8000"
Call using Skype - Fax: '(504) 501-8001
Call using Skype - Cell: '(604) 601 8002
Call using Skype - Pager: '(134) 564-7778" v

Click one of buttons at the bottom of the Phone Call dialog box
to select a response.

If you select Message, No Answer, or Busy, a note is
automatically saved to the entry with the result of the call.

If you select Answered, the Phone dialog box opens timing the
duration of the phone call.

In the Subject field, enter a subject for the phone call, and
record notes on your call as you talk.

You can continue to work in Maximizer as you are logging the
phone call.

If you are logging the phone call from the Address Book page,
changes to user-defined fields and some basic fields in the
Address Book entry are automatically added to the phone note.

E When the phone call is finished, click Hang Up.

The timer stops.
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@ You can also select a result of
the phone call from the Phone
dialog box. Click the Result
button before saving the note.

Receive a Phone Call

Subject: Arrange meeting E]
1 Name: |ABC ‘Wine Shop Inc.
B5 | |ucida gran..¥ | Size (... v BJ7 UAvarv %E H= =E = & !
Need to discuss contract changes.
Tentative meeting for next Thursday. We will cover the following points:

® Changes to price list since st contract was signed.
® Changes to our contract policy (different terms are availzble).
® New offerings (bring updated catalog and samples)

James is not sure if he'll stay with this account in the future. He may bring a new account manager with him to the meeting.

Hang Up H Pause ][ Reset ][ Transfer

Edit the note, and click Save.

If your phone call logging preferences are set to show results on
hang-up, you are prompted to select a result of the phone call.
Select a value for the result.

Phone Call Result - Morilla Firefox ==
[y
Arranged interview -
away rom deat
Away from office
Call back
Closed "
Dieussed opportuiles ]
Followed up
In a mesting

Left message on voice mail
Left message wi co-worker
Left message wi receptionist -

E Select whether or not you want to schedule a follow-up activity.

If you select Yes, specify the properties of the follow-up activity.

You can track incoming phone calls from the main lists in the Address
Book, Opportunities, Customer Service, or Hotlist page and from the
Contacts or Related Entries following pane.

When you receive a phone call in Maximizer, an incoming call note is
automatically saved to the Address Book entry, customer service case,
or opportunity associated with the call. In the Hotlist page, the note



@ In the Hotlist page, you can log
a phone call only from an
appointment or task
associated with a single
Address Book entry.

@ The menu applies only to
entries selected in the main
list.

@ You can click Transfer and
select another Maximizer user
to log the transfer in the note.
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is saved to the Address Book entry associated with the appointment
or task.

After completing a phone call, you have the option of scheduling a
follow-up activity saved to your Hotlist.

Click on the Address Book entry, opportunity, customer service
case, Hotlist task, or appointment to make it the current entry.

—or-
Open the customer service case.

Select Actions > Receive a Call.

—or-

Right-click and select Phone > Receive a Call.
—or-

In an open customer service case, select Actions > Receive a
Call.

In the following pane, select the Details tab, and under
Actions, select Receive a call.

In the Subject field, enter a subject for the phone call, and
record notes on your call as you talk.

You can continue to work in Maximizer as you are logging the
phone call.

If you are logging the phone call from the Address Book page,
changes to user-defined fields and some basic fields in the
Address Book entry are automatically added to the phone note.

When the phone call is finished, click Hang Up.

Edit the note, and click Save.

If your phone call logging preferences are set to show results on
hang-up, you are prompted to select a result of the phone call.
Select a value for the result.

Select whether or not you want to schedule a follow-up activity.

If you select Yes, specify the properties of the follow-up activity.
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Enable Logging for Phone Calls

View the Phone Log

When logging is enabled for phone calls, Incoming call and Outgoing
call notes are created when you phone or receive calls from entries in
Maximizer.

n In the top-right corner of the page, click on your image, and
select Preferences.

The Personal Preferences dialog box opens.

E Click Other Preferences.

The Preferences dialog box opens to the Calendar/Hotlist tab.
ﬂ Select the Logging tab.

n Under Phone calls, specify how you want to log phone calls.

¢ Notes and phone log - Saves phone notes to the entry
associated with the phone call. You can view phone notes
from the phone log.

¢ Journal - Saves phone notes to the Journal.

¢ Both - Saves phone notes to the entry associated with the
phone call and to the Journal.

The Journal is available only in Maximizer, not in Maximizer Web
Access. Journal notes are not created from phone calls in
Maximizer Web Access.

E To display the Phone Call Results dialog box automatically every
time you log a phone call, select View result table on hang-

up.
[ ciick ok.
Click Save to save the changes to the preferences.

Use the Phone Log to view a history of your phone calls recorded in
Maximizer to and from Address Book entries. By default, the Phone
Log displays phone calls for the current day, but you can choose to
view a list of calls for any other date. You must have phone call
logging set to “Notes and phone log” in your logging preferences
for phone calls to be displayed in the Phone Log.

From the Phone Log, you can retrieve the entries associated with
selected phone calls to display the entries in the Address Book,
Customer Service, or Opportunities page and record additional
phone calls with the entries.
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You can view the Phone Log from the Address Book, Opportunities,
Campaigns, Customer Service, Knowledge Base, Hotlist, or Calendar

page.

e Select View > Phone Log.

The Phone Log dialog box opens displaying the phone calls for
the current user on the current date.

¢ Inthe Date field, select a date to change the day for which
phone calls are displayed.

e Select entries in the list and click Phone to display the entries
associated with the phone calls in the Address Book,
Customer Service, or Opportunities page and record
additional phone calls with the entries.

Depending on the option selected in the Modify entry list
area, the entries either are added to the current list or
replace the current list in the main page.

Phane Log - Mozilla Firefox v =)
L
Date: 2010-09-29 ]
.| Phone (=) Print

~ Time | Name Address Book Entry | Phone No. Duration | Result

} 1138AM Alberts SteakHouse  Alberfs Steak House  (504) 6018000  00:50 Outgoing Cal ~
11:39AM Amelia Liquors South  Amelia Liquors South  (604) 601-8000  00:17 Outgoing Cal
11:41AM  Alberts SteakHouse  Alberfs Steak House  (504) 6018000 00:28 Outgoing Cal
118 P Alberts SteakHouse  Alberfs Steak House  1604501-8000  00:00:22  Outgoing Cal
1117 PM  ABC Wine Shop Inc. ABC Wine Shopinc. 1604 601-8000  00:00:28  Outgoing Cal
1118 P AggassiCold Beer &Win AggassiCold Beer &V 1604601-8000  00:00:22  Outgoing Cal
1:20PM  AllThe Best Spirits AllThe Best Spirts. 16046018000 00:00:33  Outgoing Cal

« i »

Details of Call Details of Call

Lt dl e - © Replace with selected entries

Phone Call Albert's Steak House £ Add selected entriss

Number Called: (604) 01-3000

Phone Description: Main

Subiert Pavmant ranuest 32

Dene
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CHAPTER

User-Defined Fields

Customize your entries with user-defined fields

In this chapter...

“About User-Defined Fields” on page 58

“Setting Up User-Defined Fields” on page 63
“Mandatory Fields” on page 71

“Formula User-Defined Fields” on page 76

“Writing Formulas and Mandatory Rules” on page 79
“Key Fields Lists” on page 93
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About User-Defined Fields

User-defined fields are custom fields used to record additional
information on Maximizer entries. You can set up different user-
defined fields for the different types of entries in Maximizer. Each
user-defined field can be associated with only one type of entry. You
can create user-defined fields for the following types of entries:

¢ Address Book - Classifies Address Book entries. You can view
these fields in the Address Book page.

e Opportunities - Classifies opportunities. You can view these
fields in the Opportunities page or in an open opportunity.

e Campaigns - Classifies campaigns. You can view these fields in
the Campaigns page or in an open campaign.

e Customer Service - Classifies customer service cases. You can
view these fields in the Customer Service page or in an open
customer service case.

e Users - Classifies Maximizer users.

You can include user-defined fields in Key Fields lists displayed in the
Details tab of the following pane for Address Book entries and
opportunities and in the Basic Information tab of open campaigns
and customer service cases.

Types of User-Defined Fields

@ Encrypted user-defined fields
cannot be transferred,
imported, or exported. They
are also not searchable.

You can create different types of user-defined fields depending on
the types of values required for the field. Maximizer defines the
following types of user-defined fields:

e Alphanumeric user-defined fields - These fields record any
alphanumeric text (letters and numbers) up to a specified
maximum number of characters. You can encrypt alphanumeric
fields for security protection. Note that you cannot disable or
enable encryption once you have created the field.

You can use alphanumeric user-defined fields to record URLs for
entries. The fields are displayed as hyperlinks in Key Fields lists.

¢ Date user-defined fields - These fields store a specific date or
an annually recurring date.

¢ Formula user-defined fields - These fields calculate values
based on other basic or user-defined fields. Formula user-
defined fields can return alphanumeric, date, or numeric values.
Because they are calculated from values of other fields, values
for formulas fields can be viewed in entries but cannot be set
manually.



Chapter3 | 59

¢ Numeric user-defined fields — These fields record numeric
values. You can specify a number of decimal places. For example,
specify two decimal places to use this type of field for monetary
values. You can also specify that currency symbols are displayed
with the field.

¢ Table user-defined fields - These fields enable you to select a
value or values from a list. This type of field is very useful for
multiple choice or multiple value fields. If you create a table
user-defined field with the “single value only” attribute, only
one value can be selected from the list.

¢ Yes/no user-defined fields — These fields record either yes or
no values. Since the fields must contain one of these values,
these user-defined fields are always mandatory.

User-Defined Fields Following Pane

User-defined fields for the current Address Book entry, opportunity,
campaign, or customer service case are displayed in the User-Defined
Fields following pane below the main list of entries.

In the Hotlist page, the User-Defined Fields pane displays fields for
the Address Book entry associated with the selected task or
appointment. User-defined fields are displayed for an appointment
only if a single Address Book entry is associated with the
appointment.

If the current entry has URLs specified for any hyperlink fields, you
can click the icon next to the hyperlink field to view the web page in
a new browser window.

Anoza, Marylin

Through the Grapevine ™ Details = Contacts = History = Notes Documents | Customer +

Fitter: Al v [¥Ishow blank fields [ show hidden fields < Qe
Field Value(s)
= 2 User-Defined Fields -
@ (] Fields for Through the Grape Vine Distri...
@ @ Fields for Anoza, Marylyn
= [ ¥} Fields for this opportunity
# > Management
# > Reps
= > Partner Information
B Partner info (olg Ho
Partner is lead?
Partner Team Leader

[ internal Resources. Pre-sales, Datasheets

H Region South East
Prospect?
Hf storesize Under 2,000 squars fest

[ Last sales cair)

[ Mumber of Retail Lines i6-8 ivl

H wine Preference 10-
Number of Distributors
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Working with User-Defined Fields

Keep the following points in mind while you work in the User-
Defined Fields pane or the User-Defined Fields tab in an open entry:

n User-defined fields are displayed in a tree view, where fields are
nested within folders.

E Click in the Value(s) column next to a field to add or modify a
user-defined field value.

E Use the options in the Filter drop-down list to display only
specific types of user-defined fields, for example table or
formula fields.

n When you select the Show blank fields option, all user-defined
fields in the Address Book for the type of entry are displayed.
When you clear this option, only the fields with existing values
are displayed.

E When you select the Show hidden fields option, fields and
folders that are set to hidden appear shaded. When you clear
this option, the fields and folders are completely hidden.

E Mandatory fields are denoted with an asterisk displayed after
the field name and type. System-defined fields are shown in
bold, black text.

Opportunities and customer service cases display the user-
defined fields for the associated Address Book entries, as well as
the user-defined fields for opportunities or cases.

Contacts display the user-defined fields for the associated
Companies or Individuals, as well as the user-defined fields for

Contacts.

?,','f‘,':éﬁ‘;:'" e ™ Details | Contacts | Hitory = Notes Documents | Customer D +

Mer: N ‘E ~  [¥] show blank fiekds ] Show hidden fields < | @ a
Field Value(s)

= £ User-Defined Fields
% [ Fields for Through the Grape Vine Distri...
¥ @ Fields for Anoza, Marylyn
= (¥} Fields for this opportunity
# [y Management
@ f Reps
= % Partner Information

i Parine No H

[5] Pariner is leaa?

[1A] Partner Team Leader

@ internal Resources Pre-sales, Datasheets
8 Rregion South East
[3] Prospect?
ff Store size Under 2,000 square fest
[T Last Sakes Cal) B

&5 Number of Retail Lnes Fe E =]
E Wine Preference

Number of Distributors

3-5
il 5




Chapter3 | 61

User-Defined Fields versus System Fields

User-defined fields are created by Maximizer users. You can create as
many user-defined fields as you need to define your entries. All user-
defined fields are available in the User-Defined Fields following
pane. You can also add user-defined fields to Key Fields lists.

System fields are created by default in Maximizer. They cannot be
deleted or modified. They included the main fields in the Details
pane, for example Address and phone number, for Address Book
entries and the main fields in the Basic Information tab for other
entries. Some system fields are available in Key Fields lists, but aren’t
otherwise visible in the entries. As well, some fields in the User-
Defined Fields tab are system fields. They are shown in bold, black
text.

User-defined fields are created and modified in the Set Up User-
Defined Fields dialog box in Maximizer or in Administrator. Users
must have permissions for User-Defined Field Setup to view, create,
modify, and delete user-defined fields.

You can set up custom values for many of the system fields using
Administrator. Only users with the Administrator role can modify
these fields. You can also set up custom values for many other system
fields in Maximizer. Users must have the Modify system fields
privilege to customize system field values from Maximizer.

View User-Defined Fields for an Entry

n In the Address Book, Opportunities, Customer Service, or
Campaigns page, select the entry.

E Select the User-Defined Fields pane.

The user-defined fields for the current entry are displayed.

B If necessary, select Show blank fields or Show hidden fields
to display the empty or hidden fields.

Add a Value to a User-Defined Field

You can specify values for user-defined fields in the User-Defined
Fields pane or in the User-Defined Fields tab of an open entry.

n Click on the entry to make it the current entry.

Open the entry.
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E Select the User-Defined Fields pane or the User-Defined
Fields tab.

E If necessary, select Show blank fields to display the user-
defined fields without values.

n If necessary, open the folder containing the user-defined field.

E Next to the user-defined field you want to edit, click in the
Value(s) column.

E Specify a value for the user-defined field.
¢ Alphanumeric and numeric fields - Type the value.

¢ Single-value table or yes/no fields - Select a value from
the drop-down list.

¢ Multi-value table fields - Click the ellipsis, select
checkboxes next to values, and click OK.

e Date fields - Click the calendar icon and select a date.

October 2011

Su Mo Tu We Th Fr Sa

23 s 87 8
s muenaus
I IEIENENE
SN IEIE JE)

ERED

If you are working in an open entry, click OK to save the
changes.
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Setting Up User-Defined Fields

User-defined fields are created and modified in the Set Up User-
Defined Fields dialog box in Maximizer and the User-Defined Fields
page in Administrator. The fields and folder are organized in a tree
view. There can be multiple levels of folders, each containing other
folders or user-defined fields. The folder structure allows a maximum
of three folder levels.

You can set up different lists of user-defined fields for each type of
entry. The user-defined field structure can be multi-tiered with
multiple levels of user-defined field folders, each of which may
contain other folders or user-defined fields. The folder structure may
contain a maximum of three folder levels.

In Maximizer, you can create user-defined fields in the Set Up User-
Defined Fields dialog box. You can access this dialog box from the
Administration section in the left navigation pane.

Set Up User-Defined Ficlds [X]
New: = Field v [y Folder | SaveAs = fems | € Delete < MoveUp §f MoveDown [ MoveTo (= ResetOrde
Address Book | Opportunities | Campaigns ‘ Customer Service | Users ‘
Name Type Requested by
= 4 [Escona Tutoria
=UseAlternateForm Alphanumeric
® > 2010 Campaigns and Sales Folder
® f Saks Folder
@ f Warketing Folder
@ ) Customer Service Folder
@ ) Partner (Retai-Reseler) Info Folder
@ ) Customer Profie Folder
@ ) Discount Levels Folder
@ ) Wine Preferences Folder
@ ) Wines of Interest Folder Joe Napoli
[ Escona Roles Table
[ Customer Interests. Table
[E Partner nterests Table
Combined Partner and Internal Sales Formula Joe Napoli
|:| Contract Expiry Date Joe Hapoli

Close

Sorting User-Defined Fields

The order that user-defined fields display in the Set Up User-Defined
Fields dialog box determines the order that user-defined fields
display for users.

Click the Move Up and Move Down buttons to move a field or folder
up or down in the list. These buttons move fields only within their
current folder level. You cannot use them to move items in or out of
folders.
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Use the Reset Order button to sort items in alphabetical order. All
user-defined fields and folders in the selected folder are resorted.

Move a User-Defined Field or Folder to Another Folder

n In the left navigation pane, hover your mouse over
Administration, and select Set Up User-Defined Fields from
the pop-up.

The Set Up User-Defined Fields dialog box opens.
E Select the field or folder you want to move.
E Click Move To.

n From the Folder name drop-down list, select the folder you
want to move the field or folder to, and click Save.

Create a Folder for User-Defined Fields

You can group similar user-defined fields into folders and subfolders
to a maximum folder depth of three levels. Grouping user-defined
fields into folders is particularly useful if you have a large number of
user-defined fields. Grouping them makes them easier to find and
reduces the amount of scrolling needed to find the one you are
looking for.

n In the left navigation pane, hover your mouse over
Administration, and select Set Up User-Defined Fields from
the pop-up.

The Set Up User-Defined Fields dialog box opens.

E Select the tab for the category of user-defined fields you want to
work with.

ﬂ To create a top-level folder, select the Address Book name at the
top of the list.
To create a folder within an existing folder, select the existing
folder.

I click Add Folder.

E Enter a name for the new folder, and click Save.

@ User-defined field and folder The new folder now appears in the user-defined fields list.
names cannot contain forward
slash or backward slash
characters (/\).



® If you set the folder to hidden,

it is not displayed on the User-

Defined Fields tab when you
clear the Show hidden fields
option.
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& | Add Folder -- Webpage Dialog ==
Add Folder ldsave [cancet
Field Properties
Parent folder: \Wine Preferences
Hame. Reds
[T set to hiden

E Move the new folder to a different position in the list, if desired.

Create a User-Defined Field

@ User-defined field and folder
names cannot contain forward
slash or backward slash
characters (/\).

® You cannot insert other
formula user-defined fields
into the formula.

To complete this procedure, you must have Insert permission for
user-defined field setup.

You can create user-defined fields for Address Book entries,
opportunities, campaigns, customer service cases, and user accounts
in the Set Up User-Defined Fields dialog box.

n In the left navigation pane, hover your mouse over
Administration, and select Set Up User-Defined Fields from
the pop-up.

The Set Up User-Defined Fields dialog box opens.

E Select the tab for the category of user-defined fields you want to
work with.

ﬂ Select an existing folder, inside which you want to create a new
field.

—or —

Select a user-defined field to create the new field at the same
level as the selected field.

n Click Add Field, and select the type of user-defined field you
want to add.

E In the Name field, type a name for the user-defined field.

E If you are adding a formula user-defined field, enter the formula
in the Formula field.

Click Insert Field to add basic or user-defined fields to the
formula.

Specify the properties of the user-defined field.
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B Click Save.
The user-defined field is added to the list.

Add Table Field - Mozilla Firefox ==
Add Table Field il save & cancel
Field properties

Folder name: Discount Levels

ruame: Distributor Discount
Field may be added to:  [¥] Companies ] Individuals Contacts
Attributes

V] single value only Set to hidden
Mandatory

® hot mandatary

Insert Field, .,

Aceess rights
Full access: Pubiic -
Read access: Fublic

Creation details

Creator; Joe Mapoli

Requested by: Joe Mapol -
Descripkion:

[ Speling |

Create a Field for Hyperlinks

To complete this procedure, you must have Insert permission for
user-defined field setup.

Use this procedure to create an alphanumeric user-defined field for
URLs. The user-defined field will be displayed as a hyperlink in Key
Fields lists.

n In the left navigation pane, hover your mouse over
Administration, and select Set Up User-Defined Fields from
the pop-up.

The Set Up User-Defined Fields dialog box opens.

E Select the tab for the category of user-defined fields you want to
work with.

ﬂ Select an existing folder, inside which you want to create a new
field.

—or —

Select a user-defined field to create the new field at the same
level as the selected field.

ﬂ Click Add Field, and select Alphanumeric.

E In the Name field, type a name for the user-defined field.



@ User-defined field and folder
names cannot contain forward
slash or backward slash
characters (/\).
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E Under Attributes, select Display as a hyperlink.
Specify the remaining properties of the field.

E Click Save.
The user-defined field is added to the list.

Create a Field for Currency Values

® User-defined field and folder
names cannot contain forward
slash or backward slash
characters (/\).

To complete this procedure, you must have Insert permission for
user-defined field setup.

Use this procedure to create a numeric user-defined field for currency
values. If multi-currency is enabled, the corporate currency is
displayed with the field.

n In the left navigation pane, hover your mouse over
Administration, and select Set Up User-Defined Fields from
the pop-up.

The Set Up User-Defined Fields dialog box opens.

E Select the tab for the category of user-defined fields you want to
work with.

ﬂ Select an existing folder, inside which you want to create a new
field.

—or —

Select a user-defined field to create the new field at the same
level as the selected field.

ﬂ Click Add Field, and select Numeric.

E In the Name field, type a name for the user-defined field.
E Under Attributes, select Show currency symbol.

In the Number of decimals field, enter 2.

E Specify the remaining properties of the field.

E Click Save.
The user-defined field is added to the list.
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Modify a User-Defined Field

To complete this procedure, you must have Modify permission for
user-defined field setup.

You can change most properties of existing user-defined fields.
However, you cannot change the type of user-defined field.

n In the left navigation pane, hover your mouse over
Administration, and select Set Up User-Defined Fields from
the pop-up.

The Set Up User-Defined Fields dialog box opens.
E Click on the user-defined field.
B Change the properties as required.
ﬂ Click Save to save the changes.

Add Items to a Table User-Defined Field

Table user-defined fields contain a list of similar items from which a
user may select one or more items. As part of the process of creating
a new user-defined field of this type, you should add the items to the
table.

n In the left navigation pane, hover your mouse over
Administration, and select Set Up User-Defined Fields from
the pop-up.

The Set Up User-Defined Fields dialog box opens.

E Select the table user-defined field, and click Items.

The list of existing items for the table user-defined field is
displayed.

E] ciick Add item.



@ If you set the item to hidden,
you can hide it from the
Available Values list by
clearing the Show hidden
items option.
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Set Up Items - Mozilla Firefox

Items list [Field name: Lead status |

Additem 3 Delete 4 MoveUp & MoveDown (= ResetOrder [X] Close

Item name Requested by Created Date and Time Creator
Hot January 14, 2004, 04:19:22 Lou Jones
Warm January 14, 2004, 04:19:22 Lou Jones
Cold January 14, 2004, 04:19:22 Lou Jones

Suspended January 14, 2004, 04:19:22

Lou Jones

Abandoned January 14, 2004, 04:19:22

Lou Jones

Unknown

January 14, 2004, 04:19:22

Lou Jones
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ﬂ Type a name for the item, and specify the other properties of the

item.

E Click Save.

£ Add Table tem -- Webpage Dialog

Add Table Item

Item properties

=

dsave [Jcancel

Name: Government

[T setto hidden

Creation details
Creator:

Requested by, Joe Napoli

E Repeat steps 3 to 5 to add any additional items to the table user-

defined field.

Modify an Item in a User-Defined Field

You can change the properties of existing items in table or yes/no
user-defined fields. For yes/no user-defined fields, you can specify

one of the items as the default value that is automatically set for the

field in all new entries.

n In the left navigation pane, hover your mouse over
Administration, and select Set Up User-Defined Fields from

the pop-up.

The Set Up User-Defined Fields dialog box opens.
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E Select the table or yes/no user-defined field, and click Items.
The Set Up Items dialog box opens.
ﬂ Click the name of the item you want to modify.

n Modify the properties of the item.

For yes/no user-defined fields, you can select Default value to
set this item as the default value for the field.

E Click Save.
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Mandatory Fields

You can specify that system fields and user-defined fields are
mandatory. System fields are set as mandatory in Administrator.
User-defined fields are set as mandatory when creating the user-
defined fields in Administrator or in the Set Up User-Defined Fields
dialog box.

Mandatory fields are denoted with an asterisk displayed after the
field type or with a red border.

When you create or modify entries, Maximizer checks that all
mandatory fields have values. If any mandatory fields are empty, you
are prompted to enter a value for the field. If you are working in the
Details pane, any user-defined fields that are empty are added to the
current Key Fields list.

Rules for Mandatory User-Defined Fields

When you work with Address Book entries or opportunities, you can
specify that user-defined fields are mandatory if a rule is matched.
For example, you can write a rule that makes a user-defined field
mandatory only when the category for an Address Book entry is set
to “Partner”. When users set the value of the Category field to
Partner, they are prompted to set a value for the user-defined field
when they save the entry.

A mandatory rule consists of a comparison statement. It may
compare a field with a value or with another field. Or it may compare
formulas using the same syntax as formula user-defined fields.

You can create comparison statements with the following symbols.
e ==to check that two values are equal to each other.

e I=to check that two values are not equal to each other.

* > to check that the first value is greater than the second value.
e < to check that the first value is less than the second value.

¢ >=to check that the first value is greater than or equal to the
second value.

e <=to check that the first value is less than or equal to the second
value.

Comparison statements are often combined with logical operators to
add multiple statements together.

e Or - Combines two comparison statements where either one of
the statements is true.
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¢ And - Combines two comparison statements where both of the
statements is true.

¢ Not - Negates a comparison statement.

While the comparison statements may be simple, say to compare a
field with a value or with another field, you can also write more
complex rules. Within the comparison statements, you can include
arithmetic operators (+, -, * /) and alphanumeric, date, and numeric
functions to create complex formulas.

Set a User-Defined Field as Mandatory

To complete this procedure, you must have Modify permission for
user-defined field setup.

Use this procedure to set an existing user-defined field as always
mandatory.

n In the left navigation pane, hover your mouse over
Administration, and select Set Up User-Defined Fields from
the pop-up.

The Set Up User-Defined Fields dialog box opens.
E Click on the user-defined field.
ﬂ In the Mandatory section, select Always mandatory.
n Click Save to save the changes.

Set a User-Defined Field as Mandatory Given Conditions

To complete this procedure, you must have Modify permission for
user-defined field setup.

Use this procedure to set a user-defined field as mandatory when a
specified rule is matched. This procedure applies only to user-defined
fields for Address Book entries or opportunities.

n In the left navigation pane, hover your mouse over
Administration, and select Set Up User-Defined Fields from
the pop-up.

The Set Up User-Defined Fields dialog box opens.
E Click on the user-defined field.
ﬂ In the Mandatory section, select Mandatory based on rule.

n In the text field, enter the rule.
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Click Insert Field to add basic or user-defined fields to the rule.

E Click Save to save the changes.

Mandatory Rules Using Table Fields

When you create mandatory rules that compare table fields, the
values in the fields are treated like alphanumeric fields.

To compare a table field that contains multiple values, the
comparison statement must include the same text that's displayed in
the Maximizer interface, including all values for the field. For
example, the statement [Category] == "Partner" will be true only if
the only value set in the Category field is "Partner". If the Category
field includes the "Distributor" value as well, the rule would validate

with the following statement: Category == "Distributor, Partner".
You can use the Search function to locate text in multiple-value table
fields.

To check that one of multiple values are set in a table field, use the
OR operator in the rule. To check that two (or more) values are set in
a table field, use the AND operator in the rule.

Example: Mandatory rule for table field using OR

The following rule validates if either the Distributor or Partner value
is set in the Category field:

(Search("Partner”,[Category]) > 0) OR (Search("Distributor”,[Category]) > 0)

Example: Mandatory rule for table field using AND

The following rule validates if both "Distributor" and "Partner” are
set in the Category field:

(Search("Partner”,[Category]) > 0) AND (Search("Distributor”,[Category]) > 0)

Using Mandatory Rules to Enforce Business Rules

You can use rules for mandatory user-defined fields to enforce your
company’s business rules. For example, you may create a user-
defined field that is used only when a user enters invalid data in
other fields.

This example shows how to create a user-defined field to enforce the
following rule: The contract expiry date must be later than the last
service date.
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n Create a table user-defined field with a name that describes why
the rule fails.

For example: "Contract expired before last service date"

E Write a mandatory rule for the field that's equivalent to the
opposite of the business rule.
For example: [Contract Expiry Date] < [Last Service Date].

This rule validates when the business rule fails.

Modify Table Field - Mozilla Firefox ==
Modify Table Field el save L3 cancel

Field properties
Folder name: \Customer Service

Mame: Contract Expired Before Service Date

Field may be added to: ¥ Companies [¥|Individuals [¥| Contacts
Attributes

V] single value only Set to hidden

Mandatory

Not mandatory
Always mandatory
© Mandatory based on rule Insert Field...

[Contract Expiry Date] < [Last Service Date]

Access rights
Full access: Public -

Read access:
Creation details
Creator: Lou Jones

Requested by: Joe Napoli -
Desaription:

| spelling |

ﬂ Add no items to the table user-defined field.

Set Up Items - Mozilla Firefox ==
Items list [Field name: Contract Expired Before Service Date |
Order [ close @

@ AddItem 7€ Delete ovelp & Move Down

When someone saves an entry that breaks the rule, the user is
prompted to provide a value for the field.

However, the table field has no items, so the user cannot supply a
value, and therefore cannot save the entry.
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Save Cancel All the fields marked with red must be completed. -

ETN E=ER ! P Key Fields for: General Customer - 7]
Company name: | All The Best Spirits - Contract Expired Before Service Date: -
Department: - Contract Expiry Date: March 23, 2013
Division: - Last Service Date: April 01, 2013

Primary Interest: As an agent/distributor -
Phone numbers sent
Retal Wine Cost: -
Main ~ || (504) 601-8000
Region: US - Northeast -
Fax - || (604) 601-8001
Industry: Wine-Retail -
Cell A
Size of Client: -
First Contacted Date: April 21, 2010
Email addresses and website Account Manager: Mark Bertolli -
an ~ ) [csconamesinizer com Full Access: public
Email 2 - B Read Access:
Email 3 - Territory: East -
Website: W maximizer .com Territory Status: Set by Rule

If you want to let the user save the entry, you can provide reasons for

breaking the rule as items in the table field. For example: add the

following table items "Complimentary service", "Negotiating

contract”, "New contract pending

Key Fields for: General Customer -

Contract Expired Before Service Date:

Contract Expiry Date: |

Last Service Date: Complimentary service
Primary Interest: Negociating new contract

Mew contract pending
Reskail Wins Cost:
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Formula User-Defined Fields

Formula user-defined fields calculate values based on other basic or
user-defined fields. Because they are calculated from values of other
fields, values for formulas fields can be viewed in entries but cannot
be set manually.

When you create a new or modify an existing formula user-defined
field, you specify the formula for the user-defined field. You can
write the formula using existing basic and user-defined fields. Click
the Insert Field button to select fields to add to the formula.

Insert Field

Formula:
If ([Creation Date] = Date(2008, 7, 8, "New”, "0ld™)

H
H

Formula user-defined fields can return alphanumeric, date, or
numeric values. You specify the type of return value while creating
the user-defined field. The functions available depend on the types
of fields that you want to manipulate.

You can add arithmetic expressions to your formulas. You can also
add functions and conditional expressions to create more complex
formulas.

Create a Formula User-Defined Field

To complete this procedure, you must have Insert permission for
user-defined field setup.

n In the left navigation pane, hover your mouse over
Administration, and select Set Up User-Defined Fields from
the pop-up.

The Set Up User-Defined Fields dialog box opens.

E Select the tab for the category of user-defined fields you want to
work with.

ﬂ Select an existing folder, inside which you want to create a new
field.

—or —

Select a user-defined field to create the new field at the same
level as the selected field.

3 click Add Field, and select Formula.

E In the Name field, type a name for the user-defined field.
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@ User-defined field and folder E In the Formula field, enter the formula.
names cannot contain forward i . i i i
slash or backward slash Click Insert Field to add basic or user-defined fields to the
characters (/\). formula.

@You cannot insert other From the Formula return type drop-down list, select the type
formula user-defined fields of value returned by the formula: Alphanumeric, Date, or
into the formula. .

Numeric.

The attributes available for the field change depending on the
value selected.

E Specify the remaining properties of the field.

E Click Save.
The user-defined field is added to the list.

Conditional Expressions for Formulas

You can create conditional expressions in your formula user-defined
fields. Conditional expressions use the If expression to evaluate
comparison statements and return values based on the results of the
statements.

Conditional expressions use the following syntax:
If (Comparison Statement, True Value, False Value)

e Comparison Statement - Uses comparison operators to
compare two values. Comparison statements can use the
following operators:

e ==to check that two values are equal to each other.
e I=to check that two values are not equal to each other.

* > to check that the first value is greater than the second
value.

e < to check that the first value is less than the second value.

e >=to check that the first value is greater than or equal to the
second value.

e <=to check that the first value is less than or equal to the
second value.

Comparison statements can be combined with logical operators:

e Or - Combines two comparison statements where either one
of the statements is true.

¢ And - Combines two comparison statements where both of
the statements is true.

¢ Not - Negates a comparison statement.
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¢ True Value - The value of the expression when the comparison
statement is true. It can also be combined with other

expressions.

e False Value - The value of the expression when the comparison
statement is false. You can include other conditional statements
to supply different answers for different values.

Examples of Conditional Expressions

The following examples illustrate complex formula user-defined

fields using conditional expressions.

Example 1

If ([Creation Date] > Date(2009, 7, 9), "New", "0Id")

This example compares a date field with a constant date, using the
Date function to format the date properly. The formula returns an
alphanumeric value. If the date is later than the supplied date, the
field has a value of “New”. If the date is earlier than the supplied

date, the field has a value of “Old".

Example 2

If(Not(Search("Canada",[Country])>0 Or Search("USA",[Country])>0 Or
Search("Mexico”,[Country])>0), " Other","North America")

This example inspects the Country field of an Address Book entry to
determine if the entry is located in North America or not. It uses the
alphanumeric Search function to look for the countries “Canada”,
"USA", or “Mexico". If none of those strings are found in the entry’s
Country field, the formula evaluates to “Other”, but if one of those
strings is found it outputs “North America”.

Example 3

If (Dayofweek([Creation Date]) == 1
If (Dayofweek([Creation Date]) =

If (Dayofweek([Creation Date]) =

If (Dayofweek([Creation Date]) =

f (Dayofweek([Creation Date]) =

f (Dayofweek([Creation Date]) =

If (Dayofweek([Creation Date]) ==

unday ,

, "Monday",

, "Tuesday",

, "Wednesday",

, "Thursday"”,

, "Friday",

. "Saturday”, " "))

This example uses the Dayofweek functlon to get the day of the
week expressed as an integer value for a date field. It compares the
value with integer values and outputs a string representing the day
of the week in. If it does not have a value, it outputs an empty string.
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Writing Formulas and Mandatory Rules

@ You cannot insert other
formula user-defined fields
into the formula.

Arithmetic Expressions

Formula user-defined fields calculate values based on other basic or
user-defined fields. You can write formulas consisting of arithmetic
expressions, alphanumeric, date and numeric functions, as well as
conditional expressions.

When you work with Address Book entries or opportunities, you can
specify that user-defined fields are mandatory if a rule is matched.
Rules for mandatory user-defined fields are similar to the formulas in
formula user-defined fields. A mandatory rule consists of a
comparison statement. It may compare a field with a value or with
another field. Or it may compare formulas using the same syntax as
formula user-defined fields. Comparison statements can contain any
of the elements included in formulas, including alphanumeric, date,
and numeric functions.

Using the basic arithmetic symbols, you can include arithmetic
expressions in formula user-defined fields and in rules for mandatory
user-defined fields. Combine multiple expressions to create
complicated arithmetic formulas.

Formula user-defined fields and rules for mandatory user-defined
fields can use the following symbols:

e + for addition.

Add any numeric values to each other, add integers to date
values, and add alphanumeric fields or strings separated with
quotation marks to each other.

e - for subtraction.

Subtract any numeric values from each other, and subtract date
values from each other. Date values return integers representing
the number of days between the dates.

e * for multiplication.

Multiply numeric values together.
e /for division.

Divide numeric values by other numeric values.
e () for nested operations.

Use parentheses to create more complex operations on several
numeric values or to combine multiple comparison statements.
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Example: Numeric Values

Formula: ([Numeric field] + [Numeric field]) * [Numeric field]
Return value: Numeric

Example: Date Values

Formula: [Date 1] - [Date 2]
Return value: Numeric, the number of days between the two dates.

Example: Date and Numeric Values

Formula: [Date 1] + [Numeric field]
Return value: Date

Example: Alphanumeric Values

Formula: [FirstName] + " " + [LastName]

Return value: Alphanumeric, the two words listed together, separated by a
space (FirstName LastName).

Alphanumeric Functions

Use alphanumeric functions to manipulate alphanumeric fields in
formula user-defined fields and in rules for mandatory user-defined
fields. When you use alphanumeric functions, you can insert
alphanumeric fields as the parameters for the function or you can
use any text strings. When you insert strings into functions, enclose
the text of the string in quotation marks.

You can add the following functions to formulas using alphanumeric
user-defined fields.

* Len - Returns the number of characters in a text string.
e Lowercase - Converts a string to lower-case characters.

¢ Mid - Returns a specific number of characters from the text
string starting at the position you specify.

e Search - Searches for text in a string and returns the position of
the text.

e Substitute - Substitutes existing text with specified text.

e Text - Changes a numeric value to an alphanumeric text string.
You can manipulate the returned string using any of the other
alphanumeric functions.



Len

Lowercase
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e Uppercase - Converts a string to upper-case characters.

e Value - Converts an alphanumeric value to a numeric value.
Alphanumeric values beginning with alphabetical characters
return a value of 0. You can manipulate the string using any of
the numeric functions.

Returns the length of a string.

Syntax

Len(Alphanumeric)

Parameters

Parameter Data Type Description

Alphanumeric  String The string to return the length of.
Example

Len([Company])

This example returns the number of characters in the company’s
name.

Converts a string to lower-case characters. Use this function or the
Uppercase function with the Search function and with equal (==
statements to compare alphanumeric values when you do not care
about the case of the string.

Syntax

Lowercase(Alphanumeric)

Parameters

Parameter Data Type Description

Alphanumeric String The string to convert to lower case.
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Mid

Search

Example

Lowercase([City])=="vancouver"

This example of a mandatory rule checks for the value "Vancouver"
in the City field. The rule validates if an entry has the values
"Vancouver", "vancouver", or "VANCOUVER" in the City field.

Returns a specific number of characters from a text string starting at
a specified position.

Syntax

Mid(Alphanumeric, Startint, Lengthint)

Parameters

Parameter Data Type Description

Alphanumeric  String The string that you want to search
through. Normally, this would be a
merge field.

Startint Integer The position of the first character
in the string you want to return.

Lengthint Integer (Optional) The length of the string
you want to return.

Example

Mid("First Last", 7)

This example returns the text starting at the 7th position in the field.
In this case, it returns “Last”.

Searches a string for text and returns the position of the text in the
string. This function is case sensitive.

Syntax

Search(SearchString, Alphanumeric, Startint)
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Parameters

Parameter Data Type Description

SearchString String The text to search for in the string.

Alphanumeric | String The string to search through. To
ignore the case of the string,
include the Lowercase or
Uppercase function in this
parameter.

Startint Integer (Optional) The starting character
to search.

Examples

Search("Wine", [Company_Name])

This example searches for the text “Wine" in the company name and
returns the place in the name where the text starts as an integer.

Search("Partner", [Category]) > 0

This example of a mandatory rule searches for the value "Partner" in
the Category field. This rule validates if an entry has the category set
to "Partner" even if the there are other values set in the Category
field as well.

Search("wine", Lowercase([Company_Name])) > 0

This example of a mandatory rule searches for the text “wine” in the
company name ignoring the case. This rule validates if the Company
Name field includes the text "Wine", "wine", or "WINE".

Substitutes existing text with specified text. This function returns the
entire string containing the new text.

Syntax

Substitute(Alphanumeric, OldText, NewText)

Parameters
Parameter Data Type Description
Alphanumeric  String The string containing the text you

want to change.
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Text

Uppercase

Parameter Data Type Description

OldText String The text you want to change.

NewText String The text substituted into the
string.

Example

Substitute([Address], "St", "Street")

This example returns the address with the abbreviation “St”
substituted with the text “Street”.

Converts a numeric value to a string. You can then use the other
alphanumeric functions to manipulate the returned string.

Syntax

Text(Number, DecPlace)

Parameters

Parameter Data Type Description

Number Decimal The numeric value that you want
to convert.

DecPlace Integer (Optional) The number of decimal
places to return.

Example

Text([Revenue], 2)

This example returns the revenue as an alphanumeric string with two
decimal places. If revenue, a numeric field, is 50000, the Text function
in the above example returns 50000.00 as an alphanumeric value.

Converts a string to upper-case characters. Use this function or the
Lowercase function with the Search function and with equal (==
statements to compare alphanumeric values when you do not care
about the case of the string.



Value

Chapter3 | 85

Syntax

Uppercase(Alphanumeric)

Parameters

Parameter Data Type Description

Alphanumeric String The string to convert to upper
case.

Example

Uppercase([City])=="VANCOUVER"

This example of a mandatory rule checks for the value "Vancouver"
in the City field. The rule validates if an entry has the value
"Vancouver", "vancouver", or "VANCOUVER" in the City field.

Converts an alphanumeric value to a numeric value. If the value
contains alphabetic characters, it returns 0. You can then manipulate
the numeric value using any numeric functions.

Syntax

Value(Alphanumeric)

Parameters

Parameter Data Type Description

Alphanumeric String The alphanumeric string to
convert.

Example

Value([Contract Number])

This example returns the alphanumeric user-defined field, Contract
Number, as a numeric value. If the field contains an alphabetical
character, it returns 0.
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Date Functions

Date

@ Any formula that supplies an
invalid date to the Date
function will result in a blank
value. For example, the
function "Date (2012, 4, 31)"
is invalid since the month of
April does not have 31 days. If
this function is part of a larger
compound expression, the
entire expression will evaluate
to blank.

Day

Use date functions to manipulate date fields in formula user-defined
fields and in rules for mandatory user-defined fields. When you use
date functions, you can use date fields as the parameters for the
function or you can supply date values for the functions. When you
supply date values, use the Date function to format the values as
dates.

You can add the following functions to formulas using date fields.

Date - Converts integers to date values.

Day - Returns the day of the month as an integer from a date
value.

Dayofweek - Returns the day of the week expressed as an
integer.

Month - Returns the month as an integer from a date value.

Year - Returns the year as an integer from a date value.

Converts integers to date values.

Syntax

Date(Year, Month, Day)

Parameters

Parameter Data Type Description

Year Integer The four-digit year.

Month Integer The one- or two-digit month.
Day Integer The one- or two-digit day.
Example

Date(2009, 7, 9)
This example returns July 9, 2009 as the date value.

Returns the day of the month as an integer from a date value.
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Syntax

Day(Date)

Parameters

Parameter Data Type Description

Date Date The date to return the day for.

Examples

Day(Date(2009, 7, 9))

This example returns 9 as the day of the month in the date value.
Day([Creation Date])

This example returns the day of the month that an entry was created.

Returns the day of the week expressed as an integer for a specified
date value, with 1 = Sunday, 2 = Monday, 3 = Tuesday, and so on.

Syntax
Dayofweek(Date)
Parameters
Parameter Data Type Description
Date Date The date value for which to return
the day of the week.
Examples

Dayofweek(Date(2009, 7, 9)

This example returns 5, for Thursday, as the day of the week for the
given date.

Dayofweek([Creation Date])
This example returns the day of the week that an entry was created.

Returns the month as an integer from a date value.
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Syntax
Month(Date)
Parameters
Parameter Data Type Description
Date Date The date from which to return the
month.
Examples

Month(Date(2009, 7, 9))

This example returns 7, for July, as the month in the date value.
Month([Creation Date])

This example returns the month that an entry was created.

Returns the year as an integer from a date value.

Syntax
Year(Date)
Parameters
Parameter Data Type Description
Date Date Date value for which to return the
year.
Examples

Year(Date(2009, 7, 9))

This example returns 2009 as the year for the date value.
Year([Creation Date])

This example returns the year that an entry was created.
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Use numeric functions to manipulate numeric values in formula user-
defined fields and in rules for mandatory fields. You can add the
following functions to formulas using numeric fields.

e Ceiling - Rounds a number up to the nearest integer or up to a
specified number of decimal points.

¢ Floor - Rounds a number down to the nearest integer or down
to a specified number of decimal points.

e Round - Rounds a number to the nearest integer or to a
specified number of decimal points.

Rounds a number up to the nearest integer or up to a specified

number of decimal points.

Syntax

Ceiling(Number, DecPlace)

Parameters

Parameter Data Type
Number Decimal
DecPlace Integer
Example

Ceiling(2.32, 1)
This example returns 2.4.

Description

The numeric value to round.

(Optional) The number of decimal
places to round up to.

Rounds a number down to the nearest integer or down to a specified

number of decimal points.

Syntax

Floor(Number, DecPlace)
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Parameters

Parameter Data Type Description
Number Decimal The numeric value to round.
DecPlace Integer (Optional) The number of decimal

places to round down to.

Example

Floor(2.36, 1)

This example returns 2.3

Round

Rounds a number to the nearest integer or to a specified number of
decimal points.

Syntax

Round(Number, DecPlace)

Parameters

Parameter Data Type Description

Number Decimal The numeric value to round.

DecPlace Integer (Optional) The number of decimal
places to round to.

Example

Round(2.45687, 2)
This example returns 2.46.
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Comparison Statements in Formulas and Mandatory Rules

Rules for mandatory user-defined fields consist of comparison
statements. Formula user-defined fields may also include comparison
statements if the formulas include conditional expressions, using “If"
statements.

You can create comparison statements with the following symbols.
e ==to check that two values are equal to each other.

For example, [Category] == “Partner” verifies that the
Category field is set to “Partner”.

e I=to check that two values are not equal to each other.

For example, [Category] != " verifies that the Category field is
not empty, i.e. it has a value.

* > to check that the first value is greater than the second value.

For example, [Annual Sales] > 20000 verifies that the Annual
Sales user-defined field has a value greater than 20,000.

e < to check that the first value is less than the second value.

For example, [Contract Expiry Date] < [Last Service Date]
verifies that the Contract Expiry Date field is earlier than the Last
Service Date field.

e >=to check that the first value is greater than or equal to the
second value.

e <=to check that the first value is less than or equal to the second
value.

Comparison statements are often combined with logical operators to
add multiple statements together.

You can compare any values including alphanumeric, date, and
numeric values. Alphanumeric values are compared by checking the
alphabetical order of the string. When you compare values from
table fields, they are treated as alphanumeric values.

Comparison statements are case sensitive. If you want to ignore the
case of fields, include the Lowercase or Uppercase function in the

statement. For example, [City] == "Vancouver" is true only if the
value of the City field is set to "Vancouver". However,
Lowercase([City]) == "vancouver" is true if the value of the City field

is set to "Vancouver", "vancouver", or "VANCOUVER".

To compare a table field that contains multiple values, the
comparison statement must include the same text that's displayed in
the Maximizer interface, including all values for the field. For
example, the statement [Category] == "Partner" will be true only if
the only value set in the Category field is "Partner”. If the Category
field includes the "Distributor" value as well, the rule would validate
with the following statement: Category == "Distributor, Partner".
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You can use the Search function to locate text in multiple-value table
fields.

Logical Operators for Formulas and Mandatory Rules

You can use logical operators to build more complex comparison
statements in formula user-defined fields and in rules for mandatory
fields.

You can use the following logical operators:

Or - Combines two comparison statements where either one of
the statements is true.

For example, [Category] == “Partner” OR [Category] ==
“Distributor, Partner” is true if the Category field has either
the “Partner” value alone or has both the "Partner" and the
"Distributor” values.

And - Combines two comparison statements where both of the
statements is true.

For example, [Category] == “Partner” AND [Annual Sales] >
20000 is true if the Category field has the “Partner” value and if
the Annual Sales field is greater than 20,000.

Not - Negates a comparison statement.

For example, NOT ([Category] == “Partner” AND [Annual
Sales] > 20000) is true in all cases where the previous example is
false.
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Key Fields are important user-defined fields and system fields that
are highlighted on the Details tab in the following pane for Address
Book entries and opportunities, and on the Basic Information tab in
campaigns, and customer service cases, making them more readily
accessible.

You can choose any user-defined fields and some system fields to
include in the Key Fields lists. You may want to select mandatory
fields as Key Fields, so users don’t miss them when creating new
records. You may also select frequently used fields, making it easier
for users to quickly enter these values. And you may select fields
important to a particular group of users because different Key Field
lists can be defined for specific users and groups, or for all users.

Use this procedure to view a list of Key Fields for an entry.

n Click on the Address Book entry or opportunity to make it the
current entry.

Open the customer service case or campaign.

E In the Address Book or Opportunities page, open the Details
pane.

B From the Key Fields for drop-down list, select a Key Fields list.
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@ This options applies only to

Key Fields for Address Book
entries and opportunities.

ﬂ To show or hide the empty fields in the list, next to the Key
Fields for drop-down list, click the gear icon, and select Show/
Hide blank fields.

Key Fields for Different Types of Entries

Each Key Fields list contains different sets of fields for each type of
entry. For example, you can create a new Key Fields list and add
different sets of fields for Companies and Opportunities. When you
add new fields to the list for opportunities, you can add only
opportunity basic fields and user-defined fields. When you open the
Opportunity dialog box in Maximizer, only the fields added to the
opportunities list will be displayed.

When you work with Address Book entries, you can set up separate
lists of Key Fields for Companies, Individuals, and Contacts. As well,
each type of Address Book entry has different lists for sales leads and
for regular entries. For example, Individual - Lead Key Fields appear
only in Individual Address Book entries that are marked as sales
leads.

Add fields to the Key Fields list for only the types of entries that you
want to make the Key Fields list available to. If the Key Fields list
contains no fields for a specific type of entry, the list will not be
available when you view that type of entry.

Each Key Fields list can contain separate lists for the following types
of entries:

e Company Lead - For Companies marked as sales leads.

e Company - For Companies that are not marked as sales leads.
¢ Individual Lead - For Individuals marked as sales leads.

¢ Individual - For Individuals that are not marked as sales leads.
e Contact Lead - For Contacts that are marked as sales leads.

e Contact - For Contacts that are not marked as sales leads.

e  Opportunity - For opportunities.

e Campaign - For campaigns

e Customer Service - For customer service cases.
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Restricting Access to Key Fields

Create a Key Fields List

@ The description is displayed
only in Key Fields lists for
Address Book entries and
opportunities.

The Key Fields lists in the Details tab of the following pane orin the
Basic Information tab are visible only to the users or groups specified
as having Read Access to the Key Fields lists. However, other users
may still be able to access the fields in the list through the User-
Defined Fields tab or through other Key Fields lists. Assigning a field
to a Key Fields list does not determine who can access the field. The
field is available as a Key Field only to users with access to both the
user-defined field and to the Key Fields list.

To complete this procedure, you must have the Modify Key Fields
permission.

You can create and modify Key Fields lists from the Details pane in
the Address Book page and the Opportunities page and from the
Basic Information tab in open customer service cases and campaigns.

n In the Address Book or Opportunities page, open the Details
pane.

Open the customer service case or campaign.

E To the right of the Key Fields for drop-down list, click the gear
icon, and select Customize Key Fields.

In an open campaign or customer service case, to the right of the
Key Fields for drop-down list, click the plus icon.

The Preferences for Key Fields dialog box opens displaying a list
of Key Fields.

Kl click Add.

n Enter the properties for the Key Fields list.
¢ In the List name field, enter a name for the Key Fields list.

¢ In the Description field, enter a description for the Key
Fields list.

The description is displayed as a tooltip when a user selects
the Key Fields list.

¢ In the Full access and Read access fields, select the user or
security group with access to the Key Field list.
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@The Read access field
determines which users will
see these fields in their Key
Fields list in Maximizer.

@ The description is displayed
only in Key Fields lists for
Address Book entries and
opportunities.

® You can add group titles only
to Key Fields lists for Address
Book entries and
opportunities.

If necessary, from the Requested by field, select the user
who requested the Key Fields list.

E Select the Key Fields tab and from the Show key fields for
drop-down list, select the type of Maximizer entry to assign Key
Fields to.

B Add user-defined fields and system fields to the list.

Click Add Field, select a system or user-defined field, and
click Insert.

You can insert multiple fields without leaving the dialog box.

When you are finished adding fields, click Close to close the
dialog box.

If necessary, select a user-defined field in the list, and modify
the text in the Description field.

The description of the field is the same as the description
specified when you modify the user-defined field. If you
change the description here, it is also changed for other
occurrences of the user-defined field. This text is displayed as
a tooltip in the Key Fields list.

Organize your fields into groups with separators and titles.

Click Add Separator to add a line between fields.

Click Add Group Title and type title text to add static text to
the Key Fields list.

Click and drag to move elements, including fields, separators,
and titles, around in the list.

You can also use the arrow buttons to move the selected
element around in the list.

You can format the list in two columns or keep all of the
information in a single column.

B If necessary, from the Show Key Fields for drop-down list,
select a different type of entry, and add fields to the list for that
type of entry.

E Click Save to save the Key Fields list.
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Default Entries

Modify a Default Entry

You can set up default entries in the Address Book, Opportunities,
and Customer Service pages. When you create new entries, fields
specified in the default entry are already filled in for you. For
example, if you know all your Address Book entries will have the
same city and state, you can specify these fields in the default
Address Book entry.

Default entries are user-specific, so each user in the Address Book can
have a different set of default entries.

n Select Edit > Default Entry.
The dialog box for the default entry opens.

E Specify default values for fields in the Basic Information and
User-Defined Fields tabs.

For the opportunity default entry, you can also select the
Strategy and Competitors & Partners tabs to specify more
default fields.

For the customer service case default entry, you can also select
the Solution Information & Billing tab to specify more
default fields.



Chapter 4

Click OK to save the changes to the default entry.
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Searching

Many of the actions you can perform with Address Book entries,
customer service cases, campaigns, and opportunities apply to the
entire list of entries in the active page. For instance, when you print a
report from the Address Book page, you are generally given a choice
between printing the selected entry (or entries) or printing the entire
list.

Maximizer’s search features let you search any field for the data you
specify and modify your current list with the matching entries. If you
wanted to create a list of Address Book entries in Washington State,
for example, you would search the State/Province field for entries
with “WA" in that field.

A search retrieves any entries that match the search criteria and that
you have the rights to view.

Find an Address Book Entry with a Quick Search

To complete this procedure, you must have the Read permission for
Address Book entries.

Maximizer makes it easy to search for Address Book entries directly
from the header bar at the top of each page. When you use the quick
search field, Maximizer retrieves any entries with a matching First
Name, Last Name, or Company Name.

Maximizer also matches partial names that start with the search
phrase. For example, searching for the name “John” would retrieve
entries named “John Adams”, “Samantha Johnston”, and “Johnson
Brothers Co".

You can also use the quick search field to search for Address Book
entries by email address or phone number. If you enter all or part of
an email address containing an @ symbol, the quick search returns
Address Book entries with a matching email address. If you enter all
or part of a phone number, the quick search returns Address Book
entries with a matching phone number.

n At the top of page, in the Search for Address Book entries
field, type the name, email, or phone number you want to
search for.

E Click the magnifying glass icon.

[Search for Address Book entries

The Address Book page opens and displays the search results.
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Search for Entries by a Field

Maximizer makes it easy to search for entries by basic field, such as
Last Name, Company, City/Town, or Email for Address Book entries or
Status, Team Leader, or Revenue for opportunities. The items in the
Search menu vary depending on what page is selected. You can
search for entries matching a single field or multiple fields.

n On the Search menu, select the field you are searching for.

For customer service cases, you can also select Basic Fields to
search for entries matching multiple basic fields.

The Search By [field] dialog box opens.
E Specify the search criteria.

Select how you want to update the current list with your search
results.

¢ Add search results to list displays the entries that match
your search criteria, without removing any currently
displayed entries from the list.

¢ Narrow list searches only selected entries (or all currently
displayed entries if none are selected), and removes any
entries that do not match your search criteria.

¢ Replace list with search results removes all entries
currently displayed in the list and replaces them with entries
that match your search criteria.

If applicable, specify the Range of the items to search.

Click OK to run the search.

Search by City/Town x]
i T
Find matching | Modify current entries list Leads conditions

| Companies Add search results to list Entries that are not leads
| Individuals Narrow list @/ Allentries
V| Contacts '@ Replace list with search resufts. Leads

Wy leads only




102 | Maximizer Web Access
User's Guide

Search for Entries by Notes

@ This option is available for full-

text searching on notes only if
you are using Microsoft SQL
Server with the Full-Text
Search component installed.
See the Maximizer CRM
Administrator’s Guide and
your system administrator for
more information.

You can search for entries that have notes matching search criteria
you specify.

n In a main page, select Search > Notes.

The Search by Notes dialog box opens.

E Specify your search criteria.

To search for entries with notes that contain a specific word
or phrase, type the word or phrase in the Text search field.

If your system administrator has enabled full-text search, the
Perform search using Full-Text Indexing checkbox is
available. This option provides faster, and often more
accurate, results. For more information, refer to the
Maximizer CRM Administrator’s Guide or your system
administrator.

To search for entries with notes created by a specific user,
select the user's name from the Creator drop-down list.

To search for entries with notes that are accessible by a
specific user or security group, select the name of the user or
group from the Full Access drop-down list.

To search for entries with notes that were created within a
specific date range, enter the date range in the From and
Until fields. Or select Search all dates.

To search for entries with notes of a specific type, select the
type(s) to search for in the Type of Note section.

To search for a specific type of Address Book entry, select the
type(s) to search for in the Find Matching section. To search
for Address Book entries that are not leads, entries that are
leads, all entries, or your own leads, select the applicable
option in the Leads Options section.

To search for an opportunity or a case with a specific status,
select the status in the Find Matching area.

E In the Modify current entries list section, select one of the
options.

Add search results to list displays the entries that match
your search criteria, without removing any currently
displayed entries from the list.

Narrow list searches only selected entries (or all currently
displayed entries if none are selected), and removes any
entries that do not match your search criteria.

Replace list with search results removes all entries
currently displayed in the list and replaces them with entries
that match your search criteria.
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ﬂ Click OK to run the search.
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7] Email Histary
Find Matching Modify current entries list Leads Options
7 companies Add search resuls o st Entries that are not leads
7] Individuals Narraw list @ Aleniries
/] contacts @ Replace list with search resutts Leads

My leads only

Search for Entries by Documents

To complete this procedure, full-text search must be enabled for your
database. For more information about full-text search, refer to the
Maximizer CRM Administrator’s Guide or your system administrator.

You can search for entries that have documents matching the search
criteria you specify. You can search for Address Book entries,
opportunities, or customer service cases by document.

Your search criteria can specify text in the body of documents. Full-
text search works for the following types of documents: .DOC, .XLS,
.PPT, .TXT, and .HTM. You may also be able to search by .RTF, .XML,
.PDF, and other files types, if your system administrator has
configured full-text search for these types of files. You cannot run
full-text search for Maximizer documents (.ETF), email messages, or
hyperlinks.

n In the Address Book, Opportunities, or Customer Service page,
select Search > Documents.

The Search by Documents dialog box opens.

E Specify your search criteria.

e To search for entries with documents that contain a specific
word or phrase, type the word or phrase in the Text in
document field.
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The search returns only entries containing full words
specified in the search text. If you search for text that is
included in part of a word, the search does not return entries
that contain that word. For example, if you search for
“hedge”, only entries containing the word “hedge” are
returned. Entries containing the word “hedgehog” are not
returned.

e To search for entries with documents that have a specific
name, type the beginning of the name of the document in
the Name of document field.

The search looks for document names that begin with the
characters entered.

¢ To search for entries with documents of a specific category,
select the category from the Category drop-down list.

e To search for entries with documents created by a specific
user, select the user’s name from the Creator drop-down list.

¢ To search for entries with documents that are accessible by a
specific user or security group, select the name of the user or
group from the Owner drop-down list.

e To search for entries with documents that were created
within a specific date range, enter the date range in the
From and Until fields. Or, select Search all dates.

e Tosearch for entries with documents that exceed a given file
size, enter the minimum number of kilobytes in the
Documents larger than field.

e To search for a specific type of Address Book entry, select the
type(s) to search for in the Find Matching area.

B In the Modify current entries list area, select one of the
options.

¢ Add search results to list displays the entries that match
your search criteria, without removing any currently
displayed entries from the list.

¢ Narrow list searches only selected entries (or all currently
displayed entries if none are selected), and removes any
entries that do not match your search criteria.

¢ Replace list with search results removes all entries
currently displayed in the list and replaces them with entries
that match your search criteria.

n Click OK to run the search.
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Undo the Most Recent Search

You can quickly undo the most recent search in the Address Book,
Opportunities, and Customer Service pages.

e Select Search > Undo Search.

The entries in the current list are replaced with the entries in the
previous list.
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Advanced Search

The Advanced Search feature is useful when you need to search by
fields that are not listed in the Search menu or when you want to
search by more than one field. In the Advanced Search dialog box,
you can build complex search arguments and even save your search
in the catalog for later use.

Use the Advanced Search feature to find user-defined fields or a
combination of user-defined fields and basic fields to produce a
custom list of Address Book entries, opportunities, campaigns, and
customer service cases.

In the Opportunities or Customer Service page, you can search by
Address Book entry fields, as well as opportunity or customer service
fields. The search returns opportunities associated with the Address
Book entries matching the field values.

Perform an Advanced Search

You can perform an Advanced Search in the Address Book,
Opportunities, Campaigns, or Customer Service page.

n Select Search > Advanced Search.
The Advanced Search dialog box opens.
H ciick Add.
The Select Fields for Search dialog box opens.

ﬂ Select one or more fields and click OK.

To be able to select more than one field, you must have the
"Allow multi-selection in the Advanced Search" option enabled
in the Personal Preferences. This option is off by default.
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& | Select Fields for Search -- Webpage Dialog ==
Available fields: Selected fields:
# Basic Fields ~| | User-Defined Fields\2010 Campaigns and Sales\Received

User-Defined Fields\2010 Campaigns and Sales\Accepted

=- User-Defined Fields User-Defined Fields\Marketing\Promotions.

*UseAlternateForm

Combined Partner and Internal Sales
=-f 2010 Campaigns and Sales
V] Received 2010 Email Campaign
V] Accepted Winter Promations
2 Sales
= Marketing
H i[¥]Promotions.
B Subscription
B Heard About
i) Promo level
2 Customer Service
2 Partner (Retai-Reseller) Info
2 Customer Profile
2 Discount Levels

| i \>H

Show hidden fields.

n For each field selected in the previous step, select or specify
values in the dialog box that is provided.

¢ For date fields, select Rolling date range to specify date
values relative to the current date or select Specified date
range to specify the exact values of the date.

¢ For alphanumeric, date, and numeric fields, specify values in
the From and To fields to return any values within the range.

e If applicable, indicate under Search conditions whether to
return entries that match all values, or that match one or
more values.

¢ Select the Search for no value checkbox to search for
entries where no value is assigned to the selected field.

& | Specify Date Field Values for Search -- Webpage Dialog ==
Field: Creation Date
©) Roling date range:  Last Month - Values to be searched for:
Specified date range:;

Enter or change values

A
From:

To:

ULk

Search for no value

E Specify the remaining search criteria in the Advanced Search
dialog box.
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To build a list of entries that excludes a certain group, as in a list
of all Address Book entries except those in a certain state or
province, use the Not Equal button.

E In the Modify current entries list area, select one of the

options.

e Add search results to list displays the entries that match
your search criteria, without removing any currently
displayed entries from the list.

e Narrow list searches only selected entries (or all currently
displayed entries if none are selected), and removes any
entries that do not match your search criteria.

¢ Replace list with search results removes all entries
currently displayed in the list and replaces them with entries
that match your search criteria.

You can choose to further narrow the search by specifying
options to include or omit sales leads.

Click OK to run the search.

Search by All Fields

Primary Interest = ‘As

Watch entries using the following fields:

Account Manager ="Joe Napol’

Column Setup:  Territory/Account Manage

Add.__. H Change.

Remove H Not Equal

Search condition
‘@) Must match all

_/ Match one or more

Find matching
Companies
Individuals
Contacts

Modify current entries list
- Add search results to list
Narrow list

@ Replace list with search resuits

Leads options

) Entries that are not leads
© Allentries.

! Leads

~) My leads only

LastSearchl ‘ Catalog

0K | ‘ Cancel

Repeat the Last Advanced Search

Use this procedure to repeat the previous Advanced Search
performed in the Address Book, Opportunities, Campaigns, or
Customer Service page.

n Select Search > Advanced Search.

The Advanced Search dialog box opens.

E Click Last Search.
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The search criteria for the previous Advanced Search is displayed.

B Click OK to run the search.

Using Date Fields in an Advanced Search

When you include date fields in an Advanced Search, you have a
number of options to refine the search and to make the search
reusable in different contexts.

¢ Rolling Date Ranges - Select a rolling date range to specify a
generic date range, for example Today or This Month, instead of
specific dates in your searches. These date ranges make it easier
to reuse searches in future dates when you retrieve saved
searches from the search catalog.

¢ Yearless Searches - Use the Ignore Year checkbox to search for
a date range independent of the year. This option gives you the
option to search for dates, like birthdays, where the year may be
less important in some contexts.
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Search Catalog

The search catalog stores advanced searches so that you can retrieve
the searches at a later time. Each saved search stores all of the
information set up in the Advanced Search dialog box.

While setting up the search criteria, you can specify generic values in
your searches to make them reusable for different users and at
different times. For fields that take Maximizer users as values, you
can specify the current user as the value of the field. For date fields,
you can specify values in relation to the current date, such as today,
next month, and current fiscal quarter. Each time the search is run,
values for the current user and values relative to the current date are
retrieved.

While saving the search, you can select a column setup to display
automatically whenever the search is retrieved. You can also specify
that the values in the search may be changed when the search is run.
When the search is retrieved, users are prompted with the list of
fields specified in the search. Users can change the values specified
for each field.

Catalog searches are integrated with different features in Maximizer,
including the following features:

e Retrieve entries from a saved search automatically when you first
open the Address Book page.

e  Subscribe Address Book entries retrieved from a saved search to
new automated campaigns.

e Link a dashboard indicator to a catalog search.

e Link anicon on the Quick Search toolbar to a saved search.

Save a Search in the Search Catalog

You can save values in the Advanced Search dialog box to the search
catalog to retrieve at a later time.

While setting up the search criteria, you can specify generic values in
your searches to make them reusable for different users and at
different times. For fields that take Maximizer users as values, you
can specify the current user as the value of the field. For date fields,
you can specify values in relation to the current date, such as today,
next month, and current fiscal quarter. Each time the search is run,
values for the current user and values relative to the current date are
retrieved.

While saving the search, you can select a column setup to display
automatically whenever the search is retrieved. You can also specify
that the values in the search may be changed when the search is run.
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n Select Search > Advanced Search.
The Advanced Search dialog box opens.

E Enter your search criteria.
E] ciick catalog and click Add.

n Specify the properties of the search.

¢ Select Prompt for values when search is retrieved to let
users change the values specified for each field each time the
search is run.

¢ In the Full Access and Read Access fields, select a
Maximizer user or group with access to the saved search.

¢ In the Associated Column Setup area, select an existing
column setup to display when the search is retrieved.

To select a column setup created by another user, you may
first need to select Show All Column Setups at the top of
the drop-down list.

H ciick ok.
The search is added to the search catalog.

Saved Search Properties - Mozilla Firefox ==

Details of saved search
Name: Al My Accounts

Description: | shows al entries that have Joe Haggl entered as the account
manager

Full Access:  Joe Napoli -

Read Access:  Joe Napoli -

Associated Column Setup

Name: Territory/Account Manager -

Spelling‘ | 0K H Cancel |

Retrieve a Search from the Search Catalog

You can access saved searches from the Search Catalog dialog box. If
the saved search has a column setup associated with it, the column
setup is automatically displayed when the search is retrieved.
Depending on the properties of the saved search, you may be
prompted to specify values for the search fields before running the
search.

n Select Search > Search Catalog.
The Search Catalog dialog box opens.
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E If necessary, from the Show drop-down list, select My Search
Catalogs or All Search Catalogs to change the list of saved
searches displayed.

Click Add to Icon Bar for Quick Access to add the selected search
catalog to your Quick Access toolbar.

B Select the saved search, and click Retrieve.

Search Catalog - Morilla Firefox e e
Saved Searches: Show: All Search Catalogs -
+ Name Associated Column Setup Creator
| Retrieve |
“All Companies Lou Jones
=All Contacts Lou Jones | Properties |
*Last Search Joe Napol [ Delete |
*Leads Created this Quarter Lou Jones
| Mew Search |
All entries with territory unassigned Lou Jones
All non-_eads in California Lou Janes
Do not solicit by Email only Lou Jones
Mark Bertoli's Partners Lou Jones
Retrieve this search when an Address Book is opened. | Add to Tcon Bar for Quick Access | (?)
Description:
[ hep |

Depending on the properties of the search, you may be
prompted to specify values for each field included in the search.

ﬂ If necessary, change the values specified for the fields included in
the search, and click Search.

Retrieve a Recent Search from the Search Catalog

You can retrieve a recent search directly from the Search menu. If the
saved search has a column setup associated with it, the column setup
is automatically displayed when the search is retrieved. Depending
on the properties of the saved search, you may be prompted to
specify values for the search fields before running the search.

n Select Search > Last Catalog Searches, and select the name of
the saved search.

Depending on the properties of the search, you may be
prompted to specify values for each field included in the search.

E If necessary, change the values specified for the fields included in
the search, and click Search.
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Retrieve a Search Automatically

In the Address Book page, you can specify a default search from the
Search Catalog. When you log in to Maximizer and open the Address
Book page, the search is automatically run and the entries are
displayed in the list.

When you set a default search, the “Ask at Address Book startup
which list to view” option is cleared in the preferences, so you are
not prompted to select an Address Book list when you first log in. If
you also select a default Favorite List to retrieve when you log in, the
option you select last takes priority over the option selected earlier.

n In the Address Book page, select Search > Search Catalog.
The Search Catalog dialog box opens.

E If necessary, from the Show drop-down list, select My Search
Catalogs or All Search Catalogs to change the list of saved
searches displayed.

ﬂ Select the saved search.

n Select Retrieve this search when an Address Book is
opened.

E Click Close to close the Search Catalog dialog box.
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Global Edits

Modify Multiple Entries

You can update a number of entries at the same time with the Global
Edit command. The changes are applied to all entries included in the
global edit. You can either select the entries to apply the edits to or
apply the edits to all entries in the current list.

When working with a global edit, keep the following points in mind:

e Specify values in most fields available for the type of entry you
are working with.

e Specify Remove to remove values from basic and user-defined
fields, leaving the fields blank.

e |nthe Remove column of a table user-defined field, select
specific field values to remove from the field without removing
all values.

¢ In the Global Edit Rules tab, specify how to add values to
modified user-defined fields and some basic fields, such as
category.

¢ Inthe Note tab, specify a note that is logged to all entries
included in the global edit.

Global Edit is a very powerful feature, so you might consider backing
up your Address Book before making significant changes. You can
perform global edits on Address Book entries, opportunities, and
customer service cases.

To complete this procedure, you must have the Allow Global Edit
privilege.

You can use the Global Edit command to modify multiple entries at
once.

n Create a list of entries to modify.
—or-
In the current list, select the entries you want to modify.
e Click the checkbox to the left of entries.

¢ Click on the entries one at a time while holding down the
Control key.

e Toselect all entries between two entries, select an entry and,
while holding down the Shift key, select another entry.

A sclect Edit > Global Edit.
The Global Edit dialog box opens.
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B Apply your edits in the Basic Information and User-Defined
Fields tabs.

You can also apply changes to the Strategy, Competitors/
Partners, and Status tabs in opportunities.

For many basic fields, you can select Remove to remove existing
values for a field without specifying alternative values. For user-
defined fields, use the Remove column to remove all values or
specific values from a field.

Global Edit

(x]
Address Book Information Note Global Edit Rules
Basic Information  User-Defined Fields
Name and address Other information
Mr/Ms: First Name: Middle Mame: Last Name: Phone numbers
Position: Salutation: B B E E
Company: E El El
Department: Division: [ E E
B Email addresses f Website
Address 1: [-] E El
Address 2: B ] E
City/Town: [+ strerov: [+ I [
ZipfPostal: -] country: B Website: E
Key Fields for: <Defaut Key Fekis> -
Do not soliit by: L] Full Access: L]
Category: [customer ] Read Access: L]
Territory: [Remove] Partner: =[]
Territory Status: by Manage Sales Lead: =
Account Manager: [Joe Napol ] Lead status: -
| OK H Cancel |

3 sclect the Global Edit Rules tab.

E If you are working with Address Book entries, set the mailing
address options under Mailing rules.

You can specify Do not change, Yes, or No for each of the
options.

¢ In the Receives mail sent to Company or Individual
drop-down list, specify if you want to send mailings to the
associated Contacts when sending mail to the Company or
Individual.

This option applies only to Contacts.

¢ Inthe Use Address Book entry’s name in mailing
address drop-down list, specify if you want to list the
Address Book entry name as well as the Contact name (if
applicable) in the mailing address.

E Under Update options, specify how you want to use the
current list.
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@ If the table user-defined field is
“single-value only”, the Add
Table Field values option does
not apply. The new value
always replaces the existing
one.

In the other sections of the Global Edit Rules tab, specify how
you want the edits applied to specific basic fields and table user-
defined fields.

To add the selected values to the existing values, select Add
table field values or Add user/group field values.

To replace the existing values with the selected values, select
Replace table field values or Replace user/group field
values.

To remove the selected values from the existing values, select
Remove table field values or Remove user/group field
values.

This option is available only for specific basic fields. You can
specify to remove table field values from user-defined fields
in the Remove column of the User-Defined Fields tab.

Global Edit ]

Address Book Information  Note = Global Edit Rules

Mailing rules Update options
Receives mail sent to Company or Individual: Do not change  + @ Orly selacted Address Book sntries
Use Address Book entry's name in mailing address: Do not change %) All Address Book entries in the list

Details rules

Do not solicit by Category MaxExchange Distribution
© Add table field values 7 Add table field values © Add table field values
7 Replace table field values © Replace table field values 7 Replace table field values
7 Remove table field values 7 Remove table field values 7 Remove table field values
Full Access Read Access Account Manager
7 Add user/group field values 7 Add user/group field values 7 Add user field values
© Replace user/group field values © Replace user/group field values @ Replace user field values
7 Remove user /group field values 7 Remove user /group field values 7 Remove user field values

*User-defined fields and Details rules

@ Add table field values ) Replace table field values * Applies to Insert/Modify action only

| OK Cancel |

E Click OK to save the changes.

You are prompted with a message to verify that you want to
continue with the operation.

E Click OK to run the global edit.
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Add Values to a Field in Multiple Entries

To complete this procedure, you must have the Allow Global Edit
privilege.

You can use the Global Edit command to add specific values to fields
in multiple entries at a time without replacing the existing values.
This procedure applies to multiple-value table user-defined fields
and to system fields that can take multiple values, such as products/
services and categories.

n Create a list of entries to modify.
—or-
In the current list, select the entries you want to modify.
e Click the checkbox to the left of entries.

e Click on the entries one at a time while holding down the
Control key.

¢ To select all entries between two entries, select an entry and,
while holding down the Shift key, select another entry.

FA sclect Edit > Global Edit.
The Global Edit dialog box opens.

E If necessary, select a Key Fields list that contains the field or
select the User-Defined Fields tab.

ﬂ Locate the field, and select the value to add to the entries.

If you are updating a user-defined field, ensure you select the
value in the Insert/Modify column.

B sclect the Global Edit Rules tab.

E Under Update options, specify how you want to use the
current list.

If you are updating a system field, under Detail Rules, locate
the field name and select Add table field values.

If you are updating a user-defined field, this option should be
selected by default.

E Click OK to save the changes.

You are prompted with a message to verify that you want to
continue with the operation.

E Click OK to run the global edit.
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Remove Values from a Field in Multiple Entries

To complete this procedure, you must have the Allow Global Edit
privilege.

You can use the Global Edit command to remove values from specific
fields in multiple entries at a time. For fields that can take multiple
values, you can select the specific values to remove from the fields.
For most other fields, you can choose to remove all content from the
fields.

n Create a list of entries to modify.
—or-
In the current list, select the entries you want to modify.
¢ Click the checkbox to the left of entries.

e Click on the entries one at a time while holding down the
Control key.

e Toselect all entries between two entries, select an entry and,
while holding down the Shift key, select another entry.
A sclect Edit > Global Edit.
The Global Edit dialog box opens.

E Locate the field.

¢ If you are removing values from a basic field, locate the field
in the Basic Information tab.

¢ If you are removing values from a user-defined field, select
the User-Defined Fields tab and locate the field.

¢ If you are removing values from any other system field, select
a Key Fields list that contains the field.
ﬂ Select [Remove] or select the specific values to remove from the
field.

* For single-value system fields, click the arrow next to the field
and select [Removel].

¢ For multiple-value system fields, select the specific values to
remove from the fields.

® For single-value user-defined fields, click in the Remove
column next to the field, and select Remove.

e For multiple-value table user-defined fields, click in the
Remove column, and select the specific values to remove
from the fields.

B3 sclect the Global Edit Rules tab.
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E Under Update options, specify how you want to use the
current list.

If necessary, under Detail Rules, locate the name of the field,
and select Remove table field values.

This step is required if you are updating the “Products/Services”
or “Categories” fields in opportunities or customer service cases
and the “Category”, “Do not solicit by”, “MaxExchange
Distribution”, “Full Access”, “Read Access”, or “Account
Manager” fields in Address Book entries.

E Click OK to save the changes.

You are prompted with a message to verify that you want to
continue with the operation.

E Click OK to run the global edit.

Add a Note to Multiple Entries

To complete this procedure, you must have the Allow Global Edit
privilege.

You can use the Global Edit command to add a note to multiple
entries at a time.

n Create a list of entries to modify.
—or-
In the current list, select the entries you want to modify.
e Click the checkbox to the left of entries.

¢ Click on the entries one at a time while holding down the
Control key.

e Toselect all entries between two entries, select an entry and,
while holding down the Shift key, select another entry.

A select Edit > Global Edit.

The Global Edit dialog box opens.
E Select the Note tab.
n Enter the content of the note.

E Use the options in the toolbar to format the note.

To view the HTML source of the note, select the View Source/
HTML icon.

E If necessary, select the Important icon to mark the note as
important, and adjust the Full access, Read access, and
Category fields in the note.
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Global Edit

Address Book Information  Note  Global Edit Rules

Add this note to the Notes window.

Font - Szg v i=

FE(p s uEESA- 2O

Assigned this entry to the Competitor category using Global Edit.

Details
Fullaccess:  Joe Napeli

Read access:  Public

[ ][]

Category:

OK

H Cancel

Select the Global Edit Rules tab.

B Under Update options, specify how you want to use the

current list.

E Click OK to save the changes.

You are prompted with a message to verify that you want to

continue with the operation.

nmCIick OK to run the global edit.
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Favorite Lists keep track of lists of Address Book entries,
opportunities, and customer service cases. You can easily create new
Favorite Lists and retrieve the lists at any time. You can add shortcuts
to your Favorite Lists to the Quick Access toolbar for one-click access
to your frequently-used lists. You can also add and remove entries
from existing Favorite Lists to keep track of changes to the list.

You can quickly create a new Favorite List from a list of entries in the
Address Book, Opportunities, or Customer Service page. While
creating the Favorite List, you can select a column setup to display
automatically when the Favorite List is retrieved.

n Create a list of the entries you want saved in the Favorite List.

From the current list, select the entries to save in the Favorite
List.

e Click the checkbox to the left of entries.

¢ Click on the entries one at a time while holding down the
Control key.

e Toselect all entries between two entries, select an entry and,
while holding down the Shift key, select another entry.

E Select View > Favorite Lists.

The Favorite Lists dialog box opens displaying all existing
Favorite Lists.

El ciick Add.
The Add Favorite List dialog box opens.

ﬂ Specify the properties of the Favorite List.

¢ In the Full Access and Read Access fields, select a
Maximizer user or security group with access to the Favorite
List.

If you select Public, all users can modify or retrieve the
Favorite List. If you select a group or user, only members of
that group or that particular user can perform these actions.

¢ In the Associated Column Setup area, select an existing
column setup to display when the Favorite List is retrieved.
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Retrieve a Favorite List

To select a column setup created by another user, you may
first need to select Show All Column Setups at the top of
the drop-down list.

Add Favorite List - Morzilla Firefox ==

Favorite List Details
Name: Key Accounts

Desaription: List of the current important accounts.

Full access: | Joe Napoli

Readaccess: | [Sales]

1 B &

Creator: | Joe Napoli

Associated Column Setup
Name: | Accounts [=]

| Speling | | 0K | | Cancel |

B ciick ok.

The new Favorite List is added to the list in the Favorite Lists
dialog box.

You can quickly retrieve an existing Favorite List and replace the
current list of entries with the entries in the Favorite List. If the
Favorite List has a column setup associated with it, the column setup
is automatically displayed when the Favorite List is retrieved.

You can retrieve Favorite Lists from the Address Book, Customer
Service, and Opportunities pages.

n Select View > Favorite Lists,.
Select View > Recent Favorite Lists, and select a Favorite List
that you have recently accessed.

E If necessary, from the Show drop-down list, select My Favorite
Lists or All Favorite Lists to change the list of Favorite Lists
displayed.

Click Add to Icon Bar for Quick Access to add the selected
Favorite List to your Quick Access toolbar.
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E Select the Favorite List, and click Retrieve.

Favorite Lists

x

Show: My Favorite Lists -

Available Favorite Lists | Add.

Hame Associated Column Setup Creator | Save

Al Entries in Escona | Retreve
All entries. in WA Joe Napol
Allleads Joe Napol

All non-leads in California Joe Napoli

Wy leads Joe Napoli

[“IRetrieve this list when an Address Book is opened. | Addto leon Barfor Quick Access | (2)

[ 1oo not apply the associated column setup.
Favorite List Details

Number of visible entries: |185
Description:

Quick way to retrieve all original Address Book entries in Escona Tutorial

Help

Retrieve a Favorite List Automatically

In the Address Book page, you can select a default Favorite List.
When you log in to Maximizer and open the Address Book page,
entries from the Favorite List are displayed in the list.

When you set a default Favorite List, the “Ask at Address Book
startup which list to view” option is cleared in the preferences, so
you are not prompted to select an Address Book list when you first
log in. If you also select a default search to run when you log in,
option you select last takes priority over the option selected earlier.

n In the Address Book page, select View > Favorite Lists.

E If necessary, from the Show drop-down list, select My Favorite
Lists or All Favorite Lists to change the list of Favorite Lists
displayed.

E Select the Favorite List.
n Select Retrieve this list when an Address Book is opened.

E Click Close the close the dialog box.
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Add or Remove Entries in a Favorite List

@ This option applies to only the
current entry.

You can add entries from Favorite Lists and remove entries from
Favorite Lists in the Address Book, Customer Service, and
Opportunities pages. You can add or remove a single entry, or you
can select multiple entries to add or remove all of the entries at the
same time.

n Click on the entry to make it the current entry.
—or-
Select the entries.
e Click the checkbox to the left of entries.

e Click on the entries one at a time while holding down the
Control key.

¢ Toselect all entries between two entries, select an entry and,
while holding down the Shift key, select another entry.
E Select View > Add to Favorite List or Remove from Favorite
List.

Right-click and select Add to Favorite List or Remove from
Favorite List.

—or —

In the following pane, select the Details tab, and under
Actions, select Favorite List > Add to Favorite List or
Remove from Favorite List.

The Add to Favorite List or Remove from Favorite List dialog box
opens.

E If necessary, from the Show drop-down list, select My Favorite
Lists or All Favorite Lists to change the list of Favorite Lists
displayed.

n Select the Favorite List and specify the details as to what entries
you are adding or removing.

For example, to add or remove only the selected entries in the
current Address Book list, select Selected Entries.



Chapter4 | 125

E Click OK to save the changes to the Favorite List.

Add to Favorite List

[X]

Add to Favorite List
@ selected entries
() Current entry

) Allentries

Show: My Favorite Lists -

Name

Al Entries in Escona
Al entries in WA
Al leads

All non-leads in California

Ny leads

Creator
Joe Napoli
Joe Napoli
Joe Napoli
Joe Napoli

Joe Napoli

—

Some of our important customers.

View a List of Favorite Lists for an Entry

You can view a list of the Favorite Lists to which the current Address
Book entry, opportunity, or customer service case belongs.

n Click on the Address Book entry or opportunity to make it the

current entry.

Open the customer service case.

In the following tab, select the Details pane, and under
Actions, select Favorite List > View Favorite Lists.

—or —

In an open customer service case, select Favorite List > View

Favorite Lists.

The View Favorite Lists dialog box opens listing all the Favorite
Lists that the current entry belongs to.
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Quick Access Toolbar

The Quick Access toolbar provides one-click access to your most
frequently-used saved searches and Favorite Lists. The Quick Access
toolbar allows you to add shortcuts to your saved searches and
Favorite Lists from any Maximizer CRM module, and you can access
the Quick Access toolbar from any page in Maximizer CRM.

When you select a Quick Access toolbar shortcut, Maximizer CRM
automatically switches to the appropriate page and retrieves the
associated saved search or Favorite List. For example, if you are
viewing the Calendar page and you select a Quick Access toolbar
shortcut for a saved search from the Address Book search catalog,
the Address Book page opens automatically and all Address Book
entries matching the search are displayed.

You can also customize the way that shortcuts to your Favorite Lists
and saved searches appear in the Quick Access toolbar by associating
an icon with the shortcut, specifying a custom label, and choosing
the order in which the shortcuts appear.

+  Address Book [186 Displayed - 90 Companies, 3 Individuals, 93 Contacts]

« Edit + View w Search - Acdlions w Report v

o e = e T | % | ==
») QuickAccess  »|  Quick Access to Favorite Lists and Saved Searches

hene Number

3 504) 601-8000

& ¢ = @ & Retrieve Saved Search - Address Book - "Leads Created this Quarter )

504) 601-8000
51} Dashboards & Address Book - *Last Search 504) 501-5000
B s & Address Book - *All Contacts [04) 601-8000
=) My Work Day 504) 601-8000

Address Book - *All Companies

[ Address ook ® " 504) 601-8000
. 504) 601-8000
¥ opportunities coctomine. E04) 601-5000
5 quotes 504) 601-8000
el #Arrow Wine & Spirits Mark Bertoll (604) 601-8000
By Campaigns |3 Astor Wines & Spirits Mark Bertolli (604) 601-8000

D Customer Service I3 Atlas Food Inc Jon Bowser (604) 601-8000

Add a Saved Search to the Quick Access Toolbar

You can add a saved search to your quick access toolbar from the
Search Catalog dialog. When adding a saved search to the Quick
Access toolbar you can choose how you want the saved search to
appear in the toolbar by specifying a name and icon for the shortcut.

You can add saved searches from the Search Catalog dialog in the
Address Book, Campaigns, Customer Service, and Opportunities
pages.

n Select Search > Search Catalog.

E If necessary, from the Show drop-down list, select My Search
Catalogs or All Search Catalogs to change the list of saved
searches displayed.
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B Select the saved search that you want to create a shortcut for
and click Add to Icon Bar for Quick Access.

n Enter a Name and select an Icon for the new Quick Access
toolbar shortcut, and click Save.
The shortcut is added to the Quick Access toolbar.

Add a Favorite List to the Quick Access Toolbar

You can add a Favorite List to your quick access toolbar from the
Favorite Lists dialog. When adding a Favorite List to the Quick Access
toolbar you can choose how you want the Favorite List to appear in
the toolbar by specifying a name and icon for the shortcut.

You can add Favorite Lists from the Favorite Lists dialog in the
Address Book, Customer Service, and Opportunities pages.

n Select View > Favorite Lists.

E If necessary, from the Show drop-down list, select My Favorite
Lists or All Favorite Lists to change the list of Favorite Lists
displayed.

E Select the Favorite List that you want to create a shortcut for and
click Add to Icon Bar for Quick Access.

n Enter a Name and select an Icon for the new Quick Access
toolbar shortcut, and click Save.
The shortcut is added to the Quick Access toolbar.

Retrieve a Favorite List or Saved Search with the Quick Access Toolbar

Using the Quick Access toolbar, you can retrieve a saved search or
Favorite List with a single click. When you select a Quick Access
toolbar shortcut, Maximizer CRM automatically switches to the
corresponding page and retrieves the saved search or Favorite List.

e Click the icon in the Quick Access toolbar that is associated with
the saved search or Favorite List that you want to retrieve.

—or —

Hover your mouse over the Quick Access toolbar and select one
of the shortcuts in the window that appears.

The appropriate page opens and the list of entries is displayed.
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Customize the Quick Access Toolbar

You can customize the way that shortcuts to your Favorite Lists and
saved searches appear in the Quick Access toolbar by changing the
order in which the shortcuts appear and removing shortcuts that you
no longer need.

Click or hover your mouse over the arrow icon next the Quick
Access toolbar.

A window appears displaying a list of your Quick Access
shortcuts.

E Click the Customize link in the bottom-right corner of the
window.

The Customize Quick Access window appears.

Customize Quick Access
4 Retrieve Saved Search - Address Book - *Leads Created this Quarter
<

44 Address Book - *All Contacts

# Address Book - *All Companies

Hover your mouse over a shortcut in the list to reveal the up/
down and delete controls.

n Click the up or down arrows to move the shortcut to a new
location in the list.

Click the X icon to remove the shortcut from the list.
E Click Done.
Your changes to the Quick Access toolbar are saved.
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Create a Column Setup
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Maximizer provides a selection of column setups you can use for the
Address Book, Opportunities, Campaigns, Customer Service, and
Hotlist pages. You can also create your own column setups to display
different fields in various combinations.

Column setups contain basic and user-defined fields specific for the
type of entry displayed in the page. You can specify the fields
displayed in each column of the page, as well as the width and
heading of the columns.

In the Opportunities or Customer Service page, column setups can
contain fields for Address Book entries, as well as for opportunities
or cases. Columns with Address Book entry fields display values for
the Company or Individual associated with the entry.

After creating a column setup, you can associate it with a saved
search in the search catalog or with a Favorite List. The column setup
is automatically displayed whenever the saved search or Favorite List
is retrieved.

You can create custom column setups displaying any of the basic or
user-defined fields in your list of entries. You can create column
setups for the Address Book, Opportunities, Campaigns, Customer
Service, and Hotlist pages.

n Select View > Column Setup.
The Column Setup dialog box opens.

Column Setup [X]
Show: Al Column Setups -
Available Column Setup Views
| Add._ |
Hame Creator -
| Properies |
“Defautt Address Book View Joe Napol
“Defautt Contact View Joe Napol _| |Savehs.|

*Default Related Entries View Joe Napoli

Accounts Joe Napoli

Basic View Joe Napoli
Bilie’s Contact Views Billie Holly

Customer Discounts Lou Jones

H ciick Add.
The Add Column Setup View dialog box opens.
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B In the Details of View area, specify the basic properties of the
column setup.

e Enter a Name for the column setup.

¢ Specify the access rights in the Full Access and Read Access
drop-down lists.

If you leave Public selected, all users can modify or retrieve
the column setup. If you select a group or user, only members
of that group or that particular user can perform these
actions.

In the Defined columns area, click Add.

In the Selected column details area, click Insert Field.

The Insert Fields dialog box opens.

E In the Available fields list, click the plus symbol to expand a
folder, select a field, and click OK to add the field to the selected
column.

You can repeat this step to add multiple fields to the selected
column.

Fields in the current column appear in display order in the
Content template list. You can customize how fields are
displayed in the column by adding spacing, punctuation, or
labels between fields.

If necessary, modify the heading and width of the column.
E’ Repeat steps 4-7 for each column in the column setup.

E Click OK to save the column setup.

Add Column Setup View - Mozilla Firefox ==
Details of View
Mame: Accounts
Full access: | Joe Napol Creator: Joe Napali -
Read access: | [Sales] =
Columns
Edit Preview
Defined columns Selected column details
Name - . :
Eraipddress ] Content template: | Insert Field.|
[Email Address]
(&)
(¥
= Header: Width:
| Add | | Delete | Email Address 15
| 0K || Cancel |
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Retrieve a Column Setup

You can retrieve existing column setups to change the fields
displayed in the current page.

n Select View > Column Setups.

E If necessary, from the Show drop-down list, select All Column
Setups to view column setups created by other Maximizer users.

ﬂ Select the column setup.
n Click Use Now.

Retrieve a Column Setup in the Following Pane

You can change the column setup displayed in the Contacts,
Opportunities, Customer Service, and Related Entries tabs of the
following pane directly from the View bar in the following pane.

¢ Inthe View bar, from the Columns drop-down list, select the
column setup.

To select a column setup created by another user, you may first
need to select Show All Column Setups at the top of the drop-
down list.
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Coloring Rules

Create a Coloring Rule

Coloring rules shade entries with different colors depending on the
values of specific fields. You can set up coloring rules in the Address
Book, Opportunities, Customer Service, and Hotlist pages. Each
coloring rule includes a set of values for a specific field. You can
choose a background color and a text color for each value in the rule.
When you apply a coloring rule, the entries that have the same value
for the field are colored even if the value is hidden in the current
column setup.

The colors of current and selected entries override the colors in
coloring rules.

You can create coloring rules from the Address Book, Opportunities,
Customer Service, and Hotlist pages.

n Select View > Coloring Rules.

H ciick Add.
The Add Coloring Rule dialog box opens.

B Enter a name for the coloring rule.
You can also enter a description and specify values in the Full
access and Read access fields.

ﬂ Next to Match entries using this field, click the ellipsis button.

E From the Basic Fields or User Defined Fields list, select the
field for the rule, and click OK.

[ ciick Add.
The Set Up Criterion dialog box opens.

Select a value for the field, choose text and background
colors, and click OK.

In the Customer Service page, the text color of overdue cases is
always red. To distinguish overdue cases from other cases,
choose text colors other than red for values in customer service
cases.



Apply a Coloring Rule

& | Set Up Criterion -- Webpage Dialog ==

Details
Do not solicit by
Value:

Email -

Color settings

ot oo [N ]
e

E Repeat steps 6-7 for other values of the field.

E Click OK to save the coloring rule.

Chapter 4

& Add Coloring Rule -- Webpage Dialog

Details of the rule
Name Do not solict by

Shades entries based on the "Do not solicity by” field

Description:

Full access: Joe Napoli - Read access:  Public
Criteria of the rule

Match entries using this field: | Do not solicit by E

Do not solicit by=Fax
Do not solicit by = Phone’
Do not solicit by = "Print'

el ] [ o |

You can apply any existing coloring rule to the current list in the
Address Book, Opportunities, Customer Service,or Hotlist page.

In the Customer Service page, the text color of overdue cases is

always red, regardless of the text color assigned by the coloring rule.

However, the background color of overdue cases matches the

background color assigned by the coloring rule.

n Select View >Coloring Rules

The Coloring Rules dialog box opens.
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E Select an existing coloring rule, and click Apply.

Coloring Rules

Defined rules:

x]
(ot using a ruls)

Do not solict by
Lead Status




CHAPTER

Notes and Documents

Store Notes and Documents in your Address Book

In this chapter...

“Notes” on page 136

“Documents” on page 142

“History Pane” on page 145
“Hyperlinks” on page 147
“Company Library” on page 150
“Document Templates” on page 156

“Microsoft Word Integration” on page 159
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Notes

Types of Notes

@ By default, notes are logged
for all of the main activities
you can perform in Maximizer.
You can adjust logging in your
logging preferences.

Notes are used to record activities associated with Address Book
entries, customer service cases, campaigns, and opportunities. Use
notes to jot down “manual” notes—your ideas and impressions
about a customer, a case, a campaign, or an opportunity. You can
enter manual notes for short company profiles or summaries of
contracts and business agreements.

Maximizer automatically creates different types of notes, providing a
history of all your activities. Maximizer creates the following types of
notes:

Accounting - Created in previous versions of Maximizer when
you create or modify accounting transactions using external
accounting applications.

Customer Service - Created when you add a customer service
case.

Email - Created when you send an email message to one or
more Address Book entries.

History - Created when opportunities, cases, and campaigns are
added or changed.

Incoming call - Created when you receive a phone call.

Mail-outs - Created when you print documents, labels,
envelopes, or letters using the Maximizer Word Processor's
merge feature.

Manual - Added manually to entries.

Opportunity — Created for Address Book entries when
opportunities are added or changed. Opportunity notes can be
printed or searched only from Address Book entries.

Other - Third-party or custom notes created by your system
administrator. Also, notes created by remote sites.

Outgoing call - Created when you phone an Address Book
entry.

Task - Created when appointments or Hotlist tasks are
scheduled, modified, deleted, or completed. For Hotlist task
notes, the current owner of the Hotlist task is included in the
note, even when a task is reassigned. For appointment notes,
details of the appointment are included when the appointment
is scheduled. And when an attendee list is modified, an
additional note is logged.
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¢ Timed notes - Created when you use the Timer

¢ Transfer log - Created when you transfer entries between
Address Books.

The Notes pane displays notes for the current entry in the Address
Book, Opportunities, Customer Service, Campaigns, or Hotlist page.
In the Hotlist page, the Notes pane displays the notes for the Address
Book entry associated with the selected task or appointment. Notes
are displayed for an appointment only if a single Address Book entry
is associated with the appointment.

Keep the following tips in mind when working in the Notes pane:

n Identify notes marked as important with the Important icon.

By default, notes are sorted by the Important column, but you
can click any column heading to sort by another column.

E Use the Show drop-down list to narrow the entries to a specific
note type (for example, “Manual” or “Email”).

ﬂ Select Show All to display all notes for the current Address Book
entry, including notes belonging to the Company/Individual and
all associated Contacts. If this checkbox is not enabled, only
notes belonging to the selected entry are displayed.

This option is available only in the Address Book and Hotlist
pages.

n Use the Filter drop-down list to filter notes by date. Choose
<Custom...> to specify a custom date range.

E Hover your mouse over an entry to view a preview of the note in
a pop-up window.

E Click on an entry to open and modify a note.
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Use the buttons at the top of the list to add and delete notes.

>

Anoza, Marylin

Through the Gr S Details = Contacts = History User-Defined Fields = Documents | » x 8
[Z3) Add % Show: Al Typesﬂ v [Clshow Al Filter: ast 12 lﬂ - 7]
v ! | Date Time: Type Text E Creator Full Access Read Access

! 10/4/2011 1:41PM Manual  Note to sales reps: Joe Napoli Public Public
n 10/5/2011 _8:35AM Outgoing P ~ | Public

10/4/2011 BPM Task Phone to arrange meeting Public

A
10/3/2011  8:09PM  Task H I Public
9/19/2011 2:18PM  Emai 4 I phoned Susanne to confirm the appointment | Public

scheduled with her yesterday and to request a
change of location. She had already received
the appointment notification and n her
calendar. She's fine with coming office
instead of meeting off-site.

Add a Note to an Entry

@ The option applies to only the
current entry in the main list.

@ This option applies only in the
Contacts and Related Entries
tabs of the following pane.

@ The option applies to only the
current entry in the main list.

You can add notes to Address Book entries, customer service cases,
campaigns, and opportunities. When you add or edit a note, you can
add formatting and hyperlinks in the note.

You can add a note for the current entry in the Address Book,
Opportunities, Campaigns, or Customer Service page, or for the
Address Book entry associated with the current activity in the Hotlist
page. You can add the note from the Details tab and the Notes tab in
the following pane. You can also add a note to the current entry in
the Contacts and Related Entries tab in the following pane.

n In the main list, click on the entry to make it the current entry.

In the Contacts or Related Entries tab of the following pane,
click on the entry to make it the current entry.

E In the following pane, select the Notes tab, and click Add.
—or-
Right-click, and select Add a note.
—or-

In the following pane, select the Details tab, and under
Actions, select Add a note.

E Enter the content of the note.

n Use the options in the toolbar to format the note.




Set Up a Default Note
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E If necessary, select the Important icon to mark the note as
important, and adjust the Full access, Read access, and
Category fields in the note.

3 ciick ok.

Add Note for ABC Wine Shop Inc.

- Y M seif ¥ | Size... v B J UAYvavEiE @R @

Contract Note:

James wants to keep similar contract terms when the contract is up to expire next month. If any modifications
are necessary, please confirm with James.

Properties Details
Date: 6262014 & Full access: | Lou Jones =
e 6:43 PM Read access:  Public [+]
Creator: Lou Jones [=] Category: Comment [=]
oK |[ Canca |

You can create default notes for different types of entries. Default

139

notes are specific to the current user. The content of the default note

automatically appears when you create a new note. The Full access,

Read access, and Category fields can also have default values.

You can add default notes in the Address Book, Opportunities,
Campaigns, andCustomer Servicepages.

n Select Edit >Default Note.
The Default Note dialog box opens.

E Enter the content of the note.

ﬂ If necessary select a user or group for the Full access and Read

access fields, as well as a note category.
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Time a Task

@ You must have your logging
preferences for Timers set to
Notes or Both to save a note
for the task.

ﬂ Click OK to save the default note.

Default Note

¥ M Lucida Sans.Y | Size... v B s UAToTEIEEE = !
Note Text
Joe Napoli
President, Escona Estate Wines
Details
Full access: Lou Jones =
Read access: Pubic [=]
Categary: E|
[ ree | [ ok [ Coneat |

4

You can use a timer to time tasks while working in Maximizer and
have the activity saved as a note with the current entry. You can time
a task from most Maximizer modules. However, a note is saved only
when you time a task from the Address Book, Opportunities,
Customer Service, or Hotlist page.

You can create a list of entries and work through the list while
keeping the timer open. Notes will be created for each entry as you
work down the list.

n Click on the entry to make it the current entry.
E Select Actions > Time a task
Right-click, and select Time a task

In the following pane, select the Details tab, and under
Actions, select Time a task.

The Timer opens showing the duration of the current task.

In the Name field, the name of the current entry is displayed.

E In the Subject field, enter the text to save with the note.
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Click Pause to pause the timer. You can click Pause again to
restart the timer.

Click Reset to start the timer again without saving the note.

n When you complete the task, click Stop.

The note is saved with the entry.

E If necessary, use the Previous and Next buttons to work
through the list, then click Start to start the timer again.
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Documents

Documents Pane

In Maximizer, documents are files that are created in other
applications. You can attach documents to Address Book entries,
customer service cases, campaigns, and opportunities. When you
send an email message from Maximizer, you can save a copy of the
message as a document with the entry. You can also add hyperlinks
to documents stored outside of the Address Book. Documents are
stored with the entries to be accessed at any time.

The Documents pane displays documents attached to the current
entry in the Address Book, Opportunities, Customer Service,
Campaigns, or Hotlist page.

In the Hotlist page, the Documents pane displays the documents for
the Address Book entry associated with the selected task or
appointment. Documents are displayed for an appointment only if a
single Address Book entry is associated with the appointment.

Keep the following tips in mind when working in the Documents
pane:

n Use the buttons at the top of the list to add and delete
documents and hyperlinks and to view the properties of the
current entry.

E Use the Show drop-down list to narrow the entries to a specific
type of document.

e Maximizer Documents - Displays documents created in
Maximizer.

¢ Emails - Displays email messages sent from Maximizer.
e Other - Displays any other type of file attached to the entry.

B Use the Show All option to display all documents for the
current Address Book entry, including documents belonging to
the Company/Individual and all associated Contacts. If this
checkbox is not enabled, only documents belonging to the
selected entry are displayed.

This option is available only in the Address Book and Hotlist
pages.

n Use the Filter drop-down list, to specify the date range for
documents displayed in the list.

You can select a number of date ranges, including Last 30 Days
and Last 12 Months. Or choose Custom to select specific dates
for the date range.
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E Click on an entry to open the document in its native application.

Anoza, Marylin

i T £ Detsils | Contacts | History = Notes = User-Defined Fields Customer Service | Opportuni »  +
New: 3] Document [+ Hyperlink | Delete [=] Properties Show: Al Types E - [[Jshowan Filter: Last Wzn e a
10/7/2011  5:00 AM U FDF Draft Contract Joe Napoli Public
9/30/2011  8:96 AM Comment  Hyperlink  Contract Templates Joe Napoli Public
+ 9/19/2011 2:18PM Response  Email Confirmation of Contract Renewal E Joe Napoli Public
9/8/2011  B:49 AM HTM Escona Promotions Joe Napoli Public

View a Document Attached to an Entry

You can view documents attached to entries from Maximizer. The
file opens in the default application for the file extension of the
document. If the document is a hyperlink, a new browser window
opens displaying the source document.

@ From Maximizer Web Access, n Click on the entry to make it the current entry.
you can open only embedded
documents. Linked documents E Select the Documents pane.
are not supported in
Maximizer Web Access. Documents attached to the entry are displayed.

ﬂ If necessary, select an option from the Show drop-down list to
change the types of documents displayed.

ﬂ Click the document that you want to open.

You may be prompted to open or save the document. If you
select Save, you must choose a location to save the file before
viewing the document.

Add a Document to an Entry

You can attach any type of files as documents to Address Book
entries, customer service cases, campaigns, and opportunities.

You can add a document for the current entry in the Address Book,
Opportunities, Campaigns, or Customer Service page or for the
Address Book entry associated with the current activity in the Hotlist
page. You can add the note from the Details tab and from the
Documents tab in the following pane. You can also add a document
to the current entry in the Contacts and Related Entries tabs in the
following pane.

n In the main list, click on the entry to make it the current entry.

In the Contacts or Related Entries tab of the following pane,
click on the entry to make it the current entry.
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@ The option applies to only the
current entry in the main list.

@ This option applies only in the
Contacts and Related Entries
tabs of the following pane.

@ The option applies to only the
current entry in the main list.

E In the following pane, select the Documents tab, and next to
New in the View bar, click Document.

Right-click, and select Add a document.

In the following pane, select the Details tab, and under
Actions, select Add a document.

E Specify properties for the document, such as Name, Category,
Description, and Owner.

ﬂ Click Browse and browse to the location of the file, and click
Open.

E Click OK to save the file with the entry.

Add Document for Aggassi Cold Beer & Wine Store [X]
Name and description
Name: Escona Contract 2011
Category: -
Description: Updated contract for 2011
Properties Details
Date: 172812011 ] Owner. Public -
Time: 12:08 PM Creator Joe Napoli
Upload file
C:\Contracts\EsconaContract pef
MNote: maximum supported upload file size is 4MB

Change the Properties of a Document

@ If you click in the text of the
entry, the document opens.
Instead, click to the left of the
entry to select it, or click in an
empty area of the row to make
it the current entry.

After adding documents, you can access the properties of the
documents at any time to change any of the properties.

n Click on the entry to make it the current entry.

E Select the Documents pane.

ﬂ Click on the document to make it the current entry.

n In the View bar, click Properties.

E Edit any of the properties of the document.

B To replace the content of the document, click Browse and
browse to a new file.

Click OK to save the changes to the document.



History Pane

@ Click the Filter button to filter
notes and documents in the
History pane by date range
and/or type.
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In Maximizer, you can quickly access the entire history for an entry in
the History pane. The History pane displays all of the notes and

documents associated with the current entry in the main window so
that you can see all of the recent activity with the entry at a glance.

The History pane is available for entries in the Address Book,
Opportunities, Campaigns, Customer Service, and Hotlist pages. All
of the notes, documents, and emails associated with the current
entry are displayed in the History pane. Each note, document, and
email is displayed along with the name of the user who created it,
the user's profile picture, and the date and time it was created. Notes
and emails are displayed along with a preview of their content. The
history is displayed in reverse-chronological order with the most
recent notes and documents displayed first. Notes marked as
important are displayed first.

Keep the following tips in mind when working with the History
pane:

n You can easily add notes to an entry in the History pane by
typing directly in the field labeled Click here to add a note.

E Identify whether a history entry is a note, an email, a Maximizer
document, or a different document type by viewing the icon
displayed next to the entry.

B For emails with attachments, a paperclip is shown in the Subject
line. Click the More link to open the attachment without
opening the email.

Open or Delete a note, document, or email by clicking the link
below it.

Click the Properties link below a document or email to view its
properties.

Reply to and forward an email by clicking Reply, Reply All, and
Forward.

|

Click More below a note or email preview to display its entire
content.

Bennington, Albert

Albert's Steak House T Details Contacts History Notes User-Defined Fields » +

Last 12 Months filter applied ¥ | < | @

Joe Napoli added a note:
Appointment Created

Proposal review

Appointment details:

Date: Friday, October 12, 2012
More...

[£2] Open - Delete - Print + October 12, 2012 10:02 Ak
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Add a Note in the History Pane

You can add notes to Address Book entries, customer service cases,
campaigns, and opportunities in the History pane. Notes added
through the History pane are added as manual notes.

n Click on the entry in the main window to make it current.

E Click in the Click here to add a note field.
The field expands and a Submit button appears.

B Enter the content of the note and click Submit to save it.
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Hyperlinks

Hyperlinks record links to documents stored outside of the Address
Book, for example on local and network drives, on external websites,
in Microsoft SharePoint folders, and in any other locations that can
be expressed as URLs. When you open a hyperlink, the source
document of the hyperlink is displayed in a new browser window.

You can add hyperlinks to Maximizer entries, including Address Book
entries, opportunities, campaigns, and customer service cases, and to
the Company Library.

Hyperlinks let users store documents in locations outside the Address
Book and then link to the documents in Maximizer, instead of
storing the documents directly in the Address Book. This can be
beneficial for a number of reasons:

* You want to store documents larger than the 4 MB limit.

* You want to store a large quantity of documents, dramatically
increasing the size of your database.

Add a Hyperlink to an Entry

You can add hyperlinks as documents to Address Book entries,
customer service cases, campaigns, and opportunities.

n Click on the entry to make it the current entry.

E Select the Documents pane.

ﬂ Next to New in the view bar, click Hyperlink.

n In the Name field, enter the name of the document.

E In the Hyperlink field, enter the URL of the document.

E Specify other properties of the document, such as Category,
Description, and Owner.



148 | Maximizer Web Access
User's Guide

Click OK to save the hyperlink as a document with the entry.

Add Hyperlink for Amelia Liquors South [X]
Name and description
Hame Company Description
Category: -
Hyperink: hitpifivewe e, wikipedia.org/wikiAmelaLiquors
Description: Information on the company from Wikipedia.
Properties Details
Date: 112872011 (] Caaes Public hd
Time: 12:14 P Creator. Joe Napoli

Storing Documents for Hyperlinks

You can use hyperlinks to point to documents stored on a web
server. You may need to ask your network administrator or an
Information Technology professional to set up a location for the
documents. Here are the main steps that will need to be completed
to set up the location:

n Find a location for the documents on a web server, and add a
folder for the documents. This location should be stable, so the
links will be preserved in the future. For example, create a folder
named "Documents" on the webserver.

E Create a virtual directory for the folder. The name of the virtual
directory will determine the URL for the folder.

You could also find a location in an existing virtual directory for
the documents. For example, add a folder named "Documents"
in the same folder used for the Maximizer web application.
However, you must ensure that this location is stable and won't
be modified later (for example, during a software update).

ﬂ Grant full access to the folder for all users that need to save files
to the location. If the folder is in an existing web application,
you should grant access only to the folder, not to the entire
virtual directory.

Save files to the physical folder using the network location of the
folder.

In Maximizer, add hyperlinks pointing to the files using the URL
of the virtual directory and the file name.

For example, if the Documents folder is added to the Maximizer
application folder, use the URL of Maximizer Web Access as the
base URL:
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[Server Name]/maximizerwebaccess/documents/Filename.EXT

Note: Filename is the name of the file, and EXT is the file
extension.
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Company Library

Company Library Page

You know the value of keeping an organized database of your
marketing materials and other company collateral. Brochures, price
lists, photos, magazine reviews—all of these materials should be easy
to find when you need them. The Company Library provides shared
access to a central library of these materials with the security offered
by the Maximizer environment.

You can add documents, notes and hyperlinks to the Company
Library. Documents are created with external applications. Notes
contain plain text. Hyperlinks point to documents stored externally
and are expressed as URLs. These items are arranged in the Company
Library in a folder structure.

Keep the following points in mind when working in the Company
Library page.

n Select the Company Library icon to open the Company Library
page.

E In the area on the left side of the page, view your folders and
files in a tree view.

To view the contents of a folder, click the plus sign on the left
side of the folder.

B Use the toolbar for common tasks.

ﬂ Select the Preview checkbox to display a preview of notes and
hyperlinks in the right part of the page.
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E Click on a document, hyperlink, or note to open it.
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Customer relationship
management

From Wikipedia, the free encyclopedia

C lationship gement (CRM) is a widely
implemented strategy for managing a company's
interactions with customers, clients and sales prospects
It involves using technology to organize, automate, and
synchronize business processes—principally sales
activities, but also those for marketing, customer senice,

and technical support.!"! The overall goals are to find,
attract, and win new clients, nurture and retain those the
company already has, entice former clients back into the
fold. and reduce the costs of marketing and client

senice % Customer relationship management describes a
company-wide business strategy including customer-
interface departments as well as other departments 1!
Measuring and valuing customer relationships is critical to

Organizing the Company Library

Items in the Company Library are organized in a folder structure to
help you keep track of your corporate documents and notes. Folders,
documents, hyperlinks, and notes are listed in alphabetical order in
the Company Library. You can create new folders and move existing
documents, hyperlinks, and notes to other folders to organize this
structure.

Add a Folder to the Company Library

n In the Company Library page, click on the parent folder that you
want to add the new folder to.

—or —

To add the folder at the root level, click the Company Library

f

older.

E Next to New in the toolbar, click Folder.
The Add Folder dialog box opens.
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E Enter the name for the new folder, and click Save.

£ Add Folder - Webpage Dialog ==l
Add Folder el Save [ cancel
Field properties
Parent folder:  Company Announcements.
Name: February Announcements

Move an Item in the Company Library

@ If you select a folder, all items
in the folder are moved with it.

n In the Company Library page, click the checkbox next to the
document, note, hyperlink, or folder that you want to move.

You can select multiple documents, notes, hyperlinks, and
folders to move a number of items to the same destination
folder.

E In the toolbar, click the Move To icon.
The Move To dialog box opens.

ﬂ In the Folder name drop-down list, select the destination

folder.
To move the item to the root level, select the Company Library
folder.
n Click Save.
& Move To -- Webpage Dialog ==
Move To Ll save [] cancel
Folder properties
Folder name: Company Library -

Company Library

Company Library\Company Announcements.
Company Library\General

Company Library\Customer Services
Company Library\Finance

Company Library\Human Resources
Company Library\Marketing Department
Company Library\Sales Department
Company Library\Dashboards

Company Library\Dashboards\Templates

E If necessary, click OK at the prompt to confirm that you want to
move all selected items.
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Add a Document to the Company Library

The Company Library can store many different file types. Provided
that your system administrator has given you access to the Company
Library, you can add documents as either private or public entries.
While adding the document, you browse to an existing file on your
hard drive or network.

n In the Company Library page, click on the folder to which you
want to add the document.

E Next to New in the toolbar, click Document.
The Add Document dialog box opens.

ﬂ Click Browse to select a file.
n Locate the file, and click Open.

E Specify a Name, Category (optional), and Owner for the
document.

E Click Save.

If a document with the specified name already exists in the
selected folder, you are prompted with a message asking if you
want to replace the existing document.

Click Yes to replace the existing document, or click No to keep
the existing document.

Add a Note to the Company Library

You can add plain text notes to the Company Library. Write the
content of the note directly in the Company Library page while
adding the note.

n In the Company Library page, click on the folder to which you
want to add the note.

E Next to New in the toolbar, click Note.
The Add Note dialog box opens.

B Type the content of the note in the large text box at the bottom
of the dialog box.

n Specify a Name, Category (optional), and Owner for the note.
E Click Save.
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Add a Hyperlink to the Company Library

You can add hyperlinks to the Company Library. Hyperlinks point to
documents stored outside of the Address Book. Hyperlinks record
links to any locations that can be expressed as URLs.

n In the Company Library page, click on the folder to which you
want to add the hyperlink.

E Next to New in the toolbar, click Hyperlink.
The Add Hyperlink dialog box opens.

B In the Name field, enter a name to refer to the document.
ﬂ In the Hyperlink field, enter the URL of the document.

E Specify the category and owner for the hyperlink, as desired.

E Click Save.
Add Hyperlink - Mozilla Firefox ==
Add Hyperlink il save [] cancel
Hyperlink Details
Parent folder: Sales Department
Name: CRM Overview
Category. -

Hyperlink http:fen. wikipedia. org/w ikilCustomer_relationship_management

Access rights

Qwner. Public -

Send Items by Email from the Company Library

You can send items by email directly from the Company Library page.
You can select one or multiple documents, hyperlinks, and notes or a
folder to send all items in the folder. Documents are attached to the
email message, while hyperlinks are inserted directly into the content
of the email message. Notes are either inserted into the message or

attached to the message depending on the number of items selected.

n If you want to send the items to an Address Book entry, in the
Address Book page, select the Address Book entry to send the
documents to.

E In the Company Library page, select the checkbox beside any
documents, hyperlinks, and notes you want to send.
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You can also select a folder to send all documents, notes, and
hyperlinks in the folder.

E In the toolbar, click Email Document.

The Send Email dialog box opens with the selected items
attached to or inserted into the email message.

n Enter the details of your email message.

E Click Send.

155
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Document Templates

Maximizer's Template Library allows you to save document
templates that you can use to generate letters and other documents.

About Document Templates

A document template is a standard design meant to be used
repeatedly to create new documents. Document templates are
generally designed to be used with a company’s stationery, including
default page margins, standard fonts, and merge fields.

For example, a template might be used for the following:

e Create form letters for bulk mailings to clients and prospects.
e Provide a default structure for letters and faxes.

*  Provide a consistent company image.

You can create document templates and save them to the Template
Library in Maximizer. When you next create a new document, you
can use a saved template as the basis for the document.

About the Document Template Library

The document templates in your Address Book are stored in the
Template Library.You can access the Template Library from the
Administration section in the left navigation pane.

You can add new document templates to the Template Library,
modify the properties of existing document templates, and can
download any existing document templates for further
customization.

Add a Document Template to the Template Library

You can upload document templates to the Template Library in
Maximizer to add them to your library.

n In the left navigation pane, hover your mouse over
Administration, and select Template Library from the pop-up
menu.

E Select the Document Templates tab.
ﬂ Click Add to add a new document template.
n Specify the details for the document template.
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¢ Specify a Name for the document template

¢ |n the Full Access and Read Access fields, select the users
with access to the document template.

¢ In the Description field, enter additional notes.
E Under Upload file, select the document template to upload.
E Click OK to add the document template.

The document template is saved to the Template Library.

Modify a Document Template in the Template Library

You can download and modify any of the existing document
templates in your Template Library.

n In the left navigation pane, hover your mouse over
Administration, and select Template Library from the pop-up
menu.

E Select the Document Templates tab.

B Under Action, select Download next to the document template
you want to modify.

n Save the file to a location on your computer and open it for
editing.

E Make the desired modifications to the document template and
save your changes.

E Under Action, select Properties next to the document template
you are modifying.

Under Upload file, select the modified document template on
your local hard drive.

B Click OK to update the document template.

The changes to the document template are saved to the
Template Library.
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Delete a Document Template from the Template Library

You can delete document templates from your Template Library in
Maximizer to remove old or unused templates.

n In the left navigation pane, hover your mouse over
Administration, and select Template Library from the pop-up
menu.

E Select the Document Templates tab.

E Under Action, click Delete next to the document template you
want to delete.

ﬂ Click Yes to delete the document template.

The document template is deleted from the Template Library.

Merge a Document Template for an Entry

You can merge document templates for your Maximizer entries.
When you merge the document template, the merge fields in the
template are replaced with values from the current Maximizer
Address Book entry, opportunity, customer service case, or Hotlist
task.

n Click on the Address Book entry, opportunity, customer service
case, or Hotlist task to make it the current entry.

E Right-click the entry and select Merge to Document.
Select Actions > Merge to Document.

The Merge to Document dialog opens.

ﬂ Select the document template in the list that you want to merge
and click OK.

The document template opens in Microsoft Word with the
merge fields in the template replaced with values from the
current entry.
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Microsoft Word Integration

@Word integration is available
only in Microsoft Internet
Explorer.

You can use Microsoft Word as your word processor while working
with Maximizer. With Word integration, you can launch Word
directly from Maximizer and work with Maximizer entries from
Word.

Word integration installs the Maximizer tab in the ribbon in versions
of Word that use a ribbon interface and the Maximizer toolbar in
earlier versions of Word. The options in the Maximizer toolbar menu
integrate information from Maximizer Address Book entries,
opportunities, customer service cases, and users with Word
documents.

Install Microsoft Word Integration

@Word integration is available
only in Microsoft Internet
Explorer.

® This setup involves
downloading Active X
controls, which may be

disallowed on some networks.

Word integration can also be
installed from the Maximizer
CRM installation media. For
more information, see the
Maximizer CRM
Administrator’s Guide.

If Microsoft Word integration is enabled, you can install Word
integration directly from Maximizer. For information on enabling
Word integration, see the Maximizer CRM Administrator’s Guide or
your system administrator.

n In the left navigation pane, hover your mouse over
Administration, and select Desktop and Mobile Setup from
the pop-up window.

The Desktop and Mobile Setup page opens.

E In the Microsoft Word Integration section, select View more
information.

The system requirements and a description of the basic steps
required to install the Microsoft Word Integration appear below
the link.

ﬂ Click Download Word Integration.
n Click Download.

A window opens giving you the option to run or save the file.

E Click Run and follow the steps outlined in the setup wizard to
install the files.
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Open Microsoft Word from Maximizer

@Word integration is available
only in Microsoft Internet
Explorer.

To complete this procedure, Microsoft Word Integration must be
installed.

You can launch Word from the Address Book, Opportunities,
Campaigns, Customer Service, or Hotlist page in Maximizer.

¢ Inthe menu bar, select the Open Microsoft Word icon.

Maximizer Merge Fields in Microsoft Word

Merge fields are place-holders in your document that can be
replaced by basic Address Book entry or user-defined field
information when you perform a merge.

You can insert Maximizer merge fields into documents in Microsoft
Word, letting you add information from your Address Book to your
Word documents.

Merge fields are not restricted to Address Book entry information—
you can insert merge fields for your own user information, customer
service cases, and opportunities as well.

When you add a merge field to a Word document, you have the
option of adding the merge field as a link. When the merge field is
added as a link, a field is added to the document. When you merge
the document, the field is replaced with the value from the current
entry. You should add merge fields as link if you plan on reusing the
document for different Maximizer entries. If you add a merge field
without linking it, the value of the field in the current entry is added
to the document as text.

Name and Address Merge Field

You can use the Name and Address merge field to add a block of
name and address fields quickly to the document. The Name and
Address merge field follows the Address format in your Preferences
in Maximizer.

When you preview or print a document with the Name and Address
merge field, any lines that do not contain text are excluded from the
document. As well, correct spacing is always maintained between
fields. If you add the merge fields separately in Word, the finished
document may contain empty lines when previewed with real data.

The Name and Address merge field is included in the list of basic
merge fields, available when you click the bottom of the Insert
Merge Field icon in Word.
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Insert a Merge Field in a Microsoft Word Document

@Word integration is available
only in Microsoft Internet
Explorer.

@ This procedure is written for
Microsoft Word 2007 or later.
The steps are slightly different
in earlier versions of Word.

To complete this procedure, Microsoft Word Integration must be
installed.

n With a document open in Word, place your cursor where you
want to insert the merge field.

E In the Maximizer tab, click the top of the Insert Merge Field
icon in the Insert and Preview group.

The Insert Merge Field dialog box opens.

Insert Merge Field ==
Select a Merge Field for: [rddress ook ~]
Accourt Manager -

Accourting Link Type

Address Line 1 =
Address Line 2

Category

City / Town

Client Name

Combined Pariner and Intemal Sales

Cortiact Number

Courtry

Creation Date

Creator

Customer Interests

Customer Profile/Contact How?

Customer Profile/Employees

Customer Profile/First Contacted Date

Customer Profile/Have Intemet Access 2
W Link Insert Close

ﬂ From the Select a Merge Field for drop-down list, select the
type of merge field to insert.

n Select a merge field from the list.
E To add the merge field as a link, select the Link checkbox.

B Click Insert to add the merge field to the document.

The merge field is inserted into the document at the current
cursor position.

Continue inserting merge fields until your document is
complete. You may edit the document and reposition the cursor
while the Insert Merge Field dialog box remains open.

When you are finished inserting merge fields, click Close.
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Insert a Basic Merge Field in a Microsoft Word Document

To complete this procedure, Microsoft Word Integration must be
installed.

You can add a merge field for some basic fields directly from the
Insert and Preview group in the Maximizer tab. The current state of
the Link checkbox in the Insert Merge Field dialog box determines if
the merge field is added as a link or not. By default, the merge field
is added as a link.

®Word_ integration is available n With a document open in Word, place your cursor where you
‘E’;‘go'?e'rv“”oso‘(t Internet want to insert the merge field.

E In the Maximizer tab, click the bottom of the Insert Merge
Field icon in the Insert and Preview group, and select the
merge field.

The merge field is inserted into the document at the cursor
position.

Preview a Microsoft Word Document

To complete this procedure, Microsoft Word Integration must be

installed.
@Woro_l integration is available You can view previews of Word documents showing information
‘E’)’("%(;Pe'rv“m’so“ Internet from entries in your Maximizer Address Book. When you preview the
ploret document, the linked merge fields in the document are replaced
with values for the current Maximizer user, Address Book entry,
customer service case, or opportunity.
@This procedure is written for n Open the document in Word.
Microsoft Word 2007 or later.
The steps are slightly different A 1n Maximizer, click on the entry to make it the current entry.

in earlier versions of Word.
ﬂ In the Maximizer tab in Word, select Preview from the Insert
and Preview group.

The merge fields in the document are replaced with values from
the current entry.

Select Preview a second time to return to the default view
showing the merge fields.
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Print a Microsoft Word Document

To complete this procedure, Microsoft Word Integration must be

installed.
@Word_ integration is available When you use Microsoft Word with Maximizer, you can send a Word
‘E)’(‘g(;?e'rv“croso‘(t Internet document to the printer, automatically merging the document with
' entries in Maximizer. When you send the document, you can choose
to merge the document with the current entry or with all selected
entries in Maximizer.
You can merge the document for a single Maximizer entry, or you
can select multiple entries to print the document for all entries at the
same time.
The document is automatically sent to the printer that is currently set
up in Word.
@This procedure is written for n Open the document in Word.
Microsoft Word 2007 or later.
The steps are slightly different E In Maximizer, click on the entry to make it the current entry.
in earlier versions of Word.

In Maximizer, select multiple entries.
e (Click the checkbox to the left of entries.

e Click on the entries one at a time while holding down the
Control key.

¢ To select all entries between two entries, select an entry and,
while holding down the Shift key, select another entry.

To save a copy of the document to selected Maximizer entries,
select Save Merged Documents from the Merge group.

To print the document for the current entry only, in the
Maximizer tab in Word, select the top of the Send to Printer icon
in the Merge group.

To print the document for multiple selected entries, in the
Maximizer tab in Word, select the bottom of the Send to

Printer icon in the Merge group, and select the Print Selected
Entries option.

A dialog appears confirming that the document will be printed
for the selected entries. Click Yes to continue.

The merged document is sent to the default printer currently set
up in Word.
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Save a Microsoft Word Document to a Maximizer Entry

To complete this procedure, Microsoft Word Integration must be

installed.
@Word_ integration is available When you use Microsoft Word with Maximizer, you can save a
‘E)’(‘g(;?e'rv“croso‘(t Internet Microsoft Word document to the current entry in Maximizer or to
’ multiple selected entries. The document is saved to the Documents
tab of the entries.
You can save Microsoft Word documents to Address Book entries,
customer service cases, and opportunity entries. If the document
contains any linked merge fields, the merge fields are replaced with
values for the current Maximizer user, Address Book entry,
opportunity, or customer service case when the document is saved.
@This procedure is written for n Open the document in Word.
Microsoft Word 2007 or later.
The steps are slightly different E In Maximizer, click on the entry to make it the current entry.

in earlier versions of Word.

In Maximizer, select multiple entries.
e Click the checkbox to the left of entries.

e Click on the entries one at a time while holding down the
Control key.

¢ Toselect all entries between two entries, select an entry and,
while holding down the Shift key, select another entry.
E In the Maximizer tab in Word, select Save to Maximizer
Entry.
The Save Document to Maximizer Entry dialog appears.
n In the Save document to group, select whether you want to

save the document to the Current entry only or to all Selected
entries.

E Enter the Name, Owner, Category, and Description for the
saved document, then click OK.

The merged document is saved to the current or selected
Maximizer entries.

Create Envelopes and Mailing Labels for Maximizer Entries

To complete this procedure, Microsoft Word Integration must be
installed.

When you use Microsoft Word with Maximizer, you can create
envelopes and mailing labels for the current entry in Maximizer or
for multiple selected entries. The envelopes and labels are



@ This procedure is written for
Microsoft Word 2007 or later.
The steps are slightly different
in earlier versions of Word.
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automatically formatted with the name and address of the
Maximizer contact using the Address format set up in your user
Preferences in Maximizer.

n In Maximizer, click on the entry to make it the current entry.
—or-
In Maximizer, select multiple entries.
¢ Click the checkbox to the left of entries.

¢ Click on the entries one at a time while holding down the
Control key.

e Toselect all entries between two entries, select an entry and,
while holding down the Shift key, select another entry.
E To create envelopes, in the Maximizer tab in Word, select
Envelopes in the Print group.
The Create Envelope dialog box opens.

To create mailing labels, in the Maximizer tab in Word, select
Labels in the Print group.

The Create Mailing Labels dialog box opens.

E Set the Address options to customize the way the address
appears on the envelopes or labels.

Select the All capitals, no punctuation option to display the
address in ALL CAPS with any punctuation removed.

¢ Todisplay a line of custom text above the address, enter it in
the Add additional text for the first line of the address
field.

If you do not want to display additional text above the
address, leave this field blank.

¢ To display a merge field above the address, select it in the
Add a custom field for the second line of the address
drop-down list.

If you do not want to display a custom merge field above the
address, leave this field blank.

ﬂ Set the Print option to customize the way the envelopes or

labels are printed.

* When creating envelopes, if you want to include a return
address, select the Print return address option and enter
the return address in the Return address field.



166 | Maximizer Web Access
User's Guide

@The Return address field is
automatically populated with
the return address that is
saved in Microsoft Word. Refer
to your Microsoft Word
documentation for information

on how to update this address.

@ Refer to your Microsoft Word
documentation for more
information on how to use the
settings in the Envelope
Options and Label Options
dialog boxes.

e When creating labels, if you will be printing the labels on a
partially-used label sheet and would like to set a custom
starting position for printing the labels, select the
Customize label start position option.

E To log a note to the Maximizer entries for which the envelopes
or labels are created, enter the text of the note in the Message
to log to notesfield.

If you do not wish to log a note to the Maximizer entries, leave
this field blank.
B Click Generate Envelopes or Generate Mailing Labels.

The Microsoft Word Envelope Options or Label Options dialog
box opens.

Select the envelope size or label type and other printing options,
then click OK.

A new document opens containing the envelopes or labels.

Open a Document Template

@Word integration is available
only in Microsoft Internet
Explorer.

@ This procedure is written for
Microsoft Word 2007 or later.
The steps are slightly different
in earlier versions of Word.

To complete this procedure, Microsoft Word Integration must be
installed.

You can open document templates from your Maximizer template
library in Microsoft Word allowing you to preview and print
documents based on your templates.

n In the Maximizer tab in Word, select Template from the Insert
and Preview group.

The Maximizer Document Template dialog opens.

E Select a document template from the list of available templates
and click OK.

The document template opens in Word.

Create a Document Template

@Word integration is available
only in Microsoft Internet
Explorer.

To complete this procedure, Microsoft Word Integration must be
installed.

You can add document templates to your Maximizer template library
from Microsoft Word.



Chapter5 | 167

@This procedure is written for n Create a new document in Microsoft Word and enter the
Microsoft Word 2007 or later. ; ; . :
The steps are slightly different content for the template, including any Maximizer merge fields.

in earlier versions of Word. E In the Maximizer tab in Word, click the bottom half of the Save

to Maximizer button and select Create New Template from
the drop-down list.

The New Maximizer Document Template dialog opens.

E Enter a Name and Description and choose the Full access and
Read access permissions for the template, then click OK.

The document template is saved to your Maximizer template
library.

Update a Document Template

To complete this procedure, Microsoft Word Integration must be

installed.
@Worc_l integration is available You can edit and update document templates in your Maximizer
(E);‘:)%(;’r*e'rv'"“’so“ Internet template library from Microsoft Word.
@This procedure is written for n Open the document template you wish to edit and make the

Microsoft Word 2007 or later.
The steps are slightly different
in earlier versions of Word.

desired changes.

E In the Maximizer tab in Word, click the bottom half of the Save
to Maximizer button and select Update Existing Template
from the drop-down list.

The Maximizer Document Template dialog opens.

E Select a the document template you wish to update from the list
of available templates and click OK.

The document template is saved to your Maximizer template
library.
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CHAPTER

Galendar and Hotlist

Track Your Appointments and Tasks

In this chapter...

“Hotlist Tasks” on page 170

“Calendar” on page 176

“Appointments” on page 181

“Viewing Activities for Entries” on page 188
“Notifications” on page 192

“Action Plans” on page 197
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Hotlist Tasks

Hotlist Page

The Hotlist is a timeless “to-do” list of tasks and reminders. Tasks
include calling and writing to customers. Use the Hotlist page to
record actions and follow up on personal activities, such as producing
expense reports, or those related to your interactions with Address
Book entries. For example, you can use the Hotlist to schedule a
phone call to a Contact who is out of town for a week. When the
week is up, the Hotlist will remind you to call again.

Hotlist tasks can be associated with opportunities, campaigns, and
customer service cases, as well as Address Book entries. When you
schedule strategies for opportunities, Hotlist tasks are created for all
of the activities in the opportunities. When you create new customer
service cases, Hotlist tasks are created for the assigned users based on
the follow-up deadlines of the cases.

You can view all of your Hotlist tasks in the Hotlist page. Keep the
following points in mind when working in the Hotlist page.

n Select the Hotlist icon to open the Hotlist page.

E Use the View drop-down list to select the date range you want
to show.

ﬂ Select the Filter icon to display tasks for a different user, to
show or hide appointments, and to show or hide old tasks that
are not completed.

ﬂ Click on a task to view its details.
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E View information on the Address Book entry associated with the
current task in the following panes.

Hotlist

loe Napoli - 7 displayed

Search for Address Book entries... Q

E flin'm

« Edit v View v Actions ¥ Report v Help @ jﬂ jﬁ View: This week w - @@
4 Date: Time [pr. [ Task [ Name Company E\ Phone1 | completed |
) Quick Access »
March 06, 2014 MED Schedule meeting to canfirm contract renenal.  Bolton, Lynnette Mindy  Kenwood Vineyards (604) 601-80 v
" 4 > March 06, 2014 9:30 AM Mesting: Finalize contract changes Adams, Dante Armanetti Wine Shoppe (604) 601-8000 v
I [— March 06, 2014 Z:30PM  MED Prepare report for sales meeting
March 06, 2014 3:30FM Sales meeting v
75l My
D, My Work Day @  March06, 2014  5:25PM My follow-up deadine is approaching. Wiley, Kendall Val Ansley Wine Merchants (604) 801-8000
EQ Address Book AMarch 07, 2014 6:00 AM Meeting Adams, Dante Armanetti Wine Shoppe (604) 601-8000
[¥, opportuniies 2 March07,2014  6:11PM My fallow-up deadiine is approaching. Wikey, Kendall Val Ansley Wine Merchants (604) 601-8000
[3% quotss

r;‘ Campaigns

[ customer service

@ knowledge Base
D Hodlstn

Calendar

':ﬁ Company Library

0 Video Tutorials

il user information
[@) unks »
g4 Import =
37 Administration »

Main: (604) 601-8000
Fax: (604) 601-8001
Email addresses and website

escona@maximizer.com
WWw.maxinmizer.com

Email:
Website:

4 ‘AMrﬁannkEntereta'lls Contacts | Customer Service | Opportunities | History | Notes | User-Defined Fields | Documents | Related Entrie »  + @+ 4+
Adams, Dante Key Fields for: <Defaut Key Fields> -3 © @ || Actions
Position: Project Manager P —— FEr— pubih Add 2 note
Company: Armanetti Wine Shoppe o notsaltby: Prin Ul Access: ublie Add 2 document.
Department: Business Development Category: Read Access:

— partn =| Create an opportunity

i (s i erritory: 'artner: 1
& Edit (=) Print ¥ P
= erritory Status: Unassigned Sales Lead: lo
Receive a call

Phone numbers % Account Lead status:

Manager: Time a task

Schedule a meeting
Schedule @ to-do
Schedule an Action Plan

+ Favorite lists

Filter the List of Activities

In the Hotlist page, select the Filter icon.

E Select the filter options for the activities you would like to view.

[ ]
@ You must have access to other U

users’ Hotlist to view their
Hotlist tasks. You can give
other users access to your .
Hotlist in your Calendar/Hotlist
preferences.

L]

From the User drop-down list, select the user whose activities
you want to view.

Select Show completed tasks to view completed tasks in
the list.

Select Show carried forward unfinished tasks to view old
tasks that are not yet complete.

Select Show appointments to view appointments in the list
with the tasks.

You can also select Show completed appointments and
Show carried forward unfinished appointments to view
appointments, which are completed and unfinished carried
forward appointments.

E Click OK to apply the filter options.
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Viewing Hotlist Tasks

Add a Hotlist Task

You can click on a Hotlist task in the Hotlist page to open the Hotlist
Task dialog box where you can view and edit details of the task. Keep
the following points in mind when working in the Hotlist Task dialog
box.

n Specify a date and, optionally, a time for the task.

E Select Set alarm to remind yourself of the task before the
scheduled time.

E Enter the activity.
ﬂ Mark the task as completed when you are finished with the task.

E Click the ellipsis button beside the Assigned to field to assign
the Hotlist task to another user.

E Select Personal task if you want to make the task personal and
remove the Address Book entry associated with the task.

Hotlist Task X]

Scheduled date and time

Date: 19/03/2010 =
Time:

Set alarm

Details of task E

“Activity:  Schedule meeting to talk shout new product line =
ﬂ Cormpltad

'@ Hatlist task with Chen, Melanie - Amelia Liquors South

gonaM -]

mini=(=) + | prior totask

Friority: -
o HEER& e S

Assigned To:  Joe Napol

Perzonal task

E Open Address Book entry

* Denotes mandatory field.

| Spelling ‘ ‘ QK H Cancel ‘

You can create Hotlist tasks for Address Book entries, campaigns,
customer service cases, and opportunities. You can also create
personal Hotlist tasks. Personal Hotlist tasks are not associated with
other entries.

When creating Hotlist tasks, you can set a due date and time for the
task and an alarm in advance of the due date, and you can set a
description and priority for the task.
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You can also create tasks for other Maximizer users to complete.
When you create a task for another user, the task will appear in that
user’s Hotlist, and they will be reminded by the alarm if one is set.
You can also choose to send an email reminder to the assigned user
when you create the task.

n Click on the entry to make it the current entry.
—or-
To add a personal task, select the Hotlist icon to open the
Hotlist page.
E Select Actions > Schedule a To-do.
—or—-
In the Hotlist page, select Edit > Add Task.
—or—-
Right-click and select Schedule > To-do.
—or—-

In the following pane, open the Details tab, and under Actions,
select Schedule a to-do.

—0or —

In the following pane, open the Activities tab, and next to
Add, select Task.

The Add Hotlist Task dialog box opens.
E Enter the Hotlist task details.
n Click OK to save the Hotlist task.

If the task is assigned to another user you may be prompted to
send a notification email to the user, depending on your
Calendar/Hotlist preferences.

E If necessary, customize the email notification, and click Send.
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Reassign Hotlist Tasks

You can reassign Hotlist tasks to different Maximizer users directly in
the Hotlist page. You can reassign one Hotlist task, or you can select
multiple tasks to assign all of them to the same user. When you
reassign a task from one user to another, you can send an email
notification to both users to let them know that the task has been
reassigned.

n Click on the Hotlist task to make it the current entry.
—or-
Select multiple Hotlist tasks.
e Click the checkbox to the left of entries.

¢ Click on the entries one at a time while holding down the
Control key.

¢ Toselect all entries between two entries, select an entry and,
while holding down the Shift key, select another entry.

E Select Edit > Reassign.
The Reassign Hotlist Tasks dialog box opens. Users are displayed
by group.

ﬂ Select a user.

Type the first letter in the item’s name to jump to that item in
the list.

Users are grouped by the security groups, teams, departments,
and divisions to which they belong if you have the “Display users
by groups” option enabled in your preferences.

Reassign Hotlist Tasks [¥]
Reassign selected tasks to
All Users
& Daniel Brown
& Jon Bowser
& Lucy Garcia

& Wark Bertoli
& Matt Graham
& iranda Corel

&wonda White

Departments

Divisions

Security Groups
Teams
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1 click ok.

Depending on your Calendar/Hotlist preferences, you may be
prompted to send an email message to the selected users.

E If necessary, customize the email notification, and click Send.



176 | Maximizer Web Access
User's Guide

Calendar

Calendar Page

The Calendar lets you view your appointments, and the
appointments of other Maximizer users. Appointments are displayed
in a daily, weekly, weekly list, or monthly view. All views allow you to
see your appointments at a glance.

You can view, add, and modify your appointments in the Calendar
page.

In the View bar at the top of the page, you can view the dates for
which appointments are currently displayed in the page. By default,
appointments are displayed for the current day, week, or month.
You can select any other day/week/month to view appointments in
the Calendar for that time period. You can display the appointments
for other users if they have given you access to their calendars.
Calendar access is set in your Calendar/Hotlist preferences.

Here are some tips for working with the Calendar page.
n Select the Calendar icon to open the Calendar page.

E In the top-left corner of the page, select the arrow buttons to
navigate from day to day, week to week, or month to month.

El Select the Daily, Weekly, Weekly List, or Monthly icon to
change the calendar view.

ﬂ View details of appointments directly in the Calendar page.

Color bars and icons indicate the users and booked resources and
locations for appointments.

¢ Monthly view - To view details of a day’s appointments in a
pop-up window, hold your mouse pointer over the day. To
display appointment details, hold your mouse over the
appointment. To open an appointment from the pop-up
window, click on the appointment.

e Weekly, weekly list, and daily views — To display appointment
details, hold your mouse over the appointment. To open an
appointment, double-click on the appointment.

E Select the Open Address Book entry icon to view the Address
Book entry associated with the selected appointment. You can
also right-click and choose this command from the context
menu.

E From the User drop-down list, select a user to display another
user’s appointments, or select a location or resource to view the
booked time for meeting locations and resources.
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If a user has set the response in an appointment to Declined, the
color bar is not shown for that appointment in the Calendar, and
the user’s name appears crossed-out with a red line through it in
the appointment details.

Select a date in the miniature calendar view to navigate to a
different day, or month in the calendar. Use the arrow buttons
to move between months or years.

E In the Hotlist Tasks section, view the day’s Hotlist tasks.
You can click on a Hotlist task to open it and view its details.
ﬂ In the Legend section, select the checkbox beside other users

and locations/resources to view the availability of users and
locations/resources.

You can use the Check All or Uncheck All icon to quickly select
or clear all users and resources in the list. Use the Edit List icon
to add users and resources to the calendar and to set icon colors
for these users and resources.

Search for Address Book entries...

Edt * View v~  Actons ¥ Report v
Thursday, March 06, 2014 (Week 10) i User. Shows My Calendar E
W) Quick Access  * oD BE 2= @ o March 2014 (+]
@ &Y Su Mo Tu We Th Fr Sa
= 30
1
9| Dashboards
I@ AN 2| & 4 s e[ 7 s
5l My =
E‘ My Work Day » e e a| 10 1 13 14 15
Eﬁ R - Meeting: Finalize contract changes = [ o [
o 23| 24 25/ 26| 27 28| 28
¥ | opportunities
30 10:30 AM-11:30 AM 30/ =
[@2) cuots Forscast mesting
11 AM Forecast meeting Hotlist Tasks.
H] ¢ i Users: Miranda Corell
g AR 30 \Wonda White & Warch 05, 2014 5:25 PIY
(5] Customer servee Daniel Brown n My follows-up deadiine is approaching
- 12 Pt
Jon Bowser March 06, 2014 2:30 Pl
@ Knowledge Base 2 Location: Board Room Prepare report for sales meeting
[z] otist TN 7 = Warch 08, 2014
- Start planning summer lunch Schedule meeting to confim contract rer
Calendar
30
Iy I
i Q Company Library | 5 o Legend
Uncheck Al | Edit List B
30
Q) videe Tutorias Users E
3P
e W Joe Hapoli w
§il User information > 0 e g Daniel Brown
Sales meet
(@] Links » | 2w oles meetng B Lucy Garcia E
_ W ark Bertoli
g4 mport » = B

B watt Graham -
37 Administration »
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Add Items to the Calendar Legend

expand the Legend section.

E In the Legend section, click Edit List.

You can add other Maximizer users and locations and resources to
the legend in the Calendar page. While adding the items to the
legend, you can assign colors to the items to identify which items are
assigned to specific appointments directly in the Calendar page.

n If necessary, in the bottom-right corner of the Calendar page,

The Users and Locations/Resources Color Legend dialog box
opens to the Users tab.

Users and Locations/Resources Color Legend

]
Users | Locations and Resources
Available Selected

Al Users .
= Lucy Garcia
@ Celine Dancer Mark Bertoli
] Matt Graham
o Daniel Brown
&
& Jon Bowser Add
e
&
s
&
e
& Miranda Corel SetColo
S randa Co [setColef
@ Wonda White

Departments
Divisions
Security Groups
Teams -

Locations and Resources tab.

ﬂ To add locations and resources to the legend, select the

n Select an item in the Available list, and click Add.

e To select multiple items, press Control while selecting the

items.

e To select a series of items, select the first item in the series,
then press Shift and select the last item in the series.

e Type the first letter in the item’s name to jump to that item in

the list.

e Select a security group, team, department, or division to add
all members of the group to the list.

Users are grouped by the security groups, teams, departments,
and divisions to which they belong if you have the “Display users
by groups” option enabled in your preferences.

E Select the color to assign to the item, and click OK.
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E Click OK to save the changes to the legend.

The Legend updates to show the new items with the selected
colors.

View the Availability of Users, Locations, and Resources

You can quickly view the availability of users, locations, and
resources. You can access the Free Time dialog box from the Calendar
page, or you can access the dialog box while creating or viewing an
appointment. In an open appointment, you can select a new date
and time for the appointment and add users, locations, and resources
to the appointment directly from the Free Time dialog box.

n In the Calendar page, select View > Free Time.
In an open appointment, select the Scheduling icon.

The Free Time dialog box opens showing the availability for the
users in the appointment.

E To view the availability of other Maximizer users, click Select
Users or Invite Other Users, move users to the Assigned
attendees list, and click OK.

ﬂ On the right side of the dialog box, select and clear items to view
or hide the availability of different users, locations, and
resources.

When a user has set the response for an appointment to
Declined, the user appears as available in the Free Time dialog
box during the appointment.
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If you are viewing the Free Time dialog box from an open
appointment, the selected users, locations, and resources are
automatically added to the appointment when you click OK.

| Free Time -- Webpage Dialog ==l
EN N september 26 - October 02, 2010 (Week 39) & Users
Sun26 | MWon27 | Tue28 | Wed2s | Thu30 Fri1 sat2 Select Users
8AM ~ || [¥] Joe Hapoii
Lou Jones
oA Watt Graham
10AM
1AM
12PH
1PM
Locations and Resources
2PM
E Board Room it
3PM [T cafeteria
[C] Games Room
4PN
[T interview Room
— Marketing Collateral £
[ Meeting Room
6FM Product Samples
[T projector
7PN

- [ statf Room
| S
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Viewing Appointments
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You can schedule meetings and appointments with other Maximizer
users and Address Book entries. Calendar appointments can be
associated with Address Book entries, campaigns, customer service
cases, and opportunities, or they can be personal.

Appointments for a day, week, or month, are displayed in the
Calendar page. You can hold your mouse pointer directly over an
appointment to see more information. You can also click on an
appointment to open it and view its details.

When you open an appointment, its details are displayed in the
Modify Appointment dialog box. Here are some tips for working in
the Modify Appointment dialog box.

n Click Options to set lead times for alarms and email reminders,
to specify that email reminders be sent to Address Book entries,
and to sign yourself out of the Peg Board.

Default settings for alarms are specified in your Calendar/Hotlist
preferences.
E Click Recurring to view details of recurring appointments.

E Select Completed to mark the appointment as completed.

n View information on the entry associated with the appointment
in the information bar.

If the appointment is linked to an opportunity, a case, or a
campaign, the entry is displayed as a link in the appointment.
You can click the link to open the entry.

E Specify the date and time of the appointment.
If the end time of the appointment is earlier than the start time,
the appointment spans into the next day.

E Select Private to keep the appointment details private.

When this option is selected, even users with access to your
calendar cannot see the appointment details. The appointment
appears in the calendar with the subject displayed as “Private
appointment”.

Select Alarm and Reminder to set an alarm and to send email
reminders to yourself and to selected users.
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@ You can click Options to
specify that email reminders
are also sent to Address Book
entries.

The email reminder message lists the basic appointment details.
You cannot edit this message. When adding a new appointment,
Maximizer retains the email reminder settings from the last
appointment you created. This feature is available only if the
Maximizer Email Service is running.

E Select a location for the appointment and specify the needed
resources.

These values are set in Administrator, but you can specify any
value as a location.

E Select the Users and Address Book Entries tabs to assign
Maximizer users and Address Book entries to the appointment.

You can view the current users and Address Book entries
assigned to the appointment in the Attendees and response
list. Click the name of an Address Book entry to view the entry’s
contact information.

Modify Appointmen| %]
b5 E=|Scheduing (3] Options () Recurring |[Jlcon v ’_Cnmp\etadE

Appointment

Basic Information Users Address Book Entries
Subject:  Finalizs distribution contract =
Appointment details Attendees and response
Date: 10/4/2011 = e ::'.Ehth < Response
larylyn Anoza - Through the Grape
Erom: 11:004M [« el 1200PM [+ B Tirbitors
L Celine Dancer
Priority: Private ¥ Alarm V| Reminder —
Joe: Mapoli accepted  [w
Location:  Interview Room |+
Resources: Product Samples E (
Products | Services: | g
Categories: Calfornia
Notes:
Joe and Celine work together to finalize this contract.
Save Cancel

Add a Personal Appointment

You can easily schedule a personal appointment from the Calendar
page. The Add Appointment dialog box gathers all the information
for the appointment—the date and time, the description, and who
will be in attendance.

When scheduling appointments, you can set an alarm in advance of
the appointment, mark yourself out of the Peg Board, and set the
priority.
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n In the Calendar page, select the day for the appointment.
E Select Edit > Add Appointment.

Right-click, and select Add Appointment.
The Add Appointment dialog box opens.
ﬂ Click the Scheduling icon to view the free time of users,

locations, and resources and to select a time for the
appointment.

Selected users, locations, and resources are automatically added
to the appointment.

@You can also select a time n Specify the details of the appointment.
directly in the Appointment
dialog box.
Add Appointment »

(&) g F=]scheduing [32] Options (%) Recurring | [J1con » | [ Completed

Appointment

Basicinformation  Users  Address Book Entries [= 1~
Personal Appointment
Subject:  Meeting to confim plars for summer lsunch [-]
Appointment details Attendees and respanse
Date: 31442014 ] = ane) Responsg
From: 000AM [+ untl; 1200PM <] | S Bile Holy
e )
8 108 Mapol Accepted
Priarity: El Private || flarm (Y] Reminder
Location:  Mesting Floom

Resources:

]

Products [ Services:

Categories:

V| Motify other users

Miokes:

| Save || Cancel |

E If necessary, select the Users and Address Book Entries tabs
and add other Maximizer users or Address Book entries to the
appointment.

In the Basic Information tab, you can select Notify other users
to notify other attendees of the appointment and prompt them
to select a response when they next open Maximizer.

E Click Save to save the appointment.

Depending on your Calendar/Hotlist preferences and the details
of the appointment, you may be prompted to send an email
message to other people included in the appointment.

If necessary, customize the email notification, and click Send.
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Add an Appointment with Address Book Entries

@ This option applies to only the
current entry.

@ This option applies to only the
current entry.

You can schedule appointments with Address Book entries from the
main list in the Address Book, Opportunities, Campaigns, Customer
Service, or Calendar page or from the Contacts or Related Entries
following pane. The appointment is linked by default to the current
entry.

You can schedule the appointment with the current entry. Or you
can select multiple Address Book entries to add all entries to the
appointment.

When you schedule an appointment for an opportunity or customer
service case, the Contact associated with the opportunity or case is
automatically added to the appointment. When you schedule an
appointment for a campaign, the appointment is linked to the
campaign, but Address Book entries are not included in the
appointment.

n Click on the entry to associate the appointment with.

In an Address Book list, select multiple entries to schedule the
appointment with all of the entries at once.

E Select Actions > Schedule a Meeting.
Right-click, and select Schedule > Meeting.

In the following pane, select the Details tab, and under
Actions, select Schedule a meeting.

—or —

In the following pane, select the Activities tab, and next to
Add, select Appointment.

The Add Appointment dialog box opens.
ﬂ Specify the date, time, and other details of the appointment.

Click Save to save the appointment.

Depending on your Calendar/Hotlist preferences and the details
of the appointment, you may be prompted to send an email
message to other people included in the appointment.

E If necessary, customize the email notification, and click Send.
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Add Users to an Appointment

You can add other Maximizer users to existing and new
appointments. When you choose to send notifications to other users
in the appointment they are prompted to accept or decline your
appointment request the next time they log in to Maximizer.

n Open the appointment.
E Select the Users tab.

E In the Available users list, select the users to add to the
appointment, and click the right arrow button to add the users
to the Assigned attendees list.

e To select multiple users, press Control while selecting the
users.

e To select a series of users, select the first user in the series,
then press Shift and select the last user in the series.

e Type the first letter in the item’s name to jump to that item in
the list.

e Select a security group, team, department, or division to add
all members of the group to the list.

Users are grouped by the security groups, teams, departments,
and divisions to which they belong if you have the “Display users
by groups” option enabled in your preferences.

n To notify other attendees of the appointment, in the Basic
Information tab, select Notify other users.

E Click Save to save the appointment.
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Modify Appointment [X]
2by Fjscheduing (3] options (% Recurring | [ Teon » | I Completed

Appointment
Address Book Entries

Basic Information Users

Available users:

3

d attendees:

All Users rame | Phone
4 Marylyn Anoza - Through
o & |the Grape vine (770) 555-4792
@ Daniel Brown Distributors
o
- & |celine Dancer (555} 7750599
o
:JD” Bowssr & |308 Mapoii (555) 775-0952
&Lou Jones
o & |Mark Bertoli (555) 7750978
8Lucy Garcia p—
. B
&
@Mt Graham =
S hiranda Corel [«
Swonda hite
Cepartments
Divisions
Security Groups
Teams =
| Save | | Cancel \

Depending on your Calendar/Hotlist preferences and the details
of the appointment, you may be prompted to send an email
message to other people included in the appointment.

E If necessary, customize the email notification, and click Send.

Send Email Notification as iCalendar Files

In your Calendar/Hotlist preferences, you can specify that iCalendar
(.ICS) files are attached to appointment email notification sent to
Address Book entries. Appointments are automatically added to the
calendar of Address Book entries receiving the notification if they
use calendar applications that support the iCalendar file format.
Maximizer users do not receive iCalendar file attachments.

If an attendee responds to an iCalendar notification, the response is
sent to the Maximizer user who created the appointment. When you
receive a response to an iCalendar notification, you are alerted that
the original appointment does not exist. This message refers to the
status of the appointment in your email application, not the status of
the appointment in Maximizer. The iCalendar response does not
modify the appointment in Maximizer.

n In the top-right corner of the page, click on your image, and
select Preferences.

The Personal Preferences dialog box opens.
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E Click Other Preferences.

The Preferences dialog box opens to the Calendar/Hotlist tab.

ﬂ From the Email appointment notification drop-down list,
select Ask or Always.

ﬂ Select Include the iCalendar (.ics) attachment.

E Click OK to save the changes to the Preferences dialog box.
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Viewing Activities for Entries

You can access all appointments and Hotlist tasks scheduled for
specific entries. Appointments and tasks for the current Address
Book entry, opportunity, customer, service case, or campaign are
displayed in the Activities tab in the following pane. If activities are
scheduled for opportunities and customer service cases, the activities
are listed with the associated Address Book entries as well as with the
opportunities and customer service cases. You can also add and
modify activities directly in entries.

View Activities Scheduled for an Entry

Activities Tab

Use this procedure to view the appointments and tasks scheduled
with an Address Book entry, opportunity, customer service case, or
campaign. In the Hotlist page, you can also view the activities
scheduled with the Address Book entry associated with task.

n Click on the entry to make it the current entry.
E In the following pane, select the Activities tab

E Select a date range to show activities for from the View drop-
down list.

n In the top-right corner of the following pane, click the filter icon
to adjust which activities are displayed.
The filter options dialog box opens.

E Select the filter options for the activities you would like to view.

e From the User drop-down list, select the user whose activities
you want to view.

¢ Select Show appointments, Show carried forward
unfinished tasks, or Show completed activities to
include these activities in the list.

¢ In the Options section, select whether you want to see all
activities or only those associated with an action plan.

E Click OK to apply the filter options.

All appointments and tasks for the selected entry that match the
filter and date range criteria are displayed in the list.

The Activities following pane in the Address Book, Opportunities,
Campaigns, Customer Service, or Hotlist page and the Activities tab
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in an open customer service case or campaign displays Calendar
appointments and Hotlist tasks associated with the entry. If activities
are scheduled for opportunities and customer service cases, the
activities are listed with the associated Address Book entries as well
as with the opportunities and customer service cases.

Activities are displayed in the list based on criteria specified in the
various filters including Action Plan activities, date, and user. By
default, activities are sorted by date. You can select and sort entries
like in other lists in Maximizer.

e To open an appointment or task, click on the activity.

e To complete an appointment or task, click the checkbox in the
Complete column.

e To add or delete appointments or tasks, use the icons in the view
bar at the top of the list.

The Action Plan options let you filter the list of activities by Action
Plan. The activities displayed follow the other filter elements as well
as the option selected in the Action Plan filter.

¢ When viewing activities in the Activities tab of the following
pane, click the filter icon to access the Action Plan options.

e When viewing the activities in an open campaign or customer
service case, the Action Plan options are displayed in a drop-
down list in the Activities tab.

The following options are available to customize the way Action Plan
activities are displayed:

e All Appointments and Tasks - Displays appointments and
tasks regardless of Action Plans.

e Action Plan Activities - Displays only appointments and tasks
that are scheduled as part of Action Plans.

¢ Action Plan - Select the name of an Action Plan at the bottom
of the list to display only appointments and tasks scheduled as
part of the Action Plan.

Once an Action Plan is selected, click Details to view
information on the Action Plan and the Action Plan template.

When viewing the Action Plan options in the Activities tab of an
campaign or customer service case, the following options are also
available:

e Display all Plans - Updates the list of Action Plans at the
bottom of the drop-down list so it displays all Action Plans
currently scheduled for the entry.

This option is not available in the Activities tab in the following
pane.
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Filter

Clear list - Removes all Action Plans from the current list.

This option is not available in the Activities tab in the following
pane.

Filter Plan list — Opens a dialog box where you can specify
criteria to apply to the list of Action Plans. You can specify the
dates Action Plans were scheduled and the users who scheduled
the Action Plans.

This option is not available in the Activities tab in the following
pane.

Use the filter options to change the list of activities currently
displayed

When viewing the activities in the Activities tab of the following
pane, click the filter icon in the top-right corner of the tab.

When viewing the activities in an open campaign or customer
service case, click the arrow button to the right of the primary
filter options to expand and hide the filter details.

The following filter options are available to customize the way
activities are displayed:

View - Select a date range for the activities.
Select All dates to ignore the date of activities.
Select the Custom Filter icon to specify any dates for the filter.

User - Select a specific user to view only activities scheduled by
that user.

Select All Users to ignore the user.

Show appointments - Displays appointments in the list of
activities. If this option is cleared, only Hotlist tasks are displayed.

Show carried forward unfinished tasks — Displays Hotlist
tasks that are not marked as complete but scheduled for dates
prior to the date range selected in the filter.

This option is unavailable when “Show completed activities” is
selected.

Show completed activities - Displays appointments and tasks
that are marked as complete.
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View Activities for a Custom Date Range

Use this procedure to view activities for a custom date range for
Hotlists.

n From the View drop-down list, select Custom to open select
date range dialog box.

E Specify Start date and End date.
ﬂ Select the Save as rolling date range checkbox to make the
date range generic.

The rolling date range calculates the number of days between
the start date and end date keeping the current date as the base.
So the next time you log in, the start date and end date update
to reflect the new dates.

n Click OK to view activities for a custom date range.
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Notifications

There are a number of notifications available for appointments and
Hotlist tasks:

e Schedule alarms to remind you of upcoming appointments and
tasks.

¢ Notify other users of appointments in Maximizer.
e Schedule email reminders for appointments.

The Notification panel displays any overdue alarms and any new
meeting invitations requiring responses. When an alarm is due, the
panel opens automatically. From the panel, you can view details of
the pending activities, complete the activities, reschedule the alarms,
and open the activities to view or modify them. You can also respond
to any meeting invitations in the panel.

Set an Alarm for a Hotlist Task

You can set alarms for Hotlist tasks while adding the tasks, and you
can set alarms for existing tasks. If you set an alarm for a timeless
task, it will go off as soon as you log in to the Address Book the day
of the task.

n Open the Hotlist task.

E Select the Set alarm checkbox.

E To the right of the checkbox, specify the amount of time before
the task to set the alarm.

From the drop-down list, you can select a different unit for the
time.

ﬂ Click OK to save the changes to the Hotlist task.

Set an Alarm and Email Reminder for an Appointment

You can set alarms and email reminders for appointments while
adding the appointments, and you can set alarms and reminders for
existing appointments.

n Open the appointment.

E To set an alarm, select the Alarm checkbox, and to set an email
reminder, select the Reminder checkbox.
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@ If you have declined an E Click Options.
appointment, the Alarm and
S?mk')rl‘d;r checkboxes are 4] Specify the lead times for the alarm and reminder.
isabled.

¢ Inthe Alarm lead time field, specify the amount of time
before the appointment to set the alarm.

¢ Inthe Reminder lead time field, specify the amount of time
before the appointment to send the email reminder.

From the drop-down list, you can select a different unit for the

time.
Options - Mozilla Firefox ==
Options
Alarm lead time: 30 minute(s) [+
Reminder lead time: 1 hour(s) []

¥ Include Address Book entries in email reminder

Sign out of Peg Board

E To send the email reminder to the Address Book entry associated
with the appointment, select the Include Address Book
entries in email reminder checkbox.

E Click OK to save the changes in the Options dialog box, and click
OK again to save the changes to the appointment.

Notify Users in an Appointment

You can notify other users of an appointment while you create an
appointment. The meeting invitation is displayed in the Notification
panel where the users are prompted to set a response. You can view
responses to meeting invitations in the Appointment dialog box.

e While creating an appointment, ensure the Notify other users
chexbox is selected.

This option is set by default. You cannot change this setting after
creating the appointment.
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Set Default Values for Alarms and Reminders

In the Calendar/Hotlist preferences, you can set default options for
alarms and email reminders in appointments and tasks. The default
values specified in the preferences are automatically set in new
appointments and tasks. You can change these values in specific
appointments and tasks while adding or modifying the activities.

n In the top-right corner of the page, click on your image, and
select Preferences.

E Click Other Preferences.

The Preferences dialog box opens to the Calendar/Hotlist tab.

ﬂ Specify default values for the alarm and reminder preferences.

¢ Inthe Alarm lead time field, specify the amount of time
before the activity to set the alarm.

This setting affects appointments and Hotlist tasks.

e Toturn alarms on by default in new appointments, select the
Set the alarm on when adding an appointment
checkbox.

¢ To send email reminders to Address Book entries by default,
select the Include Address Book entries in appointment
email reminders checkbox.

n Click OK to save the changes to the Preferences dialog box.

Reschedule Alarms

You can reschedule the alarms from the notification panel, so they
will reappear later. You can delay the alarm by a set number of
minutes, hours, days, or weeks. For upcoming activities, you can also
reschedule the alarm to go off a period of time before the activity is
scheduled to start.

n If necessary, in the top-right corner of the screen, click the
Alarm icon to open the Notification panel.

When a notification is due, the Alarm icon is red and a number is
displayed indicating the number of alarms due today and the
number of upcoming meeting invitations.

@The panel should open The Notification panel is displayed along the right-side of the
automatically when a page. Alarms for activities on past days are listed under Overdue.
notification is due. S .

And alarms for activities on the current day are listed under
Today.

E Click on an activity to view its details.
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From the Remind me again in drop-down list, select an
amount of time by which to delay the alarm, and click Snooze.

If an activity is scheduled in the future, you can also specify an
amount of time before the start of the activity.

At the top of the page, from the Snooze all alarms for drop-
down list, select an amount of time by which to delay all alarms
in the list, and click Snooze.

To close the notification panel, in the top-right corner of the
screen, click the Alarm icon.

Complete Activities from the Notification Panel

@ The panel should open
automatically when a
notification is due.

You can complete an appointment or task directly from the
Notification panel. If you have overdue activities on past days, you
can also complete all of these activities at once.

If necessary, in the top-right corner of the screen, click the
Alarm icon to open the Notification panel.

When a notification is due, the Alarm icon is red and a number is
displayed indicating the number of alarms due today and the
number of upcoming meeting invitations.

The Notification panel is displayed along the right-side of the
page. Alarms for activities on past days are listed under Overdue.
And alarms for activities on the current day are listed under
Today.

Click on an activity to view its details.
Click Complete to complete the activity.

Under Overdue, click Complete All to complete all overdue
activities due on past days.

To close the notification panel, in the top-right corner of the
screen, click the Alarm icon.
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Respond to Meeting Invitations

@ The panel should open
automatically when a
notification is due.

You can respond to meeting invitations from other users in the
notification panel. Your response is displayed in the Appointment
dialog box.

n If necessary, in the top-right corner of the screen, click the
Alarm icon to open the Notification panel.

When a notification is due, the Alarm icon is red and a number is
displayed indicating the number of alarms due today and the
number of upcoming meeting invitations.

The Notification panel is displayed along the right-side of the
page. Meeting invitations for past appointments are listed under
Overdue. Meeting invitations for future appointments are listed
under Upcoming.

E Click on an activity to view its details.

E From the Response drop-down list, select your response, and
click OK.

ﬂ To close the notification panel, in the top-right corner of the
screen, click the Alarm icon.
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Action Plans are lists of pre-determined appointments and Hotlist
tasks that can be scheduled all at once. Each appointment or task is
scheduled to occur a specified number of days before or after the
Action Plan start date. Action Plans can be scheduled as personal
appointments and tasks for Maximizer users or scheduled for Address
Book entries, opportunities, campaigns, and customer service cases.

The Action Plan Library stores Action Plan templates. Action Plan
templates store the details of your Action Plans. When you schedule
an Action Plan, you can choose an existing Action Plan template.

Each Action Plan template includes the details of the appointments
and tasks in the Action Plan, as well as the time of the activities
relative to a start date.

While creating an Action Plan template, you can assign the activities
in the Action Plan to specific Maximizer users. Then, when you
schedule the Action Plan, the appointments and tasks are
automatically assigned to the users.

You can also assign Action Plan activities to a generic user called the
“current user”. When scheduling the Action Plan, you can substitute
the current user with another Maximizer user to assign the activities
in the Action Plan to the selected user.

Users must have adequate Action Plan Library permissions to apply,
create, modify, or delete Action Plan templates.

Create an Action Plan Template

To complete this procedure, you must have Insert permission for the
Action Plan Library.

You can create Action Plan templates, which can later be scheduled
to create appointments and Hotlist tasks for Maximizer users and for
specific entries.

n In the left navigation pane, hover your mouse over
Administration, and select Action Plan Library from the pop-

up.
H ciick Add.
The Add Plan Template dialog box opens.

ﬂ Enter the template name and description.
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Dependent Activities

ﬂ Click Add and select Appointment or Task to add an activity in
the template.

E Enter the appointment or Hotlist task details.

¢ Inthe Schedule activity fields, specify when to schedule the
activity in relation to the start date of the Action Plan.

¢ Inthe Assigned to field or the Users tab, select a Maximizer
user (or multiple users in appointments) to assign to the
activity.

By default, the activity is assigned to the user who schedules
the Action Plan.

¢ Select the Personal or Personal Hotlist task option to
mark the activity as personal, not associated with an Address
Book entry.

& ciick ok.
The activity is listed as part of the template.

Repeat steps 4-6 for each activity in the template.

E In the Full Access and Read Access fields, select a user or
group to make this Action Plan template accessible to only a
particular user or group.

E Click OK to save the Action Plan template.

When you schedule an Action Plan, you can specify that the activities
in the Action Plan are dependent of each other. Dependent activities
should be completed in their scheduled order. The order of the
activities is determined by the date and time of the activities within
the Action Plan. This order is taken into account when you complete
Action Plan activities.

When you complete or change the date of a dependent activity,
Maximizer checks the order and date of the activity.

e If an earlier activity in the Action Plan is incomplete, you are
prompted with a message. The message does not prevent you
from completing the activity.

¢ If you complete an activity earlier or later than its scheduled
date, you have the option of rescheduling the remaining
activities in the Action Plan based on the date the activity is
completed.

¢ If you change the date of an activity, you have the option of
rescheduling all activities scheduled after the modified activity
based on the number of days earlier or later the activity is
moved.
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You can reschedule only activities to which you have full access.

If the “Skip non-work days” option was selected when the Action
Plan was scheduled, the activities are rescheduled only on work days.

For example, if you complete an activity one day late, all proceeding
activities in the Action Plan are moved forward by one day. If any of
the activities is scheduled to occur on a non-work day, it's moved to
the next work day. If any of the activities is assigned to a user who
has not granted you full access to the Calendar (for appointments) or
Hotlist (for tasks), the activity remains unchanged.

You must complete dependent activities individually. If you attempt
to complete multiple activities at once, any dependent activities will
not be completed.

Schedule an Action Plan

To complete this procedure, you must have Read permission for the
Action Plan Library.

You can schedule Action Plans from the main lists in the Address
Book, Opportunities, Campaigns, Customer Service, or Hotlist page
or from the Contacts or Related Entries following pane. When you
schedule an Action Plan from the main list in the Hotlist page, the
Action Plan is scheduled with the Address Book entry associated with
the selected task or appointment. If you select a personal task or
appointment, you can schedule a personal Action Plan not associated
with any entries.

You can schedule the Action Plan with a single entry, or you can
select multiple entries to schedule the Action Plan with all of the
entries at the same time. You can choose any existing Action Plan
template for the Action Plan.

n Click on the entry to make it the current entry.
—or-
Select the entries.
¢ Click the checkbox to the left of entries.

e Click on the entries one at a time while holding down the
Control key.

e Toselect all entries between two entries, select an entry and,
while holding down the Shift key, select another entry.

E Select Actions > Schedule an Action Plan.
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@ The menu applies only to
entries selected in the main
list.

@ The option applies to only the
current entry in the main list.

@ The option applies to only the
current entry in the main list.

B

—or —

Right-click and select Schedule > Action Plan or Schedule an
Action Plan.

—or —

In the following pane, select the Details tab, and under
Actions, select Schedule an Action Plan.

—or —

In the following pane, select the Activities tab, and next to
Add, select Schedule Action Plan.

If necessary, select how you want to use the current list.

You can schedule the Action Plan with only the current entry,
with all selected entries, or with all entries in the current list.

If no entries are selected, the Action Plan is automatically
scheduled with the current entry. If the current entry is a
personal task or appointment, the Action Plan is personal, not
associated with an entry.

Schedule Action Plan =3

Address Book entry options
For whom in your current list do you want to schedule this Action Plan?
@ current entry only
Allselected entries

All entries in the list

From the Plan template drop-down list, select an existing
Action Plan template.

Details of the selected template are displayed. Optionally, you
can modify the plan name and description.

In the Start plan on field, specify the start date of the Action
Plan.

You can click the Calendar icon to choose a date from a pop-up
calendar.

To take the order of activities into account when activities are
completed, select Set activities as dependent.

If this option is selected, users are prompted when they complete
activities in the incorrect order.

If necessary, click Advanced to toggle between the advanced
and simplified view of the dialog box.

In the Replace current user with drop-down list, select the
user to schedule the main Action Plan activities for.
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All template activities assigned to the current user are scheduled
for the selected user. Template activities assigned for specific
users continue to be scheduled for the users specified in the

template.

You can also assign specific appointments and tasks to other
users by editing the details of the appointment or task.

days.

Select Skip non-work days to schedule activities only on work

Any activities scheduled on a non-work day are moved to the

next work day.

nmlf necessary, click More to modify or add activities to the Action

Plan.

You can click Save As to save a modified Action Plan as a new

template.

nnclick OK to finish scheduling the Action Plan for the selected

entries.

Schedule Action Plan for Anoza, Marylyn A. - Mozilla Firefox
Action Plan details

Plan template: | Simple Sales Plan

Description: [Use when a strategy would be overkil - contains all the main steps

*Plan name: Simple Sales Plan: July 2011

=

Start plan on: | 7/21/2011

Replace current user with: | Joe Napoli

=]

Description: [Contains all the main steps in a basic strategy. Activiies in the plan are
dependent on each other.

| 5kip non-work days.

Action Plan activities

Activity Start date Assigned to
4 @ aks sl contact with customer and o Juty 21,2011 [Joe Napoii
A analyze requirements and develop proposa... |July 22,2011 |Joe Napoi
4 @ Arrange time to present proposal July 25,2011 |Joe Napoli
&) &% Present proposal - date and time need to July 26, 2011 Joe Napoli

A & review sake August 04,2011 |Joe Napoli

=]

| Save As... \

/] Set activites as dependent | Advanced << |

m

* Denotes required fisld | Spelling | | More=> | | 0K

| \ Cancel |

=

Depending on your Calendar/Hotlist preferences and the details
of the Action Plan activities, you may be prompted to send email
messages to other users added to appointments or tasks in the

Action Plan.

nﬂlf necessary, customize the email notifications, and click Send.
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View Activities Scheduled from an Action Plan

You can view a list of activities scheduled from a specific Action Plan
in the Activities tab in the following pane.

n Click on the entry to make it the current entry.
E In the following pane, select the Activities tab

E In the top-right corner of the following pane, click the filter icon.
The filter options dialog box opens.

ﬂ Under Options, select Show activities of a specific action
plan.

A list of all Action Plans scheduled with the entry is displayed in
the drop-down list.

E Select the name of the Action Plan.

E To display all activities in the Action Plan, set the following filter
options:

e From the User drop-down list, select All Users.
¢ Select Show appointments.
e Select Show completed activities.

Click OK to apply the filter options.
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Sending Email

You can send email messages to Address Book entries directly from
the main Maximizer pages. When you create email messages, you can
insert merge fields into the message text. And you can save the email
messages as templates to reuse later.

View an Email Message from an Entry

When you use Maximizer to send email messages to Address Book
entries, you can save copies of the messages as documents with the
associated Address Book entries, opportunities, and customer service
cases. You can open and view these email messages from Maximizer.
You can also reply to, forward, and print the email messages.

n In the Address Book, Opportunities, or Customer Service page,
select the entry the email message is saved to.

E In the following pane, select the Documents tab.

B Click the email message you want to view.
The email message opens in the View Email dialog box.

You can use the icons at the top of the dialog box to reply,
forward, or print the email message.

Send Email to a Contact

Use this procedure to send an email message to a Contact from the
Details tab of the following pane in the Address Book page, the
Opportunities page, or the Hotlist page. In the Opportunities page,
you can send the message to the Contact associated with the
opportunity. In the Hotlist page, you can send the message to the
Address Book entry associated with the Hotlist task.

When sending an email you can select an optional email type. If the
selected email type requires consent, the email will not be sent to
any recipients who have not opted-in to the selected email type. If no
email type is selected, the email will be sent without checking the
email profiles of the recipients.

If no email type is configured in Maximizer then the default value
will be blank for email type. You can manage the email profile and
opt-in information for your Address Book entries in the Details tab of
the following pane in the Address Book page.



@ Do not use angle brackets, <
or >, in the email editor. Any
text between the brackets will
be removed from the email
message.

@ If the email message contains
attachments that are too large
to save to the entry, you can
clear this option.
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n Click on an Address Book entry, opportunity, or Hotlist task to
make it the current entry.

E In the following pane, select the Details tab.

E For an Address Book entry, under Email addresses and
website, click on the email address.
For an opportunity, under Actions, select Write an email.

The Send Email dialog box opens.

ﬂ To add more email recipients, click the To, Cc, or Bcc buttons.

You can search the current Address Book or your global address
list. You can search by last name or by company. For entries with
multiple email addresses, select the desired address from the
drop-down list in the row for the entry.

E Enter a subject and the text of the email message.

Use the toolbar icons and font drop-down lists to format your
message.

E Click the Attach File icon to select file attachments to send with
the email message.

From the Email type drop-down list, select an email type.

B Set your logging options as follows:

¢ Select Send a copy of this message to myself to
automatically send a carbon copy of the email message to
your email address.

e Select the Include message body in note option to save
the message to the note created.

e Select the Save copy to entry’s documents option to save
the message as a document for the entry.

¢ Select Include attachments to save email attachments
along with the email message.

¢ In the Text for note field, enter any additional text you
would like to log as part of the note created by the email
message.

e Click the Logging Details button and then the Assign
More button to log the email details to additional Address
Book entries.

E) click send.
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Send an Email Message to Address Book Entries

@ The menu applies only to
entries selected in the main
list.

You can send email to multiple Address Book entries from the main
lists in the Address Book, Opportunities, Customer Service,and Hotlist
pages and from the Contacts and Related Entries following panes. If
you send the email message from the Address Book page, the
message is sent to the selected Address Book entries. If you send the
email message from another page, the email message is sent to the
Address Book entries associated with the selected entries.

The From address is automatically retrieved from your user
properties. If you do not have an email address, your email message
will not be sent. If there is an error when trying to send your email,
you will be notified by email at the From address in your user
properties.

When sending an email you can select an optional email type. If the
selected email type requires consent, the email will not be sent to
any recipients who have not opted-in to the selected email type. If no
email type is selected, the email will be sent without checking the
email profiles of the recipients.

If no email type is configured in Maximizer then the default value
will be blank for email type. You can manage the email profile and
opt-in information for your Address Book entries in the Details tab of
the following pane in the Address Book page.

When sending an email in Maximizer you can ensure that a copy of
the email appears in your email application by choosing to
automatically send a carbon copy (CC) of the email to yourself.

You can send an email message to the current entry, to all selected
entries, or to the entire list of entries.

n Make a list of entries.
—or-
Select multiple entries:
¢ Click the checkbox to the left of entries.

¢ Click on the entries one at a time while holding down the
Control key.

¢ Toselect all entries between two entries, select an entry and,
while holding down the Shift key, select another entry.

E Select Actions > Write an Email.
Right-click and select Write an Email.

The Send Email dialog box opens.

ﬂ Choose how to use the current list, and click OK.



@ In your email preferences, you
can set a default setting for
sending email separately when
you are sending email to
multiple Address Book entries.

@ Do not use angle brackets, <
or >, in the email editor. Any
text between the brackets will
be removed from the email
message.
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You can send the message to only the current entry, to all
selected entries, to all entries in the list, or to none of the entries.

Send Email ]
Email address options
To whom in your current list do you want to address this email message?
Current entry only
@) All selected entries in the current page
All entries in the list spanning all pages

Do not use the list

n If you are sending the email message to multiple Address Book
entries, choose an option from the Send as drop-down list.

e Select Separately to send a separate email message to each
Address Book entry.

¢ Select One email to send one email message to all the
selected entries at once.

E To add more email recipients, click the To, Cc, or Becc buttons.

You can search the current Address Book or your global address
list. You can search by last name or by company. For entries with
multiple email addresses, select the desired address from the
drop-down list in the row for the entry.

These options are available only if the One email option is
selected in the Send as drop-down list.

E Enter a subject and the text of the email message.

Use the toolbar icons and font drop-down lists to format your
message.

If you are sending email to a single Address Book entry or to
multiple Address Book entries using the Separately option, you
can insert merge fields into the message text.

To add a merge field, select the MergeField icon and select the
field from the Available Fields list. When the message is sent,
the field value corresponding to the Address Book entry,
customer service case, or opportunity is merged into the
message.

Click the Attach File icon to select file attachments to send with
the email message.

E From the Email type drop-down list, select an email type.

E Set your logging options as follows:

¢ Select Send a copy of this message to myself to
automatically send a carbon copy of the email message to
your email address.
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@ If the email message contains
attachments that are too large
to save to the entry, you can
clear this option.

¢ Select the Include message body in note option to save
the message to the note created.

e Select the Save copy to entry’s documents option to save
the message as a document for the entry.

¢ Select Include attachments to save email attachments
along with the email message.

¢ In the Text for note field, enter any additional text you
would like to log as part of the note created by the email
message.

¢ Click the Logging Details button and then the Assign
More button to log the email details to additional Address
Book entries.

ER0)ciick send.

From: Loy Jones <ljones@maximizer.com:> -

To»» | Mergetolist
Send ccx |
B> |

Subject: Escona Promotion

Attachments | Pricelist. bt

[ 0D ! B Send as: | One emall Format: HTML «  Email type: - =]

BEETE

address ¥ | senf v

Si... v B 7 UAYT oY= =E

Dear [First Name] [Last Name],
Please find attached or latest Escona promotional list.

Regards,
Joe Napoli

President
Escona Estate wines

Logging
["|send a copy of this message to myself (send a carbon copy to myself) Text for note:

[#]1nclude message body in note Sent updates prometional material to key prospects.
[7] Save copy to entry's documents
[¥]Indude attachments

M
I Logging Details.
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Edit an Email profile
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Maximizer allows you to set up different email types for which you
can specify whether recipient consent is required or not in order to
receive that type of email. You can manage the consent, or opt-in
settings for your email recipients via the email profile of each
Address Book entry’s email address.

When sending an email type that requires consent from Maximizer,
the email profiles of the recipients are checked to ensure that they
have consented, or opted-in to receive that type of email, and the
email will only be sent to those recipients who have opted-in to that
email type. The email types available in Maximizer can be configured
by your system administrator.

You can set up email profiles for the email addresses of each
company, individual, or contact in your Address Book. The email
profile for each email address allows you to select the email types
that the entry has opted-in to for that email address. You can select
multiple opt-in email types for each email address. For each email
type that has been opted-in to, you can specify the Opt-in date, the
date that opt-in consent expires, and a comment about the opt-in
consent. The email profile for each email address can be viewed by
hovering over the email address in the Details tab of the following
pane in the Maximizer Address Book page.

By adding unsubscribe merge fields to an email message you can
allow the email recipients to unsubscribe from the current email type
or from all email types.

By adding the manage email preferences merge field to an email
message, email recipients can opt-in or opt-out of each email type.
When a recipient clicks on the Manage your email preference link,
Maximizer redirects the recipient to a web page where they can
configure their email profile and opt-in preferences for each email

type.

To complete this procedure, you must have Modify permission for
Address Book entries and full access to the current entry. You must
also have the Modify system tables privilege.

You can edit an email profile for the email address from the Details
tab in the following pane of the Address Book page. You can opt-in
to the email types for email addresses to receive specific types of
email.



210

Maximizer Web Acces
User's Guide

n Click on the Address Book entry to make it the current entry.
E In the following pane, select the Details tab and click Edit.

B Under the Email addresses and website section, click on the +
icon next to the email address.

The opt-in email types are displayed.
ﬂ Select the checkbox next to the email type.

E Specify the Opt-in date, Expiry date and Comment for the
email type.

E Click Save.

Add an Opt-out Link to an Email Message

By adding unsubscribe merge fields to an email message you can
allow the email recipients to unsubscribe from the current email type
or from all email types.

By adding the manage email preferences merge field to an email
message, email recipients can opt-in or opt-out of each email type.
When a recipient clicks on the Manage your email preference link,
Maximizer redirects the recipient to a web page where they can
configure their email profile and opt-in preferences for each email

type.

n In an email message, put your cursor where you want to add the
link.

E Select the MergeField icon.

ﬂ Under Basic Fields, select the merge field.

¢ Select Manage your email preference to allow email
recipients to configure their email profile.

¢ Select Unsubscribe all emails URL to allow email recipients
to unsubscribe from all email types.

¢ Select Unsubscribe single email type URL to allow email
recipients to unsubscribe from only the current email type.

n From the Email type drop-down list, select an email type.

B ciick ok.

The merge field is added as a link. You can edit the text of the
link.
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You can create email templates that you can reuse to send to many
Address Book entries at different times. The email template includes
the subject and the body of the email message, including any
formatting and images added to the message.

You can add merge fields to the subject and body of email templates.
The merge fields are populated with information from the selected
Address Book entries, opportunities, or customer service cases when
email messages are sent using the template.

Create an Email Template

To complete this procedure, you must have the Modify email
templates privilege.

You can create email templates from the Compose Email Message
dialog box whenever you compose a new email message.

n From the Address Book, Customer Service, or Opportunities
page, select Actions > Write an Email.

From the Address Book, Customer Service, or Opportunities
page, right-click and select Write an Email.
E Enter the subject and text of the email message.

You can compose the email message in HTML or in plain text.
You can use the formatting toolbar to apply additional
formatting to the email text.

Select the Merge Field icon to insert merge fields in your
template.

El Select theTemplate icon.
The HTML Email Templates or Text Email Templates dialog box
opens.

n Click Add to add a new email template.

E Enter a name, description, and access rights for the template and
click OK.

To reuse this template in the future, select the template in the
Available email templates list, and click Retrieve.

To save changes made to the template, select the template in
the Available email templates list, and click Save.
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Merge Fields

To retrieve this template automatically each time you compose
an email message, select Retrieve this template when the
Compose Email Message dialog is opened.

E Click Close to return to the email message.

Merge fields are place-holders in your document that can be
replaced by basic Address Book entry or user-defined field
information when you perform a merge. For example, in the body of
a letter, you can insert a merge field for a Contact’s name:

[First Name]

When you perform the merge, the name of each recipient is
displayed in place of the merge field. If the entry does not have an
assigned value for the chosen merge field, the field does not display.

Merge fields are not restricted to Address Book entry information—
you can insert merge fields for your own user information, customer
service cases, and opportunities as well.

You can insert merge fields in email templates, email messages,
automated campaign messages, and Microsoft Word documents.
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Setting Email Preferences

Maximizer contains a number of email preferences that let you set
default options for outgoing email. You can access these settings in
the Email tab of the Preferences dialog box.

Preferences - Mozl Firefox ==
L7

Logging  CalendarHotlist  Monitoring  Email | Startup

Options
Save copy of message to entry's Documents
V| Ineclude message body in email note:
V] isplay warning when logged email has no Address Book entries assigned for logging
| When sending email From Documents tab, log only ko the current entry by defalt
7] then sending email b multiple entries set the default as "Separately” {merging the recipients one at a time)

V| Compose messages in HTML

| Forits. |

| AuteSignatwe... |

| 0K | | Cancel |

Set Up an Email AutoSignature

You can set up an email AutoSignature in the email preferences. The
AutoSignature is added to the end of outgoing email messages sent
from Maximizer. You can choose whether or not to include the
AutoSignature when you reply to and forward email messages.

n In the top-right corner of the page, click on your image, and
select Preferences.

The Personal Preferences dialog box opens.
Click Other Preferences.
Select the Email tab.

Click AutoSignature.

Enter the content of the email signature.

Use the options in the toolbar to add formatting, images, and
hyperlinks to the signature.
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E Under Options, select Add AutoSignature to the end of
outgoing messages.

To exclude the signature when you forward or reply to email
messages, select Suppress AutoSignature when forwarding
and replying.

E Click OK to save the AutoSignature, and click OK again to save
the changes to the preferences.

: ‘

| A v s v B /7 U AT T E =

o
Joe Napoli,
President

Escona Estate Winery
Tel: (335) 775-0982

Fax: (533) 775-0900
inapoli@maximizer.com

Options
[7] Add AutoSignature to the end of outgoing messages
[7] Suppress AutoSignature when forwarding and replying

[ teb ok || cancel

Set Default Fonts for Email Messages

In the email preferences you can set default fonts for email messages
in Maximizer. You can set up different fonts for new messages and
for messages that you are forwarding or replying to.

n In the top-right corner of the page, click on your image, and
select Preferences.

The Personal Preferences dialog box opens.
E Click Other Preferences.
E Select the Email tab.

n Click Fonts.
The Fonts dialog box opens displaying the current default fonts.



Fonts - Mozilla Firefox

New email messages

| Font..

Sample text

Replying or forwarding messages

| Font.

Sample text

OK

H Cancel |

E Under New email messages or Replying or forwarding

email messages, click Font.
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B Select the default font, font style, size, and color, and click OK.

Click OK to save the default fonts, and click OK again to save the

changes to the preferences.
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Microsoft Outlook Integration

® Outlook integration works
with Outlook 2003, or higher.

@ In Outlook, select View >
Toolbars to view and modify
the toolbars that are currently
enabled.

Microsoft Outlook integration for Maximizer installs toolbars in the
Mail, Contacts, and Contact information windows in Outlook.

To access Maximizer commands, the Maximizer Outlook Integration
toolbar must be enabled. From the toolbar, you can complete the
following tasks in Maximizer:

e Set Up Outlook Integration.

e Create Address Book entries.
e Create customer service cases.
e Create Hotlist tasks.

e Save email messages to Address Book entries, opportunities, and
customer service cases.

e View Address Book entries.

e Synchronize appointments and contacts between Outlook and
Maximizer.

* Track email threads in a Maximizer Address Book entry’s
documents.

Install Microsoft Outlook Integration

@ This setup involves
downloading Active X
controls, which may be

disallowed on some networks.

Outlook integration can also
be installed from the
Maximizer CRM CD. For more
information, see the
Maximizer CRM
Administrator’s Guide.

To complete this procedure, Microsoft Outlook integration must be
enabled. For more information, see the Maximizer CRM
Administrator’s Guide or your system administrator.

n In the left navigation pane, hover your mouse over
Administration, and select Desktop and Mobile Setup from
the pop-up window.

E Under Microsoft Outlook Integration, select View more
information.

The system requirements and a description of the basic steps?
required to install Microsoft Outlook Integration are displayed.

E Click Download Outlook Integration.
A window opens giving you the option to run or save the file.

n Click Run and follow the steps outlined in the setup wizard to
install the files.
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Set Up Microsoft Outlook Integration

@ To prevent the wizard from
opening every time you open
Outlook, clear the “Show this
wizard each time Outlook
starts” checkbox.

To complete this procedure, Outlook Integration for Maximizer must
be installed.

Before using Microsoft Outlook Integration, you must configure
Outlook to communicate with Maximizer. You must specify the
Maximizer URL, the Address Book, and the Maximizer user ID and
password. You can also set default preferences for creating new
Address Book entries, and configure Outlook Synchronization.

The Outlook Integration for Maximizer wizard opens automatically
when you start Outlook, letting you choose the settings for the
integration. After setting up Outlook integration, you can change
these settings at any time by selecting the Maximizer Outlook
Integration Options icon in Outlook.

n After installing Outlook integration for Maximizer, open
Outlook.

The Outlook Integration for Maximizer wizard opens.
E Click Next.
B Enter the Maximizer URL.

By default, the Maximizer URL is in the following form:
http://<servername>/MaximizerWebAccess/

5 Maximizer Web Access URL ==
Please enter the website address for your Maximizer Web Access as you would in the
address bar of your web browser.
Masimizer Web Access URL:  [Fitp://server/MasmizerWebAccess
<ok [ Mea> Cancel
n Click Next.

E In the Address Book drop-down list, select the Maximizer
Address Book that you want Outlook to connect to.

B Specify your Maximizer User ID and Password, and click Next.
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51 User Information ==

Please select the Address Book you would like to use for Qutlook Integration with Maximizer
web Access and enter the user 1D and password for that Address Book.

Address Book: |Escona Tuorial =] userip: [inapel

Psssword: [~

< Back | Next > Cancel |

Select the options for creating Address Book entries and saving
email messages:

¢ Select Include attachments when saving email to save
email attachments by default when saving email messages to
Maximizer entries.

¢ Select the Confirm when saving email and the Confirm
when creating Contact options to specify details before
saving email or contact information to Maximizer.

¢ In the Default Contact type drop-down list, select the type
of Address Book entry that is created when you add contacts
from Outlook.

If the “Confirm when creating Contact” option is selected, you
can select a different type of Address Book entry while creating

the entry.
Click Next.
51 Other Systern Options ==
Please set the otier system options for Outiook Integiation with Masimizer Web Access
I Include attachments when saving email
[~ Confitm when saving email
I Confim when creating Contact
Default Contact type: | Company/Contact ~|
Bk |[ New» Cancel |

E Specify the frequency for synchronization between Maximizer
and Outlook, and click Next.
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5 Synchronization Frequency

Please configure the synchranization frequency between Outlook and Maximizer and conflict
resclution.

Frequency Conflict resclution

(" Synchronization every: [ 1 [Hourls) <]
@ Synchronization daily at. | S0000FM =5

" Never (manual synchronization)

* Maximizer CRM overrides

" Qutlook overrides

<Back Cancel

‘ Next >

E Specify the options for synchronizing appointments between

Maximizer and Outlook, and click Next.

51 Synchronization Options

Please configure the appointment synchronization settings

[ Synchronize appointments

From: [5 =] [Dayl)  _~| beforetoday
To: [z = [weekie) v aftertoday

¥ Include private appointments

<Back Cancel

‘ Next >

nmSpecify the options for synchronizing tasks between Maximizer

and Outlook, and click Next.

nnSpecify the options for synchronizing contacts between

Maximizer and Outlook, and click Next.

¢ Select Synchronize Address Book entries if you want to
synchronize contacts between Maximizer and Outlook.

¢ In the Synchronize Address Book entries from Favorite
List drop-down, select the Maximizer Favorite List that you

want to synchronize entries from.

¢ In the Synchronize Contacts from Outlook Category
field, enter the Outlook contact category that you want to

synchronize entries from.
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¢ Click Phone Mapping to set up a mapping between Outlook
contact phone number fields and the corresponding phone
number fields in Maximizer Address Book entries.

ERFAciick Finish.

Select a Microsoft Outlook Address List for Integration

@ This procedure is written for
Microsoft Outlook 2010. The
steps may differ slightly in
earlier versions of Outlook.

Outlook integration with Maximizer only works with address lists in
the Outlook Address Book (such as Contacts), and only with one
address list at a time. It does not work with the global address list or
other address lists.

If Outlook is set to use the global address list or another address list,
which might be the case if your organization uses Microsoft
Exchange, you will see an error message when you try to save an
Outlook contact to Maximizer. If you see such an error message, use
the procedure below to select an Outlook address list.

n In Outlook, on the Home tab, select Address Book from the
Find group.

The Address Book dialog box opens.
E Select Tools > Options.

E Open the Show this address list first drop-down list, and
select one of the items under Outlook Address Book.

Typically, there is only one item in this list, called Contacts. In
that case, select Contacts.

Addressing ===
Addressing
Show this address list fists
Contacts [=]
OQutlook Address Book
Contacts
Global Address List
Al Address Lists
Al Contacts
Al Groups
Al Users
Masmail Account on Exchange
Public Folders
‘ :
[ add.. ][ Remove | [ propertes |

n Click OK, and then close the dialog box in Outlook.
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Add an Address Book Entry from Microsoft Outlook

@ To enable or disable the
“Confirm when creating
Contact” option, select the
Maximizer Outlook Integration
Options icon.

To complete this procedure, Outlook Integration for Maximizer must
be installed.

You can create Address Book entries in Maximizer directly from
Microsoft Outlook. You can create Address Book entries from
Outlook contacts or from email messages in Outlook. If you create
the entry from an email message, the entry is created from the email
sender (From address).

The Create Contact command is available in the Maximizer Outlook
Integration tab or toolbar in the Mail and Contact windows, and the
Message and Contact dialogs in Outlook.

If you cleared the “Confirm when creating Contact” option when
setting up Outlook integration, Maximizer automatically creates
entries as follows:

e If Individual is selected as the default contact type, Maximizer
creates an Individual Address Book entry.

e If Company/Contact is selected as the default contact type,
Maximizer creates a Company/Contact Address Book entry. If the
Outlook contact information does not include a company name,
you are prompted to provide one when saving the Contact to
Maximizer.

In Outlook, select the contact or the email message.

Select Create Contact.

If the “Confirm when creating Contact” option is disabled, the
Company or Individual Address Book entry is created
automatically in Maximizer.

If the “Confirm when creating Contact” option is selected, the
Save Contact to Maximizer dialog box opens.

E If necessary, change the Address Book entry type.

n If you are creating a Contact for an existing Company/Individual,
click Search to find and select the Address Book entry for which
you want to create a Contact.

E Edit the information in the available fields as required.
E Click OK to save the entry.
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Add a Customer Service Case from Microsoft Outlook

You can create customer service cases in Maximizer from email
messages in Microsoft Outlook. You can create a new Address Book
entry while creating the case or create the case for an existing
Address Book entry.

You have a number of options when creating customer service cases
in Outlook:

Create a new contact and a new customer service case at the
same time.

Create a new case from a related Address Book entry. This
option lets you search your Address Book for an entry.

Create a case for the selected Address Book entry. This option is
available only if Maximizer is open in Microsoft Internet explorer
and an Address Book entry is currently selected.

Save the email message to an existing customer service case. This
option is available only if Maximizer is open in Microsoft Internet
explorer and a customer service case is currently selected.

Select an email message in Outlook, and select Create Case.
The Maximizer Customer Service Case dialog box opens.

Select the type of entry you want to create, and click OK.

If you are creating a new Contact at the same time as the
customer service case, enter the information for the Contact.

If necessary, select the Address Book entry to which you want to
save the email message.

If there is an associated Address Book entry for the selected
email message, it is displayed in the Entries assigned for Case
Creation list. If necessary, search for entries and assign them to
the case.

Specify the most important information about the case.

The Subject and Description fields default to the subject and
content of the email message. To specify Products/Services or
Categories for the case, select the ellipsis button next to the

appropriate field and select values for the field.

Other fields for the case must be specified in Maximizer.
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Add a Hotlist Task from Microsoft Outlook

To complete this procedure, Outlook Integration for Maximizer must
be installed.

You can create Hotlist tasks in Maximizer from email messages in
Microsoft Outlook. The email message is automatically saved with
the Maximizer Contact associated with the task. When you create the
task, the following options are available:

e Create a new Contact or Individual and a Hotlist task in
Maximizer from the message.

e Create a task for an existing Contact in Maximizer.
e Create a personal task in Maximizer.

n In Outlook, select or open the email message.
E On the Maximizer tab, select Create Task.
B Select the type of entry you want to create, and click OK.

ﬂ If you are creating a new Contact or Individual at the same time
as the task, enter the basic information for the entry, and click
OK.

E If necessary, select the Address Book entry associated with the
task.

If there is an associated Address Book entry for the selected
email address, it is displayed in the list. If necessary, search for
entries and assign them to the task.

E Specify the task details, and click OK to save the task in
Maximizer.

Send an Email Message to Address Book Entries from Microsoft Outlook

You can use Microsoft Outlook to send email messages to Maximizer
Address Book entries, even if the Address Book entries do not have
related contact records in Outlook.

This method may not be available if you are using Word as your
email editor. To determine if Word is your email editor, select Tools >
Options from the menu in Outlook, and click the Mail Format tab. If
the "Use Microsoft Office Word to edit e-mail messages” checkbox is
selected, the Maximizer Addresses button may not be available in the
new email message dialog box.

When sending an email you can select an optional email type. If the
selected email type requires consent, the email will not be sent to
any recipients who have not opted-in to the selected email type. If no
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email type is selected, the email will be sent without checking the
email profiles of the recipients.

If no email type is configured in Maximizer then the default value
will be blank for email type. You can manage the email profile and
opt-in information for your Address Book entries in the Details tab of
the following pane in the Address Book page.

n In Outlook, open a new email message.

E Click the Maximizer Addresses button.

The Maximizer Addresses dialog box opens.

5 Maximizer Addresses ==
Search for Entry
oK
. of
Last Name: — Search
e — Cancel
I lonore leads
Entries available for assignment from search results
Name Email [ To
Remove
Ce
< Remove
_ B |
< Remove

B Select Last Name or Company and enter the full or partial last
name or company name to search for.

ﬂ Click Search.

The names and primary email addresses of the matching Address
Book entries appear in the “Entries available for assignment
from search results” list.

E Select the Address Book entry from the list, and click the To, Cc,
or Bcc button.

You can select multiple entries by holding down the Ctrl key or
Shift key.

E From the Email type drop-down list, select an email type.
Click OK.
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Save an Email Message to an Entry from Microsoft Outlook

@ If you or another user has
already saved the email
message to the entry,
Maximizer will avoid creating
a duplicate entry by not saving
the email again.

@ This procedure is written for
Microsoft Outlook 2010. The
steps may differ slightly in
earlier versions of Outlook.

@ To enable or disable the
"Confirm when saving email”
option, select the Maximizer
Outlook Integration
Preferences icon.

You can save email messages in Microsoft Outlook directly to Address
Book entries, opportunities, and customer service cases in Maximizer.
Email messages are saved in the documents tab of the selected
entries. You can save and send a new email message, or you can save
an existing email message, or multiple email messages, to an Address
Book entry, opportunity, or case.

If there are no Address Book entries, opportunities, or customer
service cases associated with the email message, you can search for
entries in your Maximizer Address Book to save the email message
to. The email message is then saved to the selected entries as a
document.

n In Outlook, select the email message or multiple email messages.
—or-
In Outlook, open the email message.
—or-
In Outlook, compose a new email message.

E On the Maximizer tab, expand the Save to Maximizer menu
and select Save to Address Book Entry, Save to
Opportunity, or Save to Case.

—or —

On the Maximizer tab, select Send Email and Save to
Contact, Send Email and Save to Opportunity, or Send Email
and Save to Case.

If the “Confirm when saving email” option is disabled, the email
message is saved as a document to the Address Book entry that
contains the email address of the sender or recipient, or the
opportunity or case whose contact contains the email address of
the sender or recipient.

If the “Confirm when saving email” option is selected, the Save
Email to Maximizer Address Book Entry, Save Email to
Opportunity, or Save Email to Case dialog box opens. The list
displays all of the entries that contain the email address of the
sender or recipient. If no such entries exist, the list is empty.

E If the entries that you want to save the email to do not appear in
the list, click Search Address Book entries, Search
opportunities, or Search cases.

The Search Maximizer Address Book entries, Search Maximizer
opportunities, or Search Maximizer cases dialog opens.
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@ Click "Change column view"
to choose a different column
setup for displaying the search
results.

@ To change the default for the
“Include attachments” option,
select the Maximizer Outlook
Integration Preferences icon.

ﬂ Enter the Last Name or Company of the Address Book entry or
opportunity contact that you want to search for and click
Search.

—or —

Select the case field to Search for and the value to Search
by, and select the case Status that you want to search for and
click Search.

The search results are displayed in the list.

E Select the entries that you want to save the email to and click
OK.

The selected entries are added to the list.

¢ If you want to select multiple entries, hold down the Ctrl key
as you click each entry.

¢ Click View selected entry in Maximizer to open your
Maximizer Address Book and view the selected entry.

E If you want to include attachments when saving the email, select
the Include attachments option.

Specify the document properties for the saved email.
¢ From the Owner drop-down list, select the document owner.
e From the Category drop-down list, select the document

category.

E Check the box next to each of the entries that you want to save
the email to and click OK.
The email is saved to the documents of all selected entries.

View an Address Book Entry from Microsoft Outlook

You can automatically open Maximizer to view Address Book entries
from Microsoft Outlook. You can view Address Book entries
associated with Outlook contacts or with email messages. The
Address Book entries with an email address matching the email
address in the email message or of the Outlook contact are
displayed.

When you view Address Book entries from Outlook, a new instance
of your web browser opens displaying the Address Book page in
Maximizer. The page lists all matching entries.

n In a mail or contacts window in Outlook, select an email message
or contact.

E Select the View Contact in Maximizer icon.
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Track an Outlook Email Thread in Maximizer

@ To enable or disable the

"Confirm when saving email”

option, select the Maximizer
Outlook Integration Options
icon.

You can track an Outlook email thread in your Maximizer Address
Book using the Maximizer Outlook Integration add-in. When you
choose to track an Outlook email thread you select a Maximizer
Address Book entry and any email responses in the same thread in
Outlook are automatically saved to the entry's documents in
Maximizer. By tracking email threads in Outlook you can ensure that
important email messages are always saved with the related entries
in your Maximizer Address Book and are available when you need
them.

Keep the following points in mind when tracking email threads with
Maximizer Outlook Integration:

e When you start tracking an email thread, only the current and
future emails are saved to the selected Address Book entry in
Maximizer. Any existing emails in Outlook that are part of the
same thread are not saved to the Address Book entry.

¢ If another Maximizer Address Book entry is added to an email
thread in Outlook that is already being tracked in Maximizer,
email messages in the thread are not automatically added to the
new Address Book entry's documents. If you want to track the
email thread with the new Address Book entry as well, you
should stop tracking the email thread and start tracking it again
to select the new entry.

* Once you start tracking an email thread, all messages in the
thread are saved to the documents of the selected entries. If you
no longer need to track an email thread make sure that you stop
tracking it to avoid filling up the documents of your Address
Book entries with unnecessary email messages.

n In Outlook, select or open the email message you want to track,
expand the Save and Track menu and select Save and track
messages in this thread.

If the “Confirm when saving email” option is disabled, the email
message is saved as a document to the Address Book entry that
contains the email address of the sender or recipient and all
future email responses to this message are automatically saved
to the matching entry's documents.

If the “Confirm when saving email” option is selected, the Save
Email to Maximizer Address Book Entry dialog box opens. The
Entries assigned for save list displays Address Book entries that
contain the email address of the sender or recipient. If no such
entries exist, this list is empty.

E If the entries that you want to track the email thread with do not
appear in the list, click Search Maximizer Address Book
entries.
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The Search Maximizer Address Book entries dialog opens.
B Enter the Last Name or Company of the Address Book entry
that you want to search for and click Search.

The search results are displayed in the list.

ﬂ Select the entries that you want to track the email thread with
and click OK.
The selected entries are added to the list.

¢ If you want to select multiple entries, hold down the Ctrl key
as you click each entry.

¢ C(Click View selected entry in Maximizer to open your
Maximizer Address Book and view the selected entry.

E Check the box next to each of the entries that you want to track
the email thread with and click OK.

E Select the Owner and Category that you want the tracked
emails saved under.

Click OK.

This email message and all future email responses to this
message are automatically saved to the documents of the
selected entries.

Stop Tracking an Email Thread

If you no longer need to save the messages in a tracked email
conversation to Maximizer, you can stop tracking the thread.

n In Outlook, select or open an email message in the thread that
you are tracking.

E In the Maximizer tab, select Stop Tracking Thread.

Future messages in the conversation will not be saved to
Maximizer.

Track Messages from an Email Address

You can track all email messages sent to and received from an email
address in your Maximizer Address Book using the Maximizer
Outlook Integration add-in.

When you choose to track an email address in Outlook, any emails
sent to or received from that email address are automatically saved
to the related entry's documents in Maximizer. By tracking email

addresses in Outlook you can ensure that emails from key contacts



@ To enable or disable the
“Confirm when saving email”
option, select the Maximizer
Outlook Integration Options
icon.
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are always saved with the related entries in your Maximizer Address
Book and are available when you need them.

Keep the following points in mind when tracking email addresses
with Maximizer Outlook Integration:

When you start tracking an email address, only the current and
future emails are saved to the related Address Book entry in
Maximizer. Any existing emails in Outlook that were received
from or sent to the email address are not saved to the Address
Book entry.

Once you start tracking an email address, all messages sent to or
received from that email address are saved to the documents of
the related entry. If you no longer need to track an email address
make sure that you stop tracking it to avoid filling up the
documents of your Address Book entries with unnecessary email
messages.

In Outlook, select or open an email message from the email
address you want to track, expand the Save and Track menu
and select Save and track messages sent to and from this
email address.

If the “Confirm when saving email” option is disabled, the email
message is saved as a document to all Address Book entries with
a matching email address and all future emails sent to or from
this email address are automatically saved to the matching
entries’ documents.

If the “Confirm when saving email” option is selected, the Save
Email to Maximizer Address Book Entry dialog box opens. The
Entries assigned for save list displays Address Book entries that
have a matching email address. If no such entries exist, this list is
empty.

If the entries that you want to save the tracked message to do
not appear in the list, click Search Address Book entries.
The Search Maximizer Address Book entries dialog opens.
Enter the Last Name or Company of the Address Book entry
that you want to search for and click Search.

The search results are displayed in the list.

Select the entries that you want to save the tracked emails to
and click OK.

The selected entries are added to the list.

¢ If you want to select multiple entries, hold down the Ctrl key
as you click each entry.

e Click View selected entry in Maximizer to open your
Maximizer Address Book and view the selected entry.
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E Check the box next to each of the entries to which you want to
save the tracked emails.

E Select the Owner and Category that you want the tracked
emails saved under.

Click OK.

The current email message and all future emails sent to or
received from this email address are automatically saved to the
documents of the selected entries.

Stop Tracking an Email Address

You can view a list of the email addresses that you are tracking with
the Maximizer Outlook integration.

If you no longer need to save the messages sent to or received from a
tracked email address in Maximizer, you can stop tracking the email
address.

n In Outlook, on the Maximizer tab, select View Tracking List.

The Email Tracking List dialog opens showing a list of the email
addresses being tracked.

E Click the Stop Tracking link next to the email address that you
want to stop tracking.
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Microsoft Outlook Synchronization

Microsoft Outlook Synchronization mirrors select appointments,
tasks, and Address Book entries between Maximizer and Microsoft
Outlook to ensure the entries exist in both programs and that they
both contain the same information. Outlook Synchronization is
included in Outlook Integration for Maximizer.

About Microsoft Outlook Synchronization

Outlook Synchronization settings are configured on a per-user basis,
and each Maximizer user has one set of configuration settings.
Outlook Synchronization preferences enable you to specify the
following settings:

e The frequency of synchronization. This setting determines how
often entries are synchronized including the option only to
synchronize manually.

e Conflict resolution options. When an entry has changed in both
Maximizer and Outlook since the last synchronization, you can
choose to have the Maximizer entry override the Outlook entry,
or vice-versa.

e The type of entries to synchronize. You can choose to
synchronize appointments, tasks, and Address Book entries.

e The date range within which appointments and tasks are
synchronized. All appointments and tasks scheduled within the
specified date range are synchronized. These settings apply to
appointments and tasks in both Maximizer and Outlook.

¢ Phone number mapping options. You can specify a mapping
between each phone number field in your Outlook contacts and
a corresponding field in your Maximizer Address Book entries.

You cannot use Outlook Synchronization if MaxSync for Microsoft
Exchange is installed and configured for the current Address Book
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@The “Sync Issues” folder in
Outlook contains log files and
items that Outlook has been
unable to synchronize with
Microsoft Exchange. This
folder does not apply to
Outlook Synchronization with
Maximizer.

Synchronizing Appointments and Tasks with Microsoft Outlook

Recurring Appointments

When Outlook Synchronization is configured, it can synchronize
select appointments and tasks between the Maximizer Address Book
and Microsoft Outlook. Appointments and tasks scheduled within
the specified date ranges are synchronized. As well, the following
activities are synchronized:

e If an instance of a recurring appointment occurs within the
specified date range, all instances of the recurring appointment
are synchronized.

e If atask is scheduled prior to the specified date range, but the
“Carry forward unfinished tasks” option is selected, the task is
synchronized.

You can specify whether or not to include private appointments and
tasks in the synchronization.

The Products/Services, Categories, attendees, resources, and any
notes you add to appointments in Maximizer are synchronized to
Outlook. These items appear as part of the appointment dialog box
in Outlook.

In Maximizer, you can specify custom values for the priority field in
Hotlist tasks. However, in Outlook, all tasks are set with Low, Normal,
or High priority. When a custom priority is specified in Maximizer,
the task is created with Normal priority in Outlook. When the task is
synchronized again, the priority is set as "Med" in Maximizer and the
custom value is lost.

Recurring appointments in Microsoft Outlook synchronize to
Maximizer as recurring appointments unless they have no end date.
If the recurring appointment has no end date, only the first
occurrence synchronizes with Maximizer, not the recurrences. To
synchronize recurring appointments with Maximizer, always provide
an end date.

Note that while it is possible to modify the Private property of a

single instance of a private appointment in Maximizer, this property
can be changed only for the entire series of recurring appointments
in Outlook. Therefore, if you change the Private property of a single



Recurring Tasks

Group Appointments
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instance of a recurring appointment in Maximizer, this change will
not be synchronized to Outlook.

If you synchronize a recurring task from Outlook, and then mark the
task as complete in Maximizer, Maximizer cannot create the next
instance of the recurring task. You should mark the task as complete
in Outlook, which will create the next instance of the task, and then
re-synchronize with Maximizer.

If you synchronize a recurring task from Outlook, and then delete

the task in Maximizer, all instances of the recurring tasks are deleted.
If you want to delete a single instance of a recurring task, you should
delete the task in Outlook and then re-synchronize with Maximizer.

When using Outlook Synchronization, group appointments in
Maximizer synchronize to Outlook for the current user only.
However, the synchronized appointment in Outlook includes all the
locations, resources, and attendees information in the appointment
notes.

Synchronizing Contacts with Microsoft Outlook

When Outlook Synchronization is configured, it can synchronize
select contacts between the Maximizer Address Book and Microsoft
Outlook. Contacts in the specified category in Outlook are
synchronized with the Address Book entries in the specified favorite
list in Maximizer.

Phone numbers in your Outlook contacts are synchronized with the
corresponding fields in your Maximizer Address Book entries
according to the Phone Mapping settings specified in your Microsoft
Outlook Synchronization Options.

Configure Microsoft Outlook Synchronization

To complete this procedure, Outlook Integration for Maximizer must
be installed.

You can set up Outlook Synchronization in the Outlook Integration
for Maximizer Wizard that runs when you first open Outlook after
installing Outlook Integration. After setting up Outlook Integration,
you can change the settings at any time.
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@ This procedure is written for
Microsoft Outlook 2010. The
steps may differ slightly in
earlier versions of Outlook.

n In Outlook, on the Maximizer tab, select Preferences.

The Maximizer Outlook Integration dialog box opens.
E Click Synchronization Options.

E Under Frequency, specify how often Maximizer should
synchronize with Outlook.

If you select Never (manual synchronization), you must initiate
synchronization manually.

ﬂ Under Conflict resolution, specify how to handle entries that
have changed in both Maximizer and Outlook since the last
synchronization.

E To synchronize appointment, select Synchronize
appointments.

¢ Inthe From and To fields, specify the date range of the
appointments included in synchronization.

e Select or clear Include private appointments to include or
exclude appointments marked as private in the
synchronization.

E To synchronize tasks, select Synchronize tasks.

¢ Inthe From and To fields, specify the date range of the tasks
included in synchronization.

e Select or clear Include private tasks to include or exclude
tasks marked as private in the synchronization.

e Select or clear Carry forward unfinished tasks to include
or exclude tasks that are scheduled before to the time range
and are not yet marked as complete.

To synchronize Maximizer Address Book entries and Outlook
contacts, select Synchronize Address Book entries.

¢ In the Synchronize Address Book entries from Favorite
List drop-down list, select the Maximizer Favorite List to
synchronize.

¢ In the Synchronize Contacts from Outlook Category
drop-down list, select the Outlook category to synchronize.

E’ To specify the mapping between Outlook and Maximizer phone
number fields, click Phone Mapping, and select the Maximizer
phone number field to map to each Outlook phone number
field.

For each phone number field in the Outlook column that you
want to synchronize, select a corresponding field in the
Maximizer column, and click OK.

Each Maximizer phone number field can only be mapped to one
Outlook phone number field.
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El ciick ok.
nmCIick OK to save all changes in the Outlook Integration settings.

Manually Synchronize with Microsoft Outlook

To complete this procedure, Outlook Integration for Maximizer must
be installed.

You can manually synchronize entries between your Maximizer
Address Book and Microsoft Outlook at any time.

@This procedure is written for ¢ In Outlook, on the Maximizer tab, select Sync with

Microsoft Outlook 2010. The Maximizer
steps may differ slightly in ’
earlier versions of Outlook.
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Opportunities

Organize Your Sales with Opportunity Management

In this chapter...

“About Opportunities” on page 238

“Adding Opportunities” on page 242

“Competitors and Partners” on page 244

“Assigning Campaigns to Opportunities” on page 247
“Opportunity Status” on page 251

“Sales Teams” on page 253

“Strategies” on page 255

“Multi-Currency” on page 259

“Email Notification for Opportunities” on page 263
“Quotas” on page 267
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About Opportunities

Opportunities Page

Opportunity management helps you and your colleagues manage
your sales processes. Sales prospects may range from single
businesses to multiple corporations or governments. Opportunities
help you define and strengthen your selling methodology

You can use opportunities to formalize your sales processes.

e C(Create strategies—detailed plans that identify the factors that
influence a sale and the activities you must perform to close the
opportunity.

e Apply these strategies to opportunities.

e Effectively schedule and coordinate the selling process among all
members of your sales team.

e Ensure that all the right people in your organization have up-to-
date information about the status of your opportunities.

*  Forecast the probability of successfully closing your
opportunities.

* Analyze the effectiveness of your strategies and create new ones
for new opportunities.

In short, your sales team can define a strategy—what you need to do
to close a sale and how to address the issues and obstacles involved—
and then apply this strategy to opportunities.

Keep the following points in mind when working with the
Opportunities page:

n Select the Opportunities icon to open the Opportunities page.

E View information on the current opportunity in the Details tab
of the following pane.

B Click the View in Address Book button in the menu bar or
choose the option from the shortcut menu to open the Address
Book page and view the Address Book entry associated with the
current opportunity.
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Search for Address Book entries. .,

3 Edit Wisw Search v Actions v Report Help + @ ﬂ ﬁ 7 ]
Status | Company/individual Ohjective [ stage | Revenue | & lose Date |
») QuickAccess @ In Progress Farmer & Co, Acauire as distributar Make Initial Contact $75,000.00 april 17, 2014 -
@ & # ¥ | @hnPoges Happy Times Restaurant Suj  Acquire as reseller Custamer's Review $98,000.00 April 18, 2014
- @ In Progress Astor Wines & Spirits Do Seasonal Pramotion Mot Started $60,000.00 april 22, 2014
2| pashbaards
@ In Progress Atlas Food Inc Do Seasonal Pramation Customer's Review $5,555.00 May 16, 2014
’E, My Work Day @ In Progress Ansiey Wine Merchants Promote summer line Mok Started $72,000.00 May 23, 2014
I:(‘§ Address Book @ In Progress Farmer & Ca, Promate summer line Make Initial Contact $75,000.00 May 23, 2014 ‘; ‘
[5] quotas Details | Contacts | History | Wotes | User-Defined Fields | Strateqy | Documents | Activities |+ @+ 4+
r;‘ Campaigns
’_:‘ Customer Sepice Acquire as reseller ey Fields for: General Opportunities -3 Qe Actions
. Probability of close: 79% [ ] Add a note
@‘ Knowledge Base: Status: In Progress Gompany Information Add a document
Stage: Customer's Review Region: Mid West Write an email
-] atist Confidence rating:  Cold
E Stare sizs: Under 2,000 square feet Create an opportunity
Calend it (2 Print = itori
alendar o Edit (S Print 2 Monitoring Wine Preference: Imported Make a cal
':Q Company Library Mumber of Retail Lines: =2 Receive a cal
Basic information
Humber of Distributars: 3 Tirme:  task
Comp i Happy Times Supplies .y
0 Videa Tuterials Products | Services:  Accessories Opportunities Details Sl @ mE=ing
st scheduls a to-do
Categories: Other Close Date: april 18, 2014
. . scheduls an Action Plan
&l User nformation» | | SyStem information + Revenue: 498,000.00
e Team: channel Sal + Favorite lists
5l s » sles Team: annel Sales
- N Leader: Joe Napoli
@ Administration  »

Change the List of Opportunities

@ You can also use the options
on the Search menu to search
for opportunities.

To complete this procedure, you must have Read permission for
opportunities

When you first open the Opportunities page, all In Progress
opportunities assigned to you or to your sales teams are displayed.
You can change the list of opportunities displayed to show all
opportunities assigned to you or to your sales teams, including closed
and suspended opportunities. If you use MaxExchange, you can also
choose to view only opportunities that have been updated by remote
sales teams.

¢ Inthe Opportunities page, open the View menu, and select one
of the following options:

All Opportunities - To display all opportunities that you
have the rights to view.

Current Opportunities — To display the opportunities that
are in progress.

Team Updated Opportunities - To display opportunities
that have been updated by remote sales teams.
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View an Opportunity from an Address Book Entry

You can view the opportunities associated with a specific Address
Book entry in the Opportunities following pane. From the Hotlist
page, you can view the opportunities for the Address Book entry
associated with the current task.

n Select the Address Book entry or Hotlist task.

E Select the Opportunities tab of the following pane.

All opportunities for the current Address Book entry are
displayed in the list.

{ Jser-Defined Fislds | Documents | Customer Service | Opportunities | » 4 ¥

Columns: “Default Opportunity View » | [53 2 | ] ] View: Al Dpportunities - @9
- Status Company/Individual | Objective Stage Revenus Close Date

+  GPwon Farmer & Co. Acquire new customer Hot Started $75,000.00 May 28, 2012

@ In Progress Farmer & Co. Fromote summer line: Maks Initial Contact $75,000,00 May 23, 2014
@ In Progress Farmer & Co. Acquirs s distributor Maks Initial Contack $75,000,00 April 17, 2014

B Click on an opportunity to open the Opportunities page and
view details on the opportunity.

Retrieve Address Book Entries Associated with Opportunities

You can retrieve the Address Book entries associated with
opportunities and add them to the current list in the Address Book
page. If a contact is associated with the opportunity as well as a
company or individual, both the contact and the company or
individual are retrieved and added to the list.

You can retrieve the Address Book entries associated with a single
opportunity, or you can select multiple opportunities to retrieve the
Address Book entries associated with all of the selected entries at
once.

n Click on the opportunity to make it the current entry.
—or-
Select multiple opportunities.
¢ Click the checkbox to the left of entries.

e Click on the entries one at a time while holding down the
Control key.
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¢ To select all entries between two entries, select an entry and,
while holding down the Shift key, select another entry.

E Select View > View in Address Book.

The Opportunities tab or following pane displays the opportunities
associated with the current entry. In the Opportunities following
pane for an Address Book entry, all opportunities associated with the
entry are displayed. In a campaign, all opportunities to which the
campaign is assigned are displayed. Generally, the opportunities are
for Address Book entries subscribed to the campaign.

Opportunities are displayed in a list based on criteria specified in the
status and close date filters. You can select and sort entries like in
other lists in Maximizer.

e To view details of an opportunity, click on the entry.

e  From the Columns drop-down list, select an existing
opportunity column setup to change the fields displayed in the
list.

e To add or delete opportunities, use the icons in the view bar at
the top of the list.

You can add opportunities only from an Address Book entry, not
from a campaign.
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Adding Opportunities

Add an Opportunity
To complete this procedure, you must have Insert permission for
opportunities.
All opportunities are associated with Address Book entries. To create
an opportunity, you must select or open an Address Book entry or an
existing opportunity, customer service case, or activity associated
with the Address Book entry.
n Click on the Address Book entry or on an opportunity associated
with the Address Book entry to make it the current entry.
In the Hotlist page, click on an activity associated with the
Address Book entry to make it the current entry.
@Ygg can seleﬁt a differeﬂt E In the Address Book page, select Actions > Create an
Address Book entry in the H
Opportunity Entry dialog box Opportunity.
by clicking the ellipsis button —or-
beside the Company/Individual
field. In the Address Book or Hotlist page, in the following pane, select

the Opportunities tab, and select the Add icon.
In the Opportunities page, select Edit > Add Opportunity.

In the Address Book page, right-click and select Create an
Opportunity.

—or —

In the Opportunities page, right-click and select Add
Opportunity.

—or —

In the following pane, select the Details tab, and under
Actions, select Create an opportunity.

The Details pane opens.

E Specify the basic fields for the opportunity.

e Enter the opportunity Objective. The objective should
describe the goal of this opportunity.

e Select the applicable Products/Services and Categories.
¢ Enter the Description of the opportunity.
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e Under Opportunity Analysis, select a Stage and
Confidence Rating for the opportunity.

@ Mandatory opportunity fields ﬂ From the Key Fields for drop-down list, select a Key Fields list,
are denoted by an asterisk. and enter values for the fields in the list.

E Click Save to save the opportunity.

Key Fields for: General Opportunities - 2 @

Company | Individual: | All The Best Spirts Gompany Information
Contact: Kline, winifrad a
sgion: -
Products | Services: Al -
Store size: Under 2,000 square Feet -
Cateqories: California - .
Wine: Preference: -
Ohbjective: Increase sale For Upcoming season -
) Humber of Retail Lines: 3-5 -
Description: Existing customer. Would like to increase the order For the
Sumimer 2014 season Mumber of Distributors:

Opportunities Details

’ ) Close Date: 3
Opportunity analysis ose bk My 16, 2014
Revenue: $ 2,000.00 v

Stage: Male Initial Contact -
Sales Team: West Caast Sales -

Confidencs rating; | Warm -
Next Action: -
Status Leader: Joe Napal (Team Leader) -

To complete this procedure, you must have Insert permission for
opportunities. To copy the associated notes or documents you must
also have Insert permission for notes or documents.

Use this procedure to create a new opportunity from an existing
opportunity. You have the option of copying all notes, documents,
appointments, and tasks associated with the entry.

If there's a strategy assigned to the opportunity, the strategy details
are copied to the new opportunity but the strategy remains
unscheduled. You must schedule the strategy in the new opportunity
to create the tasks included in the strategy.

n Click on the opportunity to make it the current entry.

E Select Edit > Duplicate Current Entry.
The Duplicate Entry dialog box opens.

E Select the entries that you want to copy to the new entry, and
click OK.
¢ Notes duplicates all notes associated with the current entry.
¢ Documents duplicates all document.

e Appointments and tasks duplicates incomplete
appointments and tasks associated with the current entry.
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Competitors and Partners

About Competitors

You can associate Address Book entries as partners and competitors
in your opportunities.

Competitors are other companies that are in competition to win the
current opportunity. You can add multiple competitors to an
opportunity, selecting Companies, Individuals, or Contacts as
competitors. If you later lose the opportunity, you can select the
competitor who won the opportunity while closing the opportunity.

Set an Address Book Entry as a Competitor

To complete this procedure, you must have Modify permission for
Address Book entries and full access to the current entry.

Use the Competitor value in the Category field to classify your
Address Book entries as competitors.

n Click on the Address Book entry to make it the current entry.
E In the following pane, select the Details tab, and click Edit.

ﬂ If necessary, from the Key Fields for drop-down list, select a
Key Fields list that contains the Category field.

By default, the Category field is included in the <Default Key
Fields> list.

n From the Category drop-down list, select Competitor.

E Click Save to save all changes to the entry.

Add a Competitor to an Opportunity

To complete this procedure, you must have Modify permission for
opportunities.

You can add any Address Book entry as a competitor in an
opportunity. You can also add a note about the competitor. While
searching for the entry, you can restrict the search to only Address
Book entries that are set as competitors.



Chapter 8 | 245

n Click on the opportunity to make it the current entry.
E In the following pane, select the Details tab, and click Edit.

B Next to Competitors, click Assign competitor.

The Select Competitor dialog box opens.

n Search for the competitor by last name or company name.

Leave the Competitors only checkbox selected to restrict the
search to Address Book entries set as competitors.

E In the Entries available for assignment from search results
list, select the entry, and click OK.

E Optionally, in the Comment box, enter a comment for the
competitor.

Click Save to save the changes to the opportunity.

About Partners

Partners are your business partners that you work with on the
current opportunity. You can select Companies, Contacts, or
Individuals as partners.

Set an Address Book Entry as a Partner

To complete this procedure, you must have Modify permission for
Address Book entries and full access to the current entry.

Use the Partner value in the Category field to classify your Address
Book entries as business partners.

n Click on the Address Book entry to make it the current entry.
E In the following pane, select the Details tab, and click Edit.

B If necessary, from the Key Fields for drop-down list, select a
Key Fields list that contains the Category field.

By default, the Category field is included in the <Default Key
Fields> list.

ﬂ From the Category drop-down list, select Partner.

E Click Save to save all changes to the entry.
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Add a Partner to an Opportunity

To complete this procedure, you must have Modify permission for
opportunities.

You can add any Address Book entry as a partner in an opportunity.
You can also add a note about the partner. While searching for the
entry, you can restrict the search to only Address Book entries that
are set as partners.

n Click on the opportunity to make it the current entry.

E In the following pane, select the Details tab, and click Edit.

E Next to Partners, click Assign partner.
The Select Partner dialog box opens.

ﬂ Search for the partner by last name or company name.

Leave the Partners only checkbox selected to restrict the search
to Address Book entries set as partners.

E In the Entries available for assignment from search results
list, select the entry, and click OK.

E Optionally, in the Comment box, enter a comment for the
partner.

Click Save to save the changes to the opportunity.
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Assigning Campaigns to Opportunities

You can associate automated campaigns with opportunities to
identify which campaigns are the sources of your opportunities. In
the campaigns, you can calculate the revenue generated by all of the
opportunities associated with the campaigns.

From an open campaign, you can view the opportunities associated
with the current campaign in the Opportunities tab.

Email Campaign - 2011 Fall - Email Campaign - 2011 Escona Wines [¥]

& 3 | [Z] | [ Actions +

Campaign Information  Opportunities Motes Documents Activities

View: Al Opportunities - e @
Columns: Joe's View LK EEm Close Date: Al Dates
« Status Company fIndividual Objective Account Manag: | Product [ord
@ In Progress Albert's Steak House Get New Listing on Wine List Jon Bowser Blend
+/ | @ InProgress All The Best Spirits Increase Order for Holiday Season  Mark Bertoli  Cab Franc, Caberne  Cz
@ In Progress Armanetti Wine Shoppe Get Escona on Wine List Mark Bertoli  Chardonnay, Pinot1 Cz
@ wian Palmer Vineyards Do Seasonal Promotion Mark Bertoli  Chardonnay, Gewu  Fr

You can assign campaigns to opportunities manually at any time
after creating an opportunity. You can also assign campaigns
automatically to new opportunities by specifying settings in your
user preferences.

The system administrator can set the campaign field as a mandatory
field to ensure all opportunities are associated with campaigns. You
may want to have a generic campaign to associate with
opportunities that do not correspond with existing automated
campaigns. For example, someone can create a campaign named
"None", which doesn’t contain any campaign activities for this
purpose.

You must have Read permission for campaigns to assign a campaign
to an opportunity. If the Campaign field is set as a mandatory field,
you cannot create or modify new opportunities without this
permission.
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Assign a Campaign to an Opportunity

To complete this procedure, you must have Read permission for
campaigns and Modify permission for opportunities.

You can associate existing automated campaigns with opportunities.

n Click on the opportunity to make it the current entry.
E In the following pane, select the Details tab, and click Edit.
E If necessary, from the Key Fields for drop-down list, select a
Key Fields list that contains the Campaign field.
By default, the Campaign field is included in the <Default Key
Fields> list.
n Select the Campaign field.
The Assign Campaign to Opportunity dialog box opens.

E Enter the search criteria for the campaign.
¢ In the Campaign Name field, specify the name of the
campaign.

¢ Inthe Products/Services and Categories fields, specify the
products, services and categories associated with the
campaign.

By default, the Products/Services and Categories values from
the opportunity are selected.

e Under Start date range, specify the date range for the
campaign start date, or select Search all dates.

¢ Under Find matching, select the status values of the
campaigns.

e Select Opportunity’s Address Book entry is subscribed
to campaign to return only the campaigns to which the
Address Book entry associated with the opportunity is
subscribed.

E Click Search.

The automated campaigns matching the search criteria are
displayed.

Select the campaign and click OK.
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Assign Campaign to Opportunity for All The Best Spirits - Mozilla Firefox ==
Search for campaign
Campaign Name:
Products/Services: E
Catagories [
Start date range Find matching
From: Until: V| New Abandoned
22802011 & amarzo11 & YIin progress || suspended
Search all dates | completed
/| opportunity's Address Book entry is subscribed to campaign
Campaigns avaiable for assignment from search resutts
Hame Start Date Completion Status Products/Services Categories
P Email Campaign - Spring 20 2011-03-29 In Progress

B Click Save to save the changes to the opportunity.

Automatically Assign Campaigns to Opportunities

To complete this procedure, you must have Read permission for
campaigns.

You can set your preferences to assign existing campaigns
automatically to new opportunities. If an Address Book entry is
subscribed to a campaign, the campaign is assigned to any new
opportunities for the Address Book entry within a specified time
period. If the Address Book entry is subscribed to multiple campaigns
in the time period, you are prompted to select a campaign when you
first create the opportunity.

n In the top-right corner of the page, click on your image, and
select Preferences.

The Personal Preferences dialog box opens.

E Select Automatically assign campaign when creating a
new opportunity.

ﬂ From the Limit the search to campaigns created drop-down
list, select the time period in which campaigns must be created.

You can limit the search to campaigns created in the current
year, quarter, or month.
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To ignore the creation date of campaigns, select All Dates.

ﬂ Click Save to save the changes to your preferences.
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Opportunity Status

When you add a new opportunity, its status is set to “In progress”. By
default, when you open the Opportunities page, your current, or “In
progress”, opportunities are displayed. You can change the status of
an opportunity to indicate that the opportunity is won, lost,
abandoned, or suspended.

Complete an Opportunity

To complete this procedure, you must have Modify permission for
opportunities, and you must either be assigned as the leader or be a
team member with edit rights in the opportunity.

You can complete an opportunity to indicate that the opportunity is
won, lost, or abandoned. While completing the opportunity, you can
select a reason and enter comments on the opportunity. The
completion reasons are set in Administrator. The list differs
depending on the status of the opportunity.

If the opportunity is won, the revenue for the opportunity is
recognized against any quotas assigned to the leader or sales team. If
the Address Book entries associated with the opportunity are sales
leads, the entries are automatically converted to regular entries (not
sales leads).

n Click on the opportunity to make it the current entry.
E In the following pane, select the Details tab, and click Edit.

B From the Status drop-down list, select the status of the
opportunity: Won, Lost to, or Abandoned.

ﬂ If the opportunity is won, in the Actual Revenue field, enter
the revenue for the opportunity.
By default, the projected revenue is displayed.

E If the opportunity is lost, from the Lost To drop-down list, select
the competitor who won the opportunity.
You can select any competitors assigned to the opportunity.

E From the Reason drop-down list, select a reason for completing

the opportunity, and in the Comment field, enter a comment,
as desired.
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Status

Status: wion -

Completion details
Actual Revenus: 3,000,00

B o

Daks: Saturday, March 05, 2014

4

Reason: Like Selection

Comment: We have a good relationship with this customer. Expect them to

increase again next season.

Click Save to save the changes to the opportunity.

Suspend an Opportunity

To complete this procedure, you must have Modify permission for
opportunities, and you must either be assigned as the leader or be a
team member with edit rights in the opportunity.

When you suspend an opportunity, it is no longer displayed in the list
of current opportunities. When the opportunity is suspended, you
can continue to modify the opportunity. If a strategy is scheduled for
the opportunity, you cannot modify the success factors, roles, and
steps in the opportunity. Any unfinished activities are removed from
the Hotlist. If you later reopen the opportunity, the activities are
returned to the Hotlist.

n Click on the opportunity to make it the current entry.
E In the following pane, select the Details tab, and click Edit.

ﬂ From the Status drop-down list, select Suspended.

n From the Reason drop-down list, select a reason for suspending
the opportunity, and in the Comment field, enter a comment,
as desired.

E Click Save to save the changes to the opportunity.
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Sales Teams

Maximizer offers you the ability to assign an opportunity to any sales
team your system administrator has set up in Administrator. Teams
allow you to delegate individual activities of the opportunity to
members of the team. These activities appear in the team member’s
Hotlist for completion by the scheduled time. These teams are
created and managed in Administrator.

Sales Team Members

Sales team are composed of the following types of members:

e Team leader - In a team, one person is designated as a team
leader who has the right to make any changes to the
opportunity. The team leader can schedule strategies for
opportunities, assign the activities in the strategies to other
team members, and change the status of opportunities.

e Team member - Regular team members can update the basic
and user-defined fields in an opportunity, but they do not have
the right to change the strategy or the status of the opportunity.
The member’s role is to perform the tasks the team leader
assigns. Team members can modify the tasks from the Calendar
and Hotlist pages.

e Team member with edit rights - Team members can be
granted edit rights for opportunities, giving the team member
the same abilities as the team leader.

Assign a Sales Team to an Opportunity

You can assign sales team to opportunities while adding or
modifying the opportunities. Members of the selected sales teams
can be specified as leaders of opportunities.

n Click on the opportunity to make it the current entry.
E In the following pane, select the Details tab, and click Edit.

ﬂ If necessary, from the Key Fields for drop-down list, select a
Key Fields list that contains the Sales Team and Leader fields.

By default, the Sales Team and Leader fields are included in the
<Default Key Fields> list.

n From the Sales Team drop-down list, select the sales team to
assign the opportunity to.
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E From the Leader drop-down list, select a member of the selected
sales team as the leader of the opportunity.

B Click Save to save the changes to the opportunity.
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Strategies use multiple factors to assess the probability of winning
opportunities. They provide a way of forecasting based on defined
metrics for the criteria of closing an opportunity. If your company has
existing methods of calculating the probability of winning
opportunities, they can be translated into strategies. Strategies are
most often used in complex projects involving large risk or long-term
planning.

After you have gathered your organization’s strategy information,
you can enter this information into the Strategy Library. You can
enter an unlimited number of strategies, and you can use the
components of one strategy to build other strategies.

Strategies must be created in Maximizer. In Maximizer Web Access,
you can schedule strategies for your opportunities and add and
modify strategy components in opportunities.

Strategies are made up of the following components:

e Steps - Astep is a milestone in the strategy that reflects actions
that must be taken when pursuing the opportunity. Each step
represents one or more activities that must be accomplished
before the step is considered complete.

e Activities - An activity is an action that forms the smallest
building block in the strategy. As your organization works
through an opportunity, activities are sent to the team members.
An activity contains a description of the action, an estimate of
the time it will take, and an estimate of its cost.

* Roles - A role represents a person who directly affects the
outcome of an opportunity. You assign each role a weight based
on how much you think that person affects the probability of
closing the opportunity. In each opportunity, you can assign
roles to specific Contacts in your Address Book.

* Success Factors - Factors such as cost, features, and customer
needs will influence the sale of your product or service. When
you develop a strategy, choose success factors that you believe
will play a large part in determining the successful outcome of
an opportunity. Then assign each success factor a weight based
on your assessment of how much it will influence the outcome of
the opportunity.



256

Maximizer Web Access
User's Guide

Schedule a Strategy for an Opportunity

Schedule a strategy from the Strategy Library for an opportunity.
This will ensure you keep up to date with all of the roles, success
factors, and steps that influence an opportunity’s success.

Note that if you change the scheduled strategy for an opportunity,
all incomplete activities for the initial strategy are removed from the
opportunity. Complete activities remain in the opportunity. After a
different strategy is scheduled for an opportunity, the activities
associated with that strategy are applied to the opportunity. If you
had standings associated with roles in the previously scheduled
strategy, the standings are carried over to the newly scheduled
strategy.

n Click on the opportunity to make it the current entry.
E In the following pane, select the Strategy tab.
B Click Schedule.

ﬂ From the Select a strategy template drop-down list, select a
strategy.

You can click View Details to view specific properties of the
strategy such as the description and cost.

E In the Select a start date field, select the start date for the
strategy.

E For each role in the strategy, click in the Standing column and
select a standing for the role.

You can also click in the Contacts column to select a Contact for
the role.

For each success factor in the strategy, click in the Standing
column and select a standing for the success factor.

You cannot apply standings to the “On Schedule” and “Political
Alignment” success factors. They are calculated automatically.

E’ Select a step and click the plus sign to view all activities for this
step.

E If a team is assigned to the opportunity, delegate team members
to specific activities in steps. Click on an activity and choose a
user from the Team member responsible for completion
drop-down list.

You can update the strategy as roles become more influential,
success factors change, and steps are completed. The progress
indicator changes automatically in alignment with the success of
the opportunity.
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¢ To mark an activity as complete, click inside the box displayed
after the activity. Overdue activities are denoted by a
warning symbol after the activity.

e Use the Show follow-ups option to display follow-up
activities related to an activity within a step.

¢ Use the Show done option to display completed activities.
(Otherwise, completed activities are removed from the step.)

e Use the Edit Roles, Edit Success Factors, and Edit
Activities drop-down lists to add, modify, or delete roles,
success factors, steps, and activities.

Roles Standing Score Contact W
Insider Wanks our product, has influence over purch... ~ | 48146 Winifred Kline
Success Factors Edit Success Factors ¥
Success Factors Standing Score Warning
Foltical Alignment Full support 45145 =
On Schedule on schedule 20i20
Budget Approved Funds are svaisble ~ | zmia0
Business Relationship Long, happy friendship 14114
Steps User: Al Users + [Clshow follow-ups Clshow completed
activities £t Steps v
Steps and Activities Date/Time Assigned to Status
Make initial contacts [ March 08, 2014 &
| call plan: Develop call plan: 1) Contacts March 08, 2014 108 Napol
identified 2) Cal obisctives established arch i, oe Hapal -

anhen you are finished, click OK.
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The progress indicator for the probability of close is updated based
on the weighted sum of the standing/score of the roles and success
factors, as well as the number of completed activities within a step.
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All success factors contribute to the probability of close.
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Enabling multi-currency in an Address Book enables users to enter
opportunity revenue in other currencies. All other currency fields are
displayed in the default currency for the Address Book, otherwise
known as the corporate currency. Additional currencies added to the
Address Book can be applied to opportunity revenue on a per-entry
basis.

Multi-currency is enabled in Administrator. If this functionality is not
enabled, all related fields, menu items, and dialog boxes are not
visible in Maximizer. Once multi-currency is enabled for an Address
Book, it cannot be disabled. The corporate, or default, currency for
the Address Book is also set in Administrator. For more information
on enabling multi-currency, granting users rights to manage multi-
currency, and setting the corporate currency, see the Maximizer CRM
Administrator’s Guide.

The corporate currency acts as the exchange rate baseline for other
currencies. The corporate currency always has an exchange rate of
1.0, and other currencies have their own exchange rates. The
exchange rates determine the revenue conversion from one currency
to another. By default, the corporate currency is US, but this can be
changed in Administrator.

Currencies are managed in the Currency Library in Maximizer. When
designated users are given the “Allow manage currencies” security
right in their user access rights, they can add, modify, and delete
currencies in the Address Book.

Currency Library ]

Entry currencies

a Code | Description Rate Last Modified | Add.. |
% CAD Canadian Dollar 1.03900000 2011-11-21 ‘ Mﬂd\fy |

EUR Eura 0.74100000  2011-11-21
usD® US Dollar 100000000  2011-11-21 | Delete

= Denotes the corporate currency Close

Once you add a currency, you can use it as the revenue currency for
any opportunity entry. The cost fields in the opportunity are always
displayed in the corporate currency.
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In addition to adding currencies, you can also modify and delete
currencies from the currency library using the buttons in the Currency
Library dialog box. When you modify an exchange rate for a
currency, the new rate is applied to existing opportunities that are in
progress and to new opportunities.

Add a Currency to the Currency Library

@ If you change your corporate
currency, all currency rates are
setto 1.

To complete this procedure, you must have the “Allow manage
currencies” privilege.

n In the left navigation pane, hover your mouse over
Administration, and select Currency Library from the pop-up.

The Currency Library dialog box opens.
H ciick Add.
The Add Currency dialog box opens.

B From the Currency drop-down list, select a currency.

The ISO code is entered automatically, but you can change this
field or leave it blank if necessary. For example, you may want to
use US, rather than USD, for the US Dollar.

ﬂ In the Exchange rate field, enter the value of the currency in
comparison with the corporate currency.

By default, this value is set to 1.
E If necessary, from the Requested by field, select a user.
[ ciick ok.

Add Currency - Mozilla Firefox ==
Creation details:
Currency: Australian Dollar - AUD
Exchangerate: 978 =1UsD
Crealor. |10e Napoi
Requestedby:  Joe Napoi -
Last Modified:
Date modified: |
Time modified: |
Modified by: [
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Modify a Currency in the Currency Library

To complete this procedure, you must have the “Allow manage
currencies” privilege.

You can modify some properties of existing currencies in the currency
library. If you select the corporate currency, you can modify only the
currency code and the user selected in the Requested by field. The
exchange rate of the corporate currency is always 1. If you select
another currency, you can also modify the exchange rate.

n In the left navigation pane, hover your mouse over
Administration, and select Currency Library from the pop-up.

The Currency Library dialog box opens.

E Select the currency you want to modify, and click Modify.
The Modify Currency dialog box opens.

Information on when the currency was last modified is displayed
at the bottom of the dialog box.

Medify Currency - Mozilla Firefox ==
Creation details:
Currency: | Canadian Dol CAD
Exchange rate: 0975 =1usD
Creator |Lou Jones
Requestedby:  Joe Napoli -
Last modification:
Date modified:  [2011-03-25
Time modified:  [10:27:27
Modified by: |Lou Jones

ﬂ Update the details of the currency, and click OK.

Change the Currency in an Opportunity

To complete this procedure, you must have Modify permission for
opportunities.

By default, opportunity revenue is calculated using the corporate
currency. But you can change the currency for the revenue while
adding or modifying an opportunity. Multi-currency must be enabled
in the current Address Book, and there must be more than one
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currency set up in the Currency Library in order to specify the
currency in an opportunity.

n Click on the opportunity to make it the current entry.
E In the following pane, select the Details tab, and click Edit.

E If necessary, from the Key Fields for drop-down list, select a
Key Fields list that contains the Currency field.
By default, the Currency field is included in the <Default Key
Fields> list.

ﬂ From the Currency drop-down list, select the currency.
The value in the Revenue field updates to reflect the selected
currency value.

E Click Save to save the changes to the opportunity.
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Email Notification for Opportunities

When opportunities are created, modified, abandoned, lost,
suspended, or won, email messages can be automatically sent to
partners and users notifying them of the changes. Maximizer
automatically inserts the basic details of the opportunity in the
message so you don’t have to write the email message with
opportunity details each time.

To set up opportunity email notification, you must create email
notification templates in Administrator. You can create separate
templates for each action (create, abandon, lost, suspended, or won).
Each action can also have separate templates for sending email to
partners and users. User notification email is sent to the users
identified as monitors for the opportunity.

For detailed information on how to create email templates for
opportunity notification, see the Maximizer CRM Administrator’s
Guide.

Configure Opportunity Monitoring

You can configure email notification for opportunities in the
monitoring preferences. You can specify to receive email notification
when notes are added or modified and when fields are changed. You
can also select specific fields to receive notification only when one of
the specified fields changes. You receive notification only for the
opportunities you are selected to monitor.

@ Monitoring preferences are n In the top-right corner of the page, click on your image, and
available only in Maximizer select Preferences.

CRM Enterprise Edition.
E Click Other Preferences.
El Select the Monitoring tab.

n In the Monitoring rules for drop-down list, ensure
Opportunities is selected.

E To receive notification when notes are added or modified, select
Receive monitoring notification on note changes.

E To receive notification when fields are changed, select Receive
monitoring notification on field changes, and select the
fields for which to receive notification.

e To receive notification when any field is modified, select All
fields.

¢ To receive notification when specific fields are modified,
select Only when one of these fields is changed, click the
ellipsis, and select the fields.
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Click OK to save the changes to the Preferences dialog box.

Preferences - Mozilla Firefox ==

Logging  CalendarHotlist =~ Monitering ~ Email  Startup L)

Monitoring rules for: Opportunties -

Monitoring rules
Specify the monitoring notification rules for Opportunities that you are monitoring.
| Receive monitoring notification on note changes
V| Receive monitoring netification on field changes
Al fields
@ Only when one of these fields have changed:
Close Date. Revenue, Status

| oK | | Cancel |

Select Users for Opportunity Monitoring

To complete this procedure, you must have Modify permission for
opportunities.

A default list of opportunity monitors is set up in the opportunity
preferences in Administrator. You can select this default list, or you
can select any other users to monitor specific opportunities. You can
also choose not to monitor a specific opportunity.

Opportunity monitors receive email messages based on templates set
up in Administrator. You can create different templates for each type
of action. See the Maximizer CRM Administrator’s Guide for details.

You can also specify how to monitor new opportunities in the
default opportunity entry.

n Click on the opportunity to make it the current entry.

E Select Edit > Opportunity Monitoring.
Right-click, and select Opportunity Monitoring.

In the following pane, select the Details tab, and click
Monitoring.
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B Select one of the opportunity monitoring options.

¢ Select Do not monitor this opportunity to remove all
users from the list so no user receives email regarding this
opportunity.

¢ Select Use the system default opportunity monitoring
user list to display the users specified in the system default
opportunity monitoring list.

¢ Select Use the custom list below to modify the list of users
who monitor the opportunity.

Select Users for Opportunity Monitoring ]
Select which list of users should monitor this opportunity
Do not monitor this opportunity
Use the system default opportunity monitoring user ist
©! Use the custom list below
Selected users for opportunity monitoring
Daniel Brown Add...
Joe Napoli
Jon Bowser

n If you select to use a custom list for opportunity monitoring, click
Add to add a user to the list.

The Assign User dialog box opens. A list of available users is
displayed on the left and the current list of opportunity monitors
is displayed on the right.

E Select users from the list on the left and click the right arrow
button to add the users to the list on the right.

e To select multiple users, press Control while selecting the
users.

e To select a series of users, select the first user in the series,
then press Shift and select the last user in the series.

e Type the first letter in the item’s name to jump to that item in
the list.

e Select a security group, team, department, or division to add
all members of the group to the list.

Users are grouped by the security groups, teams, departments,
and divisions to which they belong if you have the “Display users
by groups” option enabled in your preferences.

E Click OK to close the Assign User dialog box.
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Assign User - Mozilla Firefox ==

Select a user to assign

All Users Selected User(s)
= Billie Holly & Joe Napol (555) 7750982 -

S Celine Dancer & Lou Jones (555) 775-0967

& Daniel Brown
°

8 Joe Napo

& Jon Bowser
°

8 Lou Jones
& Lucy Garcia
°

& Mark Bertoli

:
& Natt Graham
& Hiranda Corel

* Wonda White

Departments

Divisions

Security Groups

Teams -

Click OK to save the changes to the opportunity monitoring list.



Quotas

@ Quotas are available only in
Maximizer CRM Enterprise
Edition.

Quotas Page

@ The year shown in the Fiscal
Period column refers to the
year that the fiscal year ends.
This value may differ from the
calendar year for some months
and quarters.
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You can manage sales quotas for teams, territories, and leaders
assigned to opportunities. Sales quotas keep track of the revenue
from opportunities compared to the quota applied to the team or
leader assigned to the opportunities.

Sales managers can create quota templates. And all users with
adequate quota permissions can apply quotas to sales teams,
territories, and opportunity leaders.

You can view your current sales quotas in the Quotas page. Keep the
following points in mind when working in the Quotas page:

n Click the Quotas icon to open the Quotas page.

E In the main area of the window, view the progress of
opportunities for users, sales teams, and territories compared to
the quotas. The following columns are displayed:

¢ Name - The name of the opportunity leader, team, or
territory that the quota is assigned to.

¢ Fiscal Period - The milestone that the quota applies to.

¢ Quota - The amount of the quota in the milestone.

¢ Weighted Forecast — The weighted revenue of all
opportunities that are in progress and are scheduled to close
during the milestone.

¢ Unweighted Forecast - The total revenue of all
opportunities that are in progress and are scheduled to close
during the milestone.

¢ Closed Sales - The total revenue of all opportunities that
are won during the milestone.

¢ Lost Sales - The total revenue of all opportunities that are
lost during the milestone.

* % of Quota - The percentage of the quota that is achieved
during the milestone.

E Use the Filter drop-down list to change the list of quotas
displayed.display all of your quotas, all of your quotas for the
current fiscal year, or all quotas that you have the right to view.

¢ My Quotas - Displays all of your quotas and all of the quotas
for your teams and territories.
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¢ My Current Quotas - Displays all of your quotas and all of
the quotas for your teams and territories in the current year.

e All Quotas - Displays all quotas in the Address Book that
you have the rights to view.

ﬂ Use the Show drop-down list to display quotas by month,
quarter, or year.

E Click on an entry to modify the quota for the entire year.

< Quotas [8 displayed] Current User: Joe Napol | Preferences | Logout | Heb [ £ in B

« Edt v  Report v @
] Deshboards Filter: My Cument Quotas Esﬁcw: Quarter .n =
- Name | Fiscai Period Quota vieighted Forecast | Unweighted Forecast | Closed Sales | Lost Sales 9% of Quota
) mywerkoy | Fr2013-Q4  §250,000.00  $8,750.00 E $87,500.00 .00 $0.00 0%
[ & Address Bock Joe Napol FY2013-Q3  $250,000.00  $87,170.00 $153,000.00 $0.00 $0.00 0%
= Joe Nagol FY2013-Q2  $250,000.00  $83,195.00 $187,000.00 $396,535.00  $197,790.00 159%
[, opportunities 2
Joe Napoli FY 2013—-Q1 $§250,000.00 $0.00 $0.00 $434,254.00 $234,000.00 174%
!
2 4 Quotas [WestCoastSales]  FY2013-Q4  §250,000.03  $0.00 $0.00 $0.00 $0.00 0%
[, campaigns [WestCoactSales]  FY2013-Q3  §249,999.99  $9,750.00 $55,000.00 $0.00 $0.00 0%
[WestCoastSales]  FY2013-Q2  §299,999.99  $25,5954 $190,000.00 $422,535.00  §125,790.00  169%
[T] customer Service
= [WestCoastSdes] FY2013-Q1  5249,999.92  $0.00 $0.00 $284300.00  $95,000.00  114%
] Knowledge Base
[] Hotist

Calendar

I
!4 Company Library

@3 RecentEntries »
§i] User information
[@] unks »
g4 Import »

§¥ administration »

Quota Templates

Quota templates store the details of quotas so they can be reused
and applied to different teams, territories, and leaders. All of the
details specified in the quota template can be modified when it's
applied.

Only users with the sales manager role can access quota templates.
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Create or Modify a Quota Template

® The beginning of the fiscal year
is set in Administrator.

@ The Total of Quota (%) value
displays the total amount of all
milestones and their
percentage of the quota value.

To complete this procedure, you must have the Sales Manager user
role.

n In the Quotas page, select Edit > Quota Templates.
A ciick Add.

Select the quota template that you want to modify, and click
Modify.
ﬂ Specify a name for the quota template.

n In the Quota field, enter the total amount of the quota for the
fiscal year.

E In the Fiscal Year drop-down list, specify the year that the
quota applies to.

E Under Milestones, select Month or Quarter as the milestones
in the fiscal year.

By default, an equal percentage of the quota is applied to each
milestone.

To modify the amount applied to a milestone, select the
milestone, click Modify, and enter the new amount or
percentage.

After making any changes, you can click Reset to return to the
default milestones.

E If necessary, redistribute the quota amounts applied to the
milestones to match the quota value.

¢ To add or subtract the difference to or from a single
milestone, select the milestone, click Rebalance, and click
Selected.

e To add or subtract the difference to or from all milestones,
click Rebalance, and click All.
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Apply a Sales Quota

E Click OK to save the quota template.

New Quota Template - Morzilla Firefox ==

Options
Name
Quotas for Enterprise Sales Teams

Teamerritory/L eader:

Quota: $600,000.00 Fiscal year: 2011 [+]

Full access: Joe Napoli [+] Read access: Fublic [+]
Milestones

© Month ) Quarter
Hilestone Quota (%) o Modify...
January $52,000.00 (8.67) = R
February $55,000.00 (9.17)
March $55,000.00 (8.17)
Apri $52,000.00 (8.67) il

Total of Quota (%): $600,000.00 (100.00)

Description:

Base quota to apply to enterprise sales teams in all regions. Modify quotas wihen
applying to adapt for regional differences.

To complete this procedure, you must have the Insert permission for
Quotas,

You can apply sales quotas to teams, territories, and leaders. You can
apply existing quota templates or create new quotas.

Only one quota can be applied to a team, territory, or leader for each
fiscal year.

n Select the Quotas icon to open the Quotas page.

E Select Edit > AddQuota.

B In the Template name drop-down list, select a quota template
to base the quota on.

n Select the leader, team, or territory that the quota applies to.
E If necessary, adjust the other properties of the quota.
[ ciick ok.



CHAPTER

GCampaigns

Market Your Products and Services

In this chapter...

“About Campaigns” on page 272

“Automated Campaign Templates” on page 275
“Automated Campaign Messages” on page 281
“Sending Automated Campaigns” on page 286
“Viewing Campaigns” on page 289

“Activities in Automated Campaigns” on page 291
“Automated Campaign Subscribers” on page 294
“Automated Campaign Statistics” on page 296
“Retrieving Campaign Subscribers” on page 299
“Status of Automated Campaigns” on page 303
“Testing Automated Campaigns” on page 305

“Calculating the Return on Investment for Campaigns” on page 306
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About Campaigns

® Fax and print campaigns are
available only in Maximizer
CRM Enterprise Edition.

Campaigns help you and your colleagues promote your company and
manage complex marketing campaigns.

With automated campaigns, you can broadcast your marketing
message to anyone in your Address Book. A campaign can reach out
to your entire Address Book or to a group of entries by email, fax, or
print.

Automated Campaign Template

You can send out automated campaign message by email,
fax, or printed document. An automated campaign
template defines when and what is sent and can be
reused for many automated campaigns.

Use automated campaigns when you want to have Maximizer
automatically send out email messages, faxes, or printed documents
on a pre-defined schedule. An automated campaign is very useful if
you want to inform customers of a new or upgraded product that
you are marketing, encourage a repeat visit to your company’s
website, or even just to keep in contact with the customer.

You can include merge fields in your outgoing campaign media so all
recipients get messages that are customized with their names,
companies, or any other fields in their Address Book entry
information.

You can “broadcast” email to any number of Address Book entries to
support your marketing campaign. Ask your Internet Service Provider
if there is a limit on how many email messages that can be sent
concurrently. You can control the cycle time check in the automated
services preferences in Administrator.
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You can work with your campaigns in the Campaigns page. Like the
other main pages, the Campaigns page is list-based, which means
your entries are displayed as items in a list. All of your campaign-
related activities are done in the Campaigns page.

Here are some tips for working in the Campaigns page:
Select the Campaigns icon to open the Campaigns page.

E Use the icons in the Type column to quickly distinguish ongoing
campaigns from fixed-date campaigns.

E The tabbed following pane shows additional information for the
selected entry.

ﬂ Click on a campaign to open it.

Search for Address Book entries... Q,
« Edt = WView v  Seach v Acions *  Report v Hep v [F E] & - @
Type | Status [ mame | Template [ Revenue

W] Quick Access  » _ P
- ) @ Completed Print Out Personalized Cover Letter for Jo  Print Out Persondlized Cover Letter for Jo - $160,000.00
© @ # Y @ In progress 2011/2012 Email Campaign - Escona Wine  Email Campaign - Escana Wines $90,000.00 | |

2] Dashboards @ In progress 2012 Email Campaign - Escona Wines Email Campaign - Escona Wines $90,000.00

= ~ \/In progress 3 014 Promotional Campaign Email Campaign - Escona Wines $16,000.00 =
[Z2), my work Day -

g @ suspended Email Campaign - 2004 Escona Wines Email Campaign - 2004 Escona Wines $700,000.00
Eﬂ Address Book @ Suspended Email Campaign: Fall 2013 Email Campaian - Escona Wines $90,000.00
(7! opportunities -

ol m ] v
[@) quotas
[l Campa\gnsn ‘ History ‘ Hotes | User-Defined Fields | Documents | Activities |+ + 4+ 2
[ customer service Last 12 Morths fiter applied ¥ Q) @ =
@ knowledge Base
Joe Napoli added a note:
[z] Hothst Joe Napoli has subscribed the Fallowing Address Book enmesﬂ
Calendar Fremant Fresh Market & wine <escona@masdmizer com:
Sam & Augies Mercantile <escons@maximizer.com>
[ :\zj Company Library Redriquez, Woodrow - Fremant Fresh Market & Wine <escona@maximizer.com: L
More...
=] Open * Delete * Print + March 08, 2014 8:19 PM
@ Widea Tutorials
Joe Napoli added a note:
. Mame: 2014 Fromotional Campaian
§il User information Terplate: Email Campaign - Escona Wines
= Description: |
@] Links * Budget: 500,00
& Tmport » Expected Revenue: 16000,00

More... -

§y Administration *

Change the List of Campaigns

To complete this procedure, you must have Read permission for
campaigns.

When you first open the Campaigns page, all campaigns in the
Address Book are displayed. You can change the list of campaigns to
display only campaigns you have created, current campaigns you
have created, or all current campaigns.
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@You can also use the options
on the Search menu to search

for campaigns.

e Inthe Campaigns page, open the View menu, and select one of
the following options:

My Campaigns - To display all campaigns you created.
My Current Campaigns - To display the campaigns you
created that are in progress.

All Campaigns - To display all campaigns in the Address
Book.

Current Campaigns - To display all campaigns that are in
progress.
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Automated Campaign Templates

Creating automated campaigns requires that you first define
campaign templates. Automated campaign templates define the
actions that occur when you implement a campaign. Each template
contains a series of scheduled activities that must be performed in
order to complete the automated campaign.

You can think of a campaign as a single implementation of one of
your automated campaign templates. Each time you create an
automated campaign, you are applying an instance of an automated
campaign template. The same automated campaign template can be
implemented over and over in the form of several campaigns.

Activities in Automated Campaign Templates

An automated campaign template determines the actions that occur
during a campaign. The campaign template sets out in precise terms
which activities to use and when to send the campaign media (email
messages, faxes, or printed documents). You can schedule as many
activities in a campaign template as you need.

When adding activities to a campaign template, you will need to
plan some details ahead of time, including the following:

e How many email messages, faxes, or printed documents you
want to send.

¢ Which file types to use for the campaign activity.

e How many days after the campaign is launched that the
campaign message are sent.

¢ Which email type to use for email messages.

Create an Automated Campaign Template

Once you have a plan worked out, you can create an automated
campaign template.

n Select Edit > Automated Campaign Templates.
The Automated Campaign Templates dialog box opens.

E Click Add to add a new template.
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Automated Campaign Templates [X]
Automated Campaign Template Information
Templates:
Follow-Up Campaign | Add_ |
One Email Activity with Merge Fields
Properties

Product Feedback | Prop |
Seasonal Promotion Template | Delete |
Two Email Activities with Merge Fields
Description:
Send this campaign quarterly to new customers,

|| Next> || Cancel |

Choose whether you are creating an entirely new campaign
template or one that is based on an existing campaign template.

If you choose to base the new campaign template on an existing
campaign template, Maximizer copies the content of the
existing campaign template into your new campaign template.

Type a name and description for the new campaign template
and click OK. Then, click Next.

In the Activities wizard page, use the Add, Properties, and
Delete buttons to define the series of activities that comprise
this template.

When adding activities, you are prompted to specify the type of
activity—email, fax, or print.
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(EIES (X]
Automated Campaign Activities
Activities:

MName Type DaysDelay | Start Time | Add>> |
4/ First proma email Email 0 5:00:00 PM [ ioperties)]

Second promotion email Email 7 11:38:42 AM

Last promo email Email 12 12:00:00 PM | Delete |
Description:
Sell and promote 2011 Escona wines.

| <Back || Next | Cancel |

E When you are finished defining activities, click Next.

To create an automated campaign immediately using the

template, select Launch a new campaign based on this
template.

B Click Finish to save the template.

Add an Email Activity to an Automated Campaign Template

An email activity is an email message, a fax, or a printed document
that is sent out a certain number of days after an automated

campaign is launched using a campaign template. You can add as
many email activities as you want.

n Select Edit > Automated Campaign Templates.

The Automated Campaign Templates dialog box opens.

E Select the automated campaign template to which you want add
the activity, and click Next.

The Activities wizard page opens.
B Click Add, and select Email.

The Add Email Activity dialog box opens.
n Enter the details of the activity.

¢ Enter the Name and Description.

e For email activities, enter the Email subject.

277
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You can click the ellipsis button to insert a merge field in the
email subject.

e From the Email type drop-down list, select an email type.

¢ Enter the Delay start, which defines the number of days
after the campaign is launched that the activity occurs.

e Specify the Start time, which defines the time of day the
activity occurs.

¢ Under Message Body, click More > Select Existing
Message to access the list of saved messages.

Select an existing message, and click OK to attach the
message to the activity.

e Choose your Logging options.

A note is created for the Address Book entries involved in the
campaign if the campaign activity is successful or if the

activity fails.
Add Email Activity - Mozilla Firefox =
v
Activity o

General  Emal Addresses  Attachments  Landing Page URLs

Mame:  peminder at end of promotion

Desaription:

Email subject: | 2ot day to take advantage of Escona’s holiday promotion )

Email type: -
Delay start: 79 days from Campaign start date
Start tme: 45912 PM [

Message Body

Name: Fax_2011-12_Escona_Price_List_to_Leads.ETF More »> ~

Logging
V| Log successful activity to Address Book entry notes

Log unsuccessful activity to Address Book entry notes

E Select the Email Addresses tab, and specify the email addresses
associated with the message.

¢ The name and email address of the From account are visible
in the email message.



Chapter9 | 279

If you leave this field empty, the email message is sent from
the current user.

e The name and email address of the ReplyTo account are
used when email recipients reply to the email message.

If you leave this field empty, replies are sent to the From
address.

In order to monitor email bounces and replies for campaigns,
you must enter From and Reply To email addresses for the
same accounts specified in the campaign monitoring settings
in Administrator.

¢ The Cc and Bcc fields define a carbon copy or blind carbon
copy recipient. Use these options to send a copy of the email
message to someone in your company, as well as to the
targeted recipients.

¢ Use the Include in all the emails or Include in the first
email only options to specify that the cc and bcc recipients
receive the message for each Address Book entry or for just
the first Address Book entry in a batch.

E Select theAttachments tab and click Add to add any
attachments to the email message.

Select the Landing Page URLs tab, and specify up to five
landing page URLs in the email message.

If you include a Campaign Redirect URL merge field in your email
message template, customers are redirected to a landing page
URL when they click on the merge field.

E Click OK and continue through the campaign template wizard.

Add a Print or Fax Activity to an Automated Campaign Template

@ Fax and print campaign
activities are available only in
Maximizer CRM Enterprise
Edition.

A print or fax activity is a fax, or a printed document that is sent out
a certain number of days after an automated campaign is launched
using a campaign template. You can add as many activities as you
want.

n Select Edit > Automated Campaign Templates.

The Automated Campaign Templates dialog box opens.

E Select the automated campaign template to which you want add
the activity, and click Next.

The Activities wizard page opens.
E Click Add, select Fax or Print.
n Enter the details of the activity.
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¢ Enter the Name and Description.
e Select a printer.

The list includes all printers and fax applications installed on
the Maximizer Automated Services computer (Maximizer
server) that are initialized for the fax/print service through
Administrator.

¢ Enter theDelay start, which defines the number of days
after the campaign is launched that the activity occurs.

e Specify the Start time, which defines the time of day the
activity occurs.

e Under Message Body, click More > Select Existing
Message to access the list of saved messages.

Select an existing message, and click OK to attach the
message to the activity.

¢ Choose your Logging options.

A note is created for the Address Book entries involved in the
campaign if the campaign activity is successful or if the
activity fails.

For adding a print or fax activity, click OK to finish adding the
activity to the campaign.
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Automated Campaign Messages

The principal action of an automated campaign is to send a message
to one or more recipients by email, fax, or printed document. When
you add activities to automated campaigns and automated
campaign templates, you choose a message for each activity.

For email activities, Maximizer can send text and HTML email
messages, in addition to the email template file (.ETF) format created
by the Maximizer Word Processor. Create HTML and text files directly
in Maximizer using the Campaign Message Editor. Or use an editor of
your choice to create the files, and import the files into Maximizer.

Email messages can contain merge fields that are replaced with the
recipients’ information when the email message is sent. For example,
your template’s salutation might be “Dear {Mr/Ms} {Last Name}" or
“Dear {First Name}”. These merge fields are replaced with a Contact’s
name, as in “Dear Ms. Anoza"” or "Dear Marylyn”.

Campaign Message Library

Automated campaign messages are stored in the Message Library,
accessible from the Campaigns page, from automated campaign
templates, from the Campaign Message Editor, and from activities in
existing automated campaigns.

You can use the Message Library to retrieve, modify, and export
existing automated campaign messages. You can also import
campaign messages created in external applications into the
Message Library to attach to activities in automated campaigns and
automated campaign templates.

Create an Automated Campaign Email Message

You can create email messages for your automated campaigns using
the Campaign Message Editor or using an external HTML editor. You
can create a new message while adding or modifying campaign
activities in existing campaigns or in campaign templates.

n In the Campaigns page, select the Message Library icon from
the toolbar.

The Message Library dialog box opens.
E Click New.
The Campaign Message Editor dialog box opens.

B From the Format drop-down list, select the format of the email
message.
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ﬂ In the large text box in the center of the dialog box, compose the
email message.

You can use the toolbar icons to apply formatting and insert
hyperlinks, images, and merge fields in the message.

E Click Save.
The Add Campaign Message dialog box opens.

E Specify the properties of the campaign message, and click OK.

Campaign Message Editor

You can use the Campaign Message Editor to create email messages
for your automated campaign email activities.

The Campaign Message Editor lets you create messages in text or
HTML format. You can add merge fields to messages in both formats.
In HTML format, you can add formatting, images, and hyperlinks to
the email message. You can also edit the HTML source of the
message.

Keep the following tips in mind when working in the Campaign
Message Editor:

n From the Format drop-down list, select the format of the email
message: Plain Text or HTML.

E Select the Message Library icon to retrieve an existing email
message from the Message Library.

B Select the Insert Fields icon to add merge fields to the message.
ﬂ Use the toolbar to apply formatting to the content of the email
message.

These options are available only if you are creating an HTML
message.

E Select the Insert Image and Hyperlink Manager icons to insert
images and hyperlinks in your message.

These options are available only if you are creating an HTML
message.
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E Select the HTML tab to view and edit the HTML source of the
email message.

v PETBED Format: (WML v

o v | serif v s v B J UAYavYiE:

@
ESCONA ESTATE WINERY

Dear Valued Customer,
Since 1995, Escona Estate Wines has produced some of the finest wines in Northern California. We invite you to try our wines... For a
limited time, we are offering a select discount to promote our new line of fine wines.

Sincerely,

Joe Napoli
Escona Estate Wines

To unsubscribe from this campaign, please click unsubscribe.

revie
[ mep | E save || Close

The campaign merge fields are specific to automated campaigns.
These merge fields can help you track information on your campaign
subscribers, like who has opened a campaign email message and who
has visited your web site from a campaign email message.

The easiest way to use merge fields in HTML is to create an email
template using the Campaign Message Editor and to insert the
merge fields into the content of the HTML file using the Insert Fields
toolbar icon.

e Campaign Opened Email Tracking URL - This merge field
tracks the number of customers that have opened an automated
campaign email message. It can be used with only HTML
message templates. When a customer opens a campaign email
message, the email opened count is updated in the automated
campaign statistics.

You should add the syntax for this merge field to an image tag in
your HTML message. The merge field syntax replaces the value of
the SRC attribute in the <img> element (image element), for

example, <img src="[Campaign Opened Email Tracking URL]">.

e Campaign Redirect URL - This merge field tracks how many
customers visit your website as a result of an automated
campaign email message. The redirect URL calls an ASP page,
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which is installed and configured at the time of installing
Maximizer. If necessary, the redirect script location can be
modified in Administrator. When a customer clicks on a link, the
URL visited count is updated.

You can add up to five redirect URL merge fields to your
campaign messages. The syntax of each merge field is [Campaign
Redirect URL], [Campaign Redirect URL1], [Campaign Redirect
URL2], Campaign Redirect URL3], and [Campaign Redirect URL4].

Add the syntax of these merge fields to hyperlinks in your HTML
message. The merge field syntax replaces the value of the HREF
attribute in the <a> element (hyperlink element), for example <a
href="[Campaign Redirect URL]">.

You specify the actual URL of the web page in the Landing Page
URLs tab of the Email Activity dialog box.

Manage your email preference - This merge field allows
recipients to manage their email preferences. When a recipient
clicks on this URL, Maximizer re-directs the recipient to a web
page where opt-in email types can be configured. The Address
Book entry is updated accordingly.

When you add this merge field to your message, the message
editor automatically converts it to a hyperlink for you. It is not
necessary to modify the syntax of this merge field to a hyperlink
in the HTML source of your message.

Unsubscribe all emails URL - This merge field unsubscribes
customers from the automated email campaign. When a
recipient clicks on this URL, the Do Not Solicit By field is set to
Email for the entry so that the entry will no longer receive
automated campaign emails, and opt-in consent is removed
from all email types in the entry’s email profile.

When you add this merge field to your message, the message
editor automatically converts it to a hyperlink for you. It is not
necessary to modify the syntax of this merge field to a hyperlink
in the HTML source of your message.

Unsubscribe single email type URL - This merge field
removes the recipient’s opt-in consent for the current email type.
When a recipient clicks on this URL, the entry’s opt-in for the
current email type is removed so that the entry will no longer
receive emails of that type.

When you add this merge field to your message, the message
editor automatically converts it to a hyperlink for you. It is not
necessary to modify the syntax of this merge field to a hyperlink
in the HTML source of your message.
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Example of a Campaign Email Message

In this example, an email message will be sent to notify the recipients
of a product discount. The message contains merge fields for
tracking who has opened the email and who has visited landing
pages. It also contains merge fields to let users manage their email
preferences, unsubscribe from future emails of this type, or
unsubscribe from all future emails.

<img src="[Campaign Opened Email Tracking URL]">

Since 1995, this company has produced some of the finest products in the state.

We invite you to try our new selection. For a limited time, we are offering a

select discount to promote our new line for 2015.<br>

For more information, please visit the following pages:<br>

<a href="[Campaign Redirect URL]">Landing Page</a><br>

<a href="[Campaign Redirect URL1]">Landing Page 1</a><br>

<a href="[Campaign Redirect URL2]">Landing Page 2</a><br>

Use the following links to manage your email subscriptions:<br>

<a href="[Unsubscribe single email type URL]">Unsubscribe this type of
email</a><br>

<a href="[Unsubscribe all emails URL]">Unsubscribe all future emails</
a><br>

<a href="[Manage your email preference]">Manage your email preference</
a><br>
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Sending Automated Campaigns

Automated campaigns are implementations of automated campaign
templates. You can add as many campaigns as you like using the
same campaign template and manage them in the Campaigns page.

An automated campaign is always associated with one or more
Address Book entries. The Address Book entries are the recipients of
the messages sent in the campaign. When you create a campaign,
you can choose either a saved search or a Favorite List of Address
Book entries to subscribe to the campaign. You can also choose to

add no subscribers to the campaign.

Send an Automated Campaign

n In the Campaigns page, select Edit > Add Automated

Campaign.

E Choose a template and enter the basic information for the

campaign, and click Next.

¢ From the Template drop-down list, select an existing

campaign template.

To create a new template, click New.

e Enter the name, description, budget, and expected

revenue of the campaign.

¢ Specify the start date for the campaign.

Automated Campaign Information

Campaign information

% Narme:* [Escona Promations - Spring 2011

Template: |Emaill:am;mgn - 2011 Ezcona Wines j Mew
Description |’c promate new spring/summer ine of fins wines
Budget and revenue
Budget: [1500.00 Expected Revenue: [1,000,000.00 .
Vhen should this campaign start?
m Chosen start date: [2/7/2011 ]

* Denotes required field | Spelling... ” <Back

” hlext= | ‘ Cancel
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B Select the subscribers to add to the campaign.
e Select an existing Favorite List of Address Book entries.

e Select a saved search of Address Book entries from the search
catalog.

e Do not select any Address Book entries.
You can add subscribers to the campaign after it is launched.
n Select Validate email addresses to be notified of any blank

email addresses or those missing the @ symbol, or select
Validate fax numbers to be notified of invalid fax numbers.

Automated Campaign Information ._j
Subscribers
% © Favorite List. My leads -
Saved Search: | ‘LastSearc
No selection (choose Address Book entries later)
Validate
@ /| Valdate email addresses
* Denotes required field <Back ” Finish | ‘ Cancel

E Click Finish to save and launch the campaign.

Restricting Campaign Activities

You can choose to restrict your campaign activities by using the Do
Not Solicit By field and email type field in the Address Book Details
tab.

You can use the “Do Not Solicit By” field to prevent automated
campaign emails from being sent to your Address Book entries. If the
“Do Not Solicit By” field is set to “Email” for an entry, no automated
campaign emails will be sent to that entry, regardless of the entry’s
other email profile settings.

Maximizer allows you to set up different email types for which you
can specify whether recipient consent is required or not in order to
receive that type of email. You can manage the consent, or opt-in
settings for your email recipients via the email profile of each
Address Book entry’s email address.



288

Maximizer Web Access
User's Guide

When sending an email type that requires consent from Maximizer,
the email profiles of the recipients are checked to ensure that they
have consented, or opted-in to receive that type of email, and the
email will only be sent to those recipients who have opted-in to that
email type.

By adding unsubscribe merge fields to an email message you can
allow the email recipients to unsubscribe from the current email type
or from all email types.

By adding the manage email preferences merge field to an email
message, email recipients can opt-in or opt-out of each email type.
When a recipient clicks on the Manage your email preference link,
Maximizer redirects the recipient to a web page where they can
configure their email profile and opt-in preferences for each email
type.
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View an Automated Campaign

After creating an automated campaign, you can view and modify
details that are not available while adding the campaign.

n In the Campaigns page, click on the automated campaign.
The Campaign Entry dialog box opens at the Basic Information
tab.

E In the Basic Information tab, view the campaign’s basic
information.

B From the Key Fields for drop-down list, select a Key Fields list to
view a different set of Key Fields.

Holiday promotion - Email Campaign - 2011 Escona Wines ]
= 3% | (] | [ Actions + @+ ¥
Campaign Information = Opportunities Motes Documents Activities

Basic Information User-Defined Fields Campaign Plan Subscribers Status Test o

Campaign description

Name:* Haliday promotion

Products / Services:  Cab Franc, Cabernet, Merlot, Pinot Noir, Re Categories:

Description: Campaign to promote our red wines for the holidays

Revenue from opportuniti d by thi

As of: 10/5/2011 Wion: In progress:

Key Fields for:  Automated Campaigns v

Status Subsribers

Expected revenue $25,000.00 Unsubscribes

Price List Distribution

Budget $2,000.00 Unique opened emails
Total unique dicks

Catalog Distribution Total bounces

humber of Catalogs Rec Total replies

Selected Customers for

| Edit. |

n Select the remaining tabs to view more details on the campaign.

Campaign Basic Information

In an open campaign, the Campaign Information tab contains the
following sub-tabs:
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Campaign Description

Revenue and Budget

Key Fields

¢ Basic Information - Displays the basic information and Key
Fields for the campaign.

e User-Defined Fields - Displays all user-defined fields for
campaigns.

e Campaign Plan - Displays information on the activities in the
automated campaign.

e Subscribers - Displays the Address Book entries subscribed to
the campaign.

e Status - Changes the status of the campaign.

¢ Test - Tests the activities in the campaign with specified Address
Book entries.

The Basic Information tab displays basic fields for the campaign.
Some of these fields are set while launching the campaign.

To modify the details of the entry, click Edit.

The campaign name and description are automatically set while
creating the automated campaign. The products/services and
categories must be set from this dialog box after creating the
campaign. The values available for these fields are shared with
opportunities, customer service cases, and appointments.

The revenue and budget are set while creating the automated
campaign. You cannot edit the values of these fields here. You must
select a Key Fields list containing these fields to modify their values.

Key Fields lists contain system fields and user-defined fields. If you
have the Modify Key Fields permission, you can create and modify
Key Fields lists.

To view different Key Fields, from the Key Fields for drop-down list,
select a Key Fields list.
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Activities in Automated Campaigns

All automated campaigns contain activities that are scheduled to
occur during the campaign. Each activity contains an email message,
a fax, or a printed document that is sent as part of an automated
campaign. Activities are scheduled to occur a specified number of
days after a campaign starts at a specific time. You can also
associated personal activities such as Hotlist tasks and appointments
with your automated campaigns.

Add an Activity to an Automated Campaign

You can add as many activities as you want to a campaign. When
you add a new activity, you choose the file containing the body of
the message, and you specify when the activity occurs during the
campaign, as well as other details of the activity.

n Open the campaign, and select the Campaign Plan tab.

E Click More, and select Add Print, Add Fax, orAdd Email.
The Add Print/Fax/Email Activity dialog box opens.

ﬂ Enter the details of the activity.
¢ Enter the Name and Description.
e For fax and print campaigns, select a printer.

The list includes all printers and fax applications installed on
the Maximizer Automated Services computer (Maximizer
server) that are initialized for the fax/print service through
Administrator.

e For email activities, enter the Email subject.

You can click the ellipsis button to insert a merge field in the
email subject.

¢ Enter the delayed start date, which defines the number of
days after the campaign is launched that the activity occurs.

¢ Specify the start time, which defines the time of day the
activity occurs.

¢ Under Message Body, click More > Select Existing
Message to access the list of saved messages.

Select an existing message, and click OK to attach the
message to the activity.

e Choose your Logging options.
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A note is created for the Address Book entries involved in the
campaign if the campaign activity is successful or if the

activity fails.
Add Email Activity - Mozilla Firefox ==
s\?
Activity

General  Emai Addresses  Attachments  Landing Page URLs

Name:  Reminder at end of promotion

Desaription:

Email subject: || oot day to take advantage of Escona's holiday promotion )
Delay start: 5p days from Campaign start date
Start time:  9.00.00 AM [
HMessage Body

Mame:  Promotion: Final message More>> ~

Logging
V] Log successful activity to Address Book entry notes

Log unsuccessful activity to Address Book entry notes

n If you are adding a print or fax activity, click OK to finish adding
the activity to the campaign.

If you are adding an email activity, continue with the remaining
steps.

E Select the Email Addresses tab, and specify the email addresses
associated with the message.

¢ The name and email address of the From account are visible
in the email message.

If you leave this field empty, the email message is sent from
the current user.

¢ The name and email address of the ReplyTo account are
used when email recipients reply to the email message.

If you leave this field empty, replies are sent to the From
address.

In order to monitor email bounces and replies for campaigns,
you must enter From and Reply To email addresses for the
same accounts specified in the campaign monitoring settings
in Administrator.



Chapter9 | 293

¢ The Cc and Bcc fields define a carbon copy or blind carbon
copy recipient. Use these options to send a copy of the email
message to someone in your company, as well as to the
targeted recipients.

¢ Use the Include in all the emails or Include in the first
email only options to specify that the cc and bcc recipients
receive the message for each Address Book entry or for just
the first Address Book entry in a batch.

E Select theAttachments tab and click Add to add any
attachments to the email message.

Select the Landing Page URLs tab, and specify up to five
landing page URLs in the email message.

If you include a Campaign Redirect URL merge field in your email
message template, customers are redirected to a landing page
URL when they click on the merge field.

E Click OK to finish adding the activity to the automated
campaign.
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Automated Campaign Subscribers

Each automated campaign targets one or more Address Book entries.
You can subscribe and unsubscribe Address Book entries to existing
campaigns.

Add Subscribers to an Automated Campaign

You can add any Address Book entries as subscribers at any time to
existing automated campaigns. You can search for an Address Book
entry to add it individually, or you can add all Address Book entries
from a Favorite List.

If you add a subscriber to a fixed-date campaign, all activities that are
already completed in the campaign are sent at once to the Address
Book entry. If you add a subscriber to an ongoing campaign, the
campaign is run from the beginning and all activities are completed
at their scheduled intervals.

n Open the campaign, and select the Subscribers tab.

E Click Add and select Search for Address Book Entries or Add
from Address Book Favorite List.

E Search for an Address Book entry by last name or Company
name, select the entry, and click OK.

—or —

Select a Favorite List, and click Retrieve.

Remove Subscribers from a Campaign

You can remove Address Book entries that are already subscribed to

a campaign.
@You can flag Address Book n Open the campaign, and select the Subscribers tab.
entries to not be included in
specific types of campaign A sclect the subscribers that you want to remove.

activities by using the “Do not
solicit by” field on the Basic

Information tab E Click Remove, and select Remove Selected Entries.
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Remove Subscribers in a Favorite List from a Campaign

You can remove all Address Book entries in a Favorite List from a
campaign.
n Open the campaign, and select the Subscribers tab.

E Click Remove, and select Remove Based on Address Book
Favorite List.

ﬂ Select the Favorite List, and click Retrieve.
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Automated Campaign Statistics

Maximizer keeps tracks of statistics on automated campaigns with
email activities. You can view statistics for the entire campaign, or
you can view statistics for specific email activities in the campaign.

List of Automated Campaign Statistics

The following information is tracked in automated campaigns:

The number of email messages opened by campaign recipients.
The following statistics are included:

¢ Unique opened emails (campaign) - The number of
campaign subscribers that have opened any message
included in a campaign.

¢ Emails opened - The total number of times a specific
message has been opened in a campaign activity.

¢ Emails opened unique (activity) - The number of
subscribers that have opened a specific message in a
campaign activity.

These statistic are tracked only if you include the
Campaign_Opened_Email_Tracking_URL merge field in your
campaign messages.

The number of campaign subscribers that have unsubscribed
from a campaign. The following statistics are tracked:

¢ Unsubscribes (campaign) - The total number of campaign
subscribers who have unsubscribed from a campaign.

¢ Unsubscribed (activity) — The number of campaign
subscribers who have unsubscribed from a specific activity in
a campaign.

This statistic is tracked only if you include the Unsubscribe all
emails URL or Unsubscribe single email type URL merge field in
your campaign messages.

The number of times landing page URLs are accessed from a
campaign. The following statistics are included:

¢ Total unique clicks (campaign) — The number of unique
visits to all landing page URLs in a campaign. A subscriber in
a campaign can increment this count only once per landing
page URL, even if the subscriber visits the landing page URL
multiple times from different campaign activities.

¢ Total URL visited (activity) — The total number of visits to
any landing page URL in an activity.

¢ Total URL visited unique (activity) — The number of
unique visits to any landing page URL in a specific activity. A
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subscriber in a campaign can increment this count only once
per landing page URL in an activity.

¢ URL visited x - The total number of visits to a specific
landing page URL (x) in an activity.

¢ URL visited unique x - The number of unique visits to a
specific landing page URL (x) in an activity.

These statistic are tracked only if you include the
Campaign_Redirect_URL merge fields in your campaign
messages and you specify the landing page URLs in the email
activity. You can add up to five landing page URLs to each
activity.

The number of messages that have bounced or been replied to.
The following statistics are included:

¢ Total bounces - The number of email messages that have
been returned to the campaign sender.

¢ Total replies — The number of campaign subscribers that
have replied to a campaign message.

These statistics are tracked only if email accounts are specified in
the campaign monitoring settings in Administrator. These email
accounts must match the From and Reply To email addresses
specified in campaign activities.

To complete this procedure, you must have Read permission for
campaigns.

You can view overall campaign statistics in the Basic Information tab
of an open campaign. You can also add the Total bounces, Total
unique clicks, Total opened emails, Total replies, and Unsubscribes
fields to the column setup in the Campaigns page.

n Open the campaign.

E If necessary, select a Key Fields list containing the campaign

statistics you want to view.

By default, the campaign statistics fields are included in the
Default Key Fields list, including the following fields:

¢ Unique opened emails - The number of subscribers that
open one of the email messages in a campaign.

¢ Unsubscribes - The total number of subscribers who have
unsubscribed from the campaign.

¢ Total unique clicks — The number of unique visits to landing
page URLs in the campaign by subscribers.
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¢ Total replies — The number of campaign subscribers that
have replied to a campaign message.

¢ Total bounces - The number of email messages that have
been returned to the campaign sender.

View Statistics on Campaign Activities

To complete this procedure, you must have Read permission for
campaigns.

You can view statistics on each activity in your campaign from the
Activities tab in an open campaign. The information you can view
includes the number of messages that were sent and that had errors.
For email messages, you can also view the numbers of subscribers
who opened the email, who unsubscribed from the campaign, and
who visited each of the URLs included in the email message.

n Open the campaign, and select the Campaign Plan tab.

E Scroll to the right to view more statistics for the activities.

Email Campaign - 2011 Fall Promotion - Email Campaign - 2011 Escona Wines ]
= 3% | (] | [ Actions + + ¥
Campaign Information = Opportunities Motes Documents Activities
Basic Information User-Defined Fields Campaign Plan Subscribers Status Test [ 7]

Selected campaign template Email Campaign - 2011 Escona Wines | Details... |
Activities of this Campaign More ~

Name Status Start Date Sent Error

First promo email In Progress 9/20/2011 11:40 AM 40 3

Second promotion email New 9/27/2011 11:38 AM 0 0

Last promo email New 10/2/2011 12:00 PM 0 0

« 0 v
Description of selected activity:

Sell and promote 2011 Escona wines.

| Edit. |
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Retrieving Campaign Subscribers

Retrieve a List of Subscribers for a Campaign

To complete this procedure, you must have Read permission for
campaigns and Read Access to the campaign subscribers.

Each automated campaign targets one or more Address Book entries.
You can quickly retrieve a list of the Address Book entries subscribed
to a campaign and display it in the Address Book page.

n Click on the campaign to make it the current entry.

E Select Actions > Retrieve Address Book Entries.
Right-click, and select Retrieve Address Book Entries.

The Address Book page opens and displays the list of the Address
Book entries subscribed to the campaign.

You can also retrieve the Address Book entries for which the
campaign was not successful by selecting Retrieve
Unsuccessful Address Book Entries.

Retrieve a List of Entries who Have Opened Email

To complete this procedure, you must have Read permission for
campaigns and Read Access to the campaign subscribers. As well, the
Campaign_Opened_Email_Tracking_URL merge field must be
included in campaign email messages.

You can retrieve a list of Address Book entries who have opened
campaign email messages.

n Click on the campaign to make it the current entry.
E Select Actions > Retrieve Opened Emails Address Book
Entries.

Right-click, and select Retrieve Opened Emails Address Book
Entries.

The Address Book page opens and displays a list of entries who
have opened a campaign email message.
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Retrieve a List of Entries who Have Visited Landing Page URLs

To complete this procedure, you must have Read permission for
campaigns and Read Access to the campaign subscribers. As well, the
Campaign_Redirect_URL merge fields must be included in campaign
email messages, and landing page URLs must be specified in the
email activity.

You can retrieve a list of Address Book entries who have visited the
landing page URLs specified in email activities for automated
campaigns.

n Click on the campaign to make it the current entry.

E Select Actions > Retrieve Click-Through Address Book
Entries.
—or-
Right-click, and select Click-Through Address Book Entries.

The Address Book page opens and displays a list of entries who
have visited one of the landing page URLs included in campaign
email messages.

Retrieve a List of Entries who Have Unsubscribed from a Campaign

To complete this procedure, you must have Read permission for
campaigns and Read Access to the campaign subscribers. As well, the
Unsubscribe all emails URL or Unsubscribe single email type URL
merge field must be included in campaign email messages.

n Click on the campaign to make it the current entry.

E Select Actions > Retrieve Unsubscribed Address Book
Entries.
Right-click, and select Retrieve Unsubscribed Address Book
Entries.

The Address Book page opens and displays the list of Address
Book entries who have unsubscribed from the automated
campaign.
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Retrieve a List of Entries for a Campaign Activity

To complete this procedure, you must have Read permission for
campaigns and Read Access to the campaign subscribers. As well, the
appropriate merge fields must be included in the campaign email
messages.

You can retrieve a list of Address Book entries that have performed
actions in specific activities in automated campaigns. You can
retrieve the entire list of Address Book entries for an activity, the list
of unsuccessful entries for an activity, the list of Address Book entries
that have opened the email message included in a specific activity,
the list of entries that have unsubscribed from a specific activity, and
the list of entries that have visited landing page URLs in an activity.

n Click on the campaign to make it the current entry.

E Select Actions > Retrieve Address Book Entries by Activity.
Right-click, and select Retrieve Address Book Entries by
Activity.

E Under Campaign Activities, select the activity.

n Under Retrieve Address Book entries option, select the list

of subscribers you want to retrieve.

Options for specifying which entries are retrieved include: All
subscribers, Unsuccessful entries, Opened email entries,
Unsubscribed entries, and Clicked-through entries.

E If you selected Clicked-through entries, from the drop-down
list, specify which landing page URLs to view entries for.
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[ ciick ok.




Chapter9 | 303

Status of Automated Campaigns

You can view the current status of your automated campaigns in the
Status column in the Campaigns page. You can also change the
status and view more details on the status of campaigns in the Status
tab of an open campaign.

Suspend an Automated Campaign

You can suspend automated campaigns that are in progress at any
time. When a campaign is suspended, all of the activities in the
campaign are also suspended.

n Open the campaign, and select the Status tab.

H ciick Edit.

ﬂ In the Current working status area, select Suspended.

n Optionally, in the Completion details area, specify the date
and reason, and enter a comment.

Email Campaign - 2011 Fall Promotion - Email Campaign - 2011 Escona Wines [¥]
& 35 | [F] | [ Actions + i+
Campaign Information = Opportunities Motes Documents Activities
Basic Information User-Defined Fields Campaign Plan Subscribers Status Test (7]

Campaign creation date and start date
Creation date: Tuesday, September 20, 2011 Startdate: | Tuesday, September 20, 2011

Current working status

New Completed Revenue:
In progress Abandaned
Updated @ suspended

Completion details

Date: 10/5/2011 )
Reason:
Comment:

We're running another promotion right now. We'l reevaluate and resume this campaign once
the other campaign is finished.

\ Save H Cancel \

E Click Save.
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Resume an Automated Campaign

You can resume any existing automated campaigns that are
completed, abandoned, or suspended at any time. Any incomplete
activities in the campaign also resume.

n Open the campaign, and select the Status tab.

H ciick Edit.

ﬂ In the Current working status area, select In progress.

n Click Save.
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Testing Automated Campaigns

You can add subscribers that test all of the activities in the
automated campaign at once. When you run the test, all of the
activities in the campaign are sent to the subscribers ignoring the
date and start time of the activity.

Run a Test Automated Campaign

n Open the campaign, and select the Test tab.

E If necessary, add Address Book entries to the test:

¢ C(Click Add and select Search for Address Book Entries or
Add from Address Book Favorite List.

e Search for an Address Book entry by last name or Company
name. Or select a Favorite List and click Retrieve.

B Click Run Test.
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Calculating the Return on Investment for Campaigns

You can calculate the return on investment for an automated
campaign in the Basic Information tab of an open campaign. The
calculation is based on the revenue generated by opportunities
associated with the campaign.

In order to be counted in the calculation, opportunities must have
values specified in the Revenue field. The return on investment adds
up the revenue from all won and in-progress opportunities
associated with the campaign.

You can add the “Revenue Won" and “In Progress Revenue” fields to
your column setup to view this calculation directly in the Campaigns
page. You must update the calculation directly in the campaign entry
to update the values shown in the column setup.

Calculate the Return on Investment for a Campaign

n Open the campaign.
H ciick Edit.

ﬂ Under Revenue from opportunities generated by this
campaign, next to As of, select the date from which you want
to calculate the revenue.

By default, the creation date of the campaign is selected, but
you can select another date to narrow the date range.

3 click calculate.

The Won field displays the total revenue of the opportunities
that are won.

The In Progress field displays the total revenue of the
opportunities that are still in progress.

Retrieve a List of Opportunities for a Campaign

You can quickly retrieve a list of the opportunities associated with a
campaign and display them in the Opportunities page.

e Select the automated campaign and select Actions > Retrieve
Opportunities.

The Opportunities page opens and displays the list of the
opportunities associated with the campaign.
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Customer Service

Provide the Key to Success with Customer Service

In this chapter...

“Customer Service Cases” on page 308

“Creating Customer Service Cases” on page 312

“Status of Customer Service Cases” on page 315

“Email Notification for Customer Service Cases” on page 319
“Knowledge Base” on page 324

“Adding Articles to the Knowledge Base” on page 328
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Customer Service Cases

The customer service features in Maximizer help support and
enhance your existing customer service business processes. All
Address Book entry customer service communication can be
recorded, categorized, and escalated appropriately to ensure issues
are dealt with in a timely manner.

Customer Service Page

The Customer Service page is list-based like the other Maximizer
pages. Keep the following points in mind while working with the
Customer Service page:

I] Select the Customer Service icon to open the Customer Service
page.

E Click on a customer service case to view or modify it.

E Use the tabbed following pane to view additional information
for the selected customer service case.

Customer Service

Search for Address Book entries. .,

3 Edit ~ Wisw Search v Actions ¥ Report v Help [Q ﬂ ﬁ - @9
- Case Mumber | Company/Individual Subject | Assigned To | Folow-up Deading
M) Quickfcesss P
HQ-00084 Atlas Food Inc Spailt product, resend Joe Napoli August 18, 201
W 0 #® Y HQ-00053 Angassi Cold Beer & Wine Store Training Request Joe: Mapoli January 18, 20
3} Dashboards HQ-00052 Amelia Liquors South Training Request Joe Napoli January 18, 2t
- HQ-00051 Astor Wines & Spiriks Training Request Joe Napoli January 18, 2
[Z5), vy work Day
) +  HQ-00079 All The Best Spirit DeFect in shipment Lou Jones February 18,2
E\“ﬂ Address Baok HQ-00066 #ll The Best Spirits Ship error, refund requested March 09, 201+
[ | opportunities HQ-00065 Arrow Wine & Spirits Ship error, refund requested April 09, 2014,
EF HQ-00064 Bayvile Package Store Ship error, refund requested april 03, 20141 _
9 | Quotas H
HQ-D0063 Beringer Vineyards Ship error, refund requested May 09, 2014 ¢
L = Campaigns HQ-00062 Alhert's Steak House Faulty Product Joe: Mapoli August 18, 201
| Customer Servic HQ-00061 Amelia Liquors South Faulty Product Joe Napoli September 18,
= L4
5| = g I ] f

U Hatlist

c\ g Contacks | History | Motes | User-Defined Fields | Documents | Activities + @+ 4+
alendar

I:|=j U Last 12 Maonths filter applied Y 9 9

Joe Napoli added a note:

@ Video Tutorials \ Case HQ-00079 has been modified: Defect in shipment B
The: Following Felds b bssn Updated;

Subject changed to "Defect in shipment”

i) User information

@] Links ” More. .
g Impart » 2] Open « Delete * Print * March 02, 2014 #:36 PM
@ Administration  »
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Change the List of Customer Service Cases

To complete this procedure, you must have Read permission for
customer service cases.

When you first open the Customer Service page, all of your current
cases are displayed. You can change the list of cases to display all of
your cases or all cases in the Address Book.

@You can also use the options ® In the Customer Service page, open the View menu, and select
?(;‘rtcg‘:esfa“h menu to search one of the following options:

e My Cases - To display all cases either that are assigned to
you or that have you set as the owner.

¢ My Current Cases - To display unresolved cases either that
are assigned to you or that have you set as the owner.

e All cases - To display all cass in the Address Book.

View a Case from the Customer Service Page

n Select the Customer Service icon to open the Customer Service
page.
The Customer Service page opens.

E Click on an entry to open it.

The Customer Service Case dialog box opens displaying the
details of the case.
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Customer Service Case HQ-00067 - Ship error, refund requested [¥]
(S 3 [ [£] 3] [ (= Monitoring [85] [€] Favarite List (=] | []] Actions » [53 * @
Case Information =~ Notes Documents Activities
Basic Information  User-Defined Fields Solution Information &8iling  LinkedIn
Company / Individual:" ABC Wine Shop Inc. Contact: Johnson, Ed LJ
Case description
Case number: HQ-00067 Elapsed time: 2.3 months
ot
Subject: Ship errar, refund requested
Products / Services: Pinat Gris [ |categories: France [.]
Description: ] refund, see invoice # 229000
Key Fields for:  <Defautt Key Fields= -
Case queue Contract Status” Watt for Customer
Case type Product Return Case owner Joe Napoli
Case reason Poor packaging Assigned to Celine Dancer
Case origin Email Priority Medium
Follow-up deadine February 09, 2012 618 P Severity High

0K H Cancel |

B Select the other tabs to view more information on the case.

View a Case from an Address Book Entry

You can view the customer service cases associated with a specific
Address Book entry in the Customer Service following pane. From the
Hotlist page, you can view the customer service cases for the Address
Book entry associated with the current task.

n Select the Address Book entry.

E In the following pane, select the Customer Service tab.

All customer service cases for the current Address Book entry, or
for the Address Book entry linked to the current Hotlist task, are
displayed in the list.

Wiley, Kendall Val
Ansley Wine Merchants ™ Details | Contacts | History | Notes | User-Defined Fields | Documents Opportunities >+
Columns: “Defautt Customer Service View | [Eg) 9€ | [£] (3] ] | ] Fiter: Al a9
4 Case Number Company/Individual Subject Assigned To Follow-up Deadiine Status Priority
HQ-00060 Ansley Wine Merchants Faulty Product Joe Napali September 18, 2011 5:2¢ Resolved High
HQ-00070 Ansley Wine Merchants Spoilt product, resend Joe Napali July 18, 2012 6:11PM Resolved High
+ HQ-00085 Ansley Wine Merchants Spoilt product, resend Joe Napoli April 25, 20136:11PM  Resolved High
HQ-00091 Ansley Wine Merchants Faulty Product Joe Napali September 18, 2011 5:2¢  Resolved High

B Click on a customer service case to open it.
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Retrieve Address Book Entries Associated with Cases

You can retrieve the Address Book entries associated with cases and
add them to the current list in the Address Book page. If a contact is
associated with the case as well as a company or individual, both the
contact and the company or individual are retrieved and added to
the list.

You can retrieve the Address Book entries associated with a single
case, or you can select multiple cases to retrieve the Address Book
entries associated with all of the selected entries at once.

n Click on the case to make it the current entry.
—or-
Select multiple cases.
¢ Click the checkbox to the left of entries.

e Click on the entries one at a time while holding down the
Control key.

e Toselect all entries between two entries, select an entry and,
while holding down the Shift key, select another entry.

E Select View > View in Address Book.



312 | Maximizer Web Access
User's Guide

Creating Customer Service Cases

You can create customer service cases to track and resolve customer
service issues. Customer service cases are always associated with
Address Book entries.

Add a Customer Service Case

To complete this procedure, you must have Insert permission for
Customer Service.

When creating a new case, you can select an Address Book entry or
select an existing customer service case or activity associated with the
Address Book entry.

n Click on the Address Book entry or an existing customer service
case associated with the Address Book entry to make it the
current entry.

In the Hotlist page, click on an activity associated with the
Address Book entry to make it the current entry.

E In the Address Book page, select Actions > Create a Customer
Service Case.

In the Address Book or Customer Service page, right-click and
select Create a Case.

—or —

In the Customer Service page, select Edit > Create a Customer
Service Case.

—or —

In the Address Book or Hotlist page, in the following pane, select
the Customer Service tab, and select the Add icon.

The Customer Service Case dialog box opens.

@You can select a different E If necessary, click the ellipsis button next to the Contact field to
Address Book entry in the search for a Contact for the case.
Customer Service Case dialog
Eoi(tby E'ICkéngﬂt]heCﬁ“PSlS , The Contact can be associated with any Company or Individual in
s eld o Pany the Address Book, and not only with the selected Address Book
entry.

n Specify the basic fields for the customer service case.

e Select the applicable Products/Services and Categories for
the case.
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¢ Enter a Subject and a Description of the case.

E From the Key Fields for drop-down list, select a Key Fields list,
and enter values for the fields in the list.

Key Fields lists contain system fields and user-defined fields. They
may include the following fields:

¢ Follow-up deadline - Select the follow-up deadline for the
case.

e Case Owner - Select the Maximizer user who is ultimately
responsible for the closure of the case.

¢ Assigned to - Select the Maximizer user who the case is
assigned to.

A Hotlist task, based on the follow-up deadline, is
automatically created for the assigned user. The task is
automatically modified when the follow-up deadline or
assigned user is modified. And when the case is resolved, the
task is marked as complete.

Customer Service Case [X]
(S % | [ ] M g Monitoring [38] [iE] Favorite List (] | [<)] Actions « [ ¢
Case Information = Notes Documents Activities
Basic Information  User-Defined Fields Solution Information & Biling
Company / Individual™ Through the Grape Vine Di... || contact: Anoza, Marylyn L
Case description
Case number: {pending) Elapsed time:  (pending)
e
Subject: Faulty Product
Products f Services: ~ Chardonnay | ... |categories: California | .1
Description: [ Customer received complaints about our 2010 Chardonnay. Ask Quality Control to ook into the issue.
Key Fields for: <Default Key Fields» -
Case queue Priority Status” Assigned
Case type Spoiled Froduct Case owner Joe Napoli
Case reason Unknown Assigned to Matt Graham
Case origin Fhone Priority High
Folow-up deadine  October 06, 2011 12:00 P Severity Medium

| 0K Cancel

E Select the User-Defined Fields tab to specify additional values
for case fields.

The User-Defined Fields tab contains Address Book user-defined
fields in the Fields for [Address Book entry] folder and Customer
Service user-defined fields in the Fields for this case folder.
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If you cannot see one of the user-defined fields you need, select
the Show blank fields checkbox to display all fields.

Click OK to save the new customer service case.

Copy a Customer Service Case

To complete this procedure, you must have Insert permission for
Customer Service. To copy the associated notes or documents you
must also have Insert permission for notes or documents.

Use this procedure to create a new customer service case from an
existing customer service case. You have the option of copying all
notes, documents, appointments, and tasks associated with the
entry.

n Click on the case to make it the current entry.

E Select Edit > Duplicate Current Entry.
The Duplicate Entry dialog box opens.

B Select the entries that you want to copy to the new entry, and
click OK.

¢ Notes duplicates all notes associated with the current entry.
e Documents duplicates all document.

¢ Appointments and tasks duplicates incomplete
appointments and tasks associated with the current entry.
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Status of Customer Service Cases

You can change the status of a customer service case at any time.
When you assign a case to another representative or escalate a case
to a manager, you can specify a new status for the case. The status
also changes when you resolve a cases.

You can also set up custom statuses for cases and select which
statuses are available when you assign, escalate, and resolve cases in
the customer service preferences in Administrator.

Assign a Customer Service Case

Customer service cases should be assigned to the customer service
team member who is best able to handle the type of issue. A
customer service team member is categorized in Administrator as a
customer service representative or a customer service manager,
though a manager can serve both roles. Cases are assigned to
representatives and escalated to managers when representatives are
unable to resolve the cases.

Cases can be assigned and escalated as often as required. When a
case is assigned or escalated, you can type a message to record why
the case is assigned or escalated. This message is then included in the
logged note.

You can send email to the user who is now responsible for the case
and to the case owner when you assign or escalate a case.

The customer also can be notified by email when a case is assigned or
escalated so the customer always knows who is handling the case
although the owner of the case is the person who is ultimately
responsible for the closure of a case. If a Contact is associated with
the case, the email message is sent to the Contact. Otherwise, the
message is sent to the Company/Individual.

n Click on the customer service case to make it the current entry.
—or-
Open the customer service case.
E Right-click, and select Assign or Escalate.
—or-
In an open entry, select the Assign or Escalate icon.

The Assign Case or the Escalate Case dialog box opens.

ﬂ In the Assign to or Escalate to drop-down list, select a
Maximizer user.
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Case Hotlist Tasks

To be listed in this dialog box, users must be assigned to the
Customer Service Manager or the Customer Service
Representative role in Administrator.

n In the Status drop-down list, select the status of the case, or
leave the default status.

The default status is Assigned or Escalated. But you can select
any status that is set up to display in Administrator.

E Enter a Note about the case assignment or escalation.

E In the Actions area, select the corresponding option to notify
the assigned user, case owner, or Address Book entry.

Click OK to finish assigning or escalating the case.

Assign Case [X]
Assignment
Case number: HO-D00S1
Company / Individual: Beringer Vineyards
Contactname: Sioan, Deana Josefina
CurrentiyAssigned to: Celine Dancer
AssignTo:  Matt Graham [+]
Stalus;  Assigned [+l
Note:
HiMatt,

Please follow-up on this case while Celine is on vacation

-Joe

Actions

/| Hotify the assigned user by email
Notify the case owner by emall
/| Notify the Address Book entry by emailthat the case has been re-assigned

Create Hotlist task for myself to check on this case

Hotlist tasks are automatically created when users and follow-up
deadlines are assigned to cases. When a case is assigned or escalated,
a Hotlist task is created for the user to which the case has been
assigned or escalated. The original user’s task remains. If a case is
assigned or escalated to yet another user, a task is created for that
newly-assigned user and so on for each assigned user. When a case is
resolved, the original task is automatically marked as complete.

The task date and time correspond with the case follow-up deadline.
The assigned user, the associated Address Book entry, and the case
subject are included as the task details. Case tasks are created
regardless of Hotlist access rights.
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Resolve a Customer Service Case

@ Note that you can include this
information in automated
email templates for customers
by using the
Case_Solution_Note merge
field.

When you solve a customer’s issue, you can resolve the customer
service case in Maximizer. You can document the details of how the
case is resolved, add a new solution (if any) to the knowledge base,
and notify the customer and user to whom the case is assigned. You
can perform these tasks directly in the Resolve Case dialog box.

n Click on the customer service case to make it the current entry.
Open the customer service case.

E Right-click, and select Resolve.
In an open case, select the Resolve icon.

E Specify the billing information for the case.
e Select a Billing type.

e Specify the number of hours worked on the case in the
Billable time (hrs) field.

e Enter the hourly rate in the Billing rate field.

¢ If Maximizer prompts you to update the Case fee
automatically by multiplying the Billing rate by the Billable
time, click either Yes or No to specify your preference.
Otherwise, enter the Case fee.

n Enter the Solution notes for the case. These notes would
include any specific information about how the case was
resolved.

You can also select a knowledge base article to link to the case,
or create a draft knowledge base article from the solution note.

E Under Case Users/Case Monitors Notification and Address
Book Entry Notification, specify how you want to notify other
Maximizer users and the Address Book entry associated with the
case.

In either section, select Include related article as attachment
to attach the knowledge base article associated with the case to
the email message.
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E Click OK to finish resolving the customer service case.

Resolve Case [X]

Case information 0K
Case number: HO-00044 Company/individual. Billabong and Co. Wine Distributors

Case resolution information

Assignedto:  Joe Napoli Resolved by Jos Napol

Resolution date:  3/28/2011 3:01 PH Status: Resolved [=]
Biling type: Complimentary Bilable ime(hrs):  5.00

Biling rate 50.00 Case fee: 250.00

How the case was solved
Solution notes:

Ve investigated the problem and noticed some issues with how we processed this wine shipment. We should
investigate further to see if this issue is affecting any other customers. |

/| Create a draft knowledge base article from solution notes and link it to this case
Solution involves information from an existing knowledge base article

Artice #: Tile:
Case Users/ Case Monitors notification Address Book entry notification
Notify the assigned user by email /| Notify the Address Book entry by email
/| Notify the case owner by email Include related article as attachment

/| Include related article as attachment

Recording Case Solutions

While resolving a customer service case, you can keep track of the
solution to the case in the knowledge base. You can choose from the
following options:

¢ Solution involves information from an existing
knowledge base article - Select this option if an existing
knowledge base article resolved the case. Enter the knowledge
base article number.

¢ Create a draft knowledge base article from solution notes
and link it to this case - Select this option if the case was
resolved without the assistance of an existing knowledge base
article. Type a concise, detailed explanation of how the case was
resolved in the Solution notes text box. If the status is set to
Abandoned, this option is unavailable.
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Email Notification for Customer Service Cases

When customer service cases are created, assigned, escalated, or
resolved, email messages can be automatically sent to customers and
users notifying them of the changes. Maximizer automatically inserts
the basic details of the case in the message so you don't have to write
the email message with case details each time.

To set up case email notification, you must create email notification
templates in Administrator. You can create separate templates for
each action (create, assign, escalate, or resolved). Each action can also
have separate templates for sending email to customers/partners and
users. Partners can receive the same email notification as their
associated customer. User notification email is sent to the users
identified as monitors for the case.

For detailed information on how to create email templates for case
notification, see the Maximizer CRM Administrator’s Guide.

Configure Customer Service Case Monitoring

@ Monitoring preferences are
available only in Maximizer
CRM Enterprise Edition.

You can configure email notification for customer service cases in the
monitoring preferences. You can specify to receive email notification
when notes are added or modified and when fields are changed. You
can also select specific fields to receive notification only when one of
the specified fields changes. You receive notification only for the
customer service cases you are selected to monitor.

n In the top-right corner of the page, click on your image, and
select Preferences.

E Click Other Preferences.
ﬂ Select the Monitoring tab.

n From the Monitoring rules for drop-down list, select
Customer Service.

E To receive notification when notes are added or modified, select
Receive monitoring notification on note changes.

E To receive notification when fields are changed, select Receive
monitoring notification on field changes, and select the
fields for which to receive notification.

e To receive notification when any field is modified, select All
fields.

¢ To receive notification when specific fields are modified,
select Only when one of these fields is changed, click the
ellipsis, and select the fields.
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Click OK to save the changes to the Preferences dialog box.

Preferences - Mozl Firefox ==

Logging  CalendawHotlist | Manitoring  Email — Startup L7

Monitoring rules for: - Customer Service =
Monitoring rules
Specify the monitaring notification rules For Customer Service cases that you are monitoring.

| peceive monitaring notification on nate changes
| Receive monitoring notification on field changes
Al figlds

8 Only when one of thess Fislds have changed:

Fallow-up deadine, Queue, Status

| 0K | | Cancel |

Select Users for Case Monitoring

To complete this procedure, you must have Modify permission for
customer service cases.

A default list of case monitors is set up in the Customer Service
preferences in Administrator. You can select this default list, or you
can select any other users to monitor specific customer service cases.
You can also choose not to monitor specific customer service cases.

Case monitors receive email messages based on templates set up in
Administrator. You can create different templates for each type of
action. See the Maximizer CRM Administrator’s Guide for details.

You can also specify how to monitor new cases in the default case
entry.

n Click on the customer service case to make it the current entry.

Open the customer service case.



Chapter 10 | 321

E Select Edit > Case Monitoring.
—or-
Right-click, and select Case Monitoring.
—or-
In an open case, select the Monitoring icon.
B Select one of the case monitoring options.

e Select Do not monitor this case to remove all users from
the list so no user receives email regarding this case.

¢ Select Use the system default case monitoring user list
to display the users specified in the system default case
monitoring list.

¢ Select Use the custom list below to modify the list of users
who monitor the case.

Select Users for Case Monitoring ]
Select which list of users should monitor this case
Do not monitor this case
Use the system default case monitoring user list
©! Use the custom list below
Selected users for case monitoring
Celine Dancer Add...
Joe Napoli
Lou Jones
Matt Graham l:l

n If you select to use a custom list for case monitoring, click Add to
add a user to the list.

The Assign User dialog box opens. A list of available users is
displayed on the left and the current list of case monitors is
displayed on the right.

E Select users from the list on the left and click the right arrow
button to add the users to the list on the right.

e To select multiple users, press Control while selecting the
users.

e To select a series of users, select the first user in the series,
then press Shift and select the last user in the series.

¢ Type the first letter in the item’s name to jump to that item in
the list.
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e Select a security group, team, department, or division to add
all members of the group to the list.

Users are grouped by the security groups, teams, departments,
and divisions to which they belong if you have the “Display users
by groups” option enabled in your preferences.

E Click OK to close the Assign User dialog box.

Assign User - Mozilla Firefox =5

Select a user to assign

All Users Selected User(s)
2 Bille Holly & Joe Napol (555) 775-0962

& Celine Dancer & LouJones (555) 775-0987

o
@ Daniel Brown
o

o
@ Jon Bowser

[ 1]

& Lucy Garcia
o
& Mark Bertoli

>
& Matt Graham =]
& Miranda Corel <
= Wonda White

D

Divisions

Security Groups

Teams -

Click OK to save the changes to the case monitoring list.

Customer Service Merge Fields

@ You cannot access the
Maximizer Word Processor
from Maximizer Web Access,
as it is available only in
Maximizer.

Merge fields in the email template personalize the message for each
recipient by replacing the merge field code with the actual field
value for that Address Book entry. For example, including the
{First_Name?} merge field in an email template would replace that
code with each email recipient’s actual first name.

You can create templates in either .ETF (Maximizer Word Processor)
or .HTML format. When creating templates in the Maximizer Word
Processor, simply click the Merge Field button and select the merge
field to insert into your email template. However, HTML templates
are created in an HTML or text editor, which does not contain the
Maximizer merge field selection dialog box. While you can manually
type the merge field codes into your HTML document, it’s easier to
first create the template in the Maximizer Word Processor and then
copy the template (including the merge field codes) into an HTML
template.

Commonly used customer service merge fields are described below:



@ The question mark in a merge
field is used to alert users to
not leave a space if no value is
assigned to the related
Address Book entry for the
merge field.
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{My_Name?} - Full name of the logged-in user (first name,

initial, and last name).

{My_Company?} - Name of the logged-in user’s company.

{CS.Case_Number?} - Case number.

{CS.Client_Name?} - Name of the associated Address Book
entry (Company or Individual).

{CS.Contact_Name?} - Name of the Contact associated with
the case. Because this field is not mandatory in customer service
cases, a value may not display in case notification emails.

{CS.Subject?} - Case subject.

{CS.Assigned_To?} - Name of the user who the case is assigned
to. Applies to case assignment or escalation emails only.

{CS.Resolved_By?} - Name of the user who resolved the case.
Applies to case resolution emails only.

{CS.Resolved_Date?} - Date when the case was resolved.
Applies to case resolution emails only.

{CS.Resolved_Time?} - Time when the case was resolved.
Applies to case resolution emails only.

{Case_Solution?} - Knowledge base article number associated
with the case resolution. Applies to case resolution emails only.

{Case_Solution_Note?} - Notes from the Solution Notes field
in the Solution Information & Billing tab of the Case dialog box.
Applies to case resolution emails only.
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Knowledge Base

The knowledge base keeps track of the solutions to your customer
service cases. Each separate case solution is stored in a knowledge
base article. An article is typically created for each case solution,
answered question, or guideline relating to your products or services.

Articles in the knowledge base are stored in standard format (text),
in a document format (file attachment), or hyperlink format (URL to
external file).

Knowledge Base Page

The Knowledge Base page provides you with a library-style tool to
manage your knowledge base articles. The page is tightly integrated
with the Customer Service page.

The Knowledge Base page displays articles according to number, last
modified date, product, category, title, and status. Click on a column
heading to sort the articles by the column subject matter.

] Knowledge Base [11 displayed] Current User: Joe Napoli | Preferences | Logout | |Help «
« Bt v | View | Search | Actions v | Report - @
2| Dashboards Status: Al -1 &=
~ Artide # | Last Modified Product Category Title Status
[5), my work Day
v HQKB0ODOI July 28,2011 Dolmath, Hunts Merlat 1995 Bin 999 - Sour Taste Published
I:‘i Address Book HQKBOOD0Z  July 28,2011 Al Cabernet Sauvignon  Emai Campaigns with Maximizer CRM Cam  Internal
HQKBOOD0Z  October 05, 2011 Hunter France Sour Wine Shipment Draft
[ ! opporturities
HQKBODD04  July 28,2011 Hunter Chardennay Product Descriptions (Chardonnay) Draft
[Z] quotas HQKB00D05  October 05, 2011 St. Piere california 2007 Red Wine blend has too much Tanin ~ Published
[ HQKBODD0S  July 28,2011 Hunter France About the Winery Published
2]
{2 CamPaigns + HQKBOOOD?7  October 05, 2011 Al California Escona Wines Quality Statement Draft
[, customer Service HQKBOODDS Iy 28,2011 Al Australia Procedure for customers with broken bott  Tnternal
- HQKBOODO3  luly 28,2011 5. Pierre California Hotel &Restaurant Wine Descriptions Draft
@ Knowledae Base HQKBOOD10  October 05, 2011 Al California Retail Marketing Co-Op Funds Internal
5] wotist HQKBOOD11  October 05,2011 Chardonnay  California Fauity Product Draft

Q Company Library

E_J Reports

3 RecentEntries *
."j) User information *
@] ks »
@ Administration
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View a Knowledge Base Article

The knowledge base ensures that valuable case solutions are
recorded, reviewed for quality assurance, and made available to the
appropriate users. You can view existing knowledge base articles as
long as you have the required permissions.

n Select the Knowledge Base icon.
The Knowledge Base page opens.

E If necessary, select an option from the Status drop-down list to
filter the list of articles.

E Click on an article to open it.

The Knowledge Base Article dialog box opens displaying details
on the article.

If the article is in standard format, the entire content of the
article is displayed.

Knowledge Base Article x]
Article details
Article number: File type
Status: Draft - Owner: Public -
Craator: Last Modified:
Article description
“Title: Sour Wine Shipment
Keywords.
Products /
cervices: Hunter (| Categories: |
Article content
A number of lots of this wine have the same problem. These lots are affected: =
12300-12345
Please ask customers to return these lots for credit
Speling | \ oK H Cancel |

If the article is in document format, only the article details are
displayed.
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Knowledge Base Article x]
Article details
Article number: File type:
Status: Published Owner: Public -
Craator: Last Modified:
Article description
“Title: About the Winery
Keywords: corporate about history
Products / -
corvices. Hunter (| Categories: California L]
Replace article content
Filename: Browse
Downioad |[ ok |[ cancel |

If the article is a hyperlink, the source of the hyperlink opensin a
new browser window.

n To view the content of a document article, click Download.

Searching for Knowledge Base Articles

You can search the knowledge base for any article that matches the
basic article fields you specify, such as creator, owner, and last
modified date. To find all articles, leave all the fields blank.

You can also search for articles by phrase. Once selected, the three
search options described below apply to the article content, as well
as to the title and keywords. The Search by Phrase option searches
the article title and keywords and can be fine-tuned using the
following options:

¢ Article contains all of the words in phrase - Searches for
every word you specify.

e Article contains the exact phrase - Searches for the words in
the exact order you specify.

¢ Article contains at least one of the words in phrase -
Searches for at least one of the words you specify.

The search returns only entries containing full words specified in the
search text. If you search for text that is included in part of a word,
the search does not return entries that contain that word. For
example, if you search for “hedge”, only entries containing the word
“hedge” are returned. Entries containing the word “hedgehog” are
not returned.

You can choose to search the article content, as well as the title and
keywords, using the “Include article body contents when executing
search” option.

If you are running Maximizer on a SQL server, the Full-Text Search
engine must be installed in order to search article content. If this
option is grayed out, contact your system administrator or see the
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Maximizer CRM Administrator’s Guide for information on how to
enable the full-text search in SQL.

Status of Knowledge Base Articles

The status of knowledge base articles determines which users can
read or modify articles. Articles can also have the following statuses:

¢ Draft - Articles can be viewed and modified by creators, owners
(users or security groups), and users with the Knowledge Base
Approver role.

¢ Internal - Articles can be viewed by all users who have
knowledge base read rights, excluding Customer Access and
Partner Access users, and modified by users with the Knowledge
Base Approver role.

e Published - Articles can be viewed by all users who have
knowledge base read rights, including Customer Access and
Partner Access users, and modified by users with the Knowledge
Base Approver role.

e Expired - Articles can be viewed and modified by creators,
owners (users or security groups), and users with the Knowledge
Base Approver role.
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Adding Articles to the Knowledge Base

When you resolve customer service cases, you can create new
knowledge base articles automatically from case solution notes.
Cases are automatically linked to their new knowledge base articles.
You can also add knowledge base articles directly to the Knowledge
Base page. These articles are not linked to specific customer service
cases, though you can link the articles to cases in the future.

You can add articles to the knowledge base in standard (text) format
and in document (file attachment) format. If the article content is
short and straightforward, standard format should suffice. However,
if you want to carefully compose the article over a day or two,
confirm data with an external source, or run a spell check, you may
wish to write the document in Microsoft Word, for example, and
then attach the article as a document. You can also add an article as
a hyperlink pointing to a document stored outside of the Maximizer
Address Book.

A newly created article is assigned a draft status until it is opened
and assigned a different status by the appropriate users.

Add a Standard Knowledge Base Atrticle

Standard format knowledge base articles contain only text. You can
specify all details and content of the article directly in the Knowledge
Base Article dialog box.

n In the Knowledge Base page, select Edit > Add Standard
Article.

E Specify details of the article, including the Title, Keywords,
Products/Services, and Categories.

ﬂ In the Article content area, enter the complete content of the
knowledge base article.
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ﬂ Click OK to save the article to the knowledge base.

1. Verify number of broken bettles in case
2. Verify number of cases involved.

4. Draft/file document for re-shipment
5. Re-ship bottles.
6. Track all communications in customer record

Knowledge Base Article X]
Article details
Article number: File type:
Status: Draft Owner: Joe Napol -
Creator: Last Modified:
Article description
“Title: Procedure for processing shipments with broken bottles
Keywords: shipping &rrors
Products / -
B (| Categories: L]
Article content
Follow this procedure to process a request for refund due to broken bottles in a shipment. =l

3. Document invoice #, all shipment documents, including freight carrier

J

Speling H oK H Cancel |

Add a Document Knowledge Base Article

You can add any type of file to the knowledge base as a document
article. When attaching the file, you can browse to folders on your

computer or network.

n In the Knowledge Base page, select Edit > Add Document

Article.

E Specify details on the article, including the Title, Keywords,

Products/Services, and Categories.

ﬂ Click Browse. Browse to and select the file, and click Open.

n Click OK to save the article to the knowledge base.

Knowledge Base Article

Article details
Article number:
Status: Draft

Creator:

Article description

Keywords: storage

Products /
Services:

Article content

“Title:  Optimum wine storage temperatures

|

Filename: Di\Shared\StorageTemperatures. pdf

]
File type:
Owner: Joe Napoli -
Last Modified
Categories: L]

329
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File Formats for Document Knowledge Base Articles

Files of any format can be attached to the knowledge base as a
document article. However, the content of only the following file
formats can be searched:

e  Microsoft Word (*.DOC)

e Microsoft Excel (*.XLS)

e  Microsoft PowerPoint (*.PPT)
e Text (*.TXT)

e HTML (*.HTM or *.HTML)

Add a Hyperlink Knowledge Base Article

You can add articles to the knowledge base as hyperlinks. Hyperlinks
record links to documents stored outside of the Address Book, for
example on local and network drives, on external websites, in
Microsoft SharePoint folders, and in any other locations that can be
expressed as URLs. When you open a hyperlink, the source document
of the hyperlink is displayed in a new browser window.

n In the Knowledge Base page, select Edit > Add Hyperlink
Article.

E Specify details of the article, including the Title, Keywords,
Products/Services, and Categories.

ﬂ In the Article Hyperlink area, enter the URL of the article.
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ﬂ Click OK to save the article to the knowledge base.

Knowledge Base Article =
Article details
Article # File type:
Status: Draft [+] Owner: Jos Napoli [+]
Creator: Lou Jones Last Modified:

Article description
“Title: Background Information on California Wine Industry

Keywords: History California Wine

Products /
services: ! ] Categories:

Article Hyperlink

http:ifen. wikipedia.org/wikiCalifornia_%28wine%29|

speling | [ ok

| [ cance

Modify a Knowledge Base Article

Users can modify existing articles depending on their user roles and

the status of the knowledge base articles.

n In the Knowledge Base page, click on the article to make it the

current entry.

E In the View bar, select the Properties icon.

331

The Knowledge Base Article dialog box opens displaying details

on the article.

E Edit the article details.

ﬂ To replace the content of a document article, click Browse and

select the new article.

E Click OK to save the changes to the article.
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CHAPTER

Report on the Progress of Your Business

In this chapter...

“Dashboards” on page 334

“Reports Module” on page 350

“Printing Reports from Maximizer” on page 358
“Exporting Entries to Microsoft Excel” on page 365

“Reporting in Excel” on page 367
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Dashboards

View a Dashboard

Maximizer Dashboard provides you an instant view of various metrics
measuring your activities and your performance in real time. With
the appropriate metrics, you will be able to see which areas are
doing well and which areas need attention. Management can also
use Dashboards to help proactively adjust tactics, resources and
follow-up activities important to the success of the company.

With this type of information on your screen at all times, you can see
in a glance how your company is doing and even see the indicators
register activity from moment to moment.

For important indicators, such as daily lost or won opportunities, you
can configure Dashboard to notify you with an alarm when the
indicator passes a certain mark. This helps to notify you when a
critical situation has occurred that requires your attention, or when
you surpass a goal that you set for your team.

To complete this procedure, you must have Read permission for
Dashboards. As well, Show Dashboards must be selected in your
Startup preferences.

You can access your dashboards from the Dashboards icon in the icon
bar. If the dashboard you want to view is not displayed, select it from
the drop-down list.

n Select the Dashboards icon.

E From the drop-down list, select the dashboard you want to view.
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The selected dashboard is displayed.
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My Work Day | | Dashboards ‘

Joe's Dashboard -

[ save [lsaveas [-|Properties | [3Share ,=Print | 43 DashboardWizard |&limport | ™ Refresh < Cancel

Open Oppotturities DOpen Cases

Celine Dancer.

0123456781910

9 Joe Napoli T — 4

Today's Activities
‘Weekly Reverus

Iy follow-up deadline is approaching
et with Patsy to confirm deal
Customer Service Meeting

Phone La Casita to confirm reservation

Book hatel for West Coast Wines trade
show.

05/01/2010
17/02/2010
Ti0gemo
17/02/2010
17/0z/200

12:31 P
11:30 Ak
300PM
12:00 Ak
12:00 Ak

Setting up a new dashboard involves the following tasks:

n Set up searches or SQL metrics for your dashboard indicators.
For more information, see “About Indicators” on page 337.

E Create the dashboard using the Dashboard Wizard.
For more information, see “Create a Dashboard” on page 336.

Add indicators to the dashboard.

For more information, see “Add an Indicator to a Dashboard” on

page 341.

ﬂ Customize the appearance of the dashboard indicators.

For more information, see “Customize a Dashboard Indicator”

on page 345.

E Resize and move the dashboard indicators.

For more information, see “Moving and Resizing Dashboard

Indicators” on page 346.
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Create a Dashboard

You can create new dashboards from the Dashboards tab of the My
Work Day page. While creating the dashboard, you can add multiple
indicators to the dashboard. The new dashboard is available to any
user or group that you give read access to. When you create a
dashboard, you have the option of publishing it to Mobile Access.

n In the Dashboards tab of the My Work Day page, select the
Dashboard Wizard icon.

The Dashboard Wizard opens.
E Select Create a New Dashboard, and click Next.

& | Dashboard Wizard -- Webpage Dialog ==

Dashboard

HiA ‘Work with Dashboards

¥ Create a New Dashboard

Create a completely new Dashboard. This option starts with a blank canvas and alows
you to build, save, and distribute a dashboard

" Edit current Dashboard

This option allows you to change an existing dashboard and save those changes so that
you and other users can ses them, or to save it as a new dashboard

£\ 2 ‘Work with Indicators

" Create a New Indicator

Create a completely new Indicator, which is a measure of one or more of your business
metrics. This option adds a new Indicator to the current dashboard. If this is a shared
dashboard, all other users wil also see the new Indicator.

" Edtt an existing Indicator

This option allows you to change an existing Indicator on the current dashboard and
save those changes so that you and other users can see them

Next = Cancel

ﬂ Enter the basic information for the dashboard.

¢ In the Dashboard Name field, specify a name for the
dashboard.

¢ In the Full Access and Read Access fields, specify the
Maximizer user or group with access to the dashboard.

¢ Select Dashboard is available in Mobile Access to make
the dashboard available to Mobile Access users.

If you don’t select this option, the dashboard is available only
in Maximizer and in Maximizer Web Access. You might want
to clear this option if the dashboard is not set up to display
well on smaller screens.
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& | Dashboard Wizard -- Webpage Dialog ==

Dashboard details

Give the dashboard a name and description, and indicate Users and Groups which can
access the dashboard

Due to the screen size, you probably do not want all dashboards avaiable for mobile users
To make a dashboard avaiable to mobile users, check the "Dashboard is available for Mobile
Access” option

Dashboard Name: Joe's Dashboard
Full Access. Joe Napoli -
Read Access:. Public -

Description

V| Dashboard is available for Mobile Access

<Back | [ Next= | [ Finish | [ cancel

n Click Next.
The Indicators screen opens.

E Add an indicator to the dashboard.

For more information on adding indicators, see “Add an
Indicator to a Dashboard” on page 341.

E When you are finished adding indicators, click Finish in the
Dashboard Wizard to finish creating the dashboard and to view
it in My Work Day.

Indicators display the information in your dashboards. Each
dashboard can contain multiple indicators.

You can set up indicators to access Address Book information in the
following ways:

e Saved searches - You can link indicators with existing searches
in the search catalog. The indicator reports either the number of
entries returned in the search or a calculation based on fields in
the entries.

e SQL metrics - Your administrator can set up SQL queries that
report on any information in your Address Book. While they are
defined in Administrator, you can add any of these metrics to
your dashboard indicators in Maximizer.

¢  Filters - You can specify filters for activities and quotas and
return information on the entries that match the filters. You can
filter information by date, assigned users or teams, and values of
specific fields in appointments and tasks.
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Searches for Indicators

SQL Metrics for Indicators

You can choose from a number of indicator controls to display the
data. These controls format your Address Book data in charts, lists,
and gauges.

While setting up your indicators, you can set up Click Throughs for
the indicators. Click Throughs determine what happens when a
Maximizer user clicks on an indicator. You can set up the Click
Throughs for an indicator to open another Dashboard, to retrieve a
list in Maximizer containing the results of the search associated with
the indicator, or to retrieve a list of the entries included in the total
for an individual group within the indicator.

You can use the Advanced Search command to set up searches in the
Address Book, Opportunities, Customer Service, and Campaigns
pages and then save the searches to the search catalog. When you
create indicators, you can select any of these saved searches to access
data for the indicator. You can also report on quotas, appointments,
and Hotlist tasks in your indicators. While you cannot save searches
for these types of entries, you can set up some search criteria while
creating the indicator.

While setting up the search criteria, you can specify generic values in
your searches to make them reusable for different users and at
different times. For fields that take Maximizer users as values, you
can specify the current user as the value of the field. For date fields,
you can specify values in relation to the current date, such as today,
next month, and current fiscal quarter. Each time the search is run,
values for the current user and values relative to the current date are
retrieved.

Your administrator can define any number of SQL metrics for
dashboard indicators. You can specify any of these metrics when you
create new indicators. When you create group indicators, you can
define a number of SQL metrics for each indicator. For more
information on setting up SQL metrics, see the Maximizer CRM
Administrator's Guide.

Reporting on Data for Indicators

After setting up your search from the search catalog, you can decide
how to report on the search. The indicator can report on the entries
in the following ways:

¢ Average - The indicator displays the average value of a selected
numeric field for all entries returned in the search.
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Minimum - The indicator displays the minimum value of a
selected numeric field for all entries returned in the search.

Maximum - The indicator displays the maximum value of a
selected numeric fields for all entries returned in the search.

Range - The indicator displays the difference between the
maximum and minimum values of a selected numeric field for all
entries returned in the search.

Record count - The indicator displays the number of entries
returned in the search.

Sum - The indicator displays the sum of a selected numeric field
for all entries returned in the search.

When you set up your indicators, you can choose from a number of
controls in which to display your indicator. The controls determine
how information is displayed in the indicator.

You can select the following types of controls:

Group indicators - These controls display a number of values
formatted as bar charts or pie charts. When a Click Through to
produce a list in Maximizer is specified for a group indicator,
clicking on an individual group within the indicator retrieves
only the entries included in that group

Open Cases

Lou Jones

Matt Graham 2

Celine Dancer 2

Joe Napoli 2

List Control - These controls format information in lists. They
can report information directly from Maximizer records, or they
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can summarize information based on values from multiple
entries.

Today's Aclivilies

Meeting 2401172009 3:30 PM
Customer Service Meeting 24/11/2009  2:00 PM
Phone representative about new deal.  24/11/2009  11:00 AM
Book hotel for Santa Rosa trade show.  24/11/2009

Fhone to confirm reservation 24/11/2003  11:00 AM

* Gauges - These controls display a single numeric value for an
indicator.

Open Dppottuniiss

0123456788310

]

Grouping for Indicators

When you set up a bar chart or pie chart Group Indicator, you can
choose how you wish to group the information displayed in the
indicator. For example, you may want an indicator to display the sum
of the revenue for all of the current opportunities in the pipeline.
You could choose to group the opportunities by sales team to see at-
a-glance how each team is performing, or you could choose to group
the opportunities by product or service to show what your biggest
revenue generators are. Maximizer allows you to group an indicator
on any field you want within the Address Book entries,
opportunities, customer service cases, Hotlist tasks, or Quotas
returned by the search set up for the indicator.

If the field you wish to group on allows multiple selection, for
example a multi-value basic field or multi-value table user-defined
field, you can choose to group the information by unique values or
combined values. If you select to group by unique values, every
unique value that is selected in the field will be included in the
grouping, including multiple values for individual entries returned by
the search associated with the indicator. On the other hand, if you
select to group by combined values, the grouping will only include
the combined values for each entry returned by the search. For
example, in a bar chart that displays the number of current
opportunities grouped by Products/Services, if the indicator is
selected to group by unique values, an individual opportunity
associated with two Products/Services would be included in the count
for each of the two unique Products/Services groups. However, if the
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indicator is selected to group by combined values, the opportunity
would only be counted in the group of opportunities associated with
both Products/Services, and would not be counted in the groups for
each separate Products/Services.

Click Throughs for Indicators

While setting up indicators, you can specify a Click Through for the
indicator. Click Throughs link indicators to Maximizer records,
reports, or other dashboards.

When you set up your Click Throughs, you can choose the following
options:

¢ No Click Through - The dashboard indicator is not linked with
any other information.

e Use the existing Click Through - The indicator is linked to an
existing Click Through. You can select this option when you add
indicators associated with SQL metrics or when you modify
existing indicators. Your system administrator can link SQL
metrics with reports in Administrator.

¢ Produce a list in Maximizer to work with - The Address
Book, Opportunities, Campaigns, Customer Service, Quotas, or
Hotlist page opens displaying entries retrieved from the search
associated with the indicator. If the indicator is a bar chart, you
can click on an individual bar to retrieve only the entries that are
included in the total for that bar. If the indicator is a pie chart,
you can click on an individual slice of the pie to retrieve only
those entries that are included in the total for that slice.

e Run areport - Areport opens in the Reports module. You must
enter the URL of the report while setting up the indicator. You
can get the URL by opening the report from the Reports page.

e Open another dashboard - A dashboard is displayed. You
must specify the dashboard while setting up the indicator.

Add an Indicator to a Dashboard

You can add indicators while creating dashboards, or you can add
them to existing dashboards.

n If necessary, select the dashboard from the drop-down list, and
select the Dashboard Wizard icon. Then, select Create a New
Indicator, and click Next.

The Indicator Properties screen opens.

If you are adding the indicator while creating a new dashboard,
you should already be at the Indicator Properties screen.
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E Enter the basic information for the indicator, and click Next.

In the Indicator name field, specify a name for the
indicator.

In the Full Access and Read Access fields, specify the
Maximizer user or group with access to the indicator.

&  Dashbeard Wizard -- Webpage Dialog ==

Indicator Properties

Provide the following basic information for the Indicator.

Indicator name: [Revenue/Quota

Descriptien: [pisplays the revenue for the current user
compared to the sales quota

Full Access: [ Joe Napol -]

Read Access: | Public -

< Back Next = Cancel

ﬂ Select a control for the indicator, and click Next.

For more information on controls, see “Indicator Controls” on
page 339.

The What to Report screen opens.

n Select the catalog search or SQL metric to associate with the
indicator, and click Next.

To associate the indicator with a catalog search: Select Use a
catalog search. In the Records to search drop-down list,
select the type of entry associated with the search. In the
Saved search to use drop-down list, select the search from
the search catalog.

For more information on associating indicators with saved
searches, see “Searches for Indicators” on page 338.

To associate the indicator with information from activities
(appointments and Hotlist tasks) or quotas: Select Use a
catalog search. In the Records to search drop-down list,
select Activities or Quotas and Sales.

To associate the indicator with a SQL metric, select Use an
existing SQL metric. In the SQL metric drop-down list,
select the metric.

For more information on SQL metrics, see “SQL Metrics for
Indicators” on page 338.
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& | Dashboard Wizard -- Webpage Dialog ==

What to Report

“Your control will display information from your Maximizer CRM system, such as the total
Forecast Revenue of all of your Opportunties set to close this month, or a st of Activities for
this week. This is where you define what it is that will be reported. Select one of the options
below and click Next to continue.

Y=| @ uUsea catalog search

Records to search: | Quotas and Sales -]

Saved search to use: |

L 0] 7 Use an existing SQL metric

SOL metric: | Abandoned Automated Campaigns -]

< Back Nexd = Cancel

E If you are associating the indicator with activities or quotas,
specify how to filter the information, and click Next.

If the indicator is associated with activities, you can filter the
activities by type (appointment or Hotlist task), user, date, and
other fields specified in the activity.

If the indicator is associated with quotas, you can filter the
quotas by team, territory, or leader and by date range.

&  Dashbeard Wizard -- Webpage Dialog ==

Quotas and Sales Metric Definition

The following selections define which Quotas will be reported by this Indicator.

Team/TerritoryiLeader. | <Current User= -
Date range: | Current Fiscal Quarter -

< Back Next = Cancel

B If you are creating a list control, specify the type of information
to return.

¢ To view information directly from entries, select Report
directly fields from your saved search results.

e To view summary information based on the values of
multiple entries, select Top N records based on
summarized data.
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If you are associating the indicator with a search, with activities,
or with quotas, specify how to report the data, and click Next.

¢ In the Primary field field, select the numeric field that you
want to manipulate.

* In the Function field, select the function to use on the field.

If you select Record count, you don’t need to specify a
primary field.

For more information on these options, see “Reporting on
Data for Indicators” on page 338.

& | Dashboard Wizard -- Webpage Dialog ==

Advanced Indicator Options - Summary Functions

The following choices allow you to define an aritimetic: function to apply when reporting your data,
such as sum, average, or total record count.

[%] Primary fieid: [ Closed Sales as a % of Quota -]

Choose a field to apply the action to. For example, you may want to Sum the field "Opportunity Actual
Revenue”, or find the Average of the field "Case Resolution Time”.

u Function: [ Sum k2|

Choose a function to apply to the field selected above.

< Back Next = Cancel

If you are creating a list control that returns information directly
from entries, this screen does not appear.

B If you are creating a group indicator or a list control with
summary information, in the Group by field, select the field by
which you want to organize the data, and click Next.

For example, to display data for each Maximizer user, you can
select a field that displays a user name.

If the field you select is a multi-value field, options appear to
allow you to Group by unique values or to Group by
combined values.

E If you are creating a group indicator or a list control, specify the
fields to display in the list (list control only), and specify how you
want to sort the indicator, and click Next.

¢ Inthe Sort By field, select the field by which you want to sort
the values. You can sort entries by the values of the primary
field or by the field that is splitting up the data.

¢ Inthe Sort order field, select Ascending or Descending to
determine in which order the values are sorted.

nmSpecify the Click Through for the indicator, and click Next.
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For more information on Click Throughs, see “Click Throughs for
Indicators” on page 341.

&  Dashbeard Wizard -- Webpage Dialog ==

Click Through

“Your control can be configured to display further information if clicked. Select one of the options.
below and click "Next' to set up a Click Through Behavior.

L-éi " No Click through
W | Use the existing Click through

B=| & produce a fist in Maximizer CRI to work with

.t]
" Run a Report

=\
" Open another Dashboard
< Back Next > Finish Cancel

If the Click Through runs a report or launches another
dashboard, specify the URL of the report or select the dashboard,
and click Next.

nnCIick Finish to finish adding the indicator to the dashboard.

Select Work with a different indicator and click Next to add
more indicators to the dashboard.

Customize a Dashboard Indicator

After adding indicators to dashboards, you can customize some of
the properties of the indicator controls. For all controls, you can
change the basic information, the SQL metrics associated with the
controls, and the colors of elements in the controls. For gauge
controls, you can change the style of the control and specify alarm
levels. For list controls, you can change the formatting of the list.

While customizing the indicator controls, you can launch the
Dashboard Wizard to modify some of the other properties of the
indicator.

n In the Dashboards tab of the My Work Day page, select the
dashboard containing the indicator from the drop-down list.

E Right-click on the indicator that you want to customize.
The Properties dialog box opens.

B In each tab of the dialog box, specify settings for the indicator.
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@ In group indicators, currency

symbols are displayed in the
legend.

In the Details tab, specify the name, description, and access
rights for the indicator.

In the Indicator Type tab (gauge controls only), select the
gauge type, scale, and style.

In the Alarm/Target Settings tab (gauge controls only),
enable an alarm for the indicator, and specify the alarm level.

In the Color Settings tab (gauge controls only), specify the
colors of elements in the indicator.

In the Gauge Settings tab (list controls or gauge controls
only), specify that gauge controls display currency symbols, or
specify the field, width, and alignment for each field in a list
control.

In the Metrics tab, view the name of the metric associated
with the indicator.

If the indicator uses a SQL metric, you can select a different
metric in this tab. If the indicator uses a search, you must
specify the search criteria in the Dashboard Wizard.

In the Display Settings tab (list controls) or Settings tab
(group controls), specify the colors, font size, and font style
for elements of the control.

For group indicators, you can also specify the intervals for the
charts and specify that the indicators display currency
symbols.

ﬂ To modify the properties of the indicators, click Wizard to open
the Dashboard wizard at the Indicator Properties screen.

E When you are finished, click OK.

E Click the Save icon to save the changes to the dashboard.

Moving and Resizing Dashboard Indicators

When you add an indicator to a dashboard, it's added at the bottom
of the dashboard. But you can drag and drop the indicator to move it
to any location in the dashboard. When you press Save, the location
is saved with the dashboard.

You can also resize dashboard indicators. Click the bottom-right
corner of the indicator and drag it to the desired size.
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Modify Dashboard Properties

Send a Dashboard

You can quickly modify the properties of dashboards. You can
change the basic information for the dashboard, change the
background color, and add or remove indicators from the dashboard.

n In the Dashboards tab of the My Work Day page, select the
dashboard from the drop-down list.

E Click the Properties icon.
The Dashboard Properties dialog box opens.

B In the General tab, specify the basic properties of the
dashboard.

To change the background color, click the button next to the
Background Color field, and select a color.

ﬂ In the Indicators tab, view the indicators in the dashboard.

¢ Select an indicator and click Properties to modify the
properties of an indicator.

e Select an indicator and click Remove to remove an indicator
from the dashboard.

e Click Add to open the Dashboard Wizard and add an
indicator to the dashboard.

E When you are finished, click OK.

E Click the Save icon to save the changes to the dashboard.

You can send an image of the current dashboard by email. If you
send an HTML-format email message, the image is inserted in the
content of the message. If you send a plain text email message, a
.PNG file is attached to the email message.

n In the Dashboards tab of the My Work Day page, select the
dashboard from the drop-down list.

E Select the Share icon.
The Send Email dialog box opens.

B Specify the recipients and any additional content and properties
for the email message.
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ﬂ Click Send.

Send Email - Mozilla Firefox ==

[ o ] ceineDancer
send

Subject: Customer Service Dashboard

@Bl |w e e ‘u‘;‘||®| Sendas: | One ema Format: HTWL =

FE|s 7 EE

[N
m

A-w- 8

Paragraph  w Font - Size =

Hi Celine,

Here's today's customer service dashboard:

m

All Outstanding Cases Overdue Cases by Rep

[ Celine Dancer 750.00 (12.00%) 30
I Matt Graham 1.750 00 (28 00%) 3
I Joe Napoli 3,750.00 (60.00%)

20 19.00

WHHH‘ 15,413,[1;J:
Joe Napoli o [ il
Logging

Include message body in note Save copy to entry's documents. Logging Details...

Text for note:

Import a Dashboard Created in a Previous Version of Maximizer

Dashboards created in previous versions of Maximizer are stored
locally on users’ computers in .KIN files. You can import these files
into Maximizer to store the dashboards in the Maximizer Address
Book so that they are accessible to other Maximizer users on any
computer. You must import the .KIN files into the same Address Book
they were initially created in.

The location of the .KIN files depends on your computer’s operating
system. You can search your hard drive for the .KIN file extension to
locate the files.

n On the Dashboards tab of the My Work Day page, click the
Import icon.

The Import File dialog box opens.
E Click Browse, browse to the .KIN file, and click Open.

E Click OK to import the .KIN file.

Once the .KIN file is converted to a new dashboard, it’s displayed
in the My Work Day window.
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ﬂ Click the Save As icon to save the new dashboard.
E Enter a name for the dashboard, and click OK.
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Reports Module

@ SQL Server Reporting Services
Integration must be installed
and enabled to access the
Reports module. For more
information, see the
Maximizer CRM
Administrator’s Guide.

Default Reports

Reports Page

The Reports module lets you access reports from Microsoft SQL Server
Reporting Services. You can also add new reports created in
Microsoft SQL Server Report Builder.

The following default reports are created when you first enable SQL
Server Reporting Services integration:

Login Statistics Report - Lists the date and time that each user
logs in to the Address Book in a specified time period.

Logins by User - Displays the logins to each module by users in
the Address Book.

Marketing Campaign ROI Report - Lists the opportunities
generated by each campaign and the total expected revenue
from the campaigns in a specified time period.

Opportunity Pipeline Report - Lists the opportunities
scheduled to close this quarter for the current user.

Won Opportunities Report - Lists the opportunities won in
the current quarter for the current user.

Tasks and Appointments Report - Lists the tasks and
appointments scheduled in a specified time period for the
current user.

Total Cases Reported Report - Lists the customer service cases
created by each user in a specified time period.

Unresolved Cases Report - Lists the customer service cases
currently assigned to each user.

You can access your reports from the Reports page. Keep the
following points in mind when working in the Reports page:

n Select the Reports icon to open the Reports page.

E Reports are organized in a folder structure.
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the browser.

Once the report is opened, you can export the report to a
different file format or send the report to the printer.

ﬂ Click the report icon to select a report without opening it.

E Use the toolbar icons to create a new report or folders,
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E Click on a report title to open the report in a separate instance of

download a report file to your local computer, and perform

other tasks on the selected report.

% Reports
«

ﬂ Dashboards
E My Work Day
L3 Aderess Bock
¥ Opportunities

1_«“ Campaigns

7] Knowledge Base

) RecentEntres >
§il user nformation
3| Lnks

37 Administration

I~ | customer Service

{23 company Lbrary

CurrentUser: Joe Napoli | Preferences | Logout | [Help v

&4 Hew Report _?;Mudfynaj, Download | glNew Folder < Delete  |-_|Properties 9
= [ ]EsconaTutorial
= |__] Administration

&) Loanst

|®) Lagins by User

%) Ooportunity Pipeline Report
%) wen Opportunities Report

& [ services
[€) Tasks and Aopointments Repo

[®] Total Cases Created Report
ﬂ €] unresolved Cases Report

»

View a Report

n In the Re

report.

A click the
The repo

ports page, navigate to the folder containing the

report title.
rt opens in a new instance of the browser.
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B If necessary, at the top of the report, adjust the options, and click

View Report.

For period:  This week - Carry forward unfinished activities: Mo - Wiew Report

4 4 of1 b bl @ Find | Next b~ &

61 maximizercrm
Tasks and Appeointments Report
Show activities for: This Week Current Date: Sep 09 2011
Carry forward unfinished activities: Mo
Appointments
Date Time Subject Priority  Name Company Status
08/05/2011 12:00 PM Lunch Meeting HI StHelena Wine Merchant StHelena Wine Merchant
08/06/2011 9:00 A Weekly Sales Meeting MED
08/0B2011 130PM Interview 1 Do, Jane Ceese) CE Bzer & s

Store

08/06/2011 2:00PM MNew appt. Johnzon, Ed ABC Wine Shop Inc.
08/06/2011 2:30PM Interview 2 Tulley, Jennifer Sunrise Media
08/07/2011 11:00 Abl Escona Wine Tour MED Richard, Elisabeth Capital Vineyards

Creating Reports for the Reports Module

You can create reports for the Reports module using Microsoft SQL
Server Report Builder. You should create new reports from the
existing reports that are installed when you first enable the SQL
Server Reporting Services Integration. However, if you later want to
modify the report, you can open the copy of the report stored locally
on your computer. There’s no need to download the report again
from the Reports server.

Here's an overview of the steps required to create a new report:

n If necessary, install Microsoft SQL Server Report Builder.

You can download SQL Server Report Builder from the Microsoft
Download Center.

For more information, see “Install Microsoft SQL Server Report
Builder” on page 353

Download an existing report from the Reports page.

The data source for the report automatically points to the
current Address Book.

For more information, see “Download a Report from the Reports
Page” on page 353.

Open the .RDL file in SQL Server Report Builder.

When you open the file, you do not need to connect to the
Report Server.

n Use the tools in SQL Server Report builder to modify the report.
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If you want to work on an empty report, you can delete all
existing elements in the report except for the data source.

For more information see “Using SQL Server Report Builder” on
page 354.

E Save the report locally on your computer.

E Add the report to the Reports page.

For more information, see “Add a Report to the Reports Page”
on page 355.

Install Microsoft SQL Server Report Builder

n In a web browser, visit the following URL:

http://www.maximizer.com/url/maxcrm/
Max12reportbuilder.html

The URL opens the Microsoft SQL Server 2008 R2 Report Builder
3.0 page in the Microsoft Download center.

E Download the ReportBuilder3.msi file.

E When the download is complete, run the ReportBuilder3.msi
file.

n Go through the Microsoft SQL Server Report Builder installation
wizard to complete the installation.

In the Default Target Server page, leave the Default target
server URL field empty.

E When the installation is finished, click Finish to close the
installation wizard.

Download a Report from the Reports Page

You can download an existing report from the Reports page and
open the report in Microsoft SQL Server Report Builder.

n In the Reports page, select the report.

E From the toolbar, click Download.

ﬂ Save the .RDL file locally to your computer.

n Open the file in SQL Server Report Builder.


http://www.maximizer.com/url/maxcrm/Max12reportbuilder.html
http://www.maximizer.com/url/maxcrm/Max12reportbuilder.html
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Using SQL Server Report Builder

Data Source for Reports

Running Reports

You can use Microsoft SQL Server Report Builder to create new
reports and modify existing reports in the Reports page. Reports
created in SQL Server Report Builder are saved as .RDL files, which
can be viewed in the Reports page. For detailed information on how
to use SQL Server Report Builder, see the SQL Server Report Builder
documentation.

The data source for reports should point to a Maximizer Address
Book. When you first create a report in SQL Server Report Builder, it's
best to download an existing report from the Reports page and
modify this report. The data source for the report automatically
points to the current Address Book.

If you add a data source that points to a different database (either a
Maximizer or a non-Maximizer database), the data source gets
modified while uploading the report to the Reports page. You must
modify the data source from Report Manager after uploading the
report. You can also upload the report directly to Report Manager to
keep the data source intact.

You can run a report in SQL Server Report Builder to view a preview
of the report. When you run the report, you are prompted for a user
name and password. You can use your Maximizer user credentials to
view the report. You must enter the password in uppercase letters.

If you use Windows Authentication, you must also modify the data
source of the report to run the report as the current Windows user:

n In SQL Server Report Builder, in the left pane, under Data
Sources, double-click the data source of the report.

The Data Sources Properties dialog box opens.
E In the left pane, select Credentials.
ﬂ Select Use Current Windows User and click OK.
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Add a Report to the Reports Page

You can import existing reports saved as Report Definition Language
(.RDL) files to the Reports page in Maximizer. Reports created in
Microsoft SQL Server Report Builder are saved as .RDL files. When
you first create a report in SQL Server Report Builder, it's best to
download an existing report from the Reports page and modify this
report. The data source for the report automatically points to the
current Address Book.

n In the Reports page, select the folder to which you want to add
the report.

E From the toolbar, select New Report.
The New Report dialog box opens.

E Specify access rights for the report.

By default, the SSRS Report Management group and the current
user are given full access to the report, but you can select any
users and groups in the Full access and Read access fields.

n Under File to upload, click Browse.

E Navigate to the .RDL file, and click Open.
The name of the report is replaced by the file name.

E Click Create.

Mews Report - Mozilla Firefox ==
New Report 'l create [ cancel
Basic information
Parent folder:  jEsconaTutorialiServices
Report name:  Current Cases in Progress

Description Lists the current customer service cases in the specified case

queue|

Access rights
Fulaccess:  S5RS Report Management, Joe Napol

Read access: Public

File to upload

Erowse..
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Modify an Existing Report

Export a Report

You can replace an existing report in the Reports page with another
Report Definition Language (.RDL) file created in Microsoft SQL
Server Report Builder.

If you are modifying one of the default reports, you should also
rename the report. Otherwise, the report may be overwritten with
the original report if the system administrator changes the SQL
Server Reporting Services settings in Maximizer Web Access
Administrator. You can specify a name for the report in the report
properties.

n In the Reports page, select the report.
E From the toolbar, select Modify Report.
The Modify Report dialog box opens.

E Under File to upload, click Browse.
n Navigate to the .RDL file, and click Open.
H ciick ok.

You can export a report in the Reports page as a file in one of the
following formats:

e Portable Document Format (.PDF)
e  Microsoft Word document (.DOC)
e  Microsoft Excel document (.XLS)

After exporting the report, you can edit it using external
applications.
n From the Reports page, open the report

E Select the Export icon, and select the type of file you want to
export: PDF, Excel, or Word.

E Click OK to open the file in the external application.
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Print a Report in the Reports Page

To complete this procedure, you must be using Microsoft Internet
Explorer.

n From the Reports page, open the report.

E Select the Print icon.

If it's your first time printing a report from the Reports page, you
are prompted to install the SQL Server Reporting Services add-
on.

B If necessary, install the SQL Server Reporting Services add-on.
The Print dialog box opens.

n Select a printer and specify printing properties.
E Click OK to send the report to the printer.
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Printing Reports from Maximizer

Maximizer contains a number of reports that let you view and print
detailed information on your entries and activity. For example,
column reports display any information from Maximizer as it appears
in the current list, while detailed reports let you print more detailed
information on specific entries. Other reports, such as the notes, and
user-defined fields reports, let you print specific information about
your Address Book entries, opportunities, campaigns, and customer
service cases.

Types of Reports

A number of reports are available from the Reports menu in
Maximizer:

e Calendar View - Displays the contents of the Calendar page in a
printable report. This report is available only in the monthly
view.

¢ Column Report - Displays the same information you see
displayed in a controlling window, such as names and addresses
or opportunity information.

¢ Consolidated Activity Report - Displays the notes, Hotlist
tasks, and appointments created by or assigned to Maximizer
users in a specific date range.

¢ Customer Service Workload Report - Displays the number of
customer service cases assigned to each representative, along
with summary statistics showing the average age of cases for
each representative, as well as details about each case. The
Customer Service Workload Report is only available in the
Customer Service module.

¢ Detailed Report - Includes basic information for an Address
Book entry, a customer service case, a campaign, or an
opportunity.

¢ Email Campaign Response Metrics Report - Displays
information related to email campaigns, including the number
of emails sent, the open rate for emails, and click-through
statistics. The Email Campaign Response Metrics Report is only
available in the Campaigns module.

¢ Incoming vs. Outgoing Calls Report - Displays the phone
calls made and received by users along with summary statistics
about the duration of calls.

¢ Notes Report - Prints notes attached to an Address Book entry,
a campaign, a customer service case, or an opportunity.



Print a Column Report

@ To print background colors
from the coloring rule, you
may need to enable
background colors in your
browser’s print settings.
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¢ Phone Log - Lists phone calls recorded in Maximizer for the
current user on a specific day.

e Pipeline Report - Displays information about the current
opportunities throughout the various stages of the opportunity
pipeline. The Pipeline Report is only available in the
Opportunities module.

¢ User-Defined Field Report - Lists the user-defined fields
attached to an Address Book entry, a campaign, a customer
service case, or an opportunity.

Column reports display information from the current column setup
for entries in the current list. You can choose to include information
for only the current entry, for selected entries, or for all entries in the
list. Entries are displayed in the order that they appear on the screen
using the colors in the current coloring rule.

You can print column reports from the Address Book, Opportunities,
Campaigns, Customer Service, Hotlist, and Knowledge Base pages, as
well as from the Notes, Documents, User-Defined Fields, and
Activities tabs in open entries.

n From a main page, select a column setup and apply a coloring
rule.

—or-
Open an entry and select the Notes, Documents, User-
Defined Fields, or Activities tab.

E Click on the single entry to include in the report to make it the
current entry.

—or-

Make a list of entries to include in the report.
—or-

Select the entries to include in the report.

e Click the checkbox to the left of entries.

e Click on the entries one at a time while holding down the
Control key.

¢ To select all entries between two entries, select an entry and,
while holding down the Shift key, select another entry.

E Select Report > Column Report.

In an open entry, select the Print icon.
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Print a Note Report

The Print Column Report dialog box opens.

ﬂ Specify the report details.

¢ Under Print Column Report, specify how you want to use
the current list.

¢ Under Report Options and Print Options, specify the title
and format of the report.

Print column report ]
Print column report
@) Current entry only
Al selected entries.
Al entries in the list
Report options
Report title: Contacts
) print horizontally /| Print column titles
Print vertically /| Print totals for numeric user-defined fields.
Print options
Suppress heading
Show colors of colering rule (2)
H cik ok.
A new instance of the browser opens displaying the content of
the report.
E Click Print.

Specify the printing properties and finish printing the report in
your browser.

The note report displays the content and properties of notes
attached to entries. It can include specific notes or all notes attached
to an entry or multiple entries in a list. You can filter out notes to
include only notes matching specific criteria in the report.

You can print a note report for a single entry, for multiple selected
entries, or for all entries in a list in the Address Book, Opportunities,
Campaigns, or Customer Service page. You can also open an entry
and select specific notes to include in the report.
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Create a list of entries.

In a main list, select the entries for which you want to print
notes.

Click on the entry to make it the current entry.
Open the entry and select the Notes tab.

In an open entry, select any specific notes you want to include in
the report.

Select Report > Notes Report.

In the View bar of the Notes tab in an open entry, select the
Note Report icon.

The Print Note Report dialog box opens.
Under Print note report for, select the entries to include in the
report.

If you are printing the report from a main page, the options
refer to the entries in the main list.

If you are printing the report from the Notes tab in an open
entry, the options refer to the list of notes for the current entry.
Specify criteria for filtering out notes from the report.

¢ In the Only print notes that contain the text field, enter
text to include only notes that contain the text in the report.

¢ From the Creator and Full access drop-down lists, select
values to include only notes matching the selected values.

e Under Print notes in the date range, select the date range
for the notes to include in the report.

¢ Under Include notes of the following type, select the
types of notes to include in the report.

Under Print options, specify the content to include in the note

report.

¢ Print the entire note includes all of the note content and
properties.

¢ Print only the beginning of the note includes only the
date, time, and a fragment of the note text.

¢ Include summary statistics includes the total number of
each type of note in the report.
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¢ Maintain HTML format includes formatting in the report.
This option is available only if you are printing the entire
note content.

Click OK
Print note report =
Print note report for
© Current entry only
All selected entries
All entries in the list
Report options
Only print notes that contain the text:
Creator: +  FullAccess: -
Print notes created in the date range
From: Unti
412572011 [ 412712011 [ T print all days
Include notes of the following type
| wanual -
Wai-outs Outgoing calls | incoming calls Timed notes
Transfer log || Opportunity Customer Service || Accounting
Task Email /| History
Print options
@) Print the entire note Include summary statistics
Print only the beginning of the note /| Maintain HTML format

A new instance of the browser opens displaying the content of
the report.

E Click Print.

E Specify the printing properties and finish printing the report in
your browser.

Print a Phone Log Report

You can print a Phone Log report to print the contents of the Phone
Log from the Address Book, Opportunities, Campaigns, Customer
Service, Knowledge Base, Hotlist, or Calendar page.

n Select View > Phone Log.

The Phone Log dialog box opens displaying the phone calls
recorded in Maximizer for the current user on the current date.

E To display phone calls for a different date, next to the Date
field, select the Calendar icon and select a date.
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B If necessary, select specific phone calls in the list to include in the
report.

If you want to print all phone calls in the list, skip this step.
ﬂ Click Print.
The Print Phone Log Report dialog box opens.

E Specify the report details.

e Under Print Phone Log report, specify how you want to use
the current list of entries.

¢ Under Report Options and Print Options, specify the title
and format of the report.

& | Print Phone Log Report -- Webpage Dialog ==

Print Phone Log report
Current entry only
All selected entries

©) Al entries in the list
Report options
Reportftle:  Phone Log: 29-09-10

Print list only 7| nclude address and telephone number

@ Print full details V| Include summary statistics

Print options
Suppress heading

I3 ciick ok.

A new instance of the browser opens displaying the content of
the report.

Click Print.

E Specify the printing properties and finish printing the report in
your browser.
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Print the Calendar Monthly View

Print Details of an Entry

You can print a report showing the Calendar page in monthly view.
You can choose to include the legend of users, locations, and
resources in the report. To print the legend and color bars, the print
background setting must be enabled in your web browser. This
setting is typically found in the Page Setup options. If you do not
want to include colors in the report, you can remove items from the
Calendar legend before generating the report.

n In the Calendar page, select the Monthly view.

E If necessary, select a different month and select different users,
locations, and resources to display in the report.

E Select Report > Print Calendar.

A new instance of the browser opens displaying the content of
the report.

ﬂ To include the Calendar legend at the bottom of the report,
select Include legend.

E In the text box at the top of the report, enter a title for the
report.

I3 click Print.

Specify the printing properties and finish printing the report in
your browser.

You can print the details of the current Address Book entry or of an
open opportunity, customer service case, campaign, appointment, or
Hotlist task.

n Select the Address Book entry, and open the Details tab.

Open the opportunity, customer service case, campaign,
appointment, or Hotlist task.

E Click the Print button or the Printer icon.

A new instance of the browser opens displaying the content of
the report.

ﬂ If necessary, at the top of the page, select Click to print.

n Specify the printing properties and finish printing the report in
your browser.
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Exporting Entries to Microsoft Excel

About Export to Excel

@ The Advanced Export to Excel
command is available only in
Microsoft Internet Explorer.

Maximizer enables you to quickly and easily export selected entries
from a Maximizer page to a Microsoft Excel spreadsheet.

Maximizer exports the currently selected entries for the active page
using the column setup and coloring rule displayed in that page. If
no entries are selected, it exports all displayed entries.

If the column setup includes multiple fields in a single column, each
field is displayed in a separate column in Excel, with each column
named after the Maximizer field name. For example, if the column
setup includes a column named “Details”, which contains the fields
"Contact Name”, “Next Action”, and “Last Modified Date"”, the Excel
spreadsheet would contain three columns named “Contact Name”,
“Next Action”, and “Last Modified Date”.

If the column setup includes a table user-defined field, multiple table
items are combined into a single cell in Excel. For example, if the
column setup includes a column for the “Partner Interests” table
user-defined field, and the “General Information”, “Press Releases”,
and “Technical Bulletins” table items are selected, the Excel
spreadsheet would include a column named “Partner Interests”
containing “General Information, Press Releases, Technical Bulletins”
in a single cell.

If you use Excel 2007 or later, you have the option of performing an
advanced export to Excel. This option lets you apply conditional
formatting to numeric user-defined fields. You can choose the same
data bars, color scales, and icon sets that are available in Excel. See
the Excel documentation for more information on conditional
formatting.

Note that reports exported to Excel are not dynamic, meaning they
do not automatically update when changes to the exported entries
are made. To update an exported report, repeat the export process.

Export a List of Entries to Microsoft Excel

To complete this procedure, you must have the Allow export
privilege.

n Create a list of entries to export.

Select the specific entries to export.
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¢ Click the checkbox to the left of entries.

¢ Click on the entries one at a time while holding down the
Control key.

e Toselect all entries between two entries, select an entry and,
while holding down the Shift key, select another entry.

E Select a column setup and apply a coloring rule to use for the
export.

ﬂ In the menu bar, click the Export to Excel icon or the
Advanced Export to Excel icon.

—or —

Right-click and select Export to Excel or Advanced Export to
Excel.

n If you are performing an Advanced Export to Excel, select the
conditional formatting to apply to each column, and click OK.

Only columns that display numeric user-defined fields are listed.

To apply the conditional formatting to total cell, as well as the
summed cells in the column, select Include Totals.

Excel opens and displays the selected entries.

E To keep the report, save it to your computer with a unique file
name.
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Maximizer's Template Library allows you to save Excel Report
Templates to report on your Maximizer data using Microsoft Excel.

Excel reports in Maximizer work by exporting your Maximizer entries
to an Excel spreadsheet and using the sorting, filtering, graphing,
and formatting functionality of Excel to provide detailed reports on
your Maximizer data.

You can access Excel reports via the Report menu in the Address
Book, Opportunities, Customer Service, and Campaigns pages.

When generating an Excel report, the report is based on your current
view in Maximizer. It is important to retrieve the list of entries that
you want to include in the report prior to generating the report. The
columns displayed in your current Column Setup view must also
match exactly those of the Excel report that you are generating.

Excel Report Template Library

The Excel report templates in your Address Book are stored in the
Template Library.You can access the Template Library from the
Administration section in the left navigation pane.

You can add new report templates to the Template Library, modify
the properties of existing reports, and can download any existing
report templates for further customization.

Maximizer includes several system default Excel report templates for
the Address Book, Opportunities, Customer Service, and Campaigns
modules. You can use these system default reports as the basis for
your own reports by downloading and customizing them to meet
your specific needs.

When adding a new Excel report template to your Template Library,
the columns included in the report template should match those of a
column setup in the corresponding module in Maximizer. To ensure
that there is a column setup with matching columns available when
generating the report, you may wish to create a dedicated column
setup for each of the report templates that you add to your Template
Library.
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Generate an Excel Report

To complete this procedure, you must have the Allow export
privilege.

You can generate Excel reports in the Address Book, Opportunities,
Customer Service, and Campaigns pages. Only the reports that are
available for the current module are listed.

n Select the module that you want to generate the report.

E Retrieve a list of the entries to include in the report.

Excel reports are generated based on the entries in the current
list in Maximizer. You can use a search or Favorite List to retrieve
the entries for the report.

B Under View, select Column Setup.

The Column Setup dialog box opens.

n Select the column setup to use for the report and click Use Now.
The columns in the selected column setup must match those of
the Excel report template being used.

E Under Report, select Excel Report and select the report
template that you want to use.

The selected report is exported.

E When prompted by your browser, save the exported file to your

computer and open it in Excel.

If a security warning is displayed in Excel, select the option to
Enable Content.

On the Table of Contents sheet, click Click to Generate
Reports.

The individual reports in the spreadsheet are regenerated based
on the exported data.

E Click on any report name on the Table of Contents sheet to
open the report.
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® This procedure is written for
Microsoft Excel 2010. The
steps may be different in other
versions of Excel.
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You can filter Excel reports generated by Maximizer using the filter
options available in Microsoft Excel to narrow-down the report
results.

n Generate an Excel report in Maximizer and open the report in
Excel.

E Click on any report name on the Table of Contents sheet to
open the report.
ﬂ Select the filtering options you want to apply to the report.

¢ Use the drop-downs above the report table to filter the
report results by the selected criteria or date range.

e Use the drop-downs in the body of the report table to select
the columns and rows displayed in the report, to filter the
report by date range, or to select a sort order for the report
data.

e Use the +/- buttons to show display yearly or monthly totals
in the report.

3 ciick ok.
The data in the table and on the graph is updated automatically.

Change the Chart Type in an Excel Report

@ This procedure is written for
Microsoft Excel 2010. The
steps may be different in other
versions of Excel.

You can change the type of chart displayed in an Excel report by
selecting another option from the chart types available in Microsoft
Excel.

n Generate an Excel report in Maximizer and open the report in
Excel.

E Click on any report name on the Table of Contents sheet to
open the report.

E Click the chart to select it.

ﬂ In the Insert tab, select the type of the chart that you want to
use.

—or —

Right click the chart and select Change Chart Type to choose
from the available chart types.
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Change the Chart Layout in an Excel Report

@ This procedure is written for
Microsoft Excel 2010. The
steps may be different in other
versions of Excel.

You can change the layout of any chart in an Excel report by
selecting different layout options available in Microsoft Excel.

n Generate an Excel report in Maximizer and open the report in
Excel.

E Click on any report name on the Table of Contents sheet to
open the report.

ﬂ Click the chart to select it.
n In the Design tab, select the Quick Layout drop-down to
choose from the different layout options.

In the Layout tab, select the desired layout option to change the
way that the labels, axes, or background of the chart is
displayed.

Conditional Formatting in an Excel Report

@ This procedure is written for
Microsoft Excel 2010. The
steps may be different in other
versions of Excel.

You can apply conditional formatting to the data table in an Excel
report by selecting the conditional formatting options available in
Microsoft Excel.

n Generate an Excel report in Maximizer and open the report in
Excel.

E Click on any report name on the Table of Contents sheet to
open the report.

E Select the cells in the report table that you want to apply
conditional formatting to.

n In the Home tab, select the Conditional Formatting drop-
down to choose the formatting type to apply.
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Download an Excel Report Template

You can download and save any of the existing Excel report
templates in your Template Library in order to modify the existing
report templates or to add new report templates.

n In the left navigation pane, hover your mouse over
Administration, and select Template Library from the pop-up
menu.

E Select the Excel Report Templates tab.

E From the Filter drop-down list, select a module.

All of the existing report templates available for the selected
module are listed.

n Under Action, select Download to start downloading the
selected report template.

E When prompted by your browser, save the file to a location on
your computer and open it for editing in Microsoft Excel.

Upload a Report Template to the Template Library

You can upload Excel report templates to the Template Library to
add new report templates or to update existing report templates.

n In the left navigation pane, hover your mouse over
Administration, and select Template Library from the pop-up
menu.

E Select the Excel Report Templates tab.
E Click Add to add a new report template.

Click the Properties link next to an existing report template to
update the report template.
n Specify the details for the report template.
¢ Specify a Name for the report template
¢ Select the Module that the report template is for.

¢ In the Full Access and Read Access fields, select the users
with access to the report template.

¢ In the Description field, enter additional notes.

E Under Upload file, select the Excel report file for the report
template.
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E Click OK to add the report template.
The report template is saved to the Template Library.

If you haven’t done so already, you should create a new column
setup to be used when generating the report that contains
columns which match the columns in the Excel spreadsheet.

Modify an Excel Report Template

@ This procedure is written for
Microsoft Excel 2010. The
steps may be different in other
versions of Excel.

You can download and modify any of the existing Excel report
templates in your Template Library and update the existing report
templates in your library

The system default report templates can only be modified by a
system administrator, but can be downloaded and used as the basis
for new report templates.

n Download the report template that you want to modify from
the Template Library and open it in Excel.

E Click on the name of the report you want to modify on the
Table of Contents sheet to open the sheet for that report.

ﬂ Click anywhere in the data table for the report.
n In the Options tab, select Field List.

Right click the data table and select Show Field List.
The PivotTable Field List appears.

E In the PivotTable Field List table, drag and drop fields from the
Choose fields to add to report table to the tables below to add
fields to the filter options, columns, rows, and values of the
report.

¢ Fields added to the Report Filter table are available as filter
options for the report.

¢ Fields added to the Column Labels table are used as columns
for the report.

¢ Fields added to the Row Labels table are used as rows for the
report.

e Fields added to the Values table are used as values in the
body of the report. By clicking a field in the Value table and
selecting the Value Field Settings option you can specify the
type of calculation to use to summarize data for the field.

The chart and data table in the report are automatically updated
when new fields are added so you can immediately see the
effects of your changes.
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E Make any desired changes to the chart type, layout, and
formatting.

Save a copy of the Excel spreadsheet to your computer.

E Update the properties of the report template in the Template
Library with the updated spreadsheet or add it to the library as a
new report template.

Create a New Report Template Using Maximizer Basic Fields

@ This procedure is written for
Microsoft Excel 2010. The
steps may be different in other
versions of Excel.

You can add a new report to an existing Excel report template in
your Template Library by adding a new sheet to the Excel
spreadsheet.

When adding a new report to an existing Excel report template, your
report must use the fields that are available in the Excel report. If
your new report only requires Maximizer Basic Fields, you can add
the report to one of the system default report templates in the
Template Library.

n Download and open the Excel report template that you want to
add a new report to.

E Click Insert Worksheet to add the new sheet for the report.

B In the Insert tab, select PivotTable.
The Create PivotTable dialog opens.

n Choose Select a table or range and enter TransformedData
in the Table/Range data selection box.

H ciick ok.
A new PivotTable is added to the sheet. The PivotTable Field List
table opens showing Maximizer Basic Fields.

E Right-click the new PivotTable and select PivotTable Options.
The PivotTable options dialog opens.

In the Display tab, select the Classic PivotTable layout
(enables dragging of fields in the grid) checkbox.

E’ Click OK.

E In the PivotTable Field List table, drag and drop fields from the
Choose fields to add to report table to the tables below to add
fields to the filter options, columns, rows, and values of the
report.

¢ Fields added to the Report Filter table are available as filter
options for the report.
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¢ Fields added to the Column Labels table are used as columns
for the report.

¢ Fields added to the Row Labels table are used as rows for the
report.

e Fields added to the Values table are used as values in the
body of the report. By clicking a field in the Value table and
selecting the Value Field Settings option you can specify the
type of calculation to use to summarize data for the field.

The data table in the report are automatically updated when
new fields are added so you can immediately see the effects of
your changes.

ano add a chart to the report, click the data table to select it and
select the chart type in the Insert tab.

The chart is added to the report.

nnSave the Excel spreadsheet and upload it to the Template
Library to update the existing report template with your
changes.

Create a New Report Template Using User-Defined Fields

You can create new Excel report templates using a custom column
setup. Your report template can contain any Maximizer user-defined
fields or basic fields that appear in the column setup.

Creating a new Excel report template using a custom column setup
involves configuring the columns in the column setup as the data
source for the report template. You can then add and modify
individual reports within the Excel report template spreadsheet as
you would for an existing Excel report template.

When you have completed creating your new Excel report template
spreadsheet, you must upload the spreadsheet to the Template
Library as a new report to make it available in Maximizer.

To create a new Excel report template using a custom column setup
you must use one of the existing report templates from the Template
Library as the basis for your new report template.

n Download an Excel report template from the Template Library
to use as the basis for your new report template and open the
spreadsheet in Excel.

@This procedure is written for E Open the Maximizer module you are creating the report
Microsoft Excel 2010. The
steps may be different in other template for.
versions of Excel. B Click View > Column Setup to select a column setup for the

report template.
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You can use an existing column setup that contains all of the
columns to be used in the report template, or you can create a
new column setup. This column setup must be available to select
when generating the report, so you should create a dedicated
column setup for the report template.

ﬂ Select the column setup that you want to use for the report
template and click Use Now.

E Click the Export to Excel icon to export the current view.

E In Excel, copy the exported data, including the column names, to
the Data Source sheet in the Excel spreadsheet you are using
for your template.

Right click on the sheet tabs at the bottom of the Excel window
and select Unhide.

The Unhide dialog box opens.
B Select the Rpt Template sheet and click OK.

E Copy the names of the exported fields from row 1 of the Data
Source sheet to row 6 of the Rpt Template sheet.

nmSpecify the values of the cells in row 7 of the Rpt Template
sheet.

The values of the cells should be copied from the corresponding
columns in row 2 of the Data Source sheet using a formula. For
example, in the cell in row 7 of column A, use the formula ='Data
Source'lA2 to copy the value from the cell in row 2 of column A
in the Data Source sheet. This formula may be copied to each of
the cells in the row and Excel will update the cell references
automatically.

nnRight click on the sheet tabs at the bottom of the Excel
window and select Unhide.

The Unhide dialog box opens.
HESeIect the Configuration sheet and click OK.

nﬂln the Configuration sheet, specify a value for the Template
Last Column field.

The Template Last Column field should contain the Excel
column label of the rightmost column in the Rpt Template
sheet.

nnCopy the names of the exported fields from row 1 of the Data
Source sheet to row 1 of the Configuration sheet.

The values in this row are used to verify that the selected column
setup contains the same columns as those used in the report
template. An error message is displayed if these values do not
match the selected column setup when generating the report.
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nﬂln the Sheets To Hide field, specify all unnecessary sheets to
be hidden in the report template.

HESave the file and click Test Report Generation.

The report generation is tested using the data in the Data Source
sheet.

You can now add and modify the individual reports in the Excel
report template spreadsheet as you would for an existing Excel
report template and upload the new report template to the
Template Library in Maximizer.
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User Properties

Your user properties are set up by your Maximizer administrator
when your user account is created. You can view or change these
properties in Maximizer when necessary.

Keep the following points in mind when viewing or modifying your
user properties:

Your Display Name determines how your user is seen by other
Maximizer users. For example, this is the name that users will see
when they view the properties of entries that you have created,
or when including your user in an appointment or Hotlist task,
and is also the name that is displayed in history notes that are
logged when you perform actions in Maximizer.

Your user photo is displayed in the heading bar when your
logged in and in the History tab alongside notes and documents
that you have created.

Your phone numbers are displayed in the phone list when other
users want to get in touch with you. Ensure that your phone
numbers are up-to-date.

Your email address is used by Maximizer to send system-
generated emails, for example appointment reminders and
customer service notifications. You can specify up to three email
addresses in your user properties. The first email address is your
default address where system emails are sent. It is important that
this email address be a valid email account that you check often.
You can select the other email addresses when you send email
messages from Maximizer.

Update your User Properties

You can update your user properties in Maximizer.

n In the top-right corner of the page, click on your image, and

select View profile.
The user Properties dialog box opens.

E Update your personal information, such as your Name, Main

address, Phone numbers, and Email address/Website.

B Click OK to save the change to your user properties.
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You can add a photo to your user profile. The photo is displayed in
the History tab next to notes and documents you have created.

n In the top-right corner of the page, click on your image, and
select View profile.

The user Properties dialog box opens.

E Under the image in the Name area, click Upload.
The Upload Photo dialog box opens.

ﬂ Click Browse.

n Browse to and select the image file on your computer that you
want to use as your profile photo, and click Open.

The image appears in the Upload Photo dialog box.

E Click and drag around a portion of the image to select the part
of the image to include.

Any portion of the image that is outside of the selection area is
removed from the image when it is saved.

If necessary, you can adjust the sides of the selection area. To fit
the image without distorting its proportions, the width of the
selection area is kept equal to the height.

E Click Save Photo to associate the image with your user profile.

Click OK to save the change to your user properties.
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Preferences

You can personalize how Maximizer works for you. Maximizer
provides you with various settings that give a great deal of flexibility
in how you work—in other words, Maximizer adapts to the way you
want to work.

In Maximizer Web Access, you can set some of the Maximizer
preferences. If you use the desktop application as well as Maximizer
Web Access, these preferences are applied to the Address Book in
both applications. You can also set personal preferences that affect
only Maximizer Web Access.

Set Personal Preferences

You can set personal preferences that affect the Maximizer interface.
The preferences you set are applied only to the Address Book that is
currently open.

n In the top-right corner of the page, click on your image, and
select Preferences.

The Personal Preferences dialog box opens.

E Adjust the preferences, and click Save to save the changes.

Personal Preferences - Morzilla Firefox ==
Preferences
Maximum number of entries returned: 5000
Display blank UDFs: @ Yes ) No

Allow multi-selection in Search By Al Fields.
(may require the webstte to be in the @ ves O No
Trusted Sites zone):
/| Ask at Address Book startup which list to view
| Automatically assign campaign when creating a new opportunity
Limit the search to campaigns created: This Quarter

/| Display users by groups.

V| Allusers || Disabled users || Departments.

| pivisions ¥ Security groups  [/| Teams

Customize Icon Bar...

Online Help

Choose between local or hosted online help content: Maximizer Hosted help content «

Regional Settings
Locale: English (United States) [en-US)] -
Time zone:  (UTC-08:00) Pacific Time (US & Canada) -

/| Automatically adjust for Daylight Saving

Other Preferences.. H Password.. H Save H Cancel
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Set your Time Zone

Your time zone is specified in your personal preferences. When you
log in to Maximizer, the time zone in your preferences is compared
to the time zone set on your computer. If they do not match, a
message appears in the top of the Maximizer page, prompting you
to change your time zone setting.

# My Work Day Current User: Joe Napoli | Preferences | Logout | Help v

£ The current time zone is different than the time zone set in your preferences. Do you want to change your time zone setting? Yes No

e To change the time zone, click Yes, select the time zone, and
click Continue.

You may need to log out of Maximizer and log in again for the
change to take affect.

* To close the message without adjusting the time zone, click No.

Change the Date, Time, and Currency Format

In your personal preferences, the locale setting determines how date,
time, number, and currency values are displayed in Maximizer.

n In the top-right corner of the page, click on your image, and
select Preferences.

The Personal Preferences dialog box opens.

E From the Locale drop-down list, select the language and region
value that corresponds to the display settings.

ﬂ Click Save to save the changes to your preferences.

Working with Lists of Users

The “Display Users by Groups” setting in your personal preferences
affects how users are listed in a number of dialog boxes in
Maximizer, including the Appointment and Select Users for Full or
Read Access dialog boxes. If you enable the setting, you can select
which groupings to include in the user lists. The grouping are
determined by various user properties.

e All Users - Lists all enabled users in a single list in alphabetical
order, without any other groupings.

e Departments - Groups users by department. A user’s
department is set in Administrator in the “Dept” field of the
user’s properties. Users without values specified in this field are
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not displayed in this list. In the user properties, security must be
set to “Public” for users to display in this list.

Disabled Users - Lists all disabled users in alphabetical order.
Disabled users cannot log in to Maximizer and are not displayed
in any of the other lists. However, you can add disabled users to
appointments and to opportunity and customer service case
monitoring lists.

Divisions — Groups users by division. A user’s division is set in
Administrator in the “Division” field of the user’s properties.
Users without values specified in this field are not displayed in
this list. In the user properties, security must be set to “Public”
for users to display in this list.

Security Groups - Groups users by security group. If you are
selecting values in the Full Access and Read Access fields, you can
select a security group to add to the field. In other user-selection
dialog boxes, you can select the users in the security groups.

Teams - Groups users by sales and marketing teams.

Set your Maximizer Preferences

You can set your Address Book preferences directly in Maximizer.
These settings are applied to both Maximizer and Maximizer Web
Access. Your system administrator can also set these preferences in
Administrator.

n In the top-right corner of the page, click on your image, and

select Preferences.

E Click Other Preferences.

The Preferences dialog box opens to the Calendar/Hotlist tab.

B Select the tab for the settings you want to edit.

¢ Select Logging to specify how notes are logged for various
actions.

¢ Select Calendar/Hotlist to specify the default settings and
access rights for the calendar and Hotlist.

¢ Select Monitoring to configure email notification for
opportunity and customer service case monitors.

¢ Select Email to specify the default settings for sending email.

¢ Select Startup to specify startup options and options for the
My Work Day page.

e Select Format to specify the address format used for the
Name and Address merge field and for printing envelopes
and labels.
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Preferences - Mozilla Firefox

Logging  CalendatMotlist ~ Monitoring ~ Email  Starup  Format (7}
Default Settings Dptions

Alarm lead time: 10 | Minute( I 1gniore canflict checking

DeFault inkerval: [30 =] minutes I 1gniore al slarms and notifications

W Sct slarm on when adding an appointment 7 g or mody mukuser appontment

-
Detaul visws [y =] Do nok display holidays
W carry Forward unfinished tasks
First day of week: [ Sunda -
v ¥ ¥ Carry forward unfinished apgointments
‘working hours from: | 8:00 &M B T Show completed tasks
to: [ s:00PM ~ I Show completed appaintments

I Shaw nan-work days in weekly view
¥ suppress follaw-up activiey prompt
™ Include Address Book entries in appointment email reminders

v
Access to Calendar ¥ Shaw week number

- 5 First week of year: [ Starts on Jan 1
ul access: lone -

Email appointment { task notification: [ Ask  +
Read access: All users b3

I Include the iCalendar (.ics) attachment
Access to Hotlist Work Days

Full access: ane = ™ 1. sunday I 4, wednesday [ 7. saturday
Read access: | Allusers - W 2. Manday ¥ 5. Thursday

¥ 3, Tuesday ¥ 6. Friday

{ ok || Cancel |

n Edit the settings and click OK to save the changes.
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Customizing the Interface

You can customize the basic Maximizer interface in a number of
ways. You can select the layout of the main window. You can adjust
the properties of the icon bar containing the icons linking to the
main Maximizer windows.

Adjust the Icon Bar

Use this procedure to adjust the properties of the icon bar. You can
select which icons are displayed and their order.

n In the top-right corner of the page, click on your image, and
select Preferences.

The Personal Preferences dialog box opens.
E Click Customize Icon Bar.
The Icon Bar Properties dialog box opens.

ﬂ Select the icons you want to be displayed.

Use the Move Up and Move Down buttons to position the
icons.

1 click ok.

E Click Save to save the changes to your preferences.

Customize the Following Panes

Use this procedure to customize which tabs are displayed in the
following panes, as well as their order. You can customize the
following panes in the Address Book, Opportunities, Campaigns,
Customer Service, and Hotlist pages. Removing a tab from one page
will not remove it from the other pages.

n Open the page that you want to adjust.

E In the top-right corner of the following pane, click the arrow
icon.

B Select the checkboxes next to the tabs that you want to be
displayed.

ﬂ To move a tab to the left or right, click on the name of the tab,
and click Move Up or Move Down.

E Click Save to save the changes to the following pane.
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By enabling the auditing feature for Address Book entries, you can
retain a record of changes made to Address Book entries, manage
the audit logs, and view the system audit report.

Maximizer has the ability to document changes made to Address
Book entries. Changes made to the basic fields, user-defined fields,
notes and documents are logged against the Address Book entry. The
size of the database may increase substantially when Auditing is
turned on.

If the logged-in user has the Read audit log privilege and the system
administrator has enabled Auditing for Address Book entries then
the audit log is displayed in the Auditing tab of the following pane.

View the Audit Log for an Entry

@ The Audit log ignores Full and
Read Access settings for user-
defined fields, notes, and
documents and displays
history for all changes,

regardless of security settings.

To complete this procedure, you must have the Read audit log
privilege.

You can view the auditing history for an Address Book entry from
the Auditing tab in the following pane.

n Click on the Address Book entry to make it the current entry.
E In the following pane, select the Auditing tab.

E From the Filter drop-down list, select a filter option to view the
audit log.
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Importing Data

You can import data into Maximizer from comma-separated value
(.CSV) files, tab-delimited text (.TXT) files, or Maximizer XML
Interface (.MXI or .XML) files.

About Microsoft Outlook Contact Import

@ The maximum supported file
size that can be imported is
4MB. If your Microsoft Outlook
contacts file is larger than 4MB
you will need to import your
contacts in smaller batches
rather than all at once.

You can import Address Book entries into your Maximizer Address
Book from your Microsoft Outlook Contacts. You can use this feature
to quickly add your Microsoft Outlook Contacts to your Maximizer
Address Book without having to enter them one-by-one.

Entries imported from Microsoft Outlook are created as Company
and Contact entries in your Maximizer Address Book and are not
created as sales leads. Name, address, and contact information fields
from your Microsoft Outlook Contacts are automatically mapped to
the corresponding fields in the imported Address Book entries. If an
existing Company has a matching value in the Company Name or an
existing Contact has matching values in the First Name, Last Name,
and Email Address fields, the Company or Contact is updated.
Otherwise a new Address Book entry is created.

Before importing your contacts from Microsoft Outlook you must
first export them to a comma-separated values (.CSV) file. Please
refer to your Microsoft Outlook documentation for instructions on
how to export your contacts to a comma-separated values (.CSV) file.

Once the import is complete, results of the import are sent to an
email address specified during the import. By default, the current
user's email address is set, but you can specify any other email
address during the import.

During the import, a Favorite List is created containing the Address
Book entries created or updated by the import. The name of the
Favorite List is “CSV imported [date] [time]”. You can retrieve this
Favorite List to review the results of the import.

Import Microsoft Outlook Contacts

To complete this procedure, you must have the Allow import
privilege and Insert permission for Address Book entries and user-
defined fields.

n In the left navigation pane, hover your mouse over Import and
select Microsoft Outlook Contacts from the pop-up window.

The Import Wizard - Select Import File dialog box opens.
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Import Wizard - Select Import File [X]

Use this Import Wizard to import Contacts from Microsoft Outlook into your Maximizer Address Book.
Here are some quick steps to create your CSV file in Microsoft Outlook:

= Outlook 2010: Go to File > Options > Advanced > Export > Export to a File and choose either
Comma Separated Values (Windows or DOS) > Contacts > Finish

- Qutlook 2003 or 2007: Go to File = Import and Export > Export to a File and choose either Comma
Separated Values (Windows or DOS) > Contacts > Finish

Once the CSV file has been created successfully, browse to the import file below.

Select import file

Name: ” Browse

The maximum file size that can be imported is 4 MB.

][ Next> ][ Cancel

E Click Browse, and choose the comma-separated values (.CSV)
file that contains your exported contacts from Microsoft
Outlook.

B Click Next.
The Import Wizard - Finish dialog box opens.

n In the Import results will be emailed to field, enter the email
address that you want the results of the import emailed to. If
you do not want to send an email with the results of the import,
leave the field blank.

E Click Import Now.

The file is imported. If you entered a valid email address above,
an email containing the results is sent once the import is
complete.

About Comma-Separated Value/Tab-Delimited Import

You can import comma-separated value (.CSV) or tab-delimited text
(.TXT) files into Maximizer. Files created in most spreadsheets can be
saved as .CSV or tab-delimited text files. As well, most email
applications have the option to export contacts to .CSV files.

This Import command works best when you perform a two-tier
import. In a two-tier import, you first import Company entries as
Company/Individual Address Book entries, and then you import the
people as Contacts.
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@ Individuals can have values in
the company name field as
well as in the last name field.

During the import, you select which type of entries you are
importing: Companies/Individuals or Contacts. When you import the
entries as Companies/Individuals, the type of entry created in
Maximizer depends on the values in the import file:

e If an entry has a value in the Company field but no value in the
Last name field, the entry is imported as a Company.

e If an entry has a value in the Last name field, the entry is
imported as an Individual.

e If an entry has no value in both the Company and Last name
fields, the entry is not imported into Maximizer.

When you import entries as Contacts, the entries are mapped to
existing Company and Individual entries in Maximizer using the
Identification or Company Name field. You can specify the value of
the Identification field for a Company/Individual while importing the
Companies and Individuals. If there is no match on the Identification
or Company Name field, the entry is not imported into Maximizer.

When you import a file, you map each value in the first row of the
.CSV or tab-delimited text file to a basic or user-defined field in
Maximizer. To simplify the field mapping, it's best if the first row is a
header row containing the name of each field. You can choose to
leave this row out of the import.

During the import, you can choose to import all entries as sales leads
or as regular entries.

The import updates existing entries or creates new entries depending
on values of fields in the import file. If an existing Company has a
matching value in the Company Name field, the Company is updated.
If an existing Contact or Individual has matching values in the First
Name, Last Name, and Email Address fields, the Contact or Individual
is updated. Otherwise, a new Address Book entry is created.

Once the import is complete, results of the import are sent to an
email address specified during the import. By default, the current
user’s email address is set, but you can specify any other email
address during the import.

During the import, a Favorite List is created containing the Address
Book entries created or updated by the import. The name of the
Favorite List is “CSV imported [date] [time]”, for .CSV files, or “TXT
imported [date] [time]”, for tab-delimited text files. You can retrieve
this Favorite List to review the results of the import.
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Import Companies and Individuals from a Comma-Separated Value/Tab-

Delimited File

@ The maximum supported file
size that can be imported is
4MB. If the comma-separated
values (.CSV) file or tab-
delimited (.TXT) file that you
want to import is larger than
4MB you will need to split the
file into multiple files smaller
than 4MB and import each one
separately.

To complete this procedure, you must have the Allow import
privilege and Insert permission for Address Book entries and user-
defined fields.

Use this procedure to import Companies and Individuals into
Maximizer from a comma-separated value (.CSV) or tab-delimited
text (.TXT) file. You must import the Companies/Individuals before
you can import the Contacts associated with the Companies/
Individuals.

In the left navigation pane, hover your mouse over Import, and
select Comma-Separated Values (CSV) or Tab-delimited
from the pop-up window depending on which type of file you
want to import.

The Import Wizard opens.

Click Browse, browse to a .CSV or tab-delimited text file, and
click Open.

Select the File Encoding of the file you are importing, and click
Next.

If you are unsure which character encoding your file is saved in,
please consult the documentation of the application you used to
create the file.

Under Type of Import, make sure Companies/individuals is
selected.

You can select Convert to name case to convert text that is in
capital letters to mixed case.

Under Lead Handling, choose to import all entries as sales leads
or as regular entries, and click Next.

The Fields Mapping screen opens.

Map each field in the import file to a field in Maximizer, and
click Next.

The value of each field in the first row of the import file is
displayed on the right and any matching Maximizer fields are
displayed on the left.

e Hover your mouse over a row, and click the arrow icon.

¢ Select a basic or user-defined field from Maximizer to map to
the field, and click OK.

e To exclude a field from being imported, hover your mouse
over the row, and click the X icon.
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To add entries as Companies, you must map a field in the import
file to the Company name field, and no values may be mapped
to the Last name field.

To add entries as Individuals, you must map a field in the import
file to the Last name field. Individuals may also have values
mapped to the Company Name field.

When you later import Contact entries, they are matched using
the Company Name or Identification field. You can map a field
in the Import file to the Identification field in Maximizer. This
field must be unique for each entry.

If the import file contains a header row, you can choose not to
import it by selecting Do not import first record; it is a
header.

Enter your email address, and click Import Now.

Results of the import are sent to the specified email address.

Import Contacts from a Comma-Separated-Value/Tab-Delimited File

@ The maximum supported file
size that can be imported is
4MB. If the comma-separated
values (.CSV) file or tab-
delimited (.TXT) file that you
want to import is larger than
4MB you will need to split the
file into multiple files smaller
than 4MB and import each one
separately.

To complete this procedure, you must have the Allow import
privilege and Insert permission for Address Book entries and user-
defined fields. Companies and Individuals must already exist in
Maximizer for the imported Contacts.

Use this procedure to import Contacts into Maximizer from a comma-
separated value (.CSV) or tab-delimited text (.TXT) file. The Contacts
will be mapped to existing Companies and Individuals in Maximizer.

In the left navigation pane, hover your mouse over Import, and
select Comma-Separated Values (CSV) or Tab-delimited
from the pop-up window depending on which type of file you
want to import.

The Import Wizard opens.

Click Browse, browse to a .CSV or tab-delimited text file, and
click Open.

Select the File Encoding of the file you are importing, and click
Next.

If you are unsure which character encoding your file is saved in,
please consult the documentation of the application you used to
create the file.

Under Type of Import, select Contacts.

You can select Convert to name case to convert text that is in
capital letters to mixed case.
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E Under Lead Handling, choose to import all entries as sales leads
or as regular entries, and click Next.

The Fields Mapping screen opens.

E Map each field in the import file to a field in Maximizer, and
click Next.

The value of each field in the first row of the import file is
displayed on the right and any matching Maximizer fields are
displayed on the left.

e Hover your mouse over a row, and click the arrow icon.

e Select a basic or user-defined field from Maximizer to map to
the field, and click OK.

¢ To exclude a field from being imported, hover your mouse
over the row, and click the X icon.

The entries are matched to existing Companies and Individuals in
Maximizer using the Company Name or Identification field. If an
entry does not have a value mapped to one of these fields, it will
not be imported.

If the import file contains a header row, you can choose not to
import it by selecting Do not import first record; it is a
header.

Enter your email address, and click Import Now.

Results of the import are sent to the specified email address.

When you import comma-separated value (.CSV) or tab-delimited
text (.TXT) files into Maximizer, you must map every field in the
import file to a field in Maximizer. You can save this field mapping to
the Import Catalog. If you import a similar type of file in the future,
you can retrieve the saved field mapping. The import catalog is
especially useful if you regularly import entries from the same source
(for example, Contacts exported from Microsoft Outlook).

When you retrieve a field mapping from the Import Catalog, the list
of Maximizer fields in the Import Wizard is replaced with the list
saved in the Import Catalog. The field names in the import file do not
need to match the names from the file when the field mapping was
originally saved.
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Import Mapping Catalog - Mozilla Firefox

Saved Mappings:
00g pping

Outlook Mapping
Yahoo Mapping Save

Retrieve
Properties

Delete

HERER

Close

Description:
Contacts exported from Gmail

Save a Field Mapping to the Import Catalog

To complete this procedure, you must have the Allow import
privilege and Insert permission for Address Book entries and user-
defined fields.

Use this procedure to save field mappings in the Import Wizard to
the Import Catalog. The Maximizer fields specified in the Field
Mapping screen of the Import Wizard are saved so they can be
retrieved later.

n In the left navigation pane, hover your mouse over Import, and
select Comma-Separated Values (CSV) or Tab-delimited
from the pop-up window depending on which type of file you
want to import.

The Import Wizard opens.

E Proceed through the first two screens of the Import Wizard to
select the import file and set options for the import.

ﬂ In the Field Mapping screen, map each field from your import
file to a field in Maximizer.

n Click Catalog.
The Import Mapping Catalog dialog box opens.

H ciick Add.
The Import Mapping Properties dialog box opens.
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E Specify the name, description, and access rights for the field
mapping, and click OK.

Import Mapping Properties - Morzilla Firefox ==

Details of import mapping
Name: | Google Wapping
Description: | coy file exported from Gl

Full Access:  Public -

Read Access:  Fublic

Spellingl ‘ 0K H Cancel

Retrieve Field Mappings from the Import Catalog

To complete this procedure, you must have the Allow import
privilege and Insert permission for Address Book entries and user-
defined fields.

Use this procedure to retrieve a saved field mapping from the Import
Catalog into the Import Wizard. The Maximizer fields specified in the
field mapping are retrieved to the Field Mapping screen of the
Import Wizard.

n In the left navigation pane, hover your mouse over Import, and
select Comma-Separated Values (CSV) or Tab-delimited
from the pop-up window depending on which type of file you
want to import.

The Import Wizard opens.

E Proceed through the first two screens of the Import Wizard to
select the import file and set options for the import.

ﬂ In the Field Mapping screen, click Catalog.
The Import Mapping Catalog dialog box opens.

ﬂ Select the saved field mapping, and click Retrieve.

E Follow the instructions in the Import Wizard to complete the
import.
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About Maximizer XML Interface Import

You can import Address Book entries, customer service cases,
knowledge base articles, and other data from Maximizer XML
Interface (.MXI or .XML) files. These files may have been created by
exporting from Maximizer or by exporting the information from
another source and converting it to XML using the Maximizer XML
schema.

Imported Address Book entries are stored in a Favorite List. By
default, the Favorite List is named according to the file format and
import date and time, but you can specify any name for the Favorite
List during the import.

Import from a MXI or XML File

To complete this procedure, you must have the Allow import
privilege and the required permissions for inserting and modifying
entries included in the import.

Use this procedure to import Address Book entries, customer service
cases, or knowledge base articles into Maximizer from a Maximizer
XML Interface ((MXI or .XML) file.

n In the left navigation pane, hover your mouse over Import, and
select XML and Maximizer MXI from the pop-up window.

The Import dialog box opens.
E Click Browse, and choose the MXI or XML file.

B In the Lead Handling area, choose if you want to import
Address Book entries as sales leads or not.

n Optionally, edit the name of the Favorite List created on import.

If you do not want to create a Favorite List, delete the text in the
Name field.

E Click Import.
The file is imported.
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@ If you do not have insert or When the import is finished, the Import results section updates
modify permissions, the import to show the number of entries that were successfully inserted or
results will list the entries as e g . . .

“Failed.” modified and the number of entries that failed to be imported.
Import ]

Select import file
Name
Lead handling
(@ Use values from the import file
() Import all entries as leads

() Import all entries as non-leads

Favorite List for imported Address Book entries

Name: MXIimported [DateTimeMergeField]

Import results
"ABExport March15 MXF* was processed 19/03/2010 6:04 P~ |
Address Book entries: 0 inserted, 13 updated, 0 failed
Knowledge Base articles: 0 inserted, 0 updated, 0 falled
Customer Service cases: 0 inserted, 0 updated, 0 failed

E
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Web-to-Lead Forms

@ To use Web-to-Lead Forms

your Maximizer SQL Server
database must be set up to
allow SQL Server
Authentication. Web-to-Lead
Forms do not work in a
Windows Authentication only
environment. For more
information about SQL Server
authentication methods refer
to the Administrator's Guide.
Note that this applies to
Maximizer Web Access, not
Maximizer CRM Live.

With Maximizer you can create a Web-to-Lead Form to collect
information from customers and leads on your website. Information
submitted through the Web-to-Lead Form is entered directly into
your Maximizer Address Book. For example, you can use this feature
to create a contact form to receive customer inquiries or a survey
form to receive customer feedback.

About Web-to-Lead Forms

Using the Web-to-Lead Form wizard in Maximizer you can perform
the following tasks:

e Create a Web-to-Lead Form to collect information from
customers and leads and create new Address Book entries based
on the submitted information.

e (Create a Web-to-Lead Form to collect information from existing
Address Book entries and update the existing entries in your
Address Book based on the submitted information.

¢ Select the Maximizer fields, including user-defined fields that
you want to appear on the Web-to-Lead Form. For example,
information entered in the Last Name field in a Web-to-Lead
Form is inserted into the Last Name of the Address Book entry in
Maximizer. If you have chosen a table or Yes/No user-defined
field, a drop-down list is automatically created so customers can
select available choices.

e Change how field names are displayed in Web-to-Lead Forms.
For example, if you want to include the Maximizer Address Book
entry field “Phone 1" in a Web-to-Lead Form, you can choose a
helpful label such as “Home Phone” to display when customers
view the form.

¢ Designate mandatory fields. If a customer fails to fill-in any fields
in the form that are designated as mandatory, they are notified
by an error message when they try to submit the form.

e Specify notification options for when a Web-to-Lead Form is
submitted. You can choose to have a notification email sent each
time the Web-to-Lead Form is submitted to one or more email
addresses of your choice.

¢ Designate a favorite list to add the new or updated entries to
when the Web-to-Lead Form is submitted. By adding the entries
submitted through the Web-to-Lead Form to a favorite list they
are easily accessible so that you can review the new entries, clean
up any fields that were submitted incorrectly, remove any
duplicate submissions, and follow-up on the submissions.
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e Enter the address of a web page to redirect customers to after
they submit the form. You can enter the URL of any web page,
for example a thank you page or the home page of your
website.

¢ View or modify existing Web-to-Lead Forms in the Web-to-Lead
Form Catalog, so you can update existing forms as the need
arises.

e Create new Web-to-Lead Forms based on existing ones in the
Web-to-Lead Form Catalog, so you can quickly create similar
Web-to-Lead Forms without having to re-enter all of the form
options.

e  Customize the generated HTML of the Web-to-Lead Form, so
you can adapt the look and feel of the form to suit the theme of
your website or incorporate the Web-to-Lead Form into an
existing web page.

Create a Web-to-Lead Form

To complete this procedure, you must have the Allow import
privilege and the required permissions for inserting and updating
Address Book entries and user-defined fields.

n In the left navigation pane, hover your mouse over
Administration, and select Web-to-Lead Forms from the pop-
up window.

The Web-to-Lead Forms dialog box opens.

E Select Create a new form, and click Next.
The Web-to-Lead Forms Properties dialog box opens.

B Enter a Name for the form. You can also enter a Description
and adjust the Full Access and Read Access fields if necessary,
and click Next.

By default, the Full Access and Read Access settings for new
Web-to-Lead Forms are set to the current user. If you want other
Maximizer CRM users to be able to view or edit the Web-to-Lead
Form, you must select the appropriate users or security teams in
the Full Access and Read Access fields. For example, if you are
creating a Web-to-Lead Form that your manager will review or
modify before it is uploaded, you should ensure the access
settings allow your manager to access the Web-to-Lead Form.

The Web-to-Lead Form Import Type dialog box opens.

n Select the type of Web-to-Lead Form you want to create, and
click Next.
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If you want to create new Address Book entries when your Web-
to-Lead Form is submitted, select Create new Address Book
entry and choose how you want the new entries to be created
in Maximizer CRM when the form is submitted.

Select Company and Contact if you want new entries
submitted through the form to be created as Company and
Contact entries in Maximizer CRM. If you want new entries
submitted through the form to be created as Individuals, select
Individual.

If you want new entries submitted through the form to be
created as sales leads, select Create entries as leads.

—or —

If you want to update existing Address Book entries when your
Web-to-Lead Form is submitted, select Update existing
Address Book entry.?

The Web-to-Lead Form Fields dialog box opens.

Select the fields you want to include in the Web-to-Lead Form.

Add a field to the form by selecting the field in the Available
Fields list and clicking the >> button to add it.

Remove a field from the form by selecting the field in the Fields
in the Web-to-Lead Form list and clicking the << button to
remove it.

Modify the display names of the fields in the Web-to-Lead Form
and the order in which they appear.

Modify the text in the Display Name on Form field in the
Fields in the Web-to-Lead Form list to change the way the
fields in the Web-to-Lead Form appear. For example, you could
change the label of the “Phone 1" field to something more
descriptive for your customers like “Home Phone”.

Select a field in the Fields in the Web-to-Lead Form and click
the Move Up or Move Down button to change the order in
which a field appears in the Web-to-Lead Form.

Select any fields in the Web-to-Lead Form that you want to be
mandatory, and click Next.

To make a field in the Web-to-Lead Form mandatory, check the
Mandatory option next to the field in the Fields in the Web-to-
Lead Form list. All of the fields in the Web-to-Lead Form that
are marked as mandatory must be filled out by your customers
before they can submit the form.

If you have selected to create new Company and Contact entries
through your Web-to-Lead Form, you must include the
Company and Last Name fields in the Web-to-Lead Form and
you must make them mandatory.If you have selected to create
new Individual entries through your Web-to-Lead Form, you



® Notification emails sent when

the Web-to-Lead Form is
submitted count towards your
daily email limit if you are
using Maximizer CRM Live. If
you expect a large number of
form submissions each day you
should consider not sending
notification emails and instead
save submitted entries to a
favorite list that you review
regularly to avoid exceeding
your email limit.

@ If the password of the user

who created the Web-to-Lead
Form changes, or if the fields
in the Web-to-Lead Form are
changed, you must re-generate
the HTML for the Web-to-Lead
Form and update the page on
your website with the new
HTML source.
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must include the Last Name field in the Web-to-Lead Form and
you must make it mandatory.

The Web-to-Lead Notification and Submission dialog box
appears.

E Choose how you want to be notified when the Web-to-Lead
Form is submitted.

Select the Add to this favorite list option if you want entries
submitted through the Web-to-Lead Form to be added to a
favorite list. Click the ellipsis button to select the favorite list that
you want the new or updated entries added to.

Select the Send email to option if you want a system-generated
notification email sent each time the Web-to-Lead Form is
submitted and enter the email address that you want the
notification email sent to. If you want the notification emails
sent to more than one person you can enter multiple email
addresses separated by commas or semicolons.

E Enter the address of the web page to show after the form is
submitted, and click Finish.

Enter the URL of the landing page you want to display after a
customer submits the form in the URL to show after the form is
submitted field. For example, you could display a thank you
page, or you could display a page that allows the customer to
download promotional materials or brochures, or you could
simply redirect the customer back to your company's homepage.
If you leave this field blank a generic thank you page is displayed
after a customer submits the form.

The Web-to-Lead Form HTML dialog box appears.

nmSave the HTML for the Web-to-Lead Form and upload it to your
website.

The generated HTML source for the Web-to-Lead Form is
displayed in the text field in the Web-to-Lead Form HTML dialog
box. Copy-and-paste the HTML source into your preferred HTML
editor and save it as an HTML file. Provide the HTML file to your
webmaster to upload it to your website and create links to the
form from other pages on your website so that your customers
and leads can access it.

If you have created a Web-to-Lead Form to update existing
Address Book entries, you must provide individual links to each
Address Book entry that you want to use the form. The link must
contain unique identification information that indicates which
Address Book entry to update when the form is submitted. You
can send links to your Address Book entries in Maximizer directly
by email or with an email campaign.



400 | Maximizer Web Access
User's Guide

View or Modify an Existing Web-to-Lead Form

To complete this procedure, you must have the Allow import
privilege and the required permissions for inserting and updating
Address Book entries and user-defined fields.

n In the left navigation pane, hover your mouse over
Administration, and select Web-to-Lead Forms from the pop-
up window.

The Web-to-Lead Forms dialog box opens.

E Select Work with an existing form.
The Selected Web-to-Lead Form group becomes enabled.

El Select View/Modify the selected form and click the ellipsis
button for the Selected Web-to-Lead Form field.
The Web-to-Lead Form Catalog dialog box opens.

n Select the existing Web-to-Lead Form that you want to view or
modify in the Available Web-to-Lead Forms list, and click OK.

E Click Next.

The Web-to-Lead Form Properties dialog box opens with the
Name and Description of the selected Web-to-Lead Form

displayed.

E Follow the instructions in the Web-to-Lead Form wizard to make
changes to the Web-to-Lead Form.

Create a New Web-to-Lead Form Based on an Existing One

To complete this procedure, you must have the Allow import
privilege and the required permissions for inserting and updating
Address Book entries and user-defined fields.

n In the left navigation pane, hover your mouse over
Administration, and select Web-to-Lead Forms from the pop-

up window.
The Web-to-Lead Forms dialog box opens.

E Select Work with an existing form.
The Selected Web-to-Lead Form group becomes enabled.

E Select Create a new form based on the selected form and
click the ellipsis button next to Selected Web-to-Lead Form.

The Web-to-Lead Form Catalog dialog box opens.
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ﬂ Select the existing Web-to-Lead Form that you want to use as a
template for your new form in the Available Web-to-Lead
Forms list, and click OK.

E Click Next.

The Web-to-Lead Form Properties dialog box opens with the
Name and Description of the selected Web-to-Lead Form
displayed.

E Follow the instructions in the Web-to-Lead Form wizard to
create the new Web-to-Lead Form.

Create an Email Template for Web-to-Lead Form Links

@ It's important that you use the
Insert Link toolbar button for
entering your hyperlink. If you
type the URL, the web form
will not work properly.

Before completing this procedure you must have created a Web-to-
Lead Form for updating existing entries, and have uploaded the form
to your website so that it is available to your Address Book entries.

This procedure uses merge fields in an email message template to
send unique Web-to-Lead Forms links to each Address Book entry in
an automated campaign. Before completing this procedure, you
should familiarize yourself with the use of merge fields in email
messages in automated campaigns.

n In the Campaigns page, select the Message Library icon from
the toolbar.

The Message Library dialog box opens.

E Click New.
The Campaign Message Editor dialog box opens.

B From the Format drop-down list, select HTML.
ﬂ Enter your email message.

E Place the cursor in the location where you want to insert a link to
your Web-to-Lead Form and click the Insert Link toolbar
button.

The Create Link dialog box opens.

E Fill in the information for the hyperlink, and click OK.

In the Text field, enter the text that you want the link to appear
as to the recipient. If you leave this field blank, the full URL will
appear as the link in your message.

If you want to display a tooltip when the recipient hovers over
the link, enter it in the Tooltip field.
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@ You must include the square
brackets in your URL around
the WebFormID.

@ You can also create a link to
your Web-to-Lead Form in the
same way when sending an
email to Address Book entries
directly from the Address Book

page.

8

In the URL field, enter the full URL where your Web-to-Lead
Form is hosted and add the [WebFormID] merge field to the end.
The URL should look like this:

WebFormAddress[WebFormlID], where WebFormAddress is the
full URL of your Web-to-Lead Form.

For example, your URL might look something like this: http:/
www.mycompany.com/webtoleadform.htmI[WebFormID] where
“http://www.mycompany.com/webtoleadform.html” is the URL
of the Web-to-Lead Form.

When the email is sent, the [WebFormID] merge field generates
unique identifiers for each Address Book entry which are passed
to the Web-to-Lead Form as URL parameters.

The link is added to the email.

Click Save.
The Add Campaign Message dialog box opens.

Specify the properties of the campaign message, and click OK.

The email campaign message is added to the Campaign Message
Library and can be used in a campaign activity to send a link to
the Web-to-Lead Form to your Address Book entries.

When the email template is added to a campaign activity and
sent to subscribed Address Book entries, the [WebFormID] merge
field is merged to create a unique link to the Web-to-Lead Form
for each of the email recipients. When a recipient clicks on the
link they are directed to the form which will only update their
Address Book entry.

Advanced Customization of Web-to-Lead Forms

Web-to-Lead Forms in Maximizer are very flexible. You can
customize the generated HTML source of Web-to-Lead Forms to
adapt the form to the look-and-feel of your website or to add
custom JavaScript behaviors. You can also integrate Web-to-Lead
forms with custom applications by capturing information about the
submitted form in your landing page in order to perform further
actions with the new or updated Address Book entries.

Customizing Web-to-Lead Forms HTML Source

By modifying the generated HTML source, Maximizer CRM Web-to-
Lead Forms can be customized to suit the requirements of your
website. By default, the generated HTML source for Web-to-Lead
forms includes an HTML form containing the content of the form,
some simple formatting using CSS styles, and some JavaScript
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validation of mandatory fields and submitted values. You can revise
the HTML to change the structure of the form, update the CSS styles
to adapt the look of the form, and modify the JavaScript to alter the
behavior of the form.

Modifications of the generated HTML source should only be done by
someone with expert knowledge of HTML, CSS, and JavaScript
technologies. To implement any customizations of your Web-to-Lead
Forms, consult your webmaster or other web-development
professional.

Below are just a few of the customizations you can do by modifying
the generated HTML source of a Web-to-Lead Form:

e Change the appearance of the form and the fields within the
Web-to-Lead Form. By modifying the CSS styles for the Web-to-
Lead Form you can change the look and feel of the page to fit
with the rest of your website.

e Change the structure of fields within the Web-to-Lead Form. By
changing the definitions and attributes of the INPUT tags within
the Web-to-Lead Form you can make fields hidden, set default
values, and change input types.

e Change the behavior of the Web-to-Lead Form. By adding
JavaScript functions you can add custom validation or auto-
formatting to the fields in the Web-to-Lead Form.

e Embed the Web-to-Lead Form within an existing webpage by
copying the entire contents of the BODY tag, including both the
HTML and JavaScript code, in the generated HTML source into an
existing webpage.

Keep the following points in mind when modifying the HTML source
of a Web-to-Lead Form:

¢ Do not modify the ACTION attribute of the FORM tag or the
NAME attributes of any of the fields. If any of these values are
changed the Web-to-Lead Form will not work.

¢ If you modify the definition of an input field in the Web-to-Lead
Form HTML source and the content of the field contains data
that is not recognized by Maximizer CRM as valid, the field will
not be saved when the form is submitted. For example, if you
modify a Yes/No user-defined field included in the Web-to-Lead
Form to allow alphanumeric input, the value will not be saved.

e When copying the BODY tag contents of the Web-to-Lead Form
to an existing webpage, if you do not update the CSS styles or
also copy the CSS styles from the HEAD tag of the generated
HTML source to your target webpage, the form will not have any
formatting applied to it.
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Capturing Submitted Entry Identification in a Landing Page

When a customer submits a Web-to-Lead Form, the Client Id and
Contact number of the Address Book entry that is created or updated
are passed to the landing page as URL parameters. By reading these
parameters in your landing page, you can perform further actions
with the submitted entry using custom Maximizer integrations. The
parameters are passed as “id” and “contact”, where "id” contains
the client identification number of the submitted Address Book entry
and “contact” contains the contact number. Both of the parameters
are encoded as hexadecimal strings using the US-ASCII character set,
so they must be decoded before you can use them.

For more information about developing custom integrations with
Maximizer, see the Maximizer CRM Customization Suite
documentation.

Dynamically Generate Links to Web-to-Lead Forms

Instead of sending links to your Web-to-Lead Forms directly to
Address Book entries using email from within Maximizer, you can
generate dynamic links on-the-fly from within a custom application
that is integrated with Maximizer. To generate a link to a Web-to-
Lead Form for updating Address Book entries, you simply need to
pass the Client Id and Contact Number of the Address Book entry you
wish to update as parameters to the Web-to-Lead Form URL. The
parameter names used are “id” and “contact”, so a generated URL
takes the following form:

http:/{WebFormURL}?id={Client_ld}&contact={Contact_Number}
where “{WebFormURL}" is the full external URL of your Web-to-Lead
Form, “{Client_ld}" is the Clientld of the Address Book entry and
“{Contact_Number}” is the Contact_Number.
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Desktop and Mobile Setup

Office Integration

@ If you have previously installed
Word/Outlook Integration for
Maximizer or Word/Outlook
Integration for Maximizer CRM
Live, ensure the add-in is
uninstalled before installing
Word/Outlook Integration for
Maximizer Web Access.

Mobile Access

Use the office integrations to install applications on your computer
to integrate Maximizer with Microsoft Office programs. The
following integrations are available:

¢ Microsoft Word Integration - This integration allows you to
launch Microsoft Word directly from Maximizer and work with
Maximizer entries from Word documents. Word integration is
available only in Microsoft Internet Explorer.

¢ Microsoft Outlook Integration - This integration allows you
to perform tasks with Maximizer entries directly from Microsoft
Outlook.

Mobile Access lets you access your Maximizer Address Book over the
Internet from mobile devices.

¢ Mobile Access URL - Use this URL to visit the Mobile Access
site.

¢ Email the URL to your mobile device - Send a link to the
Mobile Access URL to your email address.

You can access the following types of information in Mobile Access:
e  Address Book information

e  Opportunities

e Customer service cases

e Hotlist tasks and appointments

e User-defined fields

* Notes

e Company Library documents

e Dashboards

Depending on the type of device you are using, the screens and
procedures may vary slightly.
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Compatible Browsers for Mobile Access

Log In to Mobile Access

The following browsers are compatible with Mobile Access:
e BlackBerry web browser

e Apple Safari

e Android web browser

Visit the Maximizer website at www.maximizer.com for the most up
to date list of supported browsers.

To use the full functionality in Mobile Access, users may also need to
configure their browsers in the following ways:

e Enable JavaScript

e Enable browser cookies.

You can log in to Mobile Access using your Maximizer user name and
password.

n In the browser on your device, enter the Mobile Access URL.

By default, the URL is in the form: [server name]/
MobileAccess where [server name] is the URL of your web
server.

E From the Log in to drop-down list, select the Address Book you
want to open.

E Enter your Maximizer user ID and password.

n Select Keep me logged in to avoid having to enter your
username and password every time you open Mobile Access.
This option may not be available if it has been disabled by your
system administrator.

E Select Log In.
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&R maximizer
CRM2015 r:

Log in to:
Escona Tutorial (v}

User ID:
JHAPOLL

Password:

Keep me logged in

The Mobile Access Home page opens.

Navigating Pages in Mobile Access

When you first log in to Mobile Access, the Mobile Access Home page
opens. You can access all content in Mobile Access from the Home
page.

In Mobile Access, you can navigate to different pages in the
following ways:

e From the Home page, select Address Book, Opportunities,
Customer Service, Calendar/Hotlist, Dashboards, Company
Library, or Help to open the page.

Home [Escona Tutorial] Loy out

1@
& (4 =

E
G

Corttact List Opportunities Contact
Service:
L m o
L2y
i I[I

Calendar ¢ Dashboards Otfice
Hotlist Documents

®)

Help
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From the navigation footer on any of the main pages, select the
Address Book, Opportunity, Customer Service, Calendar/
Hotlist, Company Library, or Dashboards icon to visit a
different page.

In the top-left corner of the page, select the Home icon to
return to the Home page.
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Company Information

You can quickly access information on other Maximizer users. You
can view a phone list of Maximizer users in a printable format. You
can also check the Peg Board to view the availability of your co-
workers.

View a Phone List of Maximizer Users

Check the Peg Board

You can view a phone list of all users in an Address Book. The short
form of the phone list includes last names, first names, and phone
numbers. The long form also includes the phone numbers listed in
the Phone 2 field and email addresses. The phone lists are displayed
in your browser in a printable format.

n In the left navigation pane, hover your mouse over User
information.

E In the pop-up, select Short phone list or Long phone list.

The phone list is displayed in a separate browser window.

First name Last name Email Phone 1 Phone 2. ext.

Celine Dancar c:isncm@rrsxln'lzerc:rr (555) 775-0859  (555) 775-0900 Exa. fax
Daniel Brown n@max (555) 775-0884 '5-0800 Bxt. fax
Jon Bowses (555) 7750883 [555 7750800 Exa. fax
Jos Mapoh (555) 7750982 775-0900 Exa. fax
Lucy Garcia (555) 775-0981 [555 775-0900 Ext. fax
Lou Jones (555) 775-0987 ) 7750800 Ext. fax
Mark Bencli (555) 7750978 (555} 775-0900 Exa. fax
Miranda (555) 7750977 (555) 775-0900 Bt fax
Matt Graham (555) 7750876 (555) 775-0900 Ext. fax
Wonda White (555) 7750873 (555) 775-0900 Ext. fax

The Peg Board works with the calendar to show you each user’s
current status. At a glance, you can check to see if a specific user is in
the office or is busy. You can also sign users in and out of the Peg
Board.

n In the left navigation pane, hover your mouse over User
information.
E From the pop-up, select WhereAbouts.

The Peg Board dialog box opens listing users and their current
status.
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Peq Board [X]
ser list

Status User Remarks Name Address Book Entry
Qut Billie: Holly

In Celine Dancer

In COMPANY

In Daniel Brown

Out  Joe Napoli Booked until 7.00 PM : Customer Service Me...  Chen, Melanie Amelia Liguors South

In Jon Bowser

Out  Lou Jones Booked until 7.00 PM : Customer Service Me...  Chen, Melanie Amelia Liguors South

Out  Lucy Garcia Booked until 7:00 PM : Customer Service Me. Chen, Melanie Amelia Liquors South
In Mark Bertolli
In Matt Graham

In Miranda Corell
Out  Wonda White

[“] show Qut anty

To change a user’s status manually, click on a user name and
modify the status for the user.

& User Status - Webpage Dialog

‘ User: Celine Dancer

The Peg Board Status for this user:

heck this user's calendar to update the Peg Board

Remarks concerning this user's whereabouts:

B
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